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1 Introduction 

Welcome to Producer, the SAP Enable Now tool that enables you to create web-based learning content that will 
take the user step by step through the contents of your web or Microsoft Windows application. 
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2 Settings and System Requirements 

The following chapters handle the required settings for recording and editing contents within the Producer as well 
as for playing back contents using the trainer, library, and book reader functionalities. 

2.1 System Requirements 

To install and use Producer successfully, your computer must fulfill the following requirements: 

Type Specifications 

Operating system 

• 32 & 64 bit versions of Microsoft Windows 10 
(without tile mode) 

• Microsoft Windows 11 

Processor Intel® Core™ i series, at least 1.2 GHz 

Memory A minimum of 4 GB 

Monitor Minimum resolution of 1280x720 

Hard drive 

Required free space: 

• Application files: at least 200 MB of free space 

• Content files: at least 2 GB of free space, 
depending on amount/size of workarea content 
and amount of workareas 

Browser 

Supported browsers and versions: 

• Microsoft Edge 107 
(Enablement Assistant Microsoft Edge extension 
required) 

• Google Chrome 107 
(Enablement Assistant Google Chrome extension 
required) 

Soundcard 
Any soundcard 

For production of audio lessons and book pages 

Microphone 
Any microphone 

For recording of audio 
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Scenario Requirement 

SAP Business Suite 
SAP GUI Scripting activated 
(server-side and role-specific) 

Java Applications Java Access Bridge activated 

Documentation Generation 

Supported versions: 

• Microsoft Office 2019 (Word and PowerPoint) 

• Microsoft Office 365 (Word and PowerPoint 
desktop only) 

2.2 Authoring Settings 

Recording, editing and previewing contents with the SAP Enable Now may need some preparations to your 
authoring environment. Read the following chapters according to your operating system and recording scenario to 
make your setup running perfectly. 

2.2.1 Required System Settings 

A few system settings are necessary for Microsoft Windows operating systems to allow the recording function to 
flawlessly identify Windows application objects. 

If an existing setting does not match the required settings for the application profile, a dialog box will appear to 
warn you when you start the recording. Facing this warning you should cancel the recording and configure the 
required settings. 

The following chapters describe how to configure the required system settings for each Windows operating system. 
Also, note the system requirements for Producer. 

2.2.1.1 Microsoft Windows 10 - Desktop View 

Specify the correct settings for the Microsoft Windows 10 operating system within the Appearance and 
Personalization dialog box.  
You can access this dialog in the desktop view by opening Settings -> Control Panel. Consider changing the View by: 
option in the upper right corner to Category. Select Appearance and Personalization.  
Set parameters as specified in the table below: 
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Section/Parameter Set to 

Personalization   

Change the theme Select Windows as Default Theme. 

Display   

Make text and other items larger or smaller -> use these 
display settings 

Set Change the size of text, apps and other items to value 
100% (Recommended). 

Fonts   

Adjust ClearType text  

1. Deselect the Turn on ClearType option. 

2. Select Next. 

3. Select Yes, I want to tune all monitors now. 

4. Verify the native resolution for your monitor and 
click on Next. 

5. The following four pages will provide you with 
examples of the font display. Select the best 
version to meet your needs and click on Next. 

6. Repeat steps for each of your monitors. 

7. In the last dialog box, select Finish to confirm the 
changes. 

Disabling font smoothing system-wide 

In some cases, deactivating the ClearType may not be sufficient for achieving error-free graphic object recognition. 
If this happens, you can disable the smoothing option for screen fonts system-wide. First, consult your customer 
advisor before deactivating this option on your own.  
The option to disable is Smooth edges of screen fonts which is found under Control panel -> System and Security -> 
System -> Advanced System Settings -> Settings (Performance). 

Screen resolution 

For the recording of simulations, it is recommended to use a screen resolution, that can be used consistently by all 
authors. If the content is also to be used on mobile devices, select a screen resolution that fits your screen and the 
type of mobile device you use. See also Browser Requirements. 

The screen resolution can be changed in the Display Settings -> Advanced Display Settings. Select your required 
resolution from the Resolution dropdown list. By default, the recommended resolution of the operating system 
should be used. 

2.2.2 Settings for Recording 

According to your operating system, certain preparations and practices for recording have to be considered. 
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2.2.2.1 Recording under Microsoft Windows 

Microsoft Windows allows you to run an application as a user or administrator. This is done via the command Run as 
administrator in an application link's shortcut menu. 

To allow applications to be recorded free from errors, you should ensure that the Producer and application to be 
recorded are called with matching rights. 

2.2.2.2 Settings for the SAP Client 

If projects are to be recorded using a SAP GUI for Windows client, certain settings need to be applied if the 
recording is to proceed without a hitch. 

2.2.2.2.1 SAP GUI Scripting 

The SAP GUI Scripting is necessary for the recording in order that the objects in the SAP GUI window can be 
properly recognized via the scripting interface from SAP. The SAP GUI Scripting should be activated on the server 
side so that the object information can be extracted. 
In some cases an activation on the client side is necessary (see scenario). If the scripting is activated on both sides, 
a red/white symbol will appear in the bottom right corner. 

The table gives you an overview of the recording scenarios and the necessary SAP GUI Scripting setting: 

Scenario Set to (Client) Set to (Server) 

Profound Recognition (Standard) Deactivated Activated 

Simple Recognition Activated Activated 

 Note 
NWBC with embedded SAP GUI: For the recording with profound recognition activate the SAP GUI Scripting also 
on the the client side. 

The SAP GUI Scripting on the client side can be set under the Customize Local Layout -> Options menu:  

Area / Setting Scenario Activated Scenario Deactivated 

Accessibility & Scripting -> 
Scripting 

  

Enable Scripting Activate Deactivate 

Notify when a script attaches to a 
Running GUI 

Off Disabled 

Notify when a script opens a 
connection 

Off Disabled 
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 Note 
Note that graphical object recognition is not possible when scripting is active. For graphical object recognition, 
additional requirements are necessary which are not standard. Contact your SAP consultant if you have any 
questions regarding this topic. 

2.2.2.2.2 Settings for SAP GUI 

The following settings can be defined from the option Customize Local Layout. 

Area / Setting Set to 

Theme 
Select a theme for the corresponding application profile, 
such as SAP Signature Theme, SAP Blue Crystal Theme 

Visual Design   

Font Settings Default settings 

Interaction Design > Visualization 1   

Cursor Width for Input Fields on Screens Narrow cursor 

Interaction Design > Notifications   

Tooltip Delay No Tooltip 

Local Data   

History Off 

2.2.2.2.3 Settings for Modal Dialogs 

The option Dialog (modal) is to be activated for optimal recognition of objects on modal dialogs. The setting is 
located on the F4 Help tab of the settings dialog, which can be launched from the Help -> Settings menu. 

2.2.2.2.4 Font Settings 

Position-based objects such as explanation bubbles, interactive surfaces and highlights are dependent on the 
predefined font properties in SAP; having differing settings can change the layout of the interface. It is important 
that the settings are the same when recording as well as when playing back the simulations (on users’ PCs) to 
ensure that the objects are always displayed properly. 

To adjust the font in your SAP system, go to the font settings in your SAP GUI: 

• Font settings 
You can adjust the settings under Visual Design -> Font Settings. 
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2.2.2.2.5 Page Titles in Page Keys for SAP GUI 

In the recording of SAP GUI for Windows it may be possible that advanced system information will be included in 
the page key (for example: WA1(1)/000 SAP Easy Access instead of SAP Easy Access). By performing a rerecording 
or playback a SAP Companion for desktop content this can result in an incorrect page recognition. To avoid 
additional information in the page key, the following adjustment in the registry of the operating system should be 
done: 

1. Open the registry editor with the command regedit about the Run… dialog. 

2. Select the entry HKEY_CURRENT_USER -> SOFTWARE -> SAP -> SAPGUI Front -> SAP Frontend Server -> 
Administration in the editor. 

3. Create a new DWORD value about Edit -> New: 
Value name: ShowAdditionalTitleInfo 
Value data: 1 

4. Restart your SAP system so that the registry entry can take effect. 

5. Change the value in the registry to 0. Thus you can deactivate the display of the title information. 

 Note 
Changes in the registry of the operating system should only be done by administrators. 

2.2.2.3 Settings for Microsoft Excel 

The following setting is necessary for optimal object recognition for Excel recordings: 

 Disable the setting Window in the menu Freeze panes. This prevents incorrect recognition of cell positions.  

2.2.2.4 Java Applications 

If the target application for the recording is a Java application, it is necessary to activate Java Access Bridge on 
your system. The Java Access Bridge will be installed with the Java Runtime Environment. 

To activate the Java Access Bridge, proceed as follows: 

1. Open Control Panel -> Ease of Access -> Ease of Access Center. 

2. Select Use the computer without a display to open the settings. 

3. Activate Enable Java Access Bridge in the section Other programs installed. 

2.2.3 Settings for Editing 

According to your operating system, certain preparations for editing projects have to be considered. 
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2.2.3.1 Editing Highlights 

In certain cases, it may be possible that highlights for controls are not properly displayed during the recording or 
the rerecording and therefore cannot be edited. In such instances, it is recommended to activate the option Show 
windows content while dragging, which is found under System Properties -> Advanced -> Performance. 

2.3 Learner Settings 

A few changes are required to the settings of your browser to work perfectly with SAP Enable Now functionalities. 

Independently of your preferred browser the playback functionalities require the following settings: 

Requirement Why? 

Enabled JavaScript All functionalities are based on the use of JavaScript. You must enable it. 

Deactivated pop-up blocker 

No matter which pop-up blocker you use, you must disable the blocking of 
pop-ups for the location you load your contents from. Read browser-
specific chapters to find instructions how to disable built-in pop-up blocker 
functionalities. 

Activated cookies 
The attributes and settings for displaying and executing library, trainer, and 
book reader are stored in cookies. You should therefore activate cookies in 
your browser to ensure that these functionalities run accurately. 

 Recommendation 
It may be that Flash contents are displayed incorrectly. In this case uninstall and reinstall the Flash plugin (do not 
do update only). 

2.3.1 Browser Requirements 
Consider the following requirements to ensure that the trainer, library and book reader functionalities work without 
errors, thereby ensuring that contents are played back successfully. 

Browser Version Operating system 

Microsoft Edge 107 Windows 10, 11 

Mozilla Firefox 106 Windows 10, 11 or macOS 12.x 

Google Chrome 107 Windows 10, 11 

Supported mobile platforms 

Content playback has been tested for the system built-in browsers of the following mobile device platforms. Keep in 
mind that playback on mobile devices usually requires an online connection to published contents (Manager or 
shared network storage). 
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Note 
The playback on mobile devices is supported for tablets. 

Platform OS Version Browser 

Apple iOS 15 Safari Mobile 

Google Android 8  
Stock Browser (AOSP) 

(with deactivated Desktop View) 

2.3.2 Settings for Mozilla Firefox 

The following settings are required for a flawless playback experience in Mozilla Firefox. 

Changes in the settings dialog 

Select the Settings item in the Tools menu in the open browser. Now go to the Content item in the settings dialog to 
see the required options.  

Setting Set to 

Block pop-up windows Deactivate 

Activate JavaScript Activate 

Advanced JavaScript settings 

Select the Advanced button to open Advanced JavaScript 
settings. Activate the following options: 

1. Position window before or after other windows 

2. Hide status bar 

3. Change status bar text 

Settings using about:config 

Additional browser configuration settings are available to you in Firefox. You can access these settings by entering 
about:config in the address bar and confirming with Enter. 
Enter setting name into Search field. A setting can be activated by double-clicking on it. It is then displayed in bold 
text and the value true is set. 
The following settings are to be set to the value true: 

Setting What does it do? 

dom.allow_scripts_to_close_windows  This setting allows browser windows to be closed. 

signed.applets.codebase_principal_support 
This setting displays browser windows in fullscreen 
mode. 

dom.disable_window_open_feature.resizable This setting prevents the size of an open browser 
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Setting What does it do? 

 window from being changed. 

security.fileuri.strict_origin_policy 
This setting allows links to be executed if an HTML page 
is launched from a local drive. 

Printing the stop page 

To print the stop page of the trainer correctly you have to allow the print of background elements. Activate the 
setting Print background (Colors and Images) which is to be found on the page setup dialog under File -> Page setup. 

 Note 
• Caused by the settings that have been activated, you will face a security message when starting the library or a 

content in the trainer. Confirm this message with Allow.  
Activate the option Remember this decision so that the security message will not be displayed each time the 
library starts. 

• The default bubble audio effects in simulations and in the book reader actions are in WAV format. A Windows 
Media Player plugin is required in order to be able to play back the files in Firefox. 
You will find further information on the subject at: https://addons.mozilla.org/en-US/firefox/browse/type:7 

https://addons.mozilla.org/en-US/firefox/browse/type:7
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2.3.3 Settings for Google Chrome 

The following settings are required for a flawless playback experience in Google Chrome. 

 Note 
The security model of Google Chrome prevents the playback of content from a file system. Content can only be 
played back from a Web server. 

Changing the settings 

Choose the Customize and control Google Chrome button in the open browser. Choose the Settings menu 
entry. Scroll to the bottom of the screen, choose Show advanced settings... and in the Privacy category, choose 
the Content settings... button. 

Setting Set to 

Cookies Allow local data to be set 

JavaScript Allow all sites to run JavaScript 

Pop-ups Allow all sites to show pop-ups 

2.3.4 Settings for Safari 

The following settings are required for a flawless playback experience in Safari. 

Playback settings 

Open the browser's settings dialog using the Edit -> Preferences menu. In this menu, select the Security area and 
apply the following settings: 

Section/Setting Set to 

Security   

Activate JavaScript Activate 

Block pop-up windows Deactivate 

Privacy   

Block cookies From third parties and advertisers 

Printing the stop page (OS X only) 

To print the stop page of the trainer correctly you have to allow the print of background elements. Activate the 
option Print background in print dialog. 
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2.3.5 Settings on iPad 
Specific browser settings are required for trouble-free display on an iPad. Tap Settings > Safari to change settings: 

Section/Setting Set to 

Privacy   

Accept Cookies  Always or From visited 

Security   

Block Pop-ups Disable 

 Note 
To use the trainer, library and book reader functions on an iPad, you need an active Internet connection with 
access to a central server hosting the published content. 

Playback performance relies on connection speed. If the connection is too slow, images might not be loaded in 
time. 

The iPad does not support Adobe Flash and therefore book elements containing flash animations are not 
displayed.  

2.3.6 Settings on Android Devices 
Specific settings are required for trouble-free display on an Android device. 

Section/Setting Set to 

Keyboard Settings   

Predictive text 
(Name depends on device) 

Avoids an automatic input of text in a text field. 
Disable 

2.3.7 Settings for e-Mails 
When using the Send Content function of the library it is required that the e-Mail program uses UTF-8 character 
encoding. This prevents incorrect display of the e-Mail text in a specific language. 

Microsoft Outlook 

For Microsoft Outlook UTF-8 can be activated in the Outlook Options: 

Section / Setting Set to 

Advanced -> International options   

Allow UTF-8 support for the mailto: protocol Activate 
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3 Simulation Recording 

You can record the processes of your web and Microsoft Windows applications. In the following chapters, the 
procedures for recording and rerecording of simulations are explained. 

3.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

3.2 Recording Settings 

In the Settings dialog box under the category Authoring Settings -> Recording - General you can specify settings for 
the recording. The settings can be opened in the Tools -> Settings...  menu. 

 Recommendation 
Adapt the recording settings before starting with the recording to specify default settings for all recordings. 

In the recording settings, you can specify the following: 

• Recording area and size 

• Profile change for application changes 

• Recognition method 

• Recording mode 

For more information, see the chapter Recording - General. 

3.3 Recording a Simulation 

The following section describes the procedure for recording simulations with the Producer. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_A1D0FAED1078F690
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Recording modes 

The Producer offers different recording types: 

Type Definition 

Quick Recording 
This recording mode allows you to make a fast recording 
of an application. No information is read from objects. 

Recording 

This recording mode allows you to make a complex 
recording of an application, and read information from 
objects. The recordings can be used for rerecording and 
for converting SAP Companion for desktop projects. 

Default recording mode 

You can configure the default recording mode in the Settings  dialog box. In the category Authoring Settings -> 
Recording - General, choose the mode in the Recording Mode setting. See also the chapter Recording - General. 

3.3.1 Creating a Simulation Project 

Create a project for your simulation content. For further information, see the chapter Creating a Content Object. 

To create a project, proceed as follows: 

○ In the Explorer, select New Object . 
An overview of all objects opens. 

○ Select Simulation . 
The New Project dialog box opens. 

○ Adapt the following settings:  

○ Name: 
Enter a project name. 
The default name is the object type with an ID. 

○ Language: 
Select a language for the project. The automatically created bubble texts are generated in this language. 

○ Project Type: 
The Standard - Simulation type is selected. 
You can change the type in the dropdown box. 

○ Use Audio: 
This option lets you record a project with audio. You can record audio, you can assign audio files, and you 
can convert bubble text to Text-to-Speech. The following settings appear:   

○ Output format: 
Defines the audio format for playing back a project.  

○ Editing format: 
Defines the audio format for editing a project.  

You can change the format in the Change Audio Format... dialog box (Audio menu). 
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○ Choose OK to create the project. 

The project opens in the project editor. You can now record your content. Read the following chapters about this 
subject. 

3.3.2 Starting the Recording 

To start the recording, proceed as follows: 

 Note 
The available settings depend on the active recording mode. Not all settings are displayed in the dialog boxes. 

1. Starting the recording 

1. Open the application to be recorded. 
Choose the application page where you want to start recording and prepare the application as required. 

2. Select the Recording  button in the project editor. 
The Select Window and Profile dialog box opens. 

2. Choosing the window and profile 

1. Choose Window: 
Select the application window that you want to record from the list. The selected window appears in the 
foreground.  

2. Choose Profile: 
This setting selects the application profile for recording the application automatically. If you want to use 
another profile, you can change it using the dropdown box. 
If both recording modes are activated, you can select Quick Recording instead of a profile. 

 Note 
If the application you want to record has been started with administrator privileges, then it is necessary to allow 
the Producer to run with administrator privileges as well. You can do it during the recording by pressing the 
Restart as Administrator button which is shown at the bottom of Select Window and Profile dialog. 

3. Record Screencast Video: 
When you use the Quick Recording, you are able to record a screencast video of your process. 
During recording, all your actions are saved as frames. Afterwards, you can generate a video. 

4. Associate with Selected Window: 
Activate this setting if you always want to use the profile for the selected application window. 

5. Record Audio: 
Activate this setting if you want to record an audio during the recording of the simulation. 
See also the chapter Recording Audio. 
The setting is displayed if the project was created with the option Use Audio. 

6. Select Continue . 
The Define Recording Area dialog box opens. 
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 Note 
If a suitable application profile could not be identified, then the default profile is used. Note that in this case, the 
recognition accuracy of the interactions and controls in the application window might be limited, depending on the 
application. 

3. Choosing the recording area 

1. Select Region or Active Window: 
Specify if you want to record a region with a predefined size or the exact application window. 

2. Region settings 

• Choose Size: 
In the dropdown box you can select a predefined size for the region. 

• Define Width and Height: 
Displays the current size. 
You can specify a size for the region. The dropdown box changes to the entry Custom. 

• Fit Application Window: 
Activate the setting to automatically change the window size to the specified region.  

3. Start the recording using the Record  button.  
Select the Cancel button if you want to cancel the recording. 

Now the recording starts. The recording bar or the systray icon is displayed , depending on the recording mode. 

Diagnosis for profile 

Any problems with the recording settings are displayed in the diagnosis box. Depending on the exact problem 
identified, recording may not be possible or object recognition may be restricted. 

• Select Cancel to resolve the problems. Then restart the recording. 

• Select Continue to proceed with the recording. 

3.3.3 Executing Quick Recording 

To record an application using quick recording, proceed as follows:  

1. Navigate through the application screens required for the simulation. Your actions will be recorded 
automatically. 

2. Pausing the recording 
Press the Pause key to pause the quick recording. If you are recording an audio, then this will also be paused.  

3. Select Continue to resume the quick recording. The recording is continued from the exact point at which it was 
paused.  

4. Changing the application 
You can change the application during recording if required. 
Click on the new application to select the application. Continue with the recording.  
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5. Stopping the recording 
Press the End key to finish the quick recording. 

Afterwards, the project editor is displayed. 

 Recommendation 
When recording audio, speak your text before selecting the corresponding control. 

3.3.4 Executing Recording with Profile 

To record an application, proceed as follows:  

1. Navigate through the application as needed for the simulation. Your actions will be recorded automatically. 
Execute the actions slowly so that the Producer can correctly record the individual actions. 
The basis of recording is the recognition of objects and controls. Algorithms are used to try to recognize each 
object that you click on in an application. When an object is recognized, a corresponding macro (for example, 
Input Text  or Mouse Action ) is generated. 

2. Pausing the recording 
The recording can be interrupted using the Pause  button in the recording bar. If you record an audio, also 
the audio recording is paused. 

3. Recording can be resumed using the Record  button. The recording is picked up at the exact point at which 
it was interrupted. 

4. Changing the application 
You can change the application during recording if required by your process cycle. 
Click on the new application in order to select the application. Continue with the recording. 

5. Undo an action 
If an error has been made during the recording, it is now possible to undo this action. By selecting Undo , 
the macro created for the action is deleted, then you can simply proceed with your recording as desired. Note 
that the Undo function will only work with the last action made. You cannot delete multiple actions. 

6. In some instances, it may be necessary to manually reset the data entered in the application or change back to 
a previous application. To do so, simply pause the recording, make the necessary changes and then proceed 
with the recording. 

7. Stopping the recording 
To end the recording of a project, select Stop in the recording bar. 

The recording bar will be closed. 

3.3.4.1 Inserting Additional Macros 

You can influence the design of your simulations even while recording is in progress. You have the opportunity to 
insert an additional screenshot in the form of a Screen  macro or an Explanation  macro. 

 



 

Producer (Cloud Edition) 
Simulation Recording 

 
PUBLIC   30 

 

To do this, proceed as follows: 

1. Open the menu Insert of the recording bar. 

2. Select the Insert Explanation or the Insert Screenshot button to insert the corresponding macro. 

○ Inserting an explanation  
Selecting the Insert Explanation function inserts an Explanation macro for the current step. 
An explanation can draw attention to a specific situation. Insertion while recording is in progress makes it 
easier for you to take immediate account of specific content and not have to look it up at a later date. 

○ Inserting a screenshot  
The Insert Screenshot (Ctrl+Shift+b) function allows you, while recording is in progress, to manually 
set up an additional screenshot for the application page currently being displayed without having to take 
any action in the application. This sets up a step with a Screen macro. 
You can use this screenshot for additional information between actions or else separately to draw 
attention to particular functions on the application page. 

3. Continue as usual with your recording. 

4. Upon completion of the recording you can continue editing the macros as appropriate. 

These functions can also be used in combination by you inserting a screenshot and then, superimposed on it, an 
explanation in order to clarify a particular fact. 

If you have minimized the recording bar, you can invoke these functions via the icon's context menu in the taskbar. 

3.3.4.2 Recording a Hotspot 

It may happen during recording that one control cannot clearly be recognized. In this eventuality, a Hotspot is 
recorded. 

A Hotspot defines an area for a control in respect of an unrecognized control at the point that has been clicked. 
During recording a Mouse Action macro or an Input Text macro with standard parameters is created. This does not 
involve any object information being read out of the application.  
Recognition of the Hotspot allows the recording to proceed without interruption and post-editing can then be 
carried out in the macro editor and in the step view. 

There is no visible difference between a recorded Hotspot macro and a regular control. You can see, if a macro is a 
Hotspot in the Rerecord subcategory of the macro editor. A Mouse Action macro has the value WINHotspotArea 
and an Input Text macro has the value WINHotspotEdit. 

 Note 
Note that recorded Hotspots will affect a possible rerecording of a project. As the Producer does not save any 
object information for the control, the Hotspot itself is rerecorded during rerecording even if there is no control at 
this point. 
In this regard consult the section on Interactive Rerecording. 

 

 Note 
Before creating a Hotspot the Producer first performs a graphical object recognition. It is therefore possible that 
the size used will not be the one defined for the Hotspot but the size of an object area identified during recognition. 
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3.3.5 Recording Scenarios 

There are different settings and requirements for your recording scenario. See the following chapters for more 
information. 

3.3.5.1 Recording in Browser Window 

Recording in a browser allows you to distinguish whether the displayed browser content or the browser content and 
browser interface are to be recorded. 

 Note 
For recording with Mozilla Firefox, the Quick Recording mode is recommended. 

Recording in Google Chrome and Microsoft Edge 

You can record content in Google Chrome and Microsoft Edge. To support correct object and page recognition, you 
have to install a browser extension. Activate the option Install browser extension during installation of the Producer. 
The extension can be uninstalled from the Extensions settings of Google Chrome or Microsoft Edge. 

 Note 
After uninstalling the extension in Google Chrome, it cannot be installed again with the Producer installer. Google 
Chrome blocks the installation. You can install the extension from the Chrome Web Store. Search for Enablement 
Assistant. 

Selecting the recording area 

When starting recording, select the following in the Define Recording Area window: 

• Recording the browser content 
You can record the browser content, for example, a web page or an application. The browser's user interface is 
not recorded and is therefore not visible in the screenshot. 

1. Select the Browser Content Area option. 

2. Specify the area size in the Choose Size setting. 

• Recording the browser content and browser user interface 
You can record the browser content and the browser user interface. This allows you to record menus and 
browser dialog boxes as well. 

○ Select the Active Window option. 

 Recommendation 
The Browser Content Area or Active Window option can be predefined in Settings  under Authoring Settings -> 
Recording - General. Activate the required option in the Area setting. 
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 Note 
Since SAP Enable Now 2011, Producer supports display scaling values higher than 100%. You need to restart the 
Producer after you have changed the display zoom settings. 

Multi-monitor configuration is not supported. Producer needs to run on the same monitor where you have set the 
desired scaling. 

The zoom settings used for the recording are saved in the project and are shown during the rerecording if the 
values do not match.The recommended Zoom setting of the browser is 100%. You do not need to change browser 
zoom settings, because browsers automatically take over these settings. 

 Recommendation  
The are maximum DPI scaling factors for specific screen resolutions that SAP Enable Now supports: 

Screen resolution height in px DPI scaling 

720 100% 

>720 125% 

1080 150% 

1440 200% 

3840 225% 

The DPI scaling limit is 225%. Higher scaling can still be used and most UI elements, such as text or dialog size, will 
scale above 225%. However, some UI elements, such as icons, will not be scaled above 225%. 

3.3.5.2 Recording of Microsoft Excel 

For the recording of Microsoft Excel there are several recommendations to support correct object recognition: 

Preparations 

Open only one workbook in Excel. 

Recording an Excel cell 

To record a cell entry, proceed as follows: 

1. Select a cell with a left mouse click. 

2. Enter the values. 

3. Confirm with Enter or Tab key. 

4. Click in the next cell or on a control. 

Repeat these steps for each needed cell entry. 
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Excel shortcuts 

The following shortcuts can be used during recording: 

Shortcut Description 

Enter 
Completes a cell entry from the cell or the Formula Bar, 
and selects the cell below (by default). 

Shift + Enter 
Completes a cell entry and selects the cell above. This is 
recorded as Enter. 

Tab Moves one cell to the right in a worksheet. 

Shift + Tab 
Moves to the previous cell in a worksheet or the previous 
option in a dialog box. This is recorded as Tab. 

Rerecording Excel 

For the rerecording of Excel use the interactive rerecording type. This allows you to execute the actions manually. 

If at any point during interactive Rerecording the application is not in the desired state for the next step, proceed as 
follows: 

1. Click on Show Control. 

2. Navigate to the next step while holding the Ctrl key. 

3. Record the correct step without holding Ctrl. 

No Rerecording will take place while Ctrl is pressed. This is useful when menus disappear after a click to show the 
control in the previous step. 

3.3.5.3 Recording for Mobile Devices 

For the recording of content for playback on mobile devices, the following settings are recommended: 

• Screen size 
For the playback of simulations on mobile devices a screen size of 1024 x 724 is recommended. 
Define the size for recording in the central configuration dialog box (menu Tools -> Settings... ): Authoring 
Settings -> Recording - General -> Size. 

• Screen resolution 
For an optimized recording in combination with the defined screen size, change the screen resolution of your 
workstation. 

• Content texts 
Adapt the texts of the Recording Dictionary to create a mobile dictionary. For example, change the wording 
Click... to Touch... 
See also the chapter Dictionary Editor. 

To create simulations for mobile applications see the chapter Creating iPad Simulations. 
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3.3.6 Recording Bar for Recording 

The recording bar appears when you start the recording. It includes the following sections and controls: 

Buttons and menus 

The buttons let you control the recording. 

 

 

Button / Menu Explanation 

(1) Level Meter 
The Level Meter is displayed when recording a simulation with audio. The control 
indicates the recording of the audio. 

(2) Profile 

The dropdown box contains the list of applications for which an automatic 
application profile exists. If the application is detected automatically, the correct 
application profile is selected automatically and shown in the list. You can also use 
this box to switch between application profiles manually. 

(3) Record 
Select this button to begin recording the process. Afterwards, the button changes 
to Pause. 

(3) Pause 
Select this button to interrupt the recording. This is useful when changing 
applications. Afterwards, the button changes to Record. 

(4) Stop Select this button to end the recording and to close the recording bar. 

(5) Undo 
Select this button to reset the previous action of your process. 
Note that this applies only to the last action. You cannot delete multiple actions. 

(6) Menu Insert 

Insert Explanation  
Select this button to insert an Explanation. 
For more about the Insert Explanation button, see the chapter Inserting Additional 

Macros. 

Insert Screenshot 
Select this button to insert a Screenshot. 
For more about the Insert Screenshot button, see the chapter Inserting Additional 

Macros. 

(7) Menu Tools 
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Button / Menu Explanation 

Execute Mouse Actions 

Select this button to specify whether a control is to be recorded and executed in 
the application or whether this is to be recorded without an action. 
Recording controls without executing actions is recommended if a number of 
controls on a page are to be recorded and explained without leaving the 
application page. The button has to be deactivated to do this. 

Choose Application 
Select this button to reselect an application for recording or to switch to another 
application. Afterwards, select the required application. 

Settings 
Select this button to open the Recording - General page in the Settings dialog box. 
You can also open the settings in the Tools -> Settings... menu . 

(8) Minimize 
Select this button to minimize the recording bar; an icon will appear in the system 
tray instead. You can control the recording using the context menu. By selecting 
this icon, the recording bar will return to its original size. 

(9) Close Select this button to close the recording bar. The recording will be stopped. 

Status section 

The status section shows you whether an action is required or if the Producer is working on a recording in the 
background. Supporting icons and text messages are also displayed. 

Icon Explanation Icon Explanation 

 

Record 

This status is shown, if 
your recording is running 
and you need to perform an 
action. 

After an action has been 
performed, the status also 
shows the detected control 
(Name, Type, Value, and 
Subtype). 

 

Pause 

This status is shown 
when you pause the 
recording. 

 

Busy 

This status is shown if your 
action is executed in the 
background. 

Note: Wait for the green 
Record status, to execute 
the next action. 

 

Note 

This status is shown when 
you need to perform an 
action. For example, 
selecting an application. 
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3.3.7 Systray Controls 

The systray bar for the quick recording contains the following controls: 

Button Explanation 

 

Pause 

Select Pause to pause the recording. 
With the Pause key recording can be paused. 

 

Record  

Select Record to continue recording the process. 
With the Pause key recording can be continued. 

 

Stop 

Select Stop to end the recording. 
With the End key recording can be stopped. 

 Recommendation 
It is recommended to use the key functions to avoid the recording of the context menu. 

3.4 Rerecording a Simulation 

When using various applications, companies often encounter a variety of problems when creating the 
corresponding training material. 

The applications are often used across locations in different countries and language regions and therefore consist 
of multiple language versions. However, the processes and operations when using the applications in the various 
language versions are more or less identical. 

Therefore, it is necessary that companies have consistent training material explaining a particular process available 
in the relevant languages in which the task is to be carried out. 

Another problem lies in the new versions of an application and the changes to its interface that come part and 
parcel with these newer versions. This requires a fast and simple update of the existing training material to be able 
to describe processes according to the current version of the relevant application. 

Problem definition 

The following problems arise: 

• Translation: The goal is to create a language variant for the corresponding project based on a target 
application in a different language. 

• Program update: The goal is to update the project based on a new version of the target application. 
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Troubleshooting in the Producer  

The Producer offers the possibility of rerecording. With this method, it is possible to rerecord a project in a different 
language as well as update the screenshots so that they correspond to new versions of the application. This 
process is executed automatically by the Producer and has the advantage that a project does not have to be 
manually recorded once again by the author. 

Rerecording thus greatly simplifies coherent creation and updating of training material, thereby drastically reducing 
the amount of effort needed when making a revised version. 

3.4.1 Project Changes 

The following overview shows you the information saved in the macros after a project has been recorded: 

 

1. Automatically generated instruction text 

2. Object Name / Identifier 

3. Object Image / Graphic 

 

4. Screenshot of application page 

This information has to be customized to update or localize a project. The corresponding changes can be 
automated by using rerecording:  

Area Example Description 

Automatically generated instruction 
texts 

Click ... 

The instructions generated while 
recording have to be customized 
according to the target application, 
for example, translated into a 
different language. 

Identifier of the recognized objects / 
Object Name 

Save 
Rerecording automatically modifies 
the recognized objects’ identifiers. 
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Area Example Description 

Generated graphics / Object Image  

Rerecording automatically 
customizes the graphics of the 
objects contained in the bubble 
texts. 

Generated screenshots 

 

Rerecording automatically 
translates the application page 
screenshots into a different 
language or a new version of the 
target application. 

Manually edited instruction texts 
This function applies your inputs to 
the system. 

Manually edited texts cannot be 
automatically translated with 
rerecording. These texts will be 
exported in translation templates in 
XLIFF or Microsoft Word format, 
translated externally and then re-
imported. 

3.4.2 Rerecording Functionality 

During the original recording of an application, the Producer creates a macro for each executed action. This way, a 
project contains a sequence of macros, which, when put together, describe the process. 
When rerecording takes place, the Producer repeats this process in the recorded application. Here, rerecording is 
going through a project macro by macro, and each action is executed and recorded once again in the corresponding 
application. 

This process is usually automatic and, depending on the settings actions, can also be executed manually. This way 
the user can select a control during the rerecording process and thus has the option of changing the recording 
process. To recognize and execute the recorded control of an action during rerecording, the Producer compares 
the object parameters such as position, identifier and size. 

Manual intervention by the author is necessary in some cases, if for example there is too much of a difference 
between a control and the originally recorded object following a program update or if there are process changes as 
a result of new or remote process steps. An action can also be executed manually if it was previously defined for a 
control. This allows the user to select a control during rerecording and optionally influence the rerecording process. 

Translating a project 

When the language of a project is changed using rerecording, the project will be translated into one of the project 
languages available in the Producer. Here, the automatically generated bubble texts of the macros are replaced by 
text segments in the previously specified new project language. The original screenshots are updated with 
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screenshots from the other language version of the application. 
However, projects also usually contain individually inserted texts. With the help of translation files, the text 
segments can be customized before rerecording. 

 Note 
If only the texts of the bubbles are to be translated into a different language, without rerecording the project, this 
can be done by using the Automated Translation function. 
Automatic translation makes sense if an application is only available in one language but is needed in a number of 
different languages. 

Updating a project 

When updating a project for a new version of an application, the corresponding screenshots of the interface and 
buttons are rerecorded. The relevant bubble texts can be kept or updated as required. 

3.4.3 Preparations for Rerecording 

Before being able to start rerecording, a number of preparations must be made. 

 Note 
Rerecording the projects with branches is not possible. A project will go through the rerecording process macro by 
macro in a linear fashion. However, branches provide multiple options for the path of a project which the Producer 
cannot automatically follow. Branches should therefore only be integrated into a project after rerecording. 
To be able to rerecord projects with branches, consult the Rerecording of Projects with Branches section. 

Rerecording Settings 

In the Settings...  under the category Authoring Settings -> Rerecording you can define specific settings for the 
rerecording. For further information, see the chapter Rerecording. 

3.4.3.1 Preparing the Application for Rerecording 

Before starting the rerecording, some preparations are necessary in the application to be rerecorded so that the 
rerecording can be carried out in accordance with the originally recorded project: 

• To translate a project, select the application in the desired language.  

• Open the application page containing the first step and ensure that the same status as in the original 
recording is available (for example, same tree structure).  

• Make sure that the dates and entries correspond to the system of the original recording. It might be advisable 
to log off and log on to the system in order to reset existing values. If a project needs to be translated, the 
entries for the recording should be adjusted to the particular language.  

• When using dynamic pages, make sure that the state is according to the original recording. Open and close 
the application to remove all changes.  
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• When translating a project, make sure that the design of the application (for example, SAP GUI) is the same as 
in the recording.  

• To be able to rerecord a process, this should be repeated multiple times in the application, for example, 
creating bill of materials or routings in SAP. Creating alternative recordings usually results in a divergent 
process. If necessary, the created macro must be deleted or the material copied in order to enable a new 
recording.  

 Note 
Macros may be deleted when working in the test system only. 

• When rerecording SAP applications ensure that you are only logged on to one SAP system. If applicable, first 
close all the sessions that are not required for the rerecording.  

3.4.3.2 Selecting the Control Interactively 

During the rerecording process a control can be selected interactively instead of automatically by the Producer. 
This can be useful if the control is located at a different position in the application or a different control is to be 
chosen for rerecording.  
This option should be applied to controls which were often not recognized during previous rerecording attempts. 
This way, the Producer does not have to look for them first. 
During rerecording the Producer stops at the corresponding macro. You can now select the matching control. 
Consult the Executing the Rerecording section as well. 

Activating the option 

To be able to interactively select a control when rerecording, activate the Interactive setting in the corresponding 
macro for the control. This can be done in the subcategory Rerecord of the macro editor. 
It is also possible to use the Interactive setting when switching between applications during rerecording. This way a 
recording can be stopped in order to select the application. 
Activate the Interactive setting for the first executable macro of the new application. 

 Note 
An application change must be carried out during the rerecording process as the Producer cannot automatically 
select an application. 

3.4.4 Starting the Rerecording 

Rerecording can start once the necessary preparation is complete. To start rerecording, proceed as follows: 

1. Starting the rerecording 

1. Open the application to be rerecorded. Modify the application as necessary as described in the preparation for 
rerecording. 

2. Open the project to be rerecorded in the project editor of the Producer. 
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3. Select Rerecord Application  in the project editor. 
The Rerecord Project dialog box opens. 

2. Defining the project 

1. Name: 
Specifies the name of the project. This is recommended if you duplicate the project.  

2. Language: 
Specifies a new language for the project. All of the project languages available in Producer can be selected 
from a drop-down menu. 

3. Duplicate Project: 
Selecting this option duplicates the project before rerecording begins. The rerecording is performed in the 
duplicated project. 
The project needs to be duplicated because the rerecording is based on the original project that is overwritten 
during rerecording. 

4. Select Continue . 
The Select Window and Profile dialog box opens.  

3. Choosing the window and profile 

1. Choose Window: 
The recorded window and profile is selected automatically. 
If not, select the application that should be rerecorded from the list. The selected application appears in the 
foreground. 

2. Choose Profile: 
This setting selects the application profile for recording the application automatically. If you want to use 
another profile, you can change it using the dropdown box. 
If you want to use another profile, you can change it using the dropdown box. 

 Note 
If the application you want to rerecord has been started with administrator privileges, then it is necessary to 
allow the Producer to run with administrator privileges as well. You can do it during the recording by pressing 
the Restart as Administrator button which is shown at the bottom of Select Window and Profile dialog. 

3. Associate with Selected Window: 
Activate this setting, if you always want to use the profile for the selected window. 

4. Revise Input Values: 
If you select this option, you can modify the text box inputs or selections you have made in drop-down lists 
after you have applied settings in a dialog. This allows you, for example, to modify inputs for your selected 
language or application version. The dialog is displayed after the relevant rerecording type has started. 

5. Interactive Mode: 
The option defines how you can intervene for unrecognized controls.  
For further information, refer to the chapter Rerecording Types.  

Now the rerecording bar opens and appears at the upper edge of the screen. 
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Diagnosis for profile 

Any problems with the recording settings are displayed in the diagnosis box. Due to the problems specified, 
recording may not be possible or object recognition may be restricted. 

• Choose Cancel to resolve the problems. Then restart the recording. 

• Choose Continue  to proceed with the recording. 

3.4.4.1 Rerecording Types 

In the start dialog box, you can choose between an appropriate type for the rerecording by using the option 
Interactive Mode. The types define what to do when dealing with unrecognized controls. 

• Automatic 
With this recording method, an unrecognized control is recorded as a Hotspot. 
It is also possible to define how the method will deal with a recorded Hotspot. That means that this recorded 
Hotspot can be edited with an editor or else use the wizard for the rerecording. 
Deactivate the option Interactive Mode to start the automatic mode.  

• Interactive 
This recording method can be used to edit unrecognized controls as a Hotspot directly in the application. This 
involves opening an editor which makes it possible to position and edit the range of the object area and the 
bubble. 
During interactive rerecording each control found is to be confirmed by pressing the Enter key to resume 
rerecording. 
The interactive rerecording still serves as a fallback method in a situation where a conflict occurs during 
automatic rerecording. In a conflict situation, the mode is changed to interactive mode and after the conflict 
situation was resolved it is changed to automatic mode again. 
Activate the option Interactive Mode to start the interactive mode. 

3.4.4.2 Partial Rerecording 

In addition to the normal rerecording you can also launch rerecording from a specific step or for specific, selected 
steps. This allows projects to be partially recorded and it is thus not necessary to rerecord the entire project.  

•  Rerecord Selected Steps 
This selection allows you to rerecord several related project steps. This is useful, for example, if a partial 
update of associated projects is required as a result of changes within an application. 
Before starting to rerecord, highlight the desired steps in the thumbnail view. Then select the option Rerecord 
Selected Steps. 

•  Rerecord from Current Step 
This selection allows you to start rerecording from a specific step. This setting is useful if you are only 
supposed to rerecord from a particular section of a project. The step must be selected in the Producer 
thumbnail view prior to rerecording. Then select the option Rerecord from Current Step. 



 

Producer (Cloud Edition) 
Simulation Recording 

 
PUBLIC   43 

 

3.4.5 Executing the Rerecording 

Once the rerecording has been started, the Producer executes it automatically: 

1. When rerecording a project, the Producer goes through the macros from the original recording step by step. 
The actions of the individual macros are executed in the application and recorded. 
While this is happening, the recording bar is displayed in red, showing the recording and thereby the 
recognition and execution of the controls. 

2. According to the type selected in the start dialog box the rerecording is accomplished as described in the 
respective chapters:   

○ Automatic Rerecording 

○ Interactive Rerecording 

3. Now record the project as described in the particular subchapters.  

4. If rerecording was executed successfully, a dialog box appears. Confirm it with OK. 

 Note 
If an action was incorrectly executed during rerecording it is advisable to terminate the rerecording and use the 
selection Rerecord from Current Step to resume rerecording the remainder of the project from this step. 

The rerecording bar will be closed. 

3.4.5.1 Automatic Rerecording 

When rerecording in automatic mode every step is recorded automatically by Producer. An intervention by the user 
is only necessary if a conflict situation occurs. In this event the rerecording changes into interactive mode and after 
the conflict situation was resolved it changes back to automatic mode. 

If a conflict situation occurs during rerecording, you are informed by means of an explanation bubble. Such a 
conflict can be: 

• A control device does not match the originally recorded control device  

• A control device could not be identified  

• The Interactive option was activated for a macro  

In addition to the occurring conflict situation the bubble text informs you how to resolve it. 

Conflict approach 

If one of these cases occurs, the automatic mode changes into interactive mode. By selecting the Show Control 
 function in the recording bar the designated control device can be recorded interactively. Select it in order to do 

so. 

If a control device matches the originally recorded one you can also confirm it under Accept Control . 
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Control device was set interactive 

If the macro setting Interactive is applied in the subcategory Rerecord before the rerecording takes place, the 
Producer stops at this point and changes to interactive mode. Now the object can be edited. After confirming 
Accept control device in the recording bar, the rerecording is resumed. 

This procedure is also executed if the interactive rerecording was activated in order to rerecord Hotspots. The 
particular Hotspot handling setting can be defined in the area Authoring Settings -> Rerecording in the Settings  
dialog box. 

3.4.5.2 Interactive Rerecording 

The interactive rerecording allows checking the control devices which need to be rerecorded and to influence them 
directly during the recording process. Furthermore, steps can be rerecorded, deleted or skipped. 

Using the interactive rerecording makes sense when many modifications need to be made, several objects were 
recorded as Hotspot or major alterations were introduced to the application with regard to the original tutorial. 

Accomplishing interactive rerecording 

Interactive rerecording stops at every object and displays it including its mark and bubble during the process. Now 
you can edit the object or, if it is correct, resume rerecording directly. Confirm the object via the Accept Control  
button in the recording bar. As a result, the rerecording is resumed. 

Conflict approach 

If a conflict situation occurs during rerecording, you are informed by means of an explanation bubble. Such a 
conflict can be: 

• A control device does not match the originally recorded control device  

• A control device could not be identified  

• The Interactive option was activated for a macro  

In addition to the occurring conflict situation the bubble text informs you how to resolve it. 

By selecting the Show Control  function in the recording bar the designated control device can be recorded 
interactively. Select it in order to do this. 

If a control device matches the originally recorded one you can also confirm it under Accept Control . 

3.4.5.3 Editing in Interactive Mode 

If an object is rerecorded interactively, it appears within a selection frame and with the corresponding bubble. The 
selection frame can be moved within the application, adjusted in size via the handles and positioned above the 
control. The bubble can also be moved to the designated position; a click in the bubble allows editing the particular 
bubble text. 
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It is possible to navigate in the target application during interactive rerecording in order to select a certain page or 
to make required adjustments in the application. 
Confirm the designated adjustments when completed under Accept Control in order to resume rerecording. 

• Show Control: 
If a control is not displayed correctly you can directly rerecord it via the Show Control function. Select the 
function and click on the control. 

• Step Preview: 
The Step Preview displays the originally recorded step so that it can be reproduced and the object adjusted 
accordingly. 

Further functions 

The Tools and Insert menus allow you to select further functions for editing the tutorial during rerecording: 

• Insert Explanation (Insert): 
This button allows you to add an Explanation macro during rerecording. After clicking the button, select the 
position for the bubble, then define the explanation text and confirm it with Ok. 

• Delete Control (Tools): 
This function offers the opportunity to delete the currently selected object. Then the rerecording is resumed 
using the following object in the tutorial. 

• Skip Control (Tools): 
This function allows skipping a recorded control if it does not need to be taken into account for the rerecording 
and thus remains unmodified. 

 Note 
The bubble displayed in interactive mode corresponds to the Bubble Type setting in the Authoring Settings -> 
Rerecording -> Interactive Mode section of the Settings. It can be either the Demo or the Practice bubble. 

3.4.5.4 Recording Additional Steps 

While rerecording is in progress you can use recording to record additional steps and add them to your project. This 
is useful, for example, for creating additional inputs in a form. 

To record additional steps, you need to run rerecording in interactive mode. Subsequently, rerecording comes to a 
halt at each step to be rerecorded with the control that has been found requiring confirmation. This enables you to 
edit the control that has been found as well as access the recording bar functions and launch automated recording. 

Newly recorded steps are inserted in front of the current step to be rerecorded at which automated recording was 
started. This is necessary so that once inputs have been committed rerecording means that they are displayed on 
their respective screenshots in subsequent steps. 

To record additional steps, proceed as follows: 

1. If you arrive at a step before which you would like to insert other steps, start the recording at this stop. In 
order to do so select the Record Control  button at the menu Insert in the recording bar.  

2. Record the designated control devices in the same way as during regular recording. Refer to the chapter on 
Executing the Recording with Profile.  
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3. If you would like to resume rerecording afterwards press the ESC key. The rerecording is resumed at the step 
where you started the recording.  

 Note 
Do not confirm the step in front of which you would like to record additional steps by pressing on the Enter key. 

Start recording directly as otherwise rerecording will continue. 

3.4.5.5 Changing the Application 

If a change of application takes place in a project, a particular procedure is required in order to accomplish the 
change during rerecording. This procedure applies to the automatic mode as well as to the interactive mode. 

At the point of the application change the rerecording displays a note window to inform you that the application 
does not match. Now proceed as follows to accomplish the change of application: 

1. Select Choose in the note window. 
The Choose Application dialog is opened.  

2. Select the required application from the Running Applications list.  

3. Select Choose.  

Afterwards, the rerecording continues with the required application. 

3.4.5.6 Rerecording of Projects with Branches 

Rerecording the projects with branches is not possible. A project will go through the rerecording process macro by 
macro in a linear fashion. However, branches do provide a number of options for progression, which is why some 
controls of a branch cannot be found during rerecording. 
As a general rule, branches should therefore only be integrated into the corresponding project after rerecording. 

If a project with branches exists, it is necessary to partially execute the rerecording of a project. This entails the 
corresponding project being split up in order to be able to rerecord steps that run linear to one another. Here, only 
the corresponding step with the branch will need to be edited. See also the chapter Partial Rerecording. 

When working with branches, it is necessary to remove them after rerecording so that they can be reattached. 
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3.4.5.7 Key Functions for Rerecording 

During rerecording different actions can be performed using key functions. They depend on the particular type: 

Automatic mode 

Keys Definition 

Pause With the Pause key rerecording can be paused. 

Esc With the Esc key rerecording can be cancelled. 

Interactive mode 

Keys Definition 

Enter 
With this key you can confirm a displayed control device 
and continue rerecording. 

Ctrl + Enter 
With this key you can confirm a displayed control device 
and continue rerecording if the bubble is displayed in 
edit view. 

Ctrl 

With a pressed Ctrl key you can navigate freely in the 
application without an action being recorded. 
This is useful for instance for selecting lists, in order to 
open them and record the selection. 

Esc 
Terminates recording if further steps are inserted via the 
recording function. 
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3.4.6 Recording Bar for Rerecording 

The rerecording bar appears when you start the rerecording. It includes the following sections and controls: 

Buttons and menus 

The buttons let you control the recording. 

 

Button Explanation 

(1) Profile 
The dropdown box displays the automatically detected application profile. 
The profile cannot be changed. 

(1) Accept Control 
Select this button to confirm a control during rerecording in interactive mode 
and to rerecord it. 

(2) Show Control 
Select this button to directly rerecord a control that is not displayed 
correctly. Select the function and click the control. 

(3) Step Preview 
Select this button to open a step preview. The step preview displays the 
originally recorded step. This lets it be replicated and the object is 
customized accordingly. 

(4) Rerecord 
Select this button to begin rerecording the process. Afterwards, the button 
changes to Pause. 

(5) Pause 
Select this button to interrupt the rerecording. This is useful when changing 
applications. Afterwards, the button changes to Rerecord. 

(6) Menu Insert   

Record Control 

Select this button to start recording. This allows you to record additional 
steps during rerecording. These are inserted in front of the current step. The 
ESC key ends the recording mode and rerecording continues. This function is 
available during interactive rerecording. 

Insert Explanation Select this button to insert an Explanation. 

(7) Menu Tools   

Delete Control 
Select this button to delete the currently selected object. Rerecording then 
resumes using the next object in the project. 
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Button Explanation 

Skip Control 
Select this button to skip a recorded control if it does not need to be included 
for rerecording. It remains unmodified in the project. 

Choose Application 
Select this button to reselect an application for recording or to switch to 
another application. Afterwards, select the required application. 

Settings 
Select this button to open the Recording - General page in the Settings dialog 
box. 
You can also open the settings in the Tools -> Settings... menu . 

(8) Minimize 
Select this button to minimize the rerecording bar; an icon will appear in the 
system tray instead. You can control the rerecording using the context menu. 
By selecting this icon, the rerecording bar will return to its original size. 

(9) Close  
Select this button to close the rerecording bar. The rerecording will be 
stopped. 

 

Status section 

The status section shows you whether an action is required or if the Producer is working on a rerecording in the 
background. Supporting icons and text messages are also displayed. 

Icon Explanation Icon Explanation 

 

Preview Mode 

This status is shown, if 
your rerecording is running 
and you need to perform an 
action. 

After an action has been 
performed, the status also 
shows the detected control 
(Name, Type, Value, and 
Subtype). 

 

Pause 

This status is shown 
when you pause the 
rerecording. 

 

Busy 

This status is shown, if 
your action is executed in 
the background. 

Note: Wait for the status of 
the Preview Mode to turn 
green, to execute an 
action. 

 

Note 

The status is shown, if you 
need to perform an action. 
For example, selecting an 
application. 
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3.5 Recording an eCATT File 

When recording a simulation, you can create an eCATT file (eCATT.xml). eCATT (extended Computer Aided Test 
Tool) files are used for importing data into test automation software. 
An eCATT file can be created when recording an SAP system with SAP GUI. This file allows you to use a recorded 
process for an automated test with eCATT in the live system. 

For further information on using eCATT, read the specific eCATT documentation. 

Prerequisites 

The recording of eCATT is supported for SAP GUI for Windows. Make sure to record SAP GUI as stand-alone and 
not as embedded (for example, SAP NWBC) application. 

Activating eCATT generation 

eCATT files are generated in addition to the simulation modes. To generate the files, you have to activate the eCATT 
setting in the central configuration dialog box (Tools -> Settings... ) under Producer -> Save -> Standard. 

Recording an eCATT file 

To record an eCATT file, use the project type Simulation. The information required for the eCATT file is collected 
during recording. The eCATT file is generated when the project is saved. 
If a project is rerecorded, the eCATT file information is updated. 

When a workarea is published, eCATT files are not exported because the files are not required for content playback. 

Handling an eCATT file 

 

Once the project has been saved, the eCATT file is generated and stored in the project folder. eCATT objects are 
displayed in in the object structure of the Explorer. 

The eCATT file is stored in the project folder. Open the project folder by using the Open Folder menu entry in the 
context menu of the project. 
You can import the eCATT.xml into your eCATT system and test the recorded process. 

 Note 
eCATT files use always the file name eCATT.xml. If you want to use and store multiple files in a folder, rename the 
files using different names. 
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4 Simulation Editing 

Once a simulation has been recorded it can be edited in numerous ways. For example, so as to enhance the didactic 
benefit of the projects and promote a more diverse presentation of the content. 

In addition to deleting and adding content in the form of steps or recording macros, and completing documentation 
macros, the content of macros themselves can be changed and parameterized. 

 Recommendation 
Take care at all times when editing that the changes you make do not compromise the consistency of the project in 
relation to teaching material that has yet to be added. 

4.1 Training Available 

 

Simulation editing is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

Audio recording and editing is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

4.2 Simulation Modes 

The following modes can be generated for simulation projects: 

Mode Name / Icon Description 

 

Demo mode 

The demo mode plays the recorded process as 
demonstration and displays explanations for the 
executed actions. 

User action: no action required. 

Example use case: teaching a new process 

 

Practice mode 

The practice mode expects the user to act within the 
simulated environment in the same way as with the live 
application. The mode will only move to the next step 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_FD80BB98BAAFEDB4
https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_473F83BA4683EB80
https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_473F83BA4683EB80
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Mode Name / Icon Description 

after the user has followed the instructions in the correct 
order shown in the bubbles. 

User action: executes actions displayed in instructions 

Example use case: execute a process with support 

 

Test mode 

The test mode does not display any instructions in the 
bubbles. Users have to find their own way through the 
application without any help. 

User action: executes actions unaided 

Based on: practice mode 

Example use case: test of users' knowledge of a process 

 

Concurrent mode 

The concurrent mode is based on the demo mode and is 
played back with an additional smaller browser window 
next to the live application. This supports the user by 
offering help during the live process. 

User action: executes process in live application and 
clicks to continue to next step 

Based on: demo mode 

Example use case: supporting daily work 

 

Guided Presentation mode 

The guided presentation mode plays the recorded 
process like a simulation and executes the actions 
automatically. Each action has to be confirmed by the 
user. 
No bubbles are displayed, and the control bar is hidden. 

User action: confirms executed action 

Based on: demo mode 

Example use case: presentation of a process to an 
audience 

 

Free Presentation mode 

The free presentation mode expects the presenter to act 
in the simulated environment in the same way as in the 
live application. Input fields are filled out automatically. 
No bubbles are displayed, and the control bar is hidden. 

User action: executes actions unaided 

Based on: demo mode 

Example use case: presentation of a process to an 
audience 
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Activating the modes 

You can specify the modes that you want to generate for your projects in the Settings  dialog box. The mode 
settings are available under Producer -> Save. 
By default the guided presentation mode and the free presentation mode are deactivated. You can define the 
modes globally or on project-specific basis. 

Mode configuration 

Each mode can be configured for playback individually. The settings are available in the Playback Settings of the 
Settings  dialog box. See also the chapter Settings of trainer, book reader, library and Modes. 

4.2.1 Playing a Mode 

You can play a simulation mode to preview the content of your project. The simulation is played back in trainer. 

• Project editor 
Select Play Mode in the toolbar to play the active editing mode. 

 Recommendation 
If you start the playback of a simulation from the project editor to check it, you can follow the progress of the 
playback by looking at the thumbnail view. This simplifies the localization of errors since it provides direct, visual 
identification of the corresponding macro and thus facilitates the user's orientation within the project. 

• Explorer 
Select a mode of your project and select Play  in object editor. 

4.2.2 Mouse Simulation 

You can simulate mouse movements and actions while playing back simulations in the trainer. This enables a 
greater emphasis to be given to actions, for displaying single and double clicks visually, for example. You will see 
the mouse simulation displayed in demo mode and concurrent mode. 

Activating mouse simulation 

The mouse simulation is activated in the Settings  dialog box from the Show Mouse option. You will find this in 
the Playback Settings -> General area. 

Changing the mouse pointer 

In the Visual properties area of the Playback Settings -> trainer settings you can apply the Big mouse pointers setting 
for defining the mouse pointer. This option defines, that the big mouse pointers will be shown for the visualization of 
a simulation. 
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4.3 Customizing Simulation Pages 

You can design the pages in your simulations any way you want. This can be useful if the screenshots of the 
recording do not take up the entire screen area or if you are using imported pages. The pages design is based on the 
book page design so that you can use the book page styles available in your workarea.  

You can find the respective settings under Playback Settings -> General -> Page Style in the Settings  dialog box. 

You can create the design as the default design for your workarea or for a specific project. A specific project can be 
used as template for other projects. 

Settings 

• Style: 
Specifies the page design. You can select a book style from the dropdown box. 
The setting also affects the book page objects inserted in a simulation. 

• Center Background Image: 
Centers the background image or the simulation screenshot. If the option is deactivated, the image is 
positioned in the upper left corner. 

• Page Color: 
Specifies the color of the page. Select the color preview to open the Color Selection dialog box. If you do not 
want to use any color, select Transparent . 

• Background Color: 
Specifies the color of the background. Select the color preview to open the Color Selection dialog box. If you do 
not want to use any color, select Transparent . 

• Border: 
Specifies the thickness of the page border in pixels. If no border is to be displayed, set the value to 0 (zero). 

• Border Color: 
Specifies the color of the page border. Select the color preview to open the Color Selection dialog box. 

• Border Style: 
Specifies the style of the page border that you can select from the dropdown box. 

4.4 Editing Highlights and Bubbles 

You can enhance interaction macros with highlights and bubbles. The highlights outline the recording control and 
the bubbles display text with instructions, tips, etc. 

The highlights and bubbles can be edited from the Step view. For example, you can choose a macro from the 
thumbnail view, such as Mouse Action. Then in the step view, the highlights and bubbles for the recorded control will 
be displayed on the screenshot for the macro Screen . 

There are options on the toolbar that allow you to switch between demo and concurrent modes to display the 
bubbles. This allows the bubbles to be viewed and edited for the respective mode. 
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4.4.1 Properties of Highlights 

Main differentiations for the use of highlights are: 

• Standard Highlight 
The highlight is generally used for the visualization of actions and explanations. 

• Help Highlight 
The highlight is used in case the user asks for help during playback of a test mode. 

In accordance to the use the settings can be set individually. 

Settings in central configurations 

The settings can be set globally or project specific in the Settings  dialog box in the area Playback Settings -> 
General -> Highlights.  

• Border:  
Specifies the thickness of the project highlight frame in pixels. Pixel widths available are from 1 to 10. 

• Color:  
Specifies the color of the highlight border. The color may be entered directly as an RGB value in HEX format or 
selected from out of the Color Picker dialog box. 

• Help Color: 
Specifies the highlight color used in practice or test mode in case the user is asking for help. The highlight will 
be used to show areas of correct action. 

• Form Structure Color for Correct Answer: 
Specifies the highlight color used in practice or test mode in case that the user is asking for help. The highlight 
will be used to show areas of correct actions in a form structure. 

• Type: 
This option defines the form of the highlights used in the simulation.   

○ Rectangle 

○ Ellipse 

○ Underline 

 Note 
The highlight types Ellipse and Underline are only displayed during playback. In step view and in documentation the 
highlights always use the type Rectangle. 

• Effect / Help Effect: 
This option defines the kind of effect used for highlights.   

○ Show 

○ Animate 

○ Pulsate 

○ Frame Flashing 

○ Focus Zoom 
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4.4.2 Positioning Highlights and Bubbles 

In the step view you can change the size and positioning of the bubbles and highlights as follows: 

Changing the position 

1. Select an object in the step view. 

2. A red line will appear around the object. Select the object again, this time holding the mouse button down. 

3. With the mouse button still pressed, drag the object to the desired position. 

4. Release the mouse button and the object is now positioned. 

Changing the size 

1. Select an object in the step view. 

2. Dots appear around the object so that you can change its size. Select one of the dots and hold the mouse 
button down. 

3. With the mouse button still pressed, drag the dot inwards or outwards to the desired size. 

4. Release the mouse button to set the new size. 

Changing the bubble alignment 

1. Select an object in the step view. 

2. A square will appear at the spike of the bubble, which you can use to turn the object. With bubbles that do not 
have a spike, the square will appear in the middle of the bubble. Select the dot and hold the mouse button 
down. 

3. With the mouse button still pressed, pull the dot away from the bubble until you have reached the desired 
position. Pull the dot towards the middle of the bubble if you wish to hide the tip. 

4. Release the mouse button to set the new position. 

4.4.3 Editing Bubble Text 

Bubble text for the macros for each mode can be directly edited in the bubble or in the macro editor. 

• Editing in the step view 
Double-click on a bubble and an HTML editor will appear with various options for editing the content. For more 
information on the HTML editor, refer to the HTML Editor section. Edit your text as desired and click on OK to 
confirm your changes.  

• Editing in the macro editor 
Changes can be made in the macro editor using the two options Demo Text and Practice Text. Click on the 
respective text field and the HTML editor will appear. You can now edit the text.  

 Note 
Note that when changes are made to the text, this text can no longer be automatically translated into another 
language (Automated Translation and rerecording). All customized text must be manually translated or exported 
into a translation template to be translated externally. 
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4.5 Audio in Simulations 

The Producer supports several ways to integrate audio into simulations and to enrich the information. This allows 
information to be presented using visual and audio material, thus stimulating more of the learner's senses. This 
facilitates increased awareness and superior assimilation of the content. 

 Note 
Audio files in simulations are only played back for the demo mode. 

Prerequisite 

A special audio project is required to use audio in simulations. You can either define this when setting up the project 
by selecting the parameter Use Audio, or you can convert the project later on from the menu Project -> Convert to 
Audio Project . 

Creating audio 

Audio files for simulations can be created in the following ways: 

• Importing of audio files 

• Recording of spoken texts 

• Conversion of Text to Speech 

The audio editor (in the project editor of the Producer) allows you to create and edit audio files. 
Refer to the section on Audio Editor. 
If an audio file is available in a step, you will see an audio icon in the step's thumbnail view. 

Functions in the menus 

In the Audio menu, there are several functions for editing audio. Refer to the relevant sections for further 
information. The menu is only available for an audio project. 

Supported file formats 

The following audio file formats are supported: 

• Import of audio files   

○ Sound file - wav 

○ AVI sound file - avi 

○ MP3 Sound file - mp3 

• Editing of audio in project   

○ Sound file - wav 
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4.5.1 Convert to Audio Project 

Menu item Convert to Audio Project in the Projects menu creates an audio project out of a regular project. This 
allows you to convert a project to an audio project at a later date if you have not done so when creating the project. 
Consequently, this menu item is also only displayed in projects without audio. 

 Note 
Once a project has been converted into an audio project, this step cannot be undone. 

To convert a project, proceed as follows: 

1. Select Project -> Convert to Audio Project... 
The Select Audio Format dialog box is opened. 

2. The settings in the dialog box are required to specify the properties of the audio project or its audio files: 

• Editing format: 
Specifies the audio format in which the project is created and edited.  

• Output format: 
Specifies the audio format in which the project is generated. 

3. Select Ok. 

Afterwards, the project is converted into an audio project. This saves the project file as a WRP file. You also have 
audio editing functions at your disposal. 

4.5.2 Importing Audio 

Importing audio files allows you to easily integrate audio files into a simulation. 

 Note 
By importing an audio file, the existing audio of a step will be overwritten. 

Proceed as follows to import an audio file: 

 Note 
During import, the audio files are converted into the editing format WAV with the default audio format. 

1. Select the step for which you want to import an audio file. 

2. In Audio Editor, click the button Import Audio File...  
The Choose File dialog box opens. 
Alternatively you can use the Audio menu. 

3. Select the file. 

4. Click Open to insert the file. 
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4.5.3 Recording Audio 

Audio recording allows you to narrate your own texts with the microphone. The texts can be played back as 
explanations for the relevant steps. 

There are two ways to record an audio: 

• During the recording of a simulation 

• During the editing of a simulation 

Requirement 

For audio recording, a microphone is necessary. Connect this first before starting to record. 

Audio recording during recording of a simulation 

During the recording of a simulation you are able to record an audio directly. When starting the recording of a 
simulation the Select Application dialog includes a setting Record Audio. Activate the setting, to execute the 
recording. 
See also the chapter Starting the Recording. 

The recording of audio is only possible during the recording and not for the rerecording of a simulation. 

Audio recording during editing of a simulation 

Proceed as follows to execute the recording: 

1. Select Record Audio... . The recording dialog opens. 
Alternatively you can use the Audio menu. 

2. Select Start Recording . 

3. Read out your text. 
During the recording, a sound level meter shows the volume. You also see the spoken text as an audio track. 

4. Select End Recording . The recording dialog box closes. 

For more information, refer to the Recording Dialog Box chapter. 

 Note 
During the recording of an audio file, the existing audio of a step will be overwritten. 

Read out the full text for your recording because it is not possible to record the text in sections. Any unwanted parts 
can be cut out afterwards. If you are not satisfied with the outcome, record the text again. 

 Recommendation 
If the recording contains background noise, then it is recommended that you edit the audio file with the dynamic 
editor to improve the sound. 
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4.5.4 Using Text-to-Speech 

The Text-to-Speech functionality converts written text into digitized speech. This makes it possible to play back 
simulation's bubble texts in spoken form. During the conversion process, the simulation macro's bubble text is 
converted into an audio file. The actual bubble continues to be displayed when playing the simulation back in the 
trainer so that the two formats provide mutual support. 
The default quality for Text-to-Speech is: 22kHz, 16bit, Mono. 

4.5.4.1 Supported Text-to-Speech Voices 

The Producer supports voices for Microsoft Windows 10 Text-to-Speech and Google Cloud Text-to-Speech. 

Microsoft Windows 10 Text-to-Speech 

You can use Microsoft Windows 10 voices to generate Text-to-Speech audio. For downloading voices see How to 
download Text-to-Speech languages for Windows 10. 

Default Windows system voice 

For the option Default Windows system voice in the voice selection Producer uses the Text-to-Speech voice available 
on your operating system. If you want to use a different voice, you need to change Text-to-Speech settings of your 
operating system. In Microsoft Windows Control Panel open Speech Recognition -> Text to Speech to change the 
voice in the Speech Properties. 

Google Cloud Text-to-Speech 

The Google Cloud Text-to-Speech voices can be used to generate Text-to-Speech audio. To use Google Cloud Text-
to-Speech the following preparations are required: 

1. A Google Cloud Platform account is required. 

2. Enable the API by creating an API key: 

1. Go to APIs & Services -> Credentials. 

2. Select Create credentials -> API key. 

3. Copy the API key to use it for connecting with Google Cloud Platform. 

 Note 
Google Cloud Text-to-Speech is a product of Google Cloud. Further information is available on Google Cloud. 

Further information is available in the Google Cloud Text-to-Speech documentation. 

4.5.4.2 Generating Text to Speech 

We recommend that you convert text to speech after a project has been edited. If a step contains several macros 
(for example, several steps are connected), then the texts will be read out one after the other in the order in which 

https://support.microsoft.com/en-us/office/how-to-download-text-to-speech-languages-for-windows-10-d5a6b612-b3ae-423f-afa5-4f6caf1ec5d3
https://support.microsoft.com/en-us/office/how-to-download-text-to-speech-languages-for-windows-10-d5a6b612-b3ae-423f-afa5-4f6caf1ec5d3
https://cloud.google.com/text-to-speech/
https://cloud.google.com/text-to-speech/docs/
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the macros are arranged. 
If the bubble texts of a simulation are already converted into text to speech, they are available when you open the 
editor. 

To generate Text-to-Speech audio proceed as follows: 

1. Explorer 

1. Select a simulation project or a group with simulation projects. 

2. Project editor 

1. Open a simulation project. 

2. Select all required steps. 

3. Go to Tools -> Text-to-Speech- > Generate Text-to-Speech... menu.  
Another option is to go to Audio -> Generate Text-to-Speech Audio... to open the same dialog.  

4. The Text-to-Speech dialog box is opened. 

5. Generate Text-to-Speech audio for: 

1. All Steps 
Converts all steps to Text-to-Speech. 

2. Steps Without Audio 
Converts all steps without audio to Text-to-Speech and keeps available audio files. 

3. Selected Steps 
Converts only selected steps to Text-to-Speech 

6. Cleanup Text-to-Speech Override Macros 
If you already have Text-to-Speech Override Macros in the simulation project and the override text matches the 
bubble text, then this function allows to clean it up. Such Text-to-Speech Override Macros will be deleted. 

7. Automatically Convert Non-Audio Projects* 
This setting is available when you open the Text-to-Speech menu from the Explorer. Activate it to convert your 
project to an audio project for the Text-to-Speech functionality to take effect. 

8. Configure Text-to-Speech Services 
In this section you can choose between Windows Text-to-Speech and Google Text-to-Speech.You can also 
choose to Show only language specific voices in voice selection, in this case you will see only the voices 
available for your current Producer language. To use Google Text-to-Speech service configure the following 
parameters: 

1. API URL 
Select or enter a URL for the Google Cloud Text-to-Speech API. 

2. API Key 
Enter the API Key of your Google account. 

9. Confirm your settings and now you can select the Voice for your language, choose its pitch and speed, and 
preview the generated audio. 

10. Select Generate and Close to finish.  

The Text-to-Speech conversion starts. Simulations projects will be converted into audio projects. 

Afterwards, an audio icon  can be seen for every step. The active text type for demo mode or practice mode is 
used for the audio. 
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 Recommendation 
The link of the beta release of Google Cloud Text-to-Speech should be used for tests only. The beta release can 
contain further voices and features that are not available in the final release. 

Note 
If a step contains several macros, the individual actions and associated spoken texts will run asynchronously in 
relation to one another. This is because the texts are converted into an audio file and are not linked to the actions. 
Therefore we recommend use one macro per step. 

4.5.5 Text-to-Speech Override 

The Text-to-Speech Override allows you to enter an alternative text for simulation steps. This text will be used for 
Text-to-Speech audio instead of the original steps text.  

To configure text for Text-to-Speech Override proceed as follows: 

1. Open the Text-to-Speech Override editor using the Edit Text-to-Speech...  button for each step. 
Refer to the chapter Text-to-Speech Dialog Box for more details. 

2. Insert a text in the text field or edit the available text. 

3. Specify the duration of the silence to be inserted at the beginning of the audio file. 

4. Choose the voice, its pitch and speed and preview the audio. 

5. Confirm the input. The dialog box is closed and the audio file is generated. 

To restore default text: 

1. Open the Text-to-Speech Override editor using the Edit Text-to-Speech...  button for for your selected step. 
You will see a Note saying that a Text-to-Speech override macro is used. 

2. Select Use default. The text in the text field changes to the original. 

3. Confirm the input. The dialog box is closed and the audio file is generated. 

4.5.6 Editing Audio 

The audio track can be edited in various ways to optimize the output. There are different functions available in the 
audio editor. 
For more information, refer to the Audio Editor chapter. 

4.5.6.1 Inserting a Silence 

This function inserts a silence with a defined length into a specific part of your audio. 
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The silence will be inserted at the position of the red marker. If an area is marked, it will be overwritten with silence 
completely. 

1. Select the point of the audio track with the marker for the beginning of the silence. 

2. Select the Insert Silence...  button. 

3. Define a value in milliseconds in the editing dialog. Only positive integer values can be used. 

4. Confirm the dialog with OK. 

If an area should be converted into silence, mark the relevant area on the audio track. Select the Insert Silence... 
 button and silence will be included immediately. 

4.5.6.2 Normalizing Audio 

The function Normalize allows you to equalize the volume of all audio files and thereby make audio files with 
different properties consistent. The amplitude of an audio track will be increased consistently.  

 Recommendation 
If the amplitude has big differences in the highs and lows due to normalization, it is recommended that you edit the 
dynamic of the audio with the dynamic editor. 

Normalization can be applied to the entire audio track or a particular area. 

1. Select an audio track and go to the audio editor. 

2. Highlight the area you want to normalize. 

3. Select the Normalize...  button. 

4.5.6.3 Trimming Audio 

The Trim Audio function allows you to cut an audio track down to a specific part. Unnecessary parts can be deleted 
to reduce the playback time and the size of the audio file. 

To trim an audio track, proceed as follows: 

1. Mark the area of the audio track that you want to keep. 

2. Select the Trim  button in the toolbar. 
The parts left and right of the highlight will be removed. 

4.5.6.4 Fading Audio 

Using the functions Fade In and Fade Out, you can fade a part of the audio track from mute to full volume or the 
other way around. This makes the audio track much more effective and ensures smooth transitions. 
In general, it is recommended that you use fading at the beginning and at the end of an audio track. 

To use fading for an audio track, proceed as follows: 
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1. Mark an area of the audio track, to define the position and length. 

2. Select the Fade In  or Fade Out  button in the toolbar. 

4.5.7 Audio Menu 

The Audio menu contains functions for the editing of an audio file. It is only available, if the opened project is an 
audio project. 

4.5.7.1 Play Audio 

The Play Audio  command plays the audio of the current step. 

4.5.7.2 Stop Audio 

The Stop Audio  command stops the playback of an audio. 

4.5.7.3 Record Audio 

The Record Audio  command records an audio for the current step. 

4.5.7.4 Pause Audio 

The Pause Audio  command pauses the playback of an audio. 

4.5.7.5 Repeat Audio 

The Repeat Audio  command switches loop mode for the playback of an audio on and off. 

4.5.7.6 Import Audio File... 

Audio files can be imported into Producer by using the Import Audio File...  command. The audio file is imported 
into the selected step. If no step is selected or no step exists in the project, a new step is created automatically. 
Formats supported when importing audio files are WAV, AVI and MP3. 
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 Note 
During import, the audio files are converted into the editing format WAV with the default audio format. 

If an audio file was imported into a step, this is indicated by an icon. 

 Note 
Importing an audio file overwrites the existing audio of a step. 

4.5.7.7 Import Audio Again 

If an audio file is already imported into Producer, this action can be repeated without selecting the file in the import 
dialog again. This is helpful if changes already made to the audio track did not work out as expected and the audio 
track needs to be restored or the audio file was edited with an external editor and the changes need to be applied to 
the project. 

 Note 
Importing an audio file overwrites the existing audio of a step. 

4.5.7.8 Export all Audio Files... 

The audio track of a project can be exported from Producer as a file in WAV format for other purposes. All usual 
sampling rates for audio files in this format are available. 

4.5.7.9 Delete Audio 

With the Delete Audio  command existing audio file of a step can be deleted. 

4.5.7.10 Change Audio Format... 

The Change Audio Format... command allows you to change the editing format and the output format of the audio 
files for the current project. The standard format shows default in the entry and a changed format shows current. 

Editing Format 

The internal audio format of a project which is used for editing can be changed at any time. All usual sampling rates 
for work with digital audio in mono or stereo are available. Existing audio tracks are automatically converted into the 
new format. This procedure is time intensive and can take several minutes. 
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 Note 
When changing the project from a higher to a lower sampling rate, the sound quality decreases. As soon as the 
project is saved, the changes cannot be undone anymore. 

Output Format 

With the option the output format for generating a simulation can be defined. 

4.5.7.11 Generate Text-to-Speech 

With the Generate Text-to-Speech  command the bubble texts of a step can be converted from text to speech. 

4.6 Form Structure 

The Form Structure function allows you to display forms realistically in practice mode or test mode. While a 
simulation is in progress, the user can fill in the interactions contained within the form structure in an individually 
chosen sequence and then confirm the inputs as a whole. This does not display a confirmation immediately after an 
action has been inputted but only once all actions have been performed. 

A Form Structure is made up as follows: 

• It is positioned under a Screen  macro. 

• It has a start and end macro. 

• The associated interactions are to be found between the two Form Structure macros. 

• A Mouse Action  can be used as confirmation action. 

At least two interactions should generally be available for a Form Structure.  

Example Structure 

 Screen 

 Form Begin 

 Input Text 

 Select Single 

 Radio / Checkbox 

... 

 Mouse Action - used for confirmation 

 Form End 
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4.6.1 Creating a Form Structure 

After recording a project, you can create a Form Structure in it: 

1. For the Form Structure the Screen  macros are to be combined in a step with the associated actions 
contained in the form. This is required as the Form Structure cannot be created in a way that spans steps.   

1. Select the Screen  macros belonging to the steps whose interactions are to be used for the Form 
Structure.  

2. Select Tools -> Bulk Changes -> Merge Selected Screens. 
The first macro Screen is retained and the others that are highlighted are deleted. The previous steps' 
macros are arranged in the merged step.  Now create the Form Structure.  

 Note 
A Mouse Action  macro is required as the last macro of a form structure in order to be able to complete the 
form correctly. For example, this can be an OK or dialog box Save button enabling the form inputs to be confirmed. 

2. Select the Screen macro of the merged step.  

3. Select Insert Structure Macro -> Create Form Structure . 

In the thumbnail view, you will now see that all of the step macros are incorporated within the Form Structure 
macros. 
Documentation macros contained within a step are also integrated into the form structure. But these do not affect 
the sequence of the simulation and the function of the form structure as they are only used for creating 
documentation. 

4.6.2 Bubbles in Form Structure 

The bubble texts are presented in summary form in the Form Structure for the practice mode. This provides you 
with an overview that illustrates how to fill out a form and the linkages between the inputs. 

In demo mode and concurrent mode the bubbles are displayed side by side as the processes are played back as a 
simulation meaning that there are no inputs by the user. 

The appearance of the bubbles can be edited in the Form End  macro. The individual texts accompanying the 
actions can be changed within the respective macros, as before. 

4.6.3 Removing a Form Structure 

If a Form Structure is no longer required in a project, it can be removed. Only the start and end macros of the Form 
Structure are deleted in the process; the remaining macros in the step are retained. 
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 Note 
Do not remove the macros for the Form Structure using the Delete command to avoid errors in the project. Always 
remove the Form Structure using the corresponding functionality. 

This is how to remove the form structure: 

1. Select the Form Begin  or Form End  macro.  

2. Select Remove Form Structure  in the macro editor. 

4.7 Branches 

Using branches will allow the user to digress from the sequential path within a simulation. This gives the user much 
more flexibility and portrays a more realistic process workflow. Two or more branches can be added to a simulation 
so that the user has a choice of where to go to next. 

A branch consists of several macros: 

• A branch is positioned under the Screen  macro. 

• It needs a start and an end macro.  

• Between the start and end macro, there are two macros that contain actions leading to different workflows.  

Example Structure 

 Screen 

 Branch Begin 

 Mouse Action 

 Mouse Action 

 Branch End 

 Note 
Projects with branches cannot be rerecorded. During rerecording a project will run through in a linear manner but 
branches can operate in a number of different ways that cannot automatically be followed. 
It is recommended to duplicate a project as backup, before creating the branch. The duplicate can be used for 
rerecording. 

4.7.1 Creating a Branch 

Once a project has been recorded, you can create a branch for it. To do so, proceed as follows: 

1. Screen  macros are combined into one step in which their corresponding actions should serve as buttons 
for the branches. This is important so that the buttons can be displayed properly on the page.   

1. Select the Screen  macros for the step for which the macros should be used for the branch. When 
doing so, make sure that these actions are located on the same application page.  
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2. Select Tools -> Bulk Changes -> Merge Selected Screens. 
The first macro Screen will remain and all the other highlighted macros will be deleted. The macros for 
the existing step will then be merged into the step accordingly.  

2. Select the macro Screen for the merged step.  

3. Select Insert Structure Macro -> Create Branch . 
The Edit Branch dialog box is opened. 

4. For each action macro of the step specify a jump target. The order of the selection list corresponds with the 
order of the macros in the project. 
Select Ok. 

From the thumbnail view, you can see that all the macros for the step are integrated into the macros for the branch. 
All macros that have been assigned a branch target will have an arrow . When the mouse moves over the arrow, 
the corresponding step will be highlighted in blue in the thumbnail view and the name of the step will be displayed in 
a tool tip. 

4.7.2 Editing a Branch 

Editing a branch target 

If you would like to change the target of your branch at a later time, you can open the editing dialog box by clicking 
on the button Edit Branch in the macro editor. Change the target for the respective actions and confirm the changes 
by selecting OK. 

Bubbles in a branch 

At the end of a mode, a summary of all the bubble text is displayed in one bubble within a branch. This serves as an 
overview of all the possible target steps. The individual text blocks are separated with an `or` to make it easier to 
differentiate between the different targets. 

The bubble's appearance can be edited in the macro Branch End . To do so, from the macro editor, set the 
Layout Selection to Advanced layout. The individual text blocks for the actions can be changed in the respective 
macro. 

4.7.3 Removing a Branch 

If a branch is no longer needed in a project, it can be removed. Only the starting and ending macros of the branch 
are deleted. The other macros will remain in the step. 

 Note 
Do not remove the macros for the branch by using the Delete command - this could cause errors in the project 
itself. Always remove a branch in accordance with its functionality. 

To remove a branch, proceed as follows: 

1. Select the macro Branch Begin  or Branch End .  

2. Select Remove Branch  in the macro editor. 
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4.7.4 Branches in Documentation 

Branches will also be displayed as such in the documentation. A subheading will be inserted to indicate that there is 
a branch. Underneath the subheadings, there are additional actions which have been allocated links for the 
respective steps. 

Branches appear in Word, PDF and HTML generated formats. Branches are displayed in the following types of 
documentation: standard documentation and work documents. 

4.8 Bulk Changes 

The Tools -> Bulk Changes menu contains automated functions for editing a number of macros in a simulation 
project. 

4.8.1 Setting the Bubble Duration 

The Tools -> Bulk Changes -> Set Bubble Duration... function sets the display duration for all the bubbles to the value 
entered in the dialog box using an adjustable display duration. Prior changes made in the macro editor to the 
duration of bubbles will be overwritten. 

Use the Include Explanation parameter to set whether or not the defined bubble duration should also be used for 
inserted Explanation macros or just for the bubbles of the interactions. If this parameter is activated, the 
Explanation macros will also be shown with the defined bubble duration. 
This parameter should be deactivated if individual times are to be used for the Explanation macros. This is 
necessary if the respective macros contain longer texts and thus require more time for processing. 

4.8.2 Merging Screens 

The merging screens functions allow you to merge the Screen macros of your simulation projects. This can be used 
to be able to create a form structure or branches or to create the size of a project. 

There are the following merge functions available in the Tools -> Bulk Changes menu: 

• Merge Selected Screens 
The function merges all selected Screen macros within a step. The first screenshot is kept and all other 
selected Screen macros are deleted. All the related macros are merged in a single step.  

• Merge Screens 
The function merges all Screen macros automatically within a step. This involves merging sequential steps 
with identical screenshots, for example, the same application page and it's status, into one step. The initial 
Screen macro is retained and the following Screen macros deleted. Subsequent macros are inserted in the 
project within the step according to the sequence in which they occur. 
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Graphical matching and tolerance 

The Screen macros are merged by graphically matching the screenshots. The Producer compares individual 
screenshot pixels to recognize differences. This includes differences that are already small, such as for example a 
drop-down menu that is open on one screenshot and not on another. This menu occupies a particular area on the 
screenshot which differs from the one with which it is being compared by a certain percentage. 
The degree of percentage match for merging screenshots is defined by the tolerance. This value can be changed in 
the Settings  dialog box using the Merge Screen Tolerance which can be found under Authoring Settings -> 
Recording. Increasing the value raises the tolerance threshold. The standard value is 0.4 %, resulting in screenshots 
that differ by 0.4% or less being merged. 

 Note 
After the function has been executed, check whether the Screen macros have been merged correctly and that no 
necessary screenshots have been deleted. It may be necessary to undo the merge and repeating the merge with a 
different tolerance. 

Specifying a tolerance 

The optimal tolerance may differ from one application to the next. We therefore recommend that you test different 
application values for different projects. This can be carried out for example by a master author who then 
communicates the value identified as being optimal to the authors. When testing you should now ensure that 
screenshots that differ only slightly, for example an open drop-down menu, are not merged. The tolerance 
threshold should therefore be modified one small step at a time. (Example: increase 0.4% to 0.5%). 

We recommend selecting a value greater than 0.0%. With this tolerance, screenshots exhibiting only small 
differences, such as small animations or rollover effects, which are typically ignored when comparing screenshots, 
are not merged. 

4.8.3 Anonymizing the Screen Area 

If a simulation screenshot contains information that should not be displayed to the users (for example, passwords, 
file paths, or data), you can anonymize these areas by means of a color, pixelation, or blurring. You can do this for a 
single screenshot or for a number of screenshots in a project. 

 Note 
The anonymization is done on the screenshot file and cannot be changed after the project is saved and closed. 

To anonymize the screenshot areas of a simulation, proceed as follows: 

1. If you have one macro: 

1. Select a Screen  macro. 

2. Select Anonymize Screen Area... in the macro editor. 

2. If you have a number of macros: 

1. Select all Screen  macros that show the same area. 

2. Select Tools -> Bulk Changes -> Anonymize Screen Area... 
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3. A dialog box that displays the screenshot or the first screenshot of the selection opens. 
Position the selection border on the control or area you want to anonymize. 

4. In the dropdown box in the toolbar you can select these editing options: 

• Average Fill Color: 
Uses the average color of the selection on the screenshot. 

• Edge Fill Color: 
Uses the edge colors of the selection on the screenshot. 

• Custom Fill Color: 
Allows you to select a color for your selection. Select the color field in the toolbar to open the color 
selection dialog box. 

• Pixelate and Blur: 
Allows you to specify a pixelation or blurring for your selection. 
Use the Pixelation Radius slider in the toolbar to change the pixelation radius for the selection in pixel. 
Use the Blur Strength slider in the toolbar to change the blur strength for the selection in percent. 

5. Select Confirm Selection . 
Select Cancel Selection  if you want to discard the changes. 

The dialog box closes and the screen area is anonymized. 

4.9 Adding a Step 

You are able to add new steps in your project. The steps can be used to add further macros. 

The Insert -> Add Step  function inserts a new empty step. The step is inserted behind the currently selected 
step in the thumbnail view. 

4.10 Extending the Content 

4.10.1 Importing Images 

You can use the Import Images function to import image files into your project. The images can be used, for 
example, to enhance your project contents with visual information or as an introduction for various sections within 
a project. 
When an image is imported into the Producer, a step and the macro Imported Page are automatically created. 

To import an image, proceed as follows: 

1. Select the step into which images should be inserted. 

2. Select Tools -> Import-> Import Images... 
A dialog box appears. 

3. Select the desired image or images. Select Open. 

4. A dialog box with the following settings appears: 
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○ Width and Height: 
Enter the desired width and height for your image.  

○ Display Duration: 
This option allows you to define how long an image is visible in the simulation. This image setting can 
also be adjusted later in the macro editor.  

○ Import as Screen Macro:  
When this option is activated, the image is inserted as a Screen macro instead of an Imported Page. 
Note: This option must be activated if you would like to create branches for your step. 

○ Resample Images: 
This option adjusts the image file to the defined width and height. When this option is deactivated, the 
file will be imported in its original size. 

○ Insert Mouse Action: 
When this option is activated, a Mouse Action macro will also be inserted into the step. 

5. Select OK to import the image. 

The image is imported into the project. 

 Note 
If you insert the images as Screen macro, the projects cannot be rerecorded. As the images cannot be skipped 
during rerecording, this leads to errors in the recording process. You should therefore perform a rerecording 
before importing the images. 

4.10.2 Importing Microsoft PowerPoint Slides 

In addition to the regular steps, you can import slides from a Microsoft PowerPoint document into a project. For 
example, these can be used as supporting information for the content to introduce different sections of a project. 

The PowerPoint slides are converted into images when they are imported into the Producer. One step and one 
Screen macro are created for each slide and placed in it. 

Proceed as follows, to import PowerPoint slides: 

1. Open the PowerPoint file, from which you would like to import the slides into your project, in PowerPoint.  

2. Select the step after which the PowerPoint slides are to be placed.  

3. Select Tools -> Import -> Import PowerPoint Slides...  

4. You can now apply settings for displaying the slides. Select OK.   

• Width and Height: 
Enter the desired width and height of your slides.  

• Display Duration: 
The display duration specifies for how long a slide is visible before the next one is displayed. You can also 
amend this later for each individual slide in the macro editor.  

• Import as Screen Macro:  
When you activate this setting, the PowerPoint slides are inserted as Screen macro rather than as 
Imported Pages. This is necessary if, for example, branches are to be created for an imported slide.  
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 Note 
If you insert the PowerPoint slides as Screen macro, the project cannot be rerecorded. As the slides cannot be 
skipped during rerecording, this leads to errors in the recording process. You should therefore perform a 
rerecording before importing the slides. 

5. A dialog box is displayed which requires you to select the slides to be inserted. Switch to Microsoft PowerPoint 
and select the slides to be imported in your PowerPoint file's slide outline. 

 Note 
Do not close the dialog box until after the slides have been selected because it is the dialog that starts the import 
process. 

6.  Select OK. 

The PowerPoint slides are inserted into the project. 

4.11 Intro and End Pages 

The intro page shows an introduction to the learner at the beginning of a simulation. It is also possible to start the 
simulation at a specific step and to guide the learners through this chosen step. At the end of a simulation, the end 
page shows a text or a summary for the test mode result. 
The intro and end pages can be used for the demo, practice and test mode as alternatives to the general start and 
stop pages for simulations.  

Intro Page macros 

Several macros are available to define an intro page. The macros can be inserted via the Insert -> Insert Special 
Macro menu. More information can be found in the macro overview chapter. The following macros have to be 
inserted in this structure: 

 Intro Page 

 Intro Page Start Link 

Parameters of the End Page 

To define the behavior of the end page, use the associated parameters in the Simulation End  macro. For more 
information, refer to the Simulation End chapter. 

Hide the start and stop pages 

To use only the intro and end pages for a simulation, the start and stop pages should be deactivated in Playback 
Settings -> trainer in the Settings  dialog box. Disable the Show start page and Show stop page settings in the 
Visual properties subcategory. 
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4.12 Link Actions for trainer and book reader 

To control the trainer or book reader instead of the control bar via objects or bubbles, actions can be defined as link 
targets. These are universally valid and make it possible, for example, to jump between book pages and chapters 
independently of their name. They are selected in the link dialog box. 
If you want to use these types of navigations for book pages, we recommend inserting the objects in a template for 
book pages. These are available by default for an entire book. 

 

Specifying a link action 

1. You can specify the link target in accordance with your objects as follows:   

○ Via the HTML Editor 
Mark the text to be linked and open the Link dialog box by selecting Insert Object  -> Insert Link... 

○ For book page objects 
Select Edit link...  in the Link to setting to open the Link dialog. 
For some objects, this setting is found in the Link area. 

2. Select Actions in the Link dialog box. 

3. You can then specify the link action using the dropdown box. 

4. Select Ok to confirm the dialog box. 

Overview of actions 

• Exit 

• Show help 

• Play simulation 

• Pause simulation 

• Next step 

• Previous step 

• Next book page 

• Previous book page 

• Next chapter 

• Previous chapter 

• First book page 

• Last book page 

• Show index 

• Show search 

• Activate audio 

• Deactivate audio 

• Play/stop audio 

• Stop complete audio – (if several audio objects are contained) 

• Mute complete audio – (if several audio objects are contained) 

• Unmute complete audio – (if several audio objects are contained) 
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• Mute 

• Unmute 

The other actions offered correspond to those mentioned but have an outdated form and are thus offered to be 
downward compatible. 

4.13 Creating iPad Simulations 

With the Producer it is possible to create simple simulations of iPad apps. For that, create screenshots on your 
iPad, import them into the Producer and edit the simulation project. 

To create an iPad simulation, proceed as follows: 

1. Open your iPad app. 

2. Press the On/Off button and the Home button of your iPad at once to create a screenshot. 
Repeat this for each process step. 

3. The screenshots are saved in the Photos folder of the device. 

4. Save the images on your PC to import them into the Producer. 
Do not import the images from the iPad directly. 

5. Open the Producer. 

6. Create a Simulation  project using the New Object...  toolbar button. 
The empty project opens in the project editor. 

7. Select Tools -> Import -> Import Images...  
The import dialog box will appear.  

8. Select the images and select Open. 

9. You can now edit your image if desired. See also the chapter Import images. 
The important options of this dialog box are:   

○ Import as Screen:  
Activate this option, to insert the images as Screen macros. 

○ Insert Mouse Action Macro: 
With this option, a Mouse Action macro will be inserted in the step additionally. 

10. Confirm the changes by selecting OK. 
Afterwards the images will be imported. 

The images will be inserted in the order as sorted in the folder. Each image will be inserted as Screen  macro in a 
step with a Mouse Action macro. 
Afterwards position the highlight about the control on the screenshot and insert a text into the bubble. 

Inserting additional macros  

Further macros can be inserted about the Insert Interaction toolbar. The macros also contain text modules of the 
Recording Dictionary. 
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4.13.1 Creating Object Image and Object Name 

The object name and object image of an app control can be created manually and inserted into a bubble text. This 
allows you to add this information to a text. 

For the object name insert a text into the Object Name parameter. 

To create an object image from the screenshot, proceed as follows: 

1. Position the highlight of a Mouse Action macro about the control on the screenshot. 

2. Select Update Object Image  in the macro editor. 
A dialog box for the editing of the object image opens. 

3. Adapt the object image position, if needed. 

4. Select Confirm Selection , to create the object image. 
The dialog box closes and the object image is inserted into the Object Image parameter. 

Now you can insert the object image and object name into a bubble as placeholder: 

1. Select a text field of a bubble. 
The HTML editor opens. 

2. Select Insert Object . 

3. In the menu select the entry Insert Placeholder... 
A dialog box with placeholders opens. 

4. Select one of the placeholders:   

○ Macro: Object Image 

○ Macro: Object Name 

5. Select Insert. 

4.14 Macro Parameters for Simulation Macros 

Each macro contains parameters, which define the design and the behavior for different use case like rerecording, 
playback and documentation. You are able to adapt these parameters for a selected macro in the macro editor. 

The following section gives you an overview about the available parameters. Further information about a macro and 
specific macro parameters is available in the macro descriptions. 

 Note 
The available settings are specific for each macro. 

4.14.1 General Parameters 

In the macros, there are the following general parameters: 

• Comment: 
You can enter a general comment to assist editing in the Comment field. This is displayed in the thumbnail 
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view in place of the macro text. 
You can amend the displayed comment as follows: 

○ Comment preceded by '+': Comment is appended to the macro text in brackets  

○ Comment preceded by '*': Comment is inserted in brackets in front of the macro text  

○ Comment preceded by '/': The comment is not displayed, only the macro text  

• Use Text from (Interaction macro): 
Specifies the text type used. This allows you to use different texts for demo mode and practice mode or to use 
the same text for both modes. 

○ Both Modes 

○ Demo Mode 

○ Practice Mode 

• Demo Text / Practice Text (Interaction macro): 
Contains the text for the macro to be displayed for a specific mode.  

• Text: 
Contains the text for the macro to be displayed during playback. For some macros the parameter is mode-
specific.  

• Object Name (Interaction macro): 
Contains the name of the recorded control. 
The parameter is used in all interaction macros and is shown in the bubble text.  

• Object Image (Interaction macro): 
Contains the icon or an image of the recorded control. 
The parameter is used in all interaction macros and is shown in the bubble text. 

Editing object name and object image 

It may be necessary to edit the name or the image of the parameters. For example: 

• If a control in an application has changed but it is not worth rerecording a project. 

• If changes have been made to the highlights on a screenshot.  

Any change to the parameters is automatically incorporated in the bubble texts. 

• Editing an object name 
Change the name by entering a new name. 

• Editing an object image 
Select the Update Object Image  function in the macro editor. An editing window appears in which you can 
make the necessary changes to the icon. Drag the highlight to the desired position and confirm. 
 
You can also use the Replace Image...  function to insert an image. The button opens an option menu with 
functions for creating or inserting an icon. Select the appropriate method. 
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4.14.2 Subcategory: Bubble 

The parameters of the Demo Bubble and Practice Bubble subcategories are used for the display of the action 
macro's bubbles. 
The settings provide the possibility to define different appearances for the bubble in the different modes. 

• Style: 
Here you can choose which bubble style you would like to use. The bubble styles are saved in the Resources 

. 

• Width/Height: 
Specifies the size of the bubble in pixels.  

• Orientation: 
Here you can specify in which direction the tip of your bubble should be pointing. If you choose the option 
Center – the bubble will have no point and it will be positions in the middle of the chosen area. 

• Display Duration: 
Specifies, how long a bubble is visible during playback. The setting is defined in seconds.  

• Translate Manually: 
The option Translate Manually option ensures that customized bubble content is not replaced by text 
automatically generated by Automated Translation or a rerecording. The options are activated as soon as the 
contents of a bubble is edited manually. In this case the contents can be exported by using Export Translatable 
(menu Tools -> Translation) in order to be translated manually by a translator. 

4.14.3 Subcategory: Simulation 

The subcategory Simulation contains parameters that specify the display of content during playback: 

• Highlight in Demo / Practice: 
Specifies, that the highlight for the control is displayed during playback. The setting is available for demo 
mode and practice mode. 

• Bubble in Demo / Practice: 
Specifies, that the bubble with the explanation is displayed during playback. The setting is available for demo 
mode and practice mode. 

• In Mode: 
Specifies, for which of the modes the object should be displayed during playback. 

4.14.4 Subcategory: Documentation 

The macro parameters required for documentation creation are found in the subcategory Documentation.  

• Show in Documentation: 
Specifies, whether this macro is to be taken into consideration during the creation of documentation. 
Disabling this parameter makes it possible to hide certain, specific actions described by macros in the 
documentation. 
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Screen macro 

For the Screen  macros, there are the following parameters: 

• Show in Process: 
Specifies to show the step in the process flow of a documentation. 

• As Heading in Documentation: 
Specifies to use the Screen Title as heading in the documentation. 

• Image Size: 
Specifies the size of the screenshot in percentage. 

• Screenshot Position / Size: 
Shows the position and size of the screenshot.  

• Border Width: 
Puts a border at your defined pixel width around the screenshot. The standard color is white and can be 
changed in Documentation Settings. 

Interaction macros 

For the interaction macros, there are the following parameters: 

• Highlight Position / Size: 
Shows the position and size of the highlight. 

 Recommendation 
Use the Document Highlight function to change the marker position. 

• Marker Orientation: 
Specifies the orientation of the marker on the screenshot. It is recommended to adapt the markers, if the 
screenshot displays more than one marker. 

4.14.5 Subcategory: Rerecord 

The subcategory Rerecord contains parameters that are required for a rerecording. 

• Interactive: 
The option Interactive means that when a recording is being repeated, the rerecording will stop at this macro 
and manual recording of the macro will resume. Automatic rerecording will continue thereafter. This option is 
particularly important at those points in the project where it is known that the desired object for the action to 
be recorded is to be found in another position or a different object for the recording must be selected. 

 Note 
Do not change the parameters of the Object Type, Click Position, Recognition Method and Object Key manually to 
allow a correct rerecording. 
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4.14.6 Subcategory: Control 

The parameters describing how a control is displayed and executed in the project can be defined in the Control 
subcategory. 

• Position and Size: 
The parameter defines how a control is orientated in the screen view in relation to the upper left-hand corner 
as well as the width and height of the control. For editing the parameters select the Edit button to open an 
editing dialog box. 

Various individual parameters are available for the different interactions: 

• Macro Text Input: 
The color and text design of the Text input macro can be defined. It can also be defined whether the text entry 
is to be portrayed as a password. 

o  All Values: 
If control is a drop-down box is included, all of the drop-down box's options are saved in the parameter All 
Values. The chosen entry is flagged with an asterisk {*}. While the project is being edited, the value can be 
changed by assigning the flag to the corresponding entry.  

• Macro Mouse Action: 
For the Mouse Action macro it is possible to define both the cursor type and the state of the button when it is 
clicked. 

• Macro Checkbox: 
For the Checkbox macro it is possible to define both the cursor type and the type of checkbox, whether the 
latter is to be used as a radio button. 

4.14.7 Subcategory: Advanced 

The subcategory Advanced contains the parameter: 

• Jump Target: 
Displays the selected jump target after the creation of a branch. You can select another target from the drop-
down list. 

4.15 Simulation Macros 

For simulation projects, there are the following macro types: 

• Special Macros 

• Interactions 

• Page Macros 

• Quiz Items - see Quiz chapter 

• Documentation Macros - see Documentation chapter 

The macros can be inserted by using the toolbar of the project editor. 
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4.15.1 Special Macros 

The following section describes special macros, which can be inserted into simulations. 

Icon Name 

 Simulation Start 

 Simulation End 

 Intro Page 

 Intro Page Start Link 

 Imported Page 

 Form Structure 

 Branches 

 Jump to Step 

 Mode Change Start 

 Mode Change End 

 Text-to-Speech Override 

In the following chapters, you will find further information about the special macros. 
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4.15.1.1 Simulation Start 

 

This macro is required for the initialization of the simulation in the trainer. It is located at the beginning of a project. 
When using the recording, this macro is inserted automatically. 

Score 

The parameters Maximum Score and Required Score specify the points for the test mode. The values are calculated 
from the number of single actions (always 3 points) and the percentages that have been entered in the Explorer for 
the project. Use Update to automatic calculate and actualize the score. 

 

Task description 

A task may be displayed in a separate browser popup window in practice mode and test mode. This can be created 
in the Task Description subcategory and activated for the mode in question. 

The Generate Values for Task Description option is used to insert the values from the Input Text  and Select Single 
 macros into the task. This is of use, for example, so as to have the necessary data available when creating a 

user or logging in. 

The position of the task description window on the screen is set by the parameter Orientation. In addition a 
background color for the window can be selected via Background. 

4.15.1.2 Simulation End 

 

This macro is used by the trainer to end the simulation correctly. It is located at the end of a project. When using the 
recording, this macro is inserted automatically. 

• Pause (seconds): 
The parameter defines the display duration of the last step during the playback of the simulation. 

Settings of the End Page 

Once a simulation is completed, an end page with a summary appears as well as the button to restart the 
simulation. 
The end page uses the preset that is defined in the Intro Page macro. 

The following parameters can be defined: 

• Show End Page: 
The parameter defines that the end page will be shown during playback. 
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• Title End: 
The title will be shown for the relevant mode. 
Modes: demo mode, practice mode, test mode 

• Description End: 
The description will be shown for the relevant mode. 
Modes: demo mode, practice mode, test mode passed, test mode failed 

For further information, refer also to the chapter Intro and End Pages. 

4.15.1.3 Intro Page 

 

The macro specifies that an intro page is shown in the simulation. It has to be included in the first step after the 
Simulation Start and the Intro Page Start Link macro. 

Parameters of the macro 

The following parameters are available: 

• Title: 
The parameter defines the title for the relevant mode. 
Modes: demo mode, practice mode, test mode 

• Description: 
The parameter defines the description for the relevant mode. 
Modes: demo mode, practice mode, test mode 

• Preset: 
The parameter defines the design of the start and end page. The available presets are part of the 
Configuration/Style resources. 

• Page Size (Advanced Layout): 
The parameter defines the page width and height in pixels. 

For further information, refer also to the chapter Intro and End Pages. 

4.15.1.4 Intro Page Start Link 

 

The macro defines a start link for the intro page. This makes it possible to jump to different steps in a complex 
simulation and to guide the learners. The link has to be included in the first step after the Simulation Start macro 
and before the Intro Page Start Link macro. To create several links, insert an Intro Page Start Link macro for each 
link. 
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Parameters of the macro 

The following parameters are available: 

• Description: 
The parameter defines a description for the start link. 

• Link Text: 
The parameter defines a text for the start link. 

• Target Step: 
The parameter defines a target for the start link. A step can be chosen from the drop-down-box. 

For further information, refer also to the chapter Intro and End Pages. 

4.15.1.5 Jump to Step 

 

This macro allows you to jump to a specific step in the simulation. The macro can be used to create alternative 
paths in a simulation. 

Parameters of the macro 

The following parameters are available: 

• Jump Target: 
Specifies the step for the jump. Select a step from the drop-down list. 

4.15.1.6 Mode Change 

The change of mode makes it possible, at a specific step, to switch to another mode while a mode is being played 
back. If the step was completed it switches back to the original mode. For example, while a demo mode is in 
progress, a step can be displayed as a test mode. This allows users to take an active part while viewing the 
simulation. 

Macros of a mode change 

There are two macros for the mode change available: 

 

Mode Change Start 
This macro forces a mode change when playing back the simulation in a certain mode. 
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Mode Change End 
This macro terminates the mode change and changes back to the initial mode. 

 Note 
A mode change can only be used within a step. Ensure that the Mode Change Start and Mode Change End macros 
are within the same step. 

Creating a mode change 

To create a mode change, proceed as follows: 

1. Select the Screen  macro for the step with the mode change. 

2. Insert the Mode Change Start macro using the Insert Special Macro toolbar. 

3. Select the Mode Change Start macro. 

4. Specify the target mode in the macro editor. 

5. Select the last macro of the step. 

6. Insert the Mode Change End macro using the Insert Special Macro toolbar.  

Removing a mode change 

To remove a mode change for a step, delete the Mode Change Start macro and the Mode Change End macro. 

4.15.1.7 Text-to-Speech Override 

 

You can use the Text-to-Speech Override macro to replace the prescribed spoken text for a step with a text of your 
own. 

Insert the Text-to-Speech Override macro in a step once you have converted the associated spoken text. The macro 
contains the bubble text as default spoken text. You can now change the text in accordance with your own ideas. 
Would you like to restore the original bubble text in the text box, then you can use the control Insert Text from 
Bubble to overwrite the current text with that. 
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4.15.2 Interactions 

Interactions are used for the recording, display and control of the simulation contents. They portray all the usual 
actions that a user can carry out in an application. 

Icon Name 

 Screen 

 Explanation 

 Mouse Action 

 Key Stroke 

 Input Text 

 Select Single 

 Radio / Checkbox 

In the following chapters, you will find further information about the interactions. 

 Note 
Keep in mind that, when inserting interactions manually, no object information is saved. If a new recording is to be 
made, the object is to be manually defined in its sequence or skipped. These can also not be used for SAP 
Companion for desktop projects. It is generally only recommended to create actions during a recording. 
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4.15.2.1 Screen 

 

The Screen macro contains the recorded screenshot of the application. The macro always marks the beginning of 
each step, followed by the recorded actions. When using the recording, this macro is created together with every 
new step as soon as an action is executed. 

 

Parameters of the macro 

The following parameters are available: 

• Screen Title: 
Contains the recorded screen title of the application. 

• Page: 
Contains the recorded screenshot image of the application. 

 Recommendation 
If you want to edit the screenshot for the Screen macro, it is possible to open it in an external image editor. To do 

this, select Page -> Replace Image  -> External Editor... 

4.15.2.2 Explanation 

 

The Explanation macro allows you to add further information to your project content. 

The macro can be inserted during recording or rerecording or from the toolbar in project editor. 

Parameters of the macro 

The following parameters are available: 

• Use Demo Bubble for Practice: 
To reduce editing time, activate the option to use the same text and settings of the demo mode for the bubble 
in practice mode. 

• Show Control (Simulation): 
Use the parameter to show navigation controls within a bubble. When activated, the simulation pauses and 
resumes when the Next button of the bubble is selected. 
The setting is recommended, if the bubble contains a long text to allow the user to read the text completely. 
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Type icon 

A Type (Icon) can be assigned to the bubble, which can be selected from four different types. Each type is 
represented by an icon: 

Type Icon 

Info  

Remark  

Tip  

Warning  

The icons are also added to the documentation generated for a project. The images of the icons are located in the 
resources trainer Style and Documentation Style. You can replace these with your own images. 

4.15.2.3 Mouse Action 

 

The Mouse Action macro simulates a mouse action on a button or a link. 

Parameters of the macro 

The following parameters are available: 

• Hotkey: 
If the action can also be activated by a keyboard shortcut, then the corresponding key combination may be 
entered in Hotkey. The key names are separated by spaces, for example: ctrl k.  

• Action: 
Specifies, what type of action is to be carried out with the mouse. The action is set during recording. 

• Ctrl, Alt, Shift: 
Specifies a key used for performing the action. The parameter is set during recording. 

4.15.2.4 Key Stroke 
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The Key Stroke macro simulates a keystroke or a keyboard combination. The macro can require the user to press a 
key or combination of keys to continue the simulation.  

Parameters of the macro 

The following parameters are available: 

• Hotkey: 
Specifies the keyboard shortcut. The key names are separated by spaces, for example: ctrl k.  

Defining a hotkey 

To define a hotkey, proceed as follows: 

1. Select the Hotkey parameter. 

2. Click on the Edit button. 
A dialog opens. 

3. Press the key or the keyboard combination, which should be inserted. 
The text field is filled automatically. 

4. Confirm the dialog with OK. 

The key or keyboard combination is entered in Hotkey. 

4.15.2.5 Input Text 

 

The Input Text macro simulates text being entered into a specific text field. 

Parameters of the macro 

The following parameters are available: 

• Input Text: 
Contains the value entered during the recording. 

• End Value: 
Supports the inputting of text in multiline text boxes. Whereas only single line texts can be entered using the 
Input Text parameter, the End Value parameter generates wordwraps, thus displaying the complete text in the 
text input box. 

• Confirm with: 
Specifies the manner in which the entry is to be confirmed. Three options are available: Confirm with Tab, 
Confirm with Enter and Confirm with Button. More than one option may be selected. 
If the option Confirm with Button has been selected, then it also needs to be assigned an object position. It is 
also possible to select an entry without confirming it Enter, Tab, Button. In this case, the three confirmation 
options must be disabled. 
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 Note 
If the Confirmation parameter for inputting a text is altered or an input is read out without being confirmed, then 
the instruction in the practice bubble for confirming the input is to be aligned manually. 

• Set Focus (Simulation): 
Specifies whether the focus is automatically set on the corresponding input field within the simulation page 
during playback, or if the users should define this themselves, which actually corresponds to the behavior of a 
live application. 

Using a regular expression 

A Regular Expression is an exactly defined search pattern for which a match is sought (pattern matching). When 
using a regular expression with an input field, the value entered during a simulation does not need to match exactly 
the value that was originally recorded. The value needs instead to correspond to a value described by the regular 
expression and is thus valid. The regular expression must be JavaScript compliant. Examples: 

any input:/.*/ 
not case-sensitive input: /input/i 
valid alternatives:/^kg$|^kilogram$|^kilogramme$/ 
five-digit number: /^[0-9]{5} $/ 
four-digit number with 2 decimal places:/^[0-9]{4}[,\.]{1}[0-9]{2} $/ 
date:/^[0-9]{1,2}(-|/|\.)[0-9]{1,2}(-|/|\.)([0-9]{4} $|[0-9]{2} $)/ 
currency: /^-?[0-9]+$|^(-?[0-9]+)?[,\.]{1}[-0-9]{1,2} $/ 
e-mail address: /.+@\[?[a-zA-Z0-9-\.]+\.([a-zA-Z]{2,4}|[0-9]{1,3})\]?/ 

4.15.2.6 Select Single 

 

The Select Single macro simulates the selection of a list box or a selection list. 

Parameters of the macro 

The following parameters are available: 

• Selected Index: 
Contains the index number of the selected value. 

• Selected Value: 
Contains the value selected during the recording. 
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4.15.2.7 Radio / Checkbox 

 

The Radio / Checkbox macro simulates the activation of a radio button or a checkbox. 

Parameters of the macro 

The following parameters are available: 

• Selected Value: 
Contains the value selected during the recording. 

4.15.3 Page Macros 

Page macros can be inserted into simulations, which will allow you to create simulations with greater flexibility. 
These can be positioned directly on screenshots, images, PowerPoint slides and book pages and can be activated 
for being displayed in a specific mode. In this way, simulations can be easily enriched with additional information, 
reference material and visual aids. 

The following section describes page macros, which can be inserted into simulations. 

Icon Name 

 Arrow 

 Shape 

 Highlight 

 Text Pop-Up 

 Image 

 Icon Link 
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Icon Name 

 Text Link 

 Book Page 

In the following chapters, you will find further information about the page macros. 

 Note 
Note that page macros cannot be used for documentation and can only be used for playing simulations. The only 
macro that can be used in combination with documentation is Book Page Link, which appears as a graphic image. 

4.15.3.1 Arrow 

 

The Arrow object is customizable. It creates a path for which you can choose from a variety of arrow heads. The 
arrow's length, position and direction can be modified as desired. 

Positioning a path point 

There are path points at the beginning and end of an arrow that allow you to adjust its length and direction. Select 
one of the points and drag and drop it to the desired position on the book page. 

Defining an arrow 

An arrow object can be customized as follows: 

• Color: 
Specifies the arrow's color. Select the color preview to open the Color Selection dialog box. 

• Thickness: 
Specifies the arrow's thickness. The value is given in pixels. 

• Arrow Head 1 & 2: 
Specifies the arrow's head for each side of the arrow. 
There are several types: 

Design Name 

 
None 
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Design Name 

 
Standard  

 
Triangle - Hollow  

 
Triangle - Filled  

 
Diamond – Hollow  

 
Diamond – Filled 

 
Circle - Hollow 

 
Circle - Filled  

• Advanced (Advanced Layout): 
Specifies the width and the length of the arrow heads in relation to the arrow’s thickness. Enter a value 
between 2 and 20. 
The value defines how many times the length of the thickness should be expanded (for example, value 3 = 3x 
the arrow’s thickness). 

4.15.3.2 Shape 

 

The Shape object displays a variety of shapes to choose from for the purpose of enhancing the visualization of 
learning content, process flows and sequences. Shape objects can be used in a variety of ways and can contain text. 

To insert a shape, select Insert Shape. A palette is opened in which you can select a shape type and a orientation. 
For more information, refer to the section on Shapes Overview. You can change the type with the Type and 
Orientation parameter. 
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Design 

• Shape Color: 
Specifies the shapes' color. Select the color preview to open the Color Selection dialog box. Select Transparent 

, if you do not want to use any color. 

• Shape Value: 
Specifies the shape's character. Values between 0 and 100 can be entered here. The outcome will vary 
depending on the type of shape selected. For example, you can change the width of an arrow or smooth the 
corners of a square.  
Note that this setting is not available for all shapes. For more information, refer to the section on Shapes 

Overview. 

You will find descriptions on additional settings under the section on Editing Parameters. 

Effects 

Under Effects, there is a variety of settings that allow you to define the behavior and design of a shape. 

• Gradient   

○ Shape Color (Gradient) 

○ Border Color (Gradient)  

• Design Roll-Over   

○ Shape color 

○ Shape Color (Gradient) 

○ Border color 

○ Border Color (Gradient)  

• Design Click   

○ Shape color 

○ Shape Color (Gradient) 

○ Border color 

○ Border Color (Gradient)  

4.15.3.3 Highlight 

 

This macro makes it possible to locate an additional highlight on a screenshot. The highlight is independent of a 
bubble and can be used to support an explanation. As only one highlight can ever be used for a macro, whereas it 
may be necessary for a number of highlight frames to describe a situation, this macro can be used in addition to the 
already existing highlight frame. 

Inserting and positioning a highlight 

1. From the Thumbnail View, highlight the macro Page to which you would like to add your highlight. 
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2. Then click on Insert -> Insert Page Macro -> Highlight. 
The default position for the highlight macro is directly under the macro Screen  to ensure that it is 
displayed throughout the entire duration of the step's recording. If the highlight should be displayed with a 
particular macro, you can simply drag the highlight in front of the desired macro. 

3. From the step view, you can now position (drag & drop) the highlight on the screenshot. To adjust the size of 
the highlight, click on one of the frame's points and with the left mouse button pressed, drag the frame to the 
desired size. Release the mouse button to confirm the changes. 

Macro options 

• Display in Mode: 
You can use the various options to define the mode in which the highlight is to be displayed. 

• Hide Highlight:  
Activate this parameter if you want to hide the highlight in the simulation.  
This setting has no impact on the highlight being displayed in the documentation if the parameter Show in 
Documentation is activated. 

• Object Name: 
You can use this parameter to specify a name for the object. If you have two Highlight macros in a step, you 
will need to change the name. In the event of highlight sharing the same name, only the second one in the 
sequence will be displayed. 

• Show in Documentation: 
If you activate this parameter, the highlight you have created will be displayed in the documentation. 

• Highlight Color: 
Defines the color of the highlight border. 

• Highlight Position (Documentation): 
Defines the position (left, top) and the size (width, height) of the highlight on the screenshot in pixel. 

4.15.3.4 Text Pop-Up 

 

This function inserts a text pop-up which can be opened by a button. You can insert any text you like in this box as 
well as an image. 
The text pop-up can be formatted using the Text Pop-Up Position subcategory to adjust its size and position. 

Defining type and title 

• Type: 
Different types, differentiated by a corresponding icon, can be defined for displaying the textbox. Using 
different types enables you to highlight the text box content and present it more clearly to the user. 
The following types are available and can be selected using the parameter Type:   

○ Standard  

○ More Info  

○ Tip   
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• Title: 
You can use the parameter Title to specify a title for the text box. If you do not want to display a title, you 
should leave the field blank. The default setting for the Standard type is no title whereas placeholders are 
displayed for the other types. 

Further options 

• Show on Roll-Over: 
This option allows you to define whether a text pop-up should appear when the mouse cursor rolls over the 
icon. When the mouse cursor rolls out of the icon, the text pop-up will hide again. The text pop-up behaves in 
the same way as a tooltip. 

• Fade In/Out: 
This parameter defines whether the text pop-up is displayed or hidden with a fading in effect when being 
opened or closed. Deactivate the setting if you wish to avoid this effect. 

• Hide Text Pop-Up in Editor: 
The default setting is for the text pop-up to be displayed in the book page editor. Activate the parameter to 
hide it for editing. If you would like to reinstate the text pop-up in the view, deactivate the setting. 

4.15.3.5 Image 

 

This object allows you to insert an image file to your book page. 

Inserting an image 

To insert an image, proceed as follows: 

1. Select Insert Image in toolbar. 
The Insert Image from Workarea dialog box opens. 

2. Select an image in your workarea structure. 
or 
Use Insert File... to import an image. 

3. Select Ok. 

You can use Replace Image  to change the image file. 

See the chapter Supported File Formats on Book Pages for supported file formats. 

Parameters of the object 

The following parameters are available: 

• Image Roll-Over: 
You can use the Image Roll-Over option to insert an image that is shown when the mouse is moved over it. 

• Image Click: 
You can use the Image Click option to insert an image that is shown when the image is clicked on. 
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• Keep Aspect Ratio:  
If this parameter is activated, the aspect ratio is retained when scaling an image. Deactivate this parameter if 
you want to be free to change the size of an image. 

• Zoom: 
The Zoom option allows you to zoom in and out of images on the book page. An icon will be inserted onto the 
image. By clicking on the icon, the image will be shown in its original size. This allows you to insert an image 
into the book page and save space when scaling it. 

4.15.3.6 Icon Link 

 

The Icon Link allows you to link content found in the work area or to create a link to an external source, such as a 
website. An icon will then be inserted, to which a link can then be assigned. The icon is customizable. You can insert 
an image as well as a tooltip for the target link. 

The design of the icon is based on the Style selected for the simulation that can be defined in the central 
configuration dialog in Authoring Settings -> General-> Page style. 

Defining an icon 

The look of the icon will depend on what book style has been chosen, which can be defined in the Style settings. 
For your defined target link, from the option Type, you can choose what kind of icon you would like to use: 

• Demo Mode  

• Practice Mode  

• Test Mode  

• Concurrent Mode  

• Quiz  

• Book page  

• Book  

• Document  

Alternatively, your own icon can be inserted using the option Image. It is recommended that you use your own icon 
when linking to an external source or when the icon should not have the same look as the book style itself. 

4.15.3.7 Text Link 

 

Text Link is a text field to which you can add texts and links. The entire surface area is actually a button that can 
easily be linked to an external Internet page or an object from the workarea. This allows you to display additional 
information if desired. 
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1. To create a link, go to the Insert link...  function. 

2. A dialog will then open in which you can specify a link or select an object from the workarea. 
A link to a web page or similar is to be entered in the text field under Available. This should be in the format 
http:// www... 

3. Confirm your entry by clicking on OK. 

When launched, the linked page is automatically opened in a new browser window. If you would like to open the 
page in the same window, you need to deactivate the setting Open in a new window. 
If the linked page or object from the Workarea is opened in a new window, you can define properties for displaying 
the browser window that has been opened. 

4.15.3.8 Book Page 

 

An existing book page can be inserted into a simulation with a link using the Book Page macro. Changes made to the 
book page also affect the link in the simulation. 

 

Insert a book page as follows: 

1. Use the toolbar to insert the Book Page macro into the project. You can select this macro from the drop-down 
list for the book page objects. 
When the macro is inserted, a new step is automatically created. 

2. You can then link the book page you want using the Book Page parameter. Select Edit Link...  to open the 
Edit Link dialog box where you can select the book page. 

3. You can activate the book page for the mode you want under Simulation. 

Keep in mind that the objects available on the book page cannot be edited. It is only possible to add additional 
objects within the project editor or to edit the book page directly in the book page editor. 
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5 SAP Companion for desktop 

The SAP Companion for desktop is an EPSS solution which is available at the end of the learning process to provide 
your users direct support in your enterprise application. If previously learned processes or process steps are no 
longer sufficiently front of mind, the user can request support as and when required and have himself prompted 
within the live application or obtain explanations on areas of the application user interface that are relevant to the 
process or especially prone to error. This optional assistance boosts your user's confidence in using the application 
and gradually ensures optimal performance in handling the process. It also enables your users to execute seldom 
used processes with the greatest possible accuracy, for example when having to stand in for someone without 
notice. 

The SAP Companion for desktop runs discreetly in the background in your application and indicates by means of an 
icon in the information area whether there is information available on the application page in question. Should he 
need to, the user can use this icon to launch the support and return it to the standby state when the need no longer 
exists. 

The degree of support available here is very variable. The content can accompany the user in detail through 
established processes, explain entire application interfaces specific to a particular process and object and prevent 
departures from predefined processes. If there are process-related simulations available, these too are offered to 
the user to give him the opportunity to have knowledge of process routines or steps demonstrated to him in the 
simulation environment or to work through them without affecting the live application. 

5.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

5.2 General 

SAP Companion for desktop types 

The following SAP Companion for desktop types can be created: 

 

SAP Companion for desktop 

Displays a content library to provide users context-specific content. 
See the chapter SAP Companion for desktop. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_96AB82A8C8E4FB90
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Context Help 

Displays context-specific information to explain the use of controls. 

See the chapter Context Help. 

 

Guided Tour 

Displays process-specific information to explain a process step by step. 

See the chapter Guided Tour. 

Creating SAP Companion for desktop projects 

SAP Companion for desktop projects (context help and guided tour) can be created in two ways: 

• Using existing simulations 
You can convert projects by using prerecorded simulations. Using this method can reduce the effort of 
creating a project, because application pages and their corresponding objects do not have to be manually 
rerecorded. 
See the chapter Converting Simulations. 

• Manual creation 
Creating projects manually offers you the opportunity of providing an application with EPSS support 
individually and independently of pre-existing simulations. You can identify the objects required for your 
processes on each application page and assign them help texts. 

5.3 Prerequisites for Target Applications 

The Producer ensures the creation and the playback of SAP Companion for desktop content for specific 
applications. Detailed information is available in the Product Availability Matrix (PAM) of SAP Enable Now. 

SAP Companion for desktop for SAP applications 

The following recommendations are necessary for the recording and playback of a SAP Companion for desktop for 
SAP applications: 

• Consider the Settings for the SAP Client for the recording and playback. 

• When recording SAP applications, make sure that you have only opened one SAP session. First, close all the 
sessions that you do not need for the recording. 

• The playback of content requires the corresponding GUI Theme (such as SAP Tradeshow) used for the 
recording. 

The support of additional applications has to be verified previous according to the technical feasibility. Contact your 
SAP account manager for the necessary support. 
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 Caution 
SAP Companion for desktop content does not support multi-monitor environments. Therefore, when creating 
content, make sure that the Producer and your target application are both situated on the screen registered on the 
system as the main monitor. 

 Note 
SAP NetWeaver - Update 
When updating SAP NetWeaver (including SAP_Basis), note that the release versions can include different page 
key information for specific objects. This can result in a partial mismatch of your content during playback. 
Once the SAP NetWeaver update is finished, play back your content and check your content matching. Update the 
missing objects or replace the page key attributes with regular expressions, if required. 

Playback in Google Chrome or Microsoft Edge 

You are able to playback a SAP Companion for desktop in Google Chrome or Microsoft Edge.  
To support correct page recognition you have to install a browser extension. During installation of the SAP 
Companion for desktop, activate the option Install browser extension. The extension can be uninstalled from the 
Extensions settings of the browser. 

 Note 
After uninstalling the extension in Google Chrome, it cannot be installed again with the SAP Companion for 
desktop installer. Google Chrome blocks the installation. You can install the extension from the Chrome Web 
Store. Search for Enablement Assistant. 

5.4 SAP Companion for desktop 

The SAP Companion for desktop lets you generate a context-based content delivery. The SAP Companion for 
desktop combines different content types and can be thought of as a content library. 
The required contexts of the application pages are saved automatically when a project is recorded. The SAP 
Companion for desktop uses them to assign content during playback. 

5.4.1 SAP Companion for desktop Components 

The SAP Companion for desktop has the following main components that are used during playback: 

• Sidebar 
The sidebar is a navigation bar and is used to start the main functions of the SAP Companion for desktop. 

• Main window 
The main window shows the available contents for a specific page context. 
During playback of a guided tour, the window shows the step list. 
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• Book window 
The book window shows the book (used with book reader), which was opened from the content window. 
During playback of the book, the main window and content window are hidden. 

If there is no content available for a context, the list is empty and a hint is shown. If the user changes from a page 
with an available context to a page without an available context, the SAP Companion for desktop shows the content 
of the page with the last available context. 

Activating components and functions 

The components and functions of the SAP Companion for desktop can be displayed or hidden by using the settings 
(menu Tools -> Settings... ) under the SAP Companion for desktop: Playback Settings -> SAP Companion for 
desktop. 

5.4.1.1 Sidebar 

The sidebar of the SAP Companion for desktop contains the following controls: 

• Content: 
Indicates if content is available. Allows the user to open the main window. 

• Search: 
Allows the user to open the search in the main window or in the library. 

• External Search: 
Allows the user to search on an external URL. 

• Request Content: 
Allows the user to open an e-mail window for requesting content. 

• Add Sticky Note: 
Allows the user to insert a sticky note for an application and to enter individual information. 

• Instant Help: 
Allows the user to activate the available contents of the context help for the current context. The control is 
enabled by default. 

• Start Recording: 
Allows the user to record a process in the current application. 

• Exit: 
Finishes the playback and closes the SAP Companion for desktop. 

5.4.1.2 Main Window 

The main window displays the available content for a context and allows the user to select and start content. 

The main window contains the following tabs and functions: 

Content 

The Content tab displays the available content for the current context. 
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When selecting a content entry, the available modes and documentation for the selected content as well as the 
description text will be displayed. You can start or open a content object. A Back control allows you to go back to 
the content list. 

Search 

The Search tab allows users to search specific content for a description and short description. 

Info 

The Info tab allows you to provide general information about the SAP Companion for desktop for the user. The 
information is always available and is not context-specific. 
The tab uses the text of the SAP Companion for desktop’s root group. 

User Area 

The User Area tab contains the recorded processes as documents. The documents can be opened, shared or 
deleted. Further processes can be recorded. 

With mouseover within a document, the following controls are displayed: 

• Rename Document: 
Allows the user to rename the selected document. 

• Open Document: 
Allows the user to open the selected document. 

The footer of the tab contains the following controls: 

• Record Document: 
Allows the user to record a new document. 

• Share Documents: 
Allows the user to share the selected documents by sending an e-mail. 

• Delete Documents: 
Allows the user to delete the selected documents 

Settings 

The Settings tab displays settings for specifying the displayed content. 

The Settings tab includes the following entries: 

• Show Hidden Help: 
Allows the user to reset hidden help elements which were set to hidden during playback. 

• Roles  
Contains settings for displaying role-specific content. 

○ Select All: 
The user is only allowed to display content for his or her own role. 

○ Show Content Without Roles: 
Allows the user to display content with no role assigned. 

○ Change Role: 
Allows the user to specify the roles for which content is shown. 
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Further functions 

Further functions of the main window: 

• Share Content: 
Allows the user to share specific content with other users. A menu opens to copy the link or the share the link 
via e-mail. 

• Help: 
Allows the user to open a help window with information about the SAP Companion for desktop. 

• Close: 
Allows the user to close the main window. The main window can be reopened by using the sidebar. 

5.4.2 Creating a SAP Companion for desktop 

To create a SAP Companion for desktop, consider the following process: 

1 SAP Companion for desktop content 

Create your SAP Companion for desktop content, for example, guided tours, simulations or book 
pages. 

2 Playback settings 

Set the relevant settings for the SAP Companion for desktop playback in the Settings  dialog box. 
Configure the windows and sidebar. 

See the chapter SAP Companion for desktop Playback Settings. 

3 SAP Companion for desktop 

Create a SAP Companion for desktop by using a SAP Companion for desktop object  or a group 
. 

See the chapter Creating a SAP Companion for desktop Object. 

See the chapter Creating a SAP Companion for desktop Group. 

4 Configuration 

Configure and generate the SAP Companion for desktop. 

See the chapter Creating a SAP Companion for desktop Object. 

To create a SAP Companion for desktop, you first need to perform various preparation steps before configuring and 
generating the mode. 

5.4.2.1 SAP Companion for desktop Content 

In the SAP Companion for desktop, you can include the following content types: 
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Category Icon Content type Category Icon Content type 

Simulation    Documentation     

  Demo mode    

All types and 
formats 

DOC, PDF, HTML, 
PPT 

   Test mode Other content     

   Practice mode    
Books 

  

   Concurrent mode    Book pages 

SAP Companion 
for desktop 
projects 

       Text units 

   Guided tour    Groups 

   Context help    Media objects 

Creating content 

Create a group in the content tree of the Explorer. It is also possible to use the root group of the complete tree with 
different sub groups. Include the required content in the group. The order of the content is not relevant for the 
display in the SAP Companion for desktop, as the content is displayed according to context. Additional groups allow 
you to structure the content in the tree. 
If you do not want to show a specific content object, hide the object in the tree. 

For some content objects, it is required to record a context to use them in the SAP Companion for desktop. For 
further information, see the chapter Recording a Context. 

 Recommendation 
Add a description or a short description for your content objects. It will be shown in the SAP Companion for 
desktop details view during playback. If there is no description, then a default text "Start your preferred content 
below" is shown. 
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5.4.2.2 Creating a SAP Companion for desktop Object 

You can use a dedicated SAP Companion for desktop object to generate a SAP Companion for desktop. With this 
object, you can reference available content for specific use cases. Each SAP Companion for desktop object has 
individual settings and can be filtered. This is recommended to specify different SAP Companion for desktop 
content and configurations. 

Generating the SAP Companion for desktop 

To generate a SAP Companion for desktop using a SAP Companion for desktop Object , proceed as follows: 

1. In the Explorer, select New Object . 
An overview of all objects opens. 

2. Select SAP Companion for desktop . 
The New SAP Companion for desktop Object dialog box opens. 

3. Adapt the following settings: 

1. Name: 
Enter a SAP Companion for desktop name. 
The default name is the object type with an ID. 

2. Language: 
Select the language of your content. 

3. Select Group: 
Select the group with your SAP Companion for desktop content. 

4. Use Filter: 
Allows you to select a filter to be applied to the content. 

4. Select OK to create the object. 

5. The SAP Companion for desktop Configuration dialog box is opened. The dialog box shows the available 
content types of the group. 
Select your desired contents. 

6. Select OK to generate the SAP Companion for desktop. 

The content is inserted into the SAP Companion for desktop object as references. 

Adding and removing content 

You are able to add further objects to the SAP Companion for desktop object or to remove available objects. 
We recommend adding the content as references to use the content for other publications too. Copy and paste the 
object into the SAP Companion for desktop object and select As Reference in the opened dialog box. 
Afterwards, select Generate SAP Companion for desktop  to generate the content again. 

The structure of the content is not relevant for the display in the SAP Companion for desktop, as the content is 
displayed according to a context. Additional groups allow you to structure the content in the tree. 
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5.4.2.3 Creating a SAP Companion for desktop Group 

You can use an available group with content to generate your SAP Companion for desktop. This is recommended, if 
a content structure is only used for a specific SAP Companion for desktop. 

Generating the SAP Companion for desktop 

To generate a SAP Companion for desktop by using a SAP Companion for desktop group , proceed as follows: 

1. Select a group  with your SAP Companion for desktop content. 

2. Select Generate SAP Companion for desktop  in the object editor. 

Note 
If you are using contents from another workarea and have removed some objects locally, then a Generate SAP 
Companion for desktop dialog box opens. It reminds you that locally removed objects are not considered for the 
SAP Companion for desktop generation. Select Cancel to go back and reload the missing objects from server, or 
Continue to proceed with the generation. 
For more information on using content from another workarea, see the Manager Manual, Reuse content from 
other workareas chapter).  

3. The SAP Companion for desktop Configuration dialog box is opened. The dialog box shows the available 
content types of the group. 
Select your desired contents. 

4. Select OK to generate the SAP Companion for desktop. 

The content is inserted into the SAP Companion for desktop object as references. 

Adding and removing content 

You are able to add further objects to the SAP Companion for desktop group or to remove available objects. 
Afterwards, select Generate SAP Companion for desktop to generate the content again. 

The structure of the content is not relevant for the display in the SAP Companion for desktop, as the content is 
displayed according to a context. Additional groups allow you to structure the content in the tree. 

https://help.sap.com/viewer/product/SAP_ENABLE_NOW/?task=use_task
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5.4.2.4 SAP Companion for desktop Object and Group 

The SAP Companion for desktop has the following characteristics: 

Type Description 

Icon 

 

SAP Companion for desktop object 

 

SAP Companion for desktop group 

Individual files Contains the DNT file for playback. 

Basic properties 

The object editor contains the following parameters: 

• Name: 
Specifies the name of the SAP Companion for 
desktop. 

• Language: 
Specifies the language of the SAP Companion for 
desktop. 

• Use Filter (SAP Companion for desktop object 
only): 
Specifies if a filter is applied to the content. 

• Start Link: SAP Companion for desktop: 
Generates a link to the DNT file for starting the 
content. 

• SAP Companion for desktop Configuration (SAP 
Companion for desktop object only): 
Contains the specified configuration of the SAP 
Companion for desktop. The field cannot be edited. 

Object functions 

The object editor contains the following controls: 

•  New... 
Creates a new content object in the SAP 
Companion for desktop structure. 

•  Generate SAP Companion for desktop: 
Generates the SAP Companion for desktop. The 
SAP Companion for desktop Configuration dialog 
box is opened. 

•  Play /  Stop SAP Companion for desktop: 
Starts and stops the playback of the SAP 
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Type Description 

Companion for desktop. 

5.4.3 Editing the SAP Companion for desktop 

There are different settings and functions available in the SAP Companion for desktop for editing and optimizing 
content for your use cases. 

5.4.3.1 Recording a Context 

Beside projects you can also add other objects to a SAP Companion for desktop. Objects in a SAP Companion for 
desktop must have context information. The context information for projects is added during recording and for 
other objects, each context has to be recorded individually. The context can be an application with the current 
application page and is stored in the Context parameter. 

A context can be recorded for the following objects: 

 Groups  Text Units  Media Objects 

 Books  Book Pages     

Recording a context 

To record a context, proceed as follows: 

1. Open the application at your required application page. 

2. Select an object in the content tree of the Producer. 

3. Select Record Context  in the object editor. 

4. The Select Window and Profile dialog box opens. You can define the following parameters:   

○ Choose Window: 
Select the target application window for the recording. 

○ Choose Profile: 
Shows the application profile for the target application window. 

○ Associate with Selected Window: 
Specifies, that the profile is always used for the target application window. 

5. Select Record . 

The context of the selected window is recorded and the context information is inserted into the Context: SAP 
Companion for desktop parameter of the object. 
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5.4.3.1.1 Editing a Context 

You can use more than one context information for an object. This gives you more flexibility in using content for 
different application windows or applications. 

Editing a Context 

To edit a context, proceed as follows: 

1. Select an object in the content tree with an available context. 

2. Select Record Context  in the object editor. 

3. Afterwards, a dialog box is displayed. 
Select one of the options and confirm with Ok: 

• Add Context: 
Select this option to add the context to an available context. 
The Select Window and Profile dialog box is displayed to start the recording.  

• Update Context: 
Select this option to update a recorded context with a new version. 
The Update Context dialog box is displayed, with all available contexts. Select a context to record. 

• Replace All Contexts: 
Select this option to remove all available contexts and to insert a new context. 

• Delete Context: 
Select this option to remove an available context. 
The Delete Context dialog box is displayed, with all available contexts. Select a context to delete. 
 
 

Update / Delete Context dialog box 

When updating or deleting a context, a dialog box is opened. The dialog box displays all available contexts of an 
object. 

• Select Profile: 
The dropdown box contains all profiles, which are used for recording the contexts. Select a profile to display 
the correspondent contexts. 

• Available Contexts: 
The field displays the available contexts for a selected profile. Select a context to display the detailed 
information. 

• Context Details: 
The field displays the details of a selected context. 

• Update or Delete: 
Select the control to update or to delete a selected context. 
When updating a context, the Select Window and Profile dialog box is displayed to start the recording. 
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5.4.3.2 Excluding Project Pages 

The SAP Companion for desktop uses all included content objects to match them with a context. In some cases, it is 
necessary to hide a project for a specific context. In projects, you can exclude a page key from the context 
recognition of the SAP Companion for desktop. 

To do this, activate the option Exclude from SAP Companion for desktop of the Screen  macros: 

• In SAP Companion for desktop projects, the option is located in the subcategory Key. 

• In simulation projects, the option is located in the subcategory Rerecord. 

5.4.3.3 Requesting Content 

When using the SAP Companion for desktop, users require specific content. A function is available that allows users 
to send a message to the author to specify their needs. 
Content can be requested using the Request Content button in the sidebar. If no content is found, the link for 
requesting content is displayed in the main window. 

Settings 

The following settings are available in Settings  under SAP Companion for desktop: Playback Settings -> SAP 
Companion for desktop -> SAP Companion for desktop - Sidebar: 

• Request Content Type: 
Specify a type for requesting content: 

○ E-Mail: 
Allows you to send a request with an e-mail. 

○ URL: 
Allows you to open a contact form to enter a request. 

• E-Mail: 
Insert a recipient e-mail address. 

• URL: 
Insert a URL, for example to open a contact form. 

• URL Parameters: 
You can specify the application name and the executable as parameters for the URL. The default is 
application=&executable=. 

• Position: 'Request Content' Control: 
Specify the position of the Request Content button in the sidebar. 

Texts 

The e-mail contains a standard text, which is located in the Playback Dictionary  of the SAP Companion for 
desktop. You can change the text as required by using the dictionary editor. 
The texts have the IDs MAIL_SUBJECT, MAIL_HEADER, MAIL_FOOTER, MAIL_DATA and MAIL_TOOLTIP. 
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5.4.3.4 Searching Content 

The user can search for additional content that is not available in the content list. There are two search types: 

• Search in published content of the SAP Companion for desktop 

• Search by using an external URL 

Search settings 

The following settings are available in Settings  under SAP Companion for desktop: Playback Settings -> SAP 
Companion for desktop -> SAP Companion for desktop - Sidebar: 

• Search Type: 
Specify a search type:  

○ library: 
Opens the library for searching in the library content. 

○ SAP Companion for desktop Group: 
Shows the Search tab in the main window for searching in the SAP Companion for desktop content. 

• Search Group: 
Specify a group of your workarea. 

• Position: 'Search' Control: 
Specify the position of the Search button in the sidebar. 

External search settings 

The following settings are available in the central configuration dialog box under SAP Companion for desktop: 
Playback Settings -> SAP Companion for desktop -> SAP Companion for desktop - Sidebar: 

• Position: 'External Search' Control: 
Activate the external search and specify the position of the External Search button in the sidebar. 

• URL: 
Allows you to specify a URL for the external search. Enter the URL in the following structure: 
https://www.google.com/#q= 
https://www.bing.com/search?q= 
https://search.yahoo.com/search?p= 
https://www.wolframalpha.com/input/?i= 

 Note 
Do not delete or change = of the URL parameter. 

• Provide Context Information: 
Provides additional context information of the user with the search URL during search. The context 
information is used for search. Activate the setting if your specified search can use the context information. 
The provided context information is specified in the Context Information parameter. 

• Context Information: 
Specifies the context information if the setting Provide Context Information has been activated. The following 
context information can be provided: 

○ EXE of the current application: &executable= 
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○ Page key of the current application page: &pagekey= 

 Note 
Do not change the structure of the context information string. 

5.4.3.5 Recording Content 

A user can record his or her own process during playback of the SAP Companion for desktop. The process can be 
saved as a Microsoft Word document or as video. The content can be used to share information about a process 
with other users via e-mail. 

The Microsoft Word document is saved in the local cache folder of the user and the video is stored in a specified 
folder. The recording is executed as a quick recording. 

Activating recording 

The following settings are available in Settings  under SAP Companion for desktop: Playback Settings -> SAP 
Companion for desktop -> SAP Companion for desktop - Sidebar: 

• Position: 'Recording' Control: 
Activate the recording and specify the position of the Recording button in the sidebar. 

• Allow Video Recording: 
Activate video as output format. 

• Video Recordings Folder: 
Specify a folder for storing the video files. The default folder is: %userprofile%\Videos\SAP Companion 
for desktop Videos 
Video recordings are not stored in the SAP Companion for desktop cache folder because of the file size. 

Recording a document 

A process can be recorded using the Start Recording button in the sidebar or the User Area of the main window. 

1. A dialog box with the output formats is displayed. 
Select an output format. 

2. The Recording Area dialog box is opened: 

• Select Region or Full Screen: 
Specify if you want to record a region with a predefined size or the exact application window. 

• Choose Size (Region): 
In the dropdown box, you can select a predefined size for the region. 

3. Start the recording using the Record  button. 
If you want to cancel the recording, select Cancel. 

4. Now the recording starts. 
Navigate through the application screens required for the process. 

5. Pausing the recording 
The recording can be interrupted using the Pause  button in the systray icon. If you are recording an audio, 
then the audio recording is also paused. 
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Resume the recording by using the Record  button. The recording is continued from the exact point at 
which it was paused. 

6. Stopping the recording 
Select Stop  in the systray icon to end the recording. 

7. The Generate Document dialog box is opened: 

• Name: 
Enter a project name. 

8. Select OK to generate the content. 

Afterwards, the generated document or video is available in the User Area view. 

5.4.3.6 Using Roles 

You can manage and display your content for your users by using specific roles. These roles are used to filter the 
content that is available to users. 

Defining roles 

Each object has a parameter Roles. The parameter is available in the object editor of the Explorer. 

To define a role, proceed as follows: 

1. Select an object. 

2. Go to the Roles parameter of the object editor (in Advanced layout). 

3. Insert a role name into the multi-line edit field. 

4. You can add further roles separated by a comma. 
 

Activating roles 

Roles can be activated with the setting Consider Roles. The setting is available in Settings  under SAP Companion 
for desktop: Playback Settings -> SAP Companion for desktop in the subcategory SAP Companion for desktop - 
Controls and Behavior. 

Now, the main window of the SAP Companion for desktop includes a tab entry for roles in the settings tab. 

5.4.3.7 Using Sticky Notes 

Sticky notes allow the user to insert additional notes for an application and to enter individual information. A sticky 
note is only displayed for the user who inserted it and not for other users. The text of the sticky note is saved in the 
local cache of the user. 

The sidebar of the SAP Companion for desktop includes a control for adding sticky notes. When inserting a sticky 
note, the bubble with an editing toolbar is displayed. The user can enter and edit the text or can delete an available 
sticky note. 
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 Note 
It is only possible to insert one sticky note for a screen. 

Activating sticky notes 

Sticky notes can be activated with the setting Position: 'Add Sticky Note' Control. The setting is available in Settings 
 under SAP Companion for desktop: Playback Settings -> SAP Companion for desktop in the subcategory SAP 

Companion for desktop - Sidebar. 

Sticky note bubble 

The sticky note uses the bubble style Sticky Note. The bubble style is available in the Bubble Style  resource. 

5.4.3.8 Updating Profile Information 

When the Producer is updated to a higher version, the application profile resources are also updated. SAP 
Companion for desktop content contain profile information from the application profiles, which can be outdated 
and can influence whether objects are correctly recognized. 

It is recommended to update the profile information of a project. A dialog box shows a hint, if the profile information 
is outdated. 
The dialog box contains the following buttons: 

• Select Continue to update the project. 

• Select Cancel to discard the update. 

 Recommendation 
Archive the project before updating, in order to keep the original status. 

Alternatively, create a new project by using the current application profile and keep the older project. 

5.4.3.9 Using Content Categories 

You can use content categories to sort your content in the main window of the SAP Companion for desktop. You 
can assign content categories to your content objects. During playback of the SAP Companion for desktop, the 
content is structured in dropdown lists with the corresponding content categories. 

There are default content categories that are translated in multiple languages. You can use the defaults or you can 
create your own content categories. 

Activating content categories 

Content categories can be activated with the setting Consider Content Categories. The setting is available in the 
Settings...  under SAP Companion for desktop: Playback Settings -> SAP Companion for desktop in the 
subcategory SAP Companion for desktop - Controls and Behavior. 

Now the content in the main window is structured by using the assigned content categories. 
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Content categories resource 

Content categories are saved as a Content Categories  resource in the Adaptable Resources  of the resource 
tree. This resource includes all content categories. To open the editing dialog box, choose the Edit Content 
Categories...  button in the object editor. 
The resource allows you to use content categories consistently in different workareas and you can also handle the 
resource in an authoring environment with a Manager workarea. 

5.4.3.9.1 Managing Content Categories 

Content categories are managed in the Content Categories dialog box. To open this dialog box, choose Tools -> 
Manage Content Categories...  in the menu. 

In the Content Categories dialog box, you can create, rename, and delete content categories. 

Creating content categories 

To create a content category, proceed as follows: 

1. Select the Add  button. 
A dialog box opens. 

2. Enter the name of the content category. 

3. Confirm with OK. 

The new content category is displayed in the list. 

 Recommendation 
The content category name entered is used in all languages during playback. To translate the name, see the 
chapter Translating Content Category Names. 

 

Renaming content categories 

To rename a content category, proceed as follows: 

1. Select the Rename  button. 
A dialog box opens. 

2. Change the name of the content category.  

3. Confirm with OK. 

The content category is displayed with the new name. 

 Note 
You only can rename content categories that are created by authors. The standard content categories cannot be 
renamed. 
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 Note 
When renaming a master tag that has been assigned to content objects you have the following options: 

Master and All References 
Renames the master tag and all assignments in the content objects. 

Master Only 
Renames the master tag only. For the assignments a new author tag with the previous name of the master tag is 
created. 

Removing content categories 

To remove a content category, proceed as follows: 

1. Select the content category in the list. 

2. Select the Remove  button. 

Once you have edited your content categories, close the dialog box by clicking OK. 

 Note 
When removing a master tag that has been assigned to content objects you have the following options: 

Master and All References 
Removes the master tag and all assignments in the content objects. 

Master Only 
Removes the master tag only. For the assignments a new author tag with the name of the master tag is created. 

Replacing content categories 

To replace a content category with another content category, proceed as follows: 

1. Select the content category in the list. 

2. Select the Replace  button. 
The Replace Content Category dialog box is opened. The selected content category is displayed in the Replace 
field. 

3. Select the content category in the With dropdown box. 

4. Select OK. 

The content category in all objects are replaced with the replace content category. 

Changing author content categories to master tags 

You can change your created author content categories to master content categories. Proceed as follows: 

1. Select the author content category in the list. 

2. Select the Change to Master  button. 

The tag is displayed with Master Content Category type and icon. 
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5.4.3.9.2 Translating Content Category Names 

The default content categories are translated into multiple languages. In the Explorer and Content Categories dialog 
box, only the text keys of the categories are shown. During playback of the SAP Companion for desktop the 
categories are displayed in the current content language. 

You can translate your created content categories in your required languages. Proceed as follows: 

 Note 
The content category name entered is used as a text key in the translation files of the Content Categories resource. 
Make sure, that the text key of the content category is entered as one string without spaces. You can use an 
underscore or a hyphen to connect words. 
See also the text files of the resource for examples. 

1. Select the Content Categories  resource in the Explorer. 

2. Use the secondary mouse button to open the context menu. 

3. Select the Open Folder  menu entry. 

4. The resource folder contains translation files for each language.  
Open the translation file of your required language in a text editing program. 
An overview of the languages and language codes is available in the chapter Content Languages Overview. 

5. Enter the text key and the translated name of the content category. Separate the text key and the name with a 
tab stop. 
For example: business_process Business Processes 

6. Save and close the file. 

7. Restart the Producer. 

When playing back the SAP Companion for desktop the content category is displayed with the translation. 

5.4.3.9.3 Assigning Content Categories 

You can assign your created content categories to the objects within your tree structure. Proceed as follows: 

1. Select an object in the tree structure.  

2. Select the button Edit...  next to the parameter Content Categories in the object editor. 
A dialog box opens. 

3. You can assign one or more content categories to the object. To do so, select the corresponding checkbox.  

4. Select OK to close the dialog box. 

Used content categories 

In the Manage Content Categories dialog box, you can see whether a content category is assigned and how often. A 
number is displayed in the References column of the content categories list. 
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5.4.3.10 SAP Companion for desktop on Running SAP 
Companion 

While the SAP Companion for desktop is used for desktop applications, for example, SAP GUI for Windows, SAP 
Companion is often used in parallel for web-based applications, for example, SAP S/4HANA. To improve the user 
experience when using both playback components, the SAP Companion for desktop recognizes an application with 
an opened SAP Companion and therefore the available context-sensitive help. The SAP Companion for desktop is 
minimized automatically and shows a message for the user. After the user changes to an application without SAP 
Companion the SAP Companion for desktop is shown again. 

To activate hiding of the SAP Companion for desktop, proceed as follows: 

1. Open the Settings... and go to SAP Companion for desktop: Playback Settings -> SAP Companion for desktop -> 
SAP Companion for desktop - Content and Behavior. 

2. Activate the option Hide SAP Companion for desktop on Running SAP Companion. 

3. Activate or deactivate the option Show SAP Companion Message. 

5.4.3.11 SAP Companion Mode Additional Editing Options 

If you have activated SAP Companion Mode for the SAP Companion for desktop projects, you have the following 
additional options for guided tours and context help in macro editor: 

1. Title: 
Specify a tile title for the SAP Companion mode. Default is empty. 

2. Tile Icon: 
Choose a specific tile icon from the dropdown. Same icons as in original SAP Companion projects are 
supported. 

3. Bubble size: 
Define the size of bubbles for playback. Default for regular bubbles is S. Default for freestanding bubbles that 
are attached to the help panel is M. 

4. Hotspot size: 
Choose the size of the hotspot for the SAP Companion playback mode. This parameter is not relevant for 
guided tour steps as it only applies for circle and icon hotspots 

5. Push Help: 
Show hotspots and bubbles automatically when the help bar is open on the Help tab or is closed. Push help 
can be activated individually for each context help object and it is hidden when guided tours are played back. 

5.5 Context Help 

The context help helps users to work with an application by offering help descriptions of issues and functionality 
independently of process. The information can be presented in relation to different contexts, thus providing specific 
information the user can access individually. 
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The context help thereby enables the user to orientate himself quickly in complex application interfaces and use the 
explanations to refresh and apply what he has learnt. 

Furthermore, presenting context-related information makes it possible to highlight frequently occurring problems, 
explain changes in the application or emphasize information that is important for the process. 

Use cases 

A context help lends itself for example to the following use cases: 

• For information about system changes on an object or an application page, for example during maintenance 
work.  

• For fading in additional problem-related explanations for individual objects, for example in order to prevent 
incorrect inputs by providing notes and explanations for the objects in question.  

Context help in SAP Companion for desktop 

Context help projects can be used in a SAP Companion for desktop and are displayed as Instant Help.  

5.5.1 Context Types 

The context help recognizes three context types. These can be used in combination but can also be used 
individually in a project. This allows all sorts of information to be presented in different circumstances, thus 
providing users with the necessary specific information. 

A context refers to a specific issue in an application so as to describe it and support the user with the appropriate 
context-related information. 

Application Context 

 

This context offers general information about the application as well as more in-depth information or links. 
The application context underpins the context help and serves to recognize the displayed application and call 
corresponding learning content. 
This context can also be used on its own.  
The macros for the application context are held in the second step of a project. 

Screen Context 

 

Describes an application page in greater detail. This can be for example: describe its use in general terms, draw 
attention to problem areas or else highlight changes in the event of a new version. 
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Object Context 

 

Defines a specific object. This can be a Mouse Action  macro for example or an Input Text  macro. This 
enables the function of the object to be described, points out things worthy of note or else elucidate relationships 
with other objects. 

5.5.2 Creating a Context Help 

Creating a context help manually enables you to assign context information to an application individually and 
independently of pre-existing simulations. You can record the macros required for your processes on each 
application page and create the help texts. 

In a project the different context types build on one another, i.e. the application is defined first, then the page and 
finally the object, thus proceeding from the general to the specific. The recording of the respective contexts 
behaves accordingly. An object requires all three macros of context information whereas an application context can 
also stand in its own right. 

5.5.2.1 Creating a Context Help Project 

Create a project for your context help content. For more information, see the chapter Creating a Content Object. 

To create a project, proceed as follows: 

1. In the Explorer, select New Object . 
An overview of all objects opens. 

2. Select Context Help . 
The New Project dialog box opens. 

3. Adapt the following settings:  

1. Name: 
Enter a project name. 
The default name is the object type with an ID. 

2. Language: 
Select a language for the project. The automatically created bubble texts are generated in this language. 

3. Project Type: 
The SAP Companion for desktop - Context Help type is selected. 
You can change the type in the dropdown box. 

4. Choose OK to create the project. 

The project opens in the project editor. Now, you can record your content. Read the following chapters to find out 
more about this subject. 
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5.5.2.2 Recording an Application Context 

Recording the application context determines the application and the interface to be used for reading the object 
information. This is the basis of a context help to assign the help content that is available for an application. This 
also provides general information about an application. 

The application context for an application can only be set up once in a project as it must only be defined once. But a 
number of corresponding application contexts can be created for multiple applications that are recorded. 

Record an application context as follows: 

1. Select the Record Application  function in the toolbar.  

2. The Choose Application dialog box appears: 

1. Select the target application window for the recording. 

2. Select Choose.  

3. A dialog box appears that displays the EXE name for the program. 

• Display Name: 
You can define a name for the display during playback. 

4. Select OK to confirm and finish recording. 
Select Next to confirm and record another application. 

The application context recording is now available in the second step in the project editor. 

 Recommendation 
If you want to create an explanation for a specific context, use the Insert Explanation  function. For more 
information, see the section on Inserting an Explanation. 

5.5.2.3 Recording a Screen Context 

A screen context can be recorded several times in a project and spread over several steps. This may be useful, for 
example, if you want to record and sort numerous objects on a screen. If you record a screen context you will also 
automatically record an associated application context, if one does not already exist. 

Record a screen context as follows: 

1. Select the Record Screen  function in the toolbar.  

2. A settings dialog box appears where you can select an application. 
In the dialog box you can define the following:   

○ Choose Window: 
Here you can select the target application windows for the recording. 

○ Profiles: 
Shows the application profile for the target application window. 

○ Associate with Selected Window: 
Specifies that the profile is always used for the target application window. Select Choose.  

3. Afterwards, a dialog box appears where you can change the Screen Title for the screen context.  
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4. Confirm the dialog box and complete the recording by selecting OK.  

The screen context recording is now available in a new step in the project editor. 

5.5.2.4 Recording an Object Context 

If you record an object context, you also automatically record an associated application and screen context, if they 
do not already exist. Record an object context as follows: 

1. Starting the recording 

1. Select the Record Object  function in the toolbar. 
The Select Window and Profile dialog box opens. 

2. Choosing the window and profile 

1. Choose Window: 
Select the application window that you want to record from the list. The selected window appears in the 
foreground.  

2. Choose Profile: 
This setting selects the application profile for recording the application automatically. If you want to use 
another profile, you can change it using the drop-down box. 

3. Associate with Selected Window: 
Activate this setting, if you always want to use the profile for the selected application window. 

4. Start the recording using the Record  button.  
Select Cancel, if you want to cancel the recording. 

 Note 
If a suitable application profile could not be identified, then the default profile is used. Note that in this case, the 
recognition accuracy of the interactions and controls in the application window might be limited, depending on the 
application. 

3. Recording the object 

The recording starts and the recording bar is displayed. 

1. A dialog box appears for selecting a screen context. You have the following options:   

○ The New Screen option creates a new screen context in a new step.  

○ You can select a prerecorded screen context, which you can add the object context to after recording.  

2. Confirm your selection by selecting OK.  

3. Select an object to record the control. 
or 
Select Insert Explanation  in the recording bar.  

4. After an object is selected an object bubble and an editor toolbar appears.  
You can edit the text and the bubble position. 



 

Producer (Cloud Edition) 
SAP Companion for desktop 

 
PUBLIC   125 

 

5. Confirm the editor toolbar by selecting Apply. 
or 
Select Cancel to discard the object.  

6. Record another object or insert an explanation.  

7. To end the recording, select Stop  in the recording bar.  

The recording bar closes and the recorded process is now available in the project editor. 

5.5.2.5 Recording Bar 

The recording bar appears when you start the recording. It includes the following sections and controls: 

 

Buttons 

The buttons let you control the recording. 

 

Button Explanation 

(1) Profile 

The dropdown box contains a list of available application 
profiles. If the application is detected automatically, the 
correct application profile is selected automatically and 
shown in the list. You can also use this box to switch 
between application profiles manually. 

(2) Record 
Select this button to begin the recording. Afterwards, the 
button changes to Pause. 

(2) Pause 
Select this button to interrupt the recording. This is 
useful when changing applications. When you are done, 
the button changes to Record. 

(3) Stop 
Select this button to end the recording and to close the 
recording bar. 

(4) Undo 

Select this button to reset the previous action of your 
process. 

Note that this applies only to the last action. You cannot 
delete multiple actions. 

(5) Insert Explanation 
Select this button to insert an Explanation instead of 
recording a control. 
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Button Explanation 

(6) Execute Mouse Action 

Select this button to specify, whether a control is to be 
recorded and executed in the application or whether this 
is to be recorded without an action. 
Recording controls without executing actions is 
recommended, if a number of controls on a page are to 
be recorded and explained without leaving the 
application page. The button has to be deactivated to do 
this. 

(7) Choose Application 
Select this button to reselect an application for 
recording or to switch to another application. 
Afterwards, select the required application. 

(8) Minimize 

Select this button to minimize the recording bar; an icon 
will appear in the system tray instead. You can control 
the recording using the context menu. By selecting this 
icon, the recording bar will return to its original size. 

(9) Close 
Select this button to close the recording bar. The 
recording will be stopped. 

Status section 

The status section shows you whether an action is required or if the Producer is working on a recording in the 
background. Supporting icons and text messages are also displayed. 

Icon Explanation Icon Explanation 

 

Record 

This status is shown, if the 
recording is running and 
the user needs to perform 
an action. 

After an action has been 
performed, the status also 
shows the edit mode. 

 

Pause 

This status is shown, if the 
user pauses the recording. 

 

Busy 

This status is shown, if a 
user action is executed in 
the background. 

Note: Wait for the Record 
status to turn green, to 
execute the next action. 

 

No Control 

This status is shown when 
the user selects an area 
that is not recognized as a 
control. 
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5.5.2.6 Key Functions for Recording 

During recording different actions can be performed using key functions: 

Keys Definition 

Ctrl 
With a pressed Ctrl key you can navigate freely in the application without an action being 
recorded. 
This is useful for instance for selecting lists, in order to open them and record the selection. 

Esc With the Esc key recording can be cancelled. 

5.5.3 Form for a Screen 

The form allows you to display all form actions in one bubble and not a bubble for each action. 

A form is located in a project step and is structured as follows: 

• Screen  macro 

• Action macro 1 

• Action macro 2 

• Action macro 3 

5.5.3.1 Creating a Form 

To create a form, proceed as follows: 

1. Combine the macros of the form in one step. This is necessary because the form cannot be created in a way 
that spans multiple steps.   

○ Move all interaction macros into the step with the first action of the form. Arrange the actions in the 
required order in the relevant structure. 

○ Delete the unused steps and screens.  

2. For the form screen, select the setting Form Mode in the subcategory Advanced (Advanced Layout). 

Form structure settings 

There are general settings available for defining the display of the form bubble. The following settings are available 
in Settings  under SAP Companion for desktop: Playback Settings -> General -> Form Bubble: 

• Style 

• Alignment 

• Position 

• Width 

• Height 
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5.6 Guided Tour 

The guided tour offers user support in carrying out predefined processes in an application. Users are guided 
through the process step-by-step with instructions, making it possible for them to carry out the displayed actions 
properly right in the live application. The instructions are collocated with the objects to be used. 

Sample applications 

A guided tour is suited, for example, to be used as follows: 

• To train new employees (beginners) to learn the required processes on existing systems. 

• To introduce a new system for users or to learn new business processes. 

• To learn about or reference business processes that have been in use for a long time or are rarely used. 

• The changes in the process when the system is changed. 

Structure of a guided tour 

A guided tour has the following project structure: 

• The subcategory Tour End, which is found in the macro Guided Tour Style , specifies the information that 
should be displayed at the end of the process. 

• Every step contains a macro Guided Tour Step  that defines each individual step. 

• Every action macro contains a subcategory Next Guided Tour Step that specifies the course of the process. 

5.6.1 Creating a Guided Tour 

You can record your process or update an existing process independent of existing simulations by manually 
creating a guided tour. 

The recording is similar to the recording of simulations. You follow the process step-by-step and thus record the 
entire sequence. 

5.6.1.1 Creating a Guided Tour Project 

Create a project for the content of your guided tour. For further information, see the chapter Creating a Content 

Object. 

To create a project, proceed as follows: 

1. In the Explorer, select New Object . 
An overview of all objects opens. 

2. Select Guided Tour . 
The New Project dialog box opens. 

3. Adapt the following settings:  
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1. Name: 
Enter a project name. 
The default name is the object type with an ID. 

2. Language: 
Select a language for the project. The automatically created bubble texts are generated in this language. 

3. Project Type: 
The SAP Companion for desktop - Guided Tour type is selected. 
You can change the type in the dropdown box. 

4. Select OK to create the project. 

The project opens in the project editor. Now, you can record your content. Read the following chapters to find out 
more about this subject. 

5.6.1.2 Recording a Guided Tour 

To record a guided tour, proceed as follows: 

1. Starting the recording 

1. Open the application to be recorded. 
Choose the application page where you want to start recording and prepare the application as required. 

2. Select Record Guided Tour Step  in the project editor. 
The Select Window and Profile dialog box opens. 

2. Choosing the window and profile 

1. Choose Window: 
Select the application window that you want to record from the list. The selected window appears in the 
foreground.  

2. Choose Profile: 
This setting selects the application profile for recording the application automatically. If you want to use 
another profile, you can change it using the drop-down box. 

3. Associate with Selected Window: 
Activate this setting, if you always want to use the profile for the selected application window. 

4. Start the recording using the Record  button.  
Select Cancel, if you want to cancel the recording. 

 Note 
If a suitable application profile could not be identified, the Producer uses the default profile. Note that in this case, 
the recognition accuracy of the interactions and controls in the application window might be limited, depending on 
the application. 

3. Recording the process 

The recording starts and the recording bar is displayed. 
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1. Select an object to record the control. 
or 
Select Insert Explanation  in the recording bar.  

2. After an object is selected, an object bubble and an editor toolbar appears. 
You can edit the text and the bubble position. 

3. Confirm the editor toolbar by selecting Apply. 
or 
Select Cancel to discard the object.  

4. Record another object or insert an explanation.  

5. To end the recording, select Stop  in the recording bar.  

The recording bar closes and the recorded process is now available in the project editor. 

5.6.1.3 Recording Bar 

The recording bar appears when you start the recording. It includes the following sections and controls: 

Buttons 

The buttons let you control the recording. 

 

Button Explanation 

(1) Profile 

The dropdown box contains a list of available application 
profiles. If the application is detected automatically, the correct 
application profile is selected automatically and shown in the 
list. You can also use this box to switch between application 
profiles manually. 

(2) Record 
Select this button to begin the recording. Afterwards, the 
button changes to Pause. 

(2) Pause 
Select this button to interrupt the recording. This is useful when 
changing applications. When you are done, the button changes 
to Record. 

(3) Stop 
Select this button to end the recording and to close the 
recording bar. 

(4) Undo 
Select this button to reset the previous action of your process. 

Note that this applies only to the last action. You cannot delete 
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Button Explanation 

multiple actions. 

(5) Insert Explanation 
Select this button to insert an Explanation instead of recording 
a control. 

(6) Execute Mouse Action 

Select this button to specify, whether a control is to be 
recorded and executed in the application or whether this is to 
be recorded without an action. 
Recording controls without executing actions is recommended, 
if a number of controls on a page are to be recorded and 
explained without leaving the application page. The button has 
to be deactivated to do this. 

(7) Choose Application 
Select this button to reselect an application for recording or to 
switch to another application. Afterwards, select the required 
application. 

(8) Minimize 

Select this button to minimize the recording bar; an icon will 
appear in the system tray instead. You can control the 
recording using the context menu. By selecting this icon, the 
recording bar will return to its original size. 

(9) Close 
Select this button to close the recording bar. The recording will 
be stopped. 

Status section 

The status section shows you whether an action is required or if the Producer is working on a recording in the 
background. Supporting icons and text messages are also displayed. 

Icon Explanation Icon Explanation 

 

Record 

This status is shown, if the 
recording is running and 
the user needs to perform 
an action. 

After an action has been 
performed, the status also 
shows the edit mode. 

 

Pause 

This status is shown, if the 
user pauses the recording. 

 

Busy 

This status is shown, if a 
user action is executed in 
the background. 

Note: Wait for the Record 
status to turn green, to 
execute the next action. 

 

No Control 

This status is shown when 
the user selects an area 
that is not recognized as a 
control. 
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5.6.1.4 Key Functions for Recording 

During recording different actions can be performed using key functions: 

Keys Definition 

Ctrl 

With a pressed Ctrl key you can navigate freely in the 
application without an action being recorded. 
This is useful for instance for selecting lists, in order to 
open them and record the selection. 

Esc With the Esc key recording can be cancelled. 

5.6.2 Subcategory: Next Guided Tour Step 

The subcategory Next Guided Tour Step is located in the interaction macros and defines the process flow based on 
the process steps. The subcategory contains the following settings: 

• Action: 
Specifies the action that triggers a jump to the next guided tour step.  

• Next Step: 
Specifies the step that the guided tour jumps to.  

• Alternative Step 1-3: 
Defines alternative guided tour steps for the tour sequence. 
If the guided tour cannot jump to a defined guided tour step because the application page is not available, then 
the guided tour jumps to the specified alternative steps - one after the other. If no application page is found, 
the guided tour terminates. 

5.6.3 Branches in a Guided Tour 

Branches allow the user to digress from the sequential path within a guided tour. This gives the user much more 
flexibility and portrays a more realistic process workflow, which means that the user has a choice of where to go to 
next. 

During playback, the branch actions of the step are displayed as sub steps with radio buttons in the step list. Once 
you have selected an action, the sub-steps of the branch process are displayed. 

A branch is located in a step of a guided tour and is structured as follows: 

• Guided Tour Step  macro 

• Screen  macro 

• Action macro 1 with individual Next Step 

• Action macro 2 with individual Next Step 

• Action macro 3... or further objects 
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 Note 
Branches are only recommended for use in a guided tour because they support a process. They do not explain a 
single object, unlike in the context help. 

5.6.3.1 Creating a Branch 

Combine the macros of the branch in one step. This is necessary because the branch cannot be created in a way 
that spans multiple steps.  

To create a branch, proceed as follows: 

1. Move all required action macros into one step with the same screen. 

2. Delete the unused steps, guided tour steps and screens. 

3. For every branch action, set the Next Step with the required next step of the guided tour branch. As a result, 
the steps are displayed in the guided tour window after you select a branch action. 

4. Correct the numbering in the last steps of the guided tour to match the new order. 

5.6.4 Form in a Guided Tour 

The form allows the user to fill in an on-screen form in an individually chosen sequence and then confirm all data 
entries. During playback, the form step is displayed as a standard step in the step list. Once the step is selected, a 
bubble is displayed that includes all the form actions. 

A form is located in a guided tour step and is structured as follows: 

• Guided Tour Step  macro 

• Screen  macro 

• Action macro 1 with individual Next Step 

• Action macro 2 with individual Next Step 

• Action macro 3... or further objects 

5.6.4.1 Creating a Form 

To create a form, proceed as follows: 

1. Combine the macros of the form in one step. This is necessary because the form cannot be created in a way 
that spans multiple steps.   

○ Move all interaction macros into the step with the first action of the form. Arrange the actions in the 
required order in the relevant guided tour structure. 

○ Delete the unused steps and screens. 
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○ For the last action of the form, set the Next Step setting in the process. As a result, the steps of the 
project are displayed in the guided tour window. 
For the other actions of the form, deactivate the setting Next Step (green Button ).  

2. For the form screen, select the setting Form Mode in the subcategory Advanced (Advanced Layout). 

3. Correct the numbering in the last steps of the guided tour to match the new order. 

Form structure settings 

There are general settings available for defining the display of the form bubble. The following settings are available 
in the central configuration dialog box (menu Tools -> Settings...) under SAP Companion for desktop: Playback 
Settings -> General -> Form Bubble: 

• Style 

• Alignment 

• Position 

• Width 

• Height 

5.7 Object Bubble 

The object bubble displays specific information about an object in a dedicated bubble. This bubble is used for both 
the context help and guided tour. 

Depending on the setting the bubbles are displayed in miniature with a question mark (see also SAP Companion for 

desktop: Mini Icons) and open as soon as they are clicked. In this way the bubbles do not obscure the application 
interface. Furthermore, the button in the header area can be used to minimize the bubbles again after they have 
been called. 

 

But the object bubble is also used as a bubble for an inserted Explanation  macro. This bubble is displayed on the 
application depending on its position and settings and offers alternative page or object related information. 

When used inside the guided tour, the object bubble also contains an OK button to confirm actions and go to the 
next tour step. 

Design and position 

The object bubble design is predefined in the central settings. This is where changes to the way information is 
displayed can be made. The bubble position is specified by the position of the object and the orientation setting. 
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These can be changed in the respective object's macro editor in the Object Bubble subcategory or in the Advanced 
subcategory for an Explanation macro. 

5.7.1 Settings for Object Bubbles 

In the settings, you can configure the appearance and functionality of object bubbles. The settings are available in 
the Settings  dialog box under SAP Companion for desktop: Playback Settings -> General -> Object Bubble. These 
settings are either project-specific or generic, depending on the selection. 

5.7.2 Variants of the Object Bubble 

Used for type: Context help 

There are different display variants, which can be used for the object bubble. The variants can be defined in the 
Display Variant setting of the Context Help Style  macro or for an interaction macro. 

• Icon: 
Displays an icon on the control. The user can open the bubble with a click or via a mouseover on the icon. 

• Tooltip: 
No icon or bubble is displayed. The user can open the bubble via mouseover on the control. 

• Bubble: 
Displays the opened bubble on the control. 

5.7.3 Subcategory: Object Bubble 

Each action macro has a subcategory Object Bubble in the macro editor. The settings in the subcategory define the 
style and behavior of the object bubble for the macro. 

For an Explanation  macro the settings are located in the Advanced subcategory. 

The following settings are available: 

• Style: 
Defines the bubble style resource for displaying the object bubble.  

• Mini Icon Type (Context Help): 
Defines a type for the mini icon of the object. The mini icons are a resource type of the Adaptable Resources.  

• Width / Height: 
Defines the width and height of the object bubble in pixels. 
If the amount of text exceeds the available space, the height is scaled automatically. 

• Orientation: 
Defines the orientation of the object bubble relative to the referenced object. 

• Offset: 
Defines the offset in pixels in which the object bubble is displayed to the object.  
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• Minimized (Context Help): 
Defines if the object bubble is displayed minimized when the page is loaded.  

• Minimizable: 
Specifies whether the bubble can be minimized during playback. If this option is activated, a Minimize button is 
displayed in the bubble header.  

• Hide Option (Context Help): 
Specifies whether the bubble can be deactivated by the users. If this options is activated, a setting will appear 
in the object bubble which allows the users to hide information that they no longer need. 

• Show 'Next' Button (Guided Tour): 
Defines, that the Go to Next Step button is shown in the object bubble.  

5.7.4 Hiding an Object Bubble 

Used for type: Context help 

For object bubbles, you can display an option for hiding bubbles and their highlights. This allows users to hide any 
information they do not need. 

Displaying the Hide Option in a bubble 

In order to make this option visible to the user in the object bubble, select Hide Option. You can specify this 
individually for a macro or for the entire project: 

• For an Object Bubble: 
To specify the settings for a specific macro, choose Object Context and then go to the Object Bubble area in 
the macro editor. Activate the setting Hide Option.  

• For all Object Bubbles: 
To specify the setting for all macros, open the Settings  dialog box under SAP Companion for desktop: 
Playback Settings -> General -> Object Bubble. Activate the setting Hide Option.  

Allowing the user to display bubbles 

If a user hides one or more object bubbles during playback and then wants to display the information again, there is 
the option Show Hidden Help. The option is available in the context menu from the taskbar in the SAP Companion 
for desktop and in Settings of the SAP Companion for desktop. 

5.7.5 SAP Companion for desktop Mini Icons 

Used for type: Context help 

When the object bubble is minimized, a small bubble with a question mark is displayed. You can change the mini 
bubble by using a content-specific icon. This allows you to display specific information. 
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 Recommendation 
Use Icon or Tooltip as Display Variant to show the icon instead of the bubble. 

Mini Icon Style 

The default mini icons are stored as SAP Companion for desktop: Mini Icon resource in the Adaptable Resources. The 
resource contains 12 different icons. 

The icons can be adapted in the Style Editor (menu Tools -> Customization -> Edit Styles Resources... ). You can 
change the colors and symbols of the icons. See also SAP Companion for desktop Mini Icons. 

Mini Icon Settings 

A mini bubble can be defined for each action macro and Explanation macro with the setting Mini Icon Type. The 
setting is located in the subcategory Object Bubble of the macro editor and for an Explanation in the subcategory 
Advanced. 

5.8 Converting Simulations 

You can use your simulation projects to convert them to SAP Companion for desktop projects. During conversion a 
simulation project is adjusted to correspond to the necessary macros and project structure:  

Conversion in a context help 

 

When converting a simulation into a context help, the screen and action macros are merged and arranged based on 
their page affiliation. The application, page and object contexts are automatically created by using the 
recorded context information. 

The advantage of converting simulations into a context help is that it is possible to use controls that have already 
been recorded and which are familiar to the user from the simulations as object contexts. An additional benefit is 
that no objects that are required for a process are lost in a manual recording as they already exist in a simulation. 

Conversion in a guided tour 

 

When converting a simulation into a guided tour, the screen and action macros are arranged based on their 
structure in the simulation project. 
The guided tour is created on the basis of existing process simulations. The object bubbles are always displayed for 
a step when the guided tour is running. 
To convert a simulation in a guide tour, it is recommended to use projects where the Screen macros were not 
merged. Every action should have a separate step. The bubbles are thus displayed one after another for every 
action in the tour sequence. 
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5.8.1 Generating a SAP Companion for desktop Project 

To convert a simulation into a SAP Companion for desktop project, proceed as follows: 

 Note 
During a conversion, only Screen  macros, action macros, and Explanation  macros will be converted. 
Manually inserted PowerPoint slides, quiz items, documentation macros and so on will not be considered. 

1. Open a Simulation project  in the project editor.  

2. Select Generate SAP Companion for desktop Project  in the toolbar. 
A dialog box is opened. 

3. Specify the following settings:   

• Project Title: 
Enter a name for the project. The name of the simulation project is included by default. 

• Convert Hotspot to Explanation: 
Specifies that macros with recorded hotspots will be converted to Explanations  macros. If the option 
is deactivated, the macros will be removed. 

 Note 
Explanations  depend on position and do not use any object information to recognize a control within the 
application. With dynamic application objects, Explanations do not change dynamically either. It is recommended 
that you use Explanations for static objects in an application only. 

• Guided Tour: 
Specifies that a Guided Tour  project will be created. With deactivated option, a Context Help  
project will be generated. 

• Interactive Mode: 
Specifies that a guided tour is converted with interactive mode. 
During playback, the user has to navigate in the object bubble to the next step manually. No page 
recognition is done. 

4. Select OK to convert the project. 

Afterwards, the project is created and opens in the project editor. Now you can edit the project. 

Branches of a simulation 

For a guided tour, the branches of a simulation will be converted into the required structure. When converting a 
context help, the branches will be ignored. 

Quick recording 

A simulation that has been recorded using quick recording can be converted in a guided tour with interactive mode. 
When opening the dialog box to convert a project, the Guided Tour and Interactive Mode settings are activated by 
default and cannot be changed. 
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5.8.2 Post-Processing after Converting 

To customize and design a project according to the specific requirements, manual editing is possible after 
automatic conversion of a simulation. 

Necessary customization  

The following post editing will be required as a result of the technical specifics of the recorded application: 

• If page keys were recorded with a regular expression, these page key attributes have to be customized as 
otherwise the SAP Companion for desktop cannot display the associated application pages. The Replace Key 
Page Attribute function is available for this purpose. Selecting this option, displays a dialog allowing you to 
select all the page key attributes. Now select the attribute with a regular expression and select Next. With the 
option Regular Expression enabled, the selected page key attribute will be converted accordingly, so that the 
SAP Companion for desktop will be able to interpret it. Select Replace to customize the regular expression.  

• For an application with dynamic page keys the page key has to be edited manually, so that the recording’s 
page key is not used in the project. For this purpose, the page key can be rerecorded using the function 
Update Screen.  

• Context helps are strongly dependent on the differentiation of the application pages’ page keys. In 
applications, such as Microsoft Word or Outlook, this differentiation may not be sufficiently clear because the 
application only has one view and a process does not therefore take place on several application pages. To be 
able to differentiate the pages exactly, other controls have to be added to the context help using the Record 
Page Specifier  function. To do this, select the Screen Context  macro on which the desired control is 
displayed. Now click on the function Record Page Specifier, select the desired control and confirm with Ok.  

Further customization 

The following post processing can be performed: 

• Additional application page objects can be recorded manually for a context help to explain objects of an 
application page in further detail.  

• To provide users with additional information general notes can be created that will be faded in while a project 
is in progress. This is accomplished using the Record Explanation  function, which can be selected in the 
macro editor after selecting the Screen Context  macro.  

• As regards visual presentation layout changes and position changes can be applied to the highlights and 
bubbles. As the bubbles are inserted directly at the clicked position, it is recommended standard practice to 
review them to ensure an optimal view.  

• As the text modules are adopted directly from the simulations, they should be reviewed for use in the project 
and modified if so required. For example, this is necessary in process orientated descriptions such as Click on 
Next, to obtain generic information in a context help.  

5.9 Editing Content 

Various functions for configuring how your content is displayed, its functionality and design are available to you in 
the project editor. These can be called when selecting a macro by using the macro editor or the context menu. 
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5.9.1 Inserting an Explanation 

You can insert additional information into your content and use it in a variety of different ways with the Explanation 
 macro. This information can relate, for example, to an application or page. System-wide explanations can also 

be used for generally valid information. 

System-wide explanations are applicable to all applications and processes. They make it possible to communicate 
general information quickly and directly to users, for example, information about upcoming work on a server. 

Displaying explanations 

An explanation is displayed as follows depending on the SAP Companion for desktop type and the position in the 
project: 

• Explanations in the first step can be used system-wide 

• Explanations under the application context are displayed for the respective application 

• Context help: explanations in the step of a context help are displayed for an entire page 

• Guided tour: explanations in the first step of a guided tour are displayed as start bubble - a confirmation 
button for the start of the process is displayed 

• Guided tour: explanations in the step of a guided tour are displayed for a process step 

Inserting an explanation 

The explanation is to be inserted as follows for the application context and the Style  macro: 

1. Select the macro for which the explanation is to be inserted. 

2. Select Insert Explanation  in the header of the macro editor. 

3. The explanation bubble is inserted in the step and you can now enter a text and position the bubble. 

 Note 
When using an explanation within the application context of a context help, the bubble is always visible in the SAP 
Companion for desktop for a displayed Inline Help. The explanation has to be minimized or hidden by the user. 

Adding an explanation for screen context 

The explanation is to be added as follows for the page context: 

1. Select a Screen Context  for which the explanation is to be displayed.  

2. Select Record Explanation  in the header line of the macro editor.  

3. Now define where the explanation is to be located by clicking in the application. You will be prompted by a note 
on the cursor.  

4. A dialog will then appear in which you can enter the explanatory text. Then confirm this by selecting OK.  

The recorded Explanation  macro can then be further edited in the macro editor to customize the macro's 
appearance and functionality if so required. 
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5.9.2 Editing Bubbles 

Bubbles are edited in the step view. You can change the bubble text and the size and position of the bubble here. 

There are two buttons on the toolbar that can be used to switch between the view of the bubble for the current 
macro and the bubbles for all macros in the step. 

 Note 
The highlights of the actions cannot be changed because they are linked to the recorded control. Changes can 
produce errors in the display for the playback. 

5.9.2.1 Editing Bubble Texts  

Bubble texts for the SAP Companion for desktop macros can be edited right on the bubble or in the macro editor in 
the respective mode. 

• Editing in the step view 
Double-click on a bubble and an HTML editor will appear with various options for editing the content. For more 
information on the HTML editor, refer to the HTML Editor section of the document. Edit your text as desired 
and click on OK to confirm your changes.  

• Editing in the macro editor 
Texts can be edited in the macro editor in the Text parameter. Click on the respective text field and the HTML 
editor will appear. You can now edit the text.  

5.9.2.2 Positioning Bubbles 

You can change the size and position of bubbles in the step view as follows: 

Positioning the bubbles 

1. Select the object you would like to edit.  

2. A red line will appear around the object. Select the object again, this time holding the mouse button down  

3. With the mouse button still pressed, drag the object to the desired position.  

4. Release the mouse button and the object is now positioned.  

Changing bubble alignments 

1. Select the object you would like to edit.  

2. A square will appear at the tip of the bubble, which you can use to turn the object. With bubbles that do not 
have a tip, the square will appear in the middle of the bubble. Select the dot and hold the mouse button down.  

3. With the mouse button still pressed, pull the dot away from the bubble and until you have reached the desired 
position. Pull the dot towards the middle of the bubble if you wish to hide the tip.  

4. Release the mouse button to set the new position.  
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5.9.3 Recording a Page Specifier 

Page Specifiers are used to define additional information for a page. This is useful if there is only a small difference 
between two pages. For example, with the macro you can specify a special control, which is only visible on one of 
the pages. 
The macro contains no content information. 

 Note 
Page specifiers are supported for context help projects. Do not use page specifiers for guided tour projects. 

To create a Page Specifier, proceed as follows: 

1. Select a Screen Context  where you want to add the Page Specifier. 

2. Select Record Page Specifier  in the header line of the macro editor. 
The Choose Application dialog box opens. 

3. Select the application from the list and select Choose. 

4. Select the object, which you want to use as an additional specifier. You will be prompted by a note on the 
cursor. 

5. A dialog box appears in which you can define the parameters of the page specifier. 
Object-specific parameters are:   

• Object Name 

• Object Image 

• Input Text 

• Selected Value 

6. Confirm the dialog box by selecting OK, if you would like to complete the recording. 
Select Next to record another object. 

Excluding or including a screen 

For the recorded Page Specifier, you can specify, whether the content for the recognized application page should be 
displayer or excluded. Activate the setting Exclude Screen, if the content should be hidden. In the thumbnail view a 
minus for excluding the screen or a plus for displaying the screen is displayed. 

 Recommendation 
When having two similar screens in a project, then it is recommended, to add one page specifier for excluding the 
screen and another page specifier for displaying the screen. 

5.9.4 Conditions for Input Fields 

Conditions allow you to display not only context-specific information but also information when a specific text is 
entered in a text field. If the condition does not match, a bubble with information is shown. You can also jump to a 
specific step. 
A condition can be defined for an Input Text  macro. Each macro can have one condition. 
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5.9.4.1 Creating a Condition 

To create a condition, proceed as follows: 

1. Select an Input Text  macro. 

2. Open the settings subcategory Condition in macro editor. 

3. Edit the condition parameters: 

1. Condition Pattern: 
Select a condition pattern from the dropdown list. 
Activate the parameter by selecting the green control . 

2. Condition Value: 
Enter a text or a number based on the selected pattern. 

3. Condition Text: 
Enter a text. The text is shown, if the condition does not match. 
You can enter further information for the user about the expected input value. 

When a macro contains a condition an icon  is displayed in thumbnail view. The condition control shows the 
specified parameters. 

To remove an available condition, deactivate the green control  of the Condition Pattern parameter. 

Condition pattern 

The Condition Pattern parameter contains the following entries: 

• Is equal to 

• Is not equal to 

• Is greater than 

• Is greater than or equal to 

• Is less than 

• Is less than or equal to 

• Minimum number of characters 

• Maximum number of characters 

• Number of characters equal to 

• Regular expression 

Further parameters 

The Condition subcategory contains the following additional parameters: 

• Jump Target (use for guided tour, visible in advanced layout): 
Select a step from the dropdown list. The playback jumps to the specified step if the condition matches.  

• Case Sensitive: 
Activate this setting to make the condition case-sensitive. 

• Ignore on Page Load (use for context help): 
Specifies that the condition is not checked on page load. The condition is checked when using a corresponding 
control. This avoids the need to display the condition bubble directly. 
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• Bubble Style: 
Specifies which bubble style resource is to be used for displaying the condition text. 

• Highlight Color: 
Specifies which highlight color is to be used for highlighting the control.  

5.9.5 Updating Content 

For possible process changes and extensions in the SAP Companion for desktop projects automatic updating of the 
content is available during playback in the SAP Companion for desktop. This presupposes that the projects are held 
centrally on a server or file-share. 

The parameter Update Frequency is available to you in the section SAP Companion for desktop: Playback Settings -> 
General -> Advanced of the Settings  dialog box. This is located in the Advanced subcategory visible when 
selecting the option Show More. The value is specified in minutes 

Save the projects to your relevant storage location for update purposes. The content will be updated automatically 
with the specified frequency during playback. Once it has been automatically updated, the projects will restart. 

The update frequency should not be set at too high a value, to avoid unnecessary server queries. An optimal value is 
between 3-6 hours or every 24 hours. This depends on the anticipated changes. 

In a SAP Companion for desktop added objects are displayed with a star ( ) in the content list. 

 Note 
Bear in mind with automatic updating of a guided tour that if it happens to be running when it is updated, the 
guided tour will then start again from the beginning. Guided tour updates should therefore be undertaken in the 
evening or at weekends, when low usage levels can be expected. 

5.9.6 Merging Projects 

Several SAP Companion for desktop projects can be integrated into a single project so that you can use content 
from various projects. 

The advantage of this is that content can be accessed quickly and directly and additional projects do not need to be 
loaded as the SAP Companion for desktop can only ever play back one project. Already existing objects also do not 
have to be recorded twice. It is not apparent to the user when playing back the project whether he is dealing with 
multiple projects.  

Integrate projects using the following procedure: 

1. Create a new project to add the different projects to with the New Project  function. 
You can also open an existing project from within the project editor.  

2. In the Edit menu select the Include SAP Companion for desktop Projects function.  

3. You can now select the project to be inserted from within the open dialog box. Do so by clicking on the Edit  
button. This will open a dialog box displaying all the projects within the workarea using the SAP Companion for 
desktop type. Select the desired project and click on Ok.  
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4. Then confirm the dialog by clicking on OK if you would like to insert the project or click on Next to insert the 
project and select another project.  

The projects themselves are linked by the act of inserting them. A macro displaying the link will appear in the first 
step. Linking the projects means that changes made in the original project are also incorporated in the link and thus 
also displayed in the project. 

 

The way in which the content is displayed reflects the project from which the projects are being called as the 
Style  macro is located by default within the first step. Any customization should therefore also be applied in this 
macro. If you have created a new project, then the act of inserting the project automatically creates the 
Style macro. 

When playing back the content the SAP Companion for desktop reads out the context information, starting with the 
first step. With multiple occurrences of content of one context type, such as for example the same screen contexts, 
the SAP Companion for desktop displays the first context to be read out. If one context that is the same is not to be 
preferred over another, the macro with the currently used context is to be relegated to a step further back in the 
content. 

5.10 Administrating the Context 

Context Administration includes functions for the administration of the context information and context files. The 
following functions are available in the Tools -> Context Administration menu in the Explorer: 

• Replace or Append Executables... 

• Replace Page Key Attributes... 

• Search and Replace Parameter... 

Best practices 

There are best practices for editing the content and changing page keys: 

• First, finish the entire content production before changing the page keys. This will help you to get a better 
overview about the page keys to be changed and it also reduces the effort. 

• We recommend having one responsible author for page key editing. For example, for a package of coherent 
content to be delivered to one SAP Companion for desktop target group. 

• We recommend creating a backup of the content before editing the page keys. 
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5.10.1 Replacing or Appending Executables 

The function allows you to replace an executable with a different executable or to append an executable with an 
additional name. This is required, if an application uses different executables or different applications need to be 
supported for the SAP Companion for desktop content. 

To do so, proceed as follows: 

1. Select a content structure or an object in the Explorer. 
OR 
Open a project in the project editor. 

2. Select Tools -> Context Administration -> Replace or Append Executables... 

3. A dialog box opens, which contains the following parameters:   

1. Executables:  
The drop-down box displays the available executables of the selected contents. 
Select the executable that you want to replace or append. 

2. New Executables: 
Enter one or more executable names into the text field. 
Use a semicolon ';' or a comma ',' (for example: name1.exe,name2.exe or 
name1.exe;name2.exe) to separate multiple executables. Do not enter a space before or after the 
semicolon or comma.  

4. Select Append or Replace. 

The executable names are replaced or appended. The dialog box opens again where you can adapt further 
executables. Select Close to close the dialog box. 

To remove an executable, leave the New Executable field empty and click on Replace. 

5.10.2 Replacing Page Key Attributes 

When an application is being recorded, page information that is not universally applicable is sometimes generated. 
This means that the page information exists only during the recording but is no longer up-to-date when a user plays 
back the recording, for example, material numbers or information associated with user roles. During playback of a 
SAP Companion for desktop, the content with a specific key cannot be displayed as it does not match the current 
application page. 

To make content generically available for all users, you need to replace the information in the page keys with a 
static text or a regular expression. Regular expressions allow you to replace static texts of page keys with variable 
attributes. 

Replacing page key attributes 

The Replace Page Key Attributes function allows you to customize the page information of your content. To replace 
a page key attribute, proceed like this: 
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 Note 
When adapting several projects with the same page key, remember that the page keys need to be the same. This is 
especially important for displaying all the available content when playing back a SAP Companion for desktop. 

1. Select an object or group in the Explorer. 
or 
Open a project in the project editor. 

2. Select Tools -> Context Administration -> Replace Page Key Attributes... 
The Replace Page Key Attributes dialog box opens. 

3. Filter 
The read-only Filter field shows whether a content structure filter is active. If no filter is active, None is 
displayed. 

4. Parameter 
The Parameter dropdown box contains all attribute parameters of the page keys. 
Select a page key parameter. 

5. Show Page Keys 
Select Show Page Keys to display all available page keys of the selected parameter. 
The Page Key Values dialog box opens and you can keep it open in parallel. 

6. Preset 
The Preset dropdown box contains presets based on common use cases for neutralizing or replacing the page 
keys. 
Select a preset for the page key that you want to replace. 

7. You have to add a value for some presets, for example, Number of Digits or Value to Find. When selecting the 
preset, an additional text field is displayed. 

8. Select Preview to display the found attributes and the replacement version. 
All found attributes are listed in the preview field. 

9. Preview table 
The preview table shows the Found Attribute of the page keys for the selected preset as well as the Project 
Name and Project UID of the corresponding projects. The attributes that will be changed are highlighted in 
yellow. 
In the Apply column of the preview table you can select the attributes to be replaced. 

10. Select Replace to replace the specified attributes wherever they occur. 

The page keys are replaced for the preset. 
The changes are visible in the Page Key Values dialog box when selecting Show Page Keys. All attributes have a 
regular expression and are highlighted in blue. The recorded value is shown in the Original Value column of the 
dialog box. 

You can replace further attributes or close the dialog box. 

Best practices 

Before you start to edit, we recommend analyzing the page keys in the Page Key Value dialog box to get an overview 
of the page keys to be changed. In most cases, there are dynamic values that differ for each end user when playing 
back the SAP Companion for desktop. 

For example: 
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• Names, such as the name of the author who did the recording 

• Numbers, such as a specific purchase order ID 

• Date and time, such as the date or time when a stock list was generated 

5.10.2.1 Presets for Replacing Page Keys 

The following presets are available for replacing page key attributes: 

Preset Description Examples 

Neutralize All Numbers 

Use this preset if your page keys 
contain numbers and should be 
neutralized. 

Note: This is a generic preset and 
should be used carefully. Use this 
preset after you have used more 
specific presets (for example, date 
and time) and you are sure that all 
numbers can be ignored. 

Result: During SAP Companion for 
desktop playback, all numbers will be 
ignored for the page key match. 

Technical information: 
Regular expression for the search: 
\d+ 
Regular expression for the 
replacement: \d+ 

Change Correct Maintenance 
70007340: Central Header 
Hit List 2 Entries 
Quantity Contract 1719: Selection 
List for Reference Document 
A37(1)/200 SAP Easy Access - User 
menu for Testuser HR LT Central HR 
Stock/Requirements List as of 11:05 
hrs 

Neutralize All Values 

Use this preset to neutralize all 
values of a selected page key 
attribute. 

Note: This is a generic preset and 
should be used carefully. Use this 
preset if you are sure that all values 
can be ignored. 

Result: During SAP Companion for 
desktop playback, all values will be 
ignored for the page key match. 

Technical information: 
Regular expression for the search: .* 
Regular expression for the 
replacement: * 

All values, for example, Email 
addresses, Microsoft Office titles, 
numbers, and so on, will be 
neutralized and have no effect on the 
SAP Companion for desktop 
playback. 
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Preset Description Examples 

Neutralize Any Number with at Least 
X Digits 

Use this preset if your page keys 
contain numbers that are dynamic 
and should be neutralized. All values 
with a minimum number of digits will 
be replaced. Enter a number of 
digits, for example, 3. 

Result: During SAP Companion for 
desktop playback, all numbers 
greater than or equal to t he number 
of digits specified during 
replacement will be ignored for the 
page key match. 

Technical information: 
Regular expression for the search: 
\d{VALUE,} 
Regular expression for the 
replacement: \d+ 

Change Corrective Maintenance 
70007340: Central Header 
Change Long text on task 
0000200013980002 Language EN 
Display Material Document 
500011273: Overview 

Neutralize Any Number with X Digits 

Use this preset if your page keys 
contain numbers that are dynamic 
and should be neutralized. All values 
with the exact number of digits will 
be replaced. Enter a number of 
digits, for example, 3. 

Result: During SAP Companion for 
desktop playback, all numbers equal 
to the number of digits specified 
during replacement will be ignored 
for the page key match. 

Technical information: 
Regular expression for the search: 
\b\d{VALUE,}\b 
Regular expression for the 
replacement: \d+ 

Change Corrective Maintenance 
70007340: Central Header 
Change Corrective Maintenance 
70007340: Operation Overview 
Change Preventive Maintenance 
70002737: Central Header 

Neutralize Currency 

Use this preset if your page keys 
contain currency information that is 
dynamic and should be neutralized. 
Currency abbreviations such as EUR 
or USD have to be neutralized after 
replacing the currency by using the 
Neutralize Specific Value preset. 

Result: During SAP Companion for 

Approve Shopping Cart 10000194 
with Value 5.304,00 EUR - IBM Lotus 
Notes 
Shopping Cart with Value 5.304,00€ 
Zatwierdzanie koszyka zakupów 
10000212 o wartości 106,08 USD 



 

Producer (Cloud Edition) 
SAP Companion for desktop 

 
PUBLIC   150 

 

Preset Description Examples 

desktop playback, all currency 
information will be ignored for the 
page key match. 

Technical information: 
Regular expression for the search: 
\d+(\.|,)\d{2,3}((\.|,)\d{2,3})*((\s?[
A-Z]{3}\b)|(\s?[^A-z0-9]{1}))? 
Regular expression for the 
replacement: \d+(\.|,)\d{2,3}((\.|,)\
d{2,3})*((\s?[A-Z]{3}\b)|(\s?[^A-z0-
9]{1}))? 

Neutralize Date 

Use this preset if your page keys 
contain date information that is 
dynamic and should be neutralized. 

Result: During SAP Companion for 
desktop playback, all date 
information will be ignored for the 
page key match. 

Technical information: 
Regular expression for the search: 
\d{1,4}[.|\-|\/]\d{1,2}[.|\-
|\/]\d{1,4}/ 
Regular expression for the 
replacement: \d{1,4}[.|\-
|\/]\d{1,2}[.|\-|\/]\d{1,4}/ 

Stock/Requirements List 03/04/02 
Stock/Requirements List 04-07-2011 
Stock/Requirements List 15.06.2009 

Neutralize Email Address 

Use this preset if your page keys 
contain mail addresses that are 
dynamic and should be neutralized. 

Result: During SAP Companion for 
desktop playback, all mail addresses 
will be ignored for the page key 
match. 

Technical information: 
Regular expression for the search: 
[a-zA-Z0-9._%+-]+@[a-zA-Z0-9.-
]+\.[a-zA-Z]{2,4} 
Regular expression for the 
replacement: [a-zA-Z0-9._%+-]+@[a-
zA-Z0-9.-]+\.[a-zA-Z]{2,4} 

Goods Receipt Other - 
john.smith@company.com 

Goods Receipt Outbound Delivery 
70101178 - smith@company.com 

Goods Receipt Purchase Order 
4500000357 - 
smith@company.int.com 

Neutralize Microsoft Office Title Use this preset if your page keys 
contain specific Microsoft Office 

Doc1.docx - Word 
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Preset Description Examples 

document titles that should be 
neutralized. 

Result: During SAP Companion for 
desktop playback, the Microsoft 
Office title will be checked for the 
terms Word, Excel, OneNote and 
PowerPoint.  

Technical information: 
Regular expression for the search: 
.*Word, .*Excel, .*OneNote, 
.*PowerPoint 
Regular expression for the 
replacement: Word, Excel, OneNote, 
PowerPoint 

Page_Keys.doc - Microsoft Word 

Page_Keys.xls - Microsoft Excel 

DesktopAssistant.xlsx - Excel 

Neutralize Microsoft Outlook 
(Calendar) Title 

Use this preset if your page keys 
contain specific Microsoft Outlook 
Calendar titles that should be 
neutralized. 

Result: During SAP Companion for 
desktop playback, the Microsoft 
Outlook Calendar title will be 
checked for the terms Calendar and 
Outlook only. 

Technical information: 
Regular expression for the search: 
Calendar.*Outlook 
Regular expression for the 
replacement: Calendar.*Outlook 

Calendar - john.smith@sap.com - 
Outlook 

Calendar - john.doe@sap.com - 
Microsoft Outlook 

Neutralize Microsoft Outlook (Inbox) 
Title 

Use this preset if your page keys 
contain specific Microsoft Outlook 
Inbox titles that should be 
neutralized. 

Result: During SAP Companion for 
desktop playback, the Microsoft 
Outlook Inbox title will be checked 
for the terms Inbox and Outlook only. 

Technical information: 
Regular expression for the search: 
Inbox.*Outlook 
Regular expression for the 
replacement: Inbox.*Outlook 

Inbox - john.smith@sap.com - 
Outlook 

Inbox - john.doe@sap.com - Microsoft 
Outlook 
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Preset Description Examples 

Neutralize SAP GUI System Name 

Use this preset if the page keys 
contain SAP GUI system names that 
should be neutralized. 

Result: During SAP Companion for 
desktop playback, the SAP GUI 
system names will be ignored for the 
page key match. 

Technical information: 
Regular expression for the search: 
[A-Z0-9]{2,3}\(\d\)\/\d{3}\s 
Regular expression for the 
replacement: .* 

ERD(1)/110 Display Purchase Req. 
10010586 

UI2(2)/110 SAP Easy Access 

YE2(3)/100 Delete source lists 

Neutralize Specific Value 

Use this preset if your page keys 
contain specific values that should 
be neutralized, for example, personal 
data. Enter the value that you want to 
neutralize. 

Result: During SAP Companion for 
desktop playback, the specific values 
will be ignored for the page key 
match. 

Technical information: 
Regular expression for the search: 
VALUE 
Regular expression for the 
replacement: .* 

Goods Receipt Other - John Smith 

Purchase Order 4500000357 - John 
Doe 

Neutralize Time 

Use this preset if your page keys 
contain time information that is 
dynamic and should be neutralized. 
Language-dependent time 
information abbreviations such as 
'hrs' may have to be neutralized after 
replacing the time with a different 
preset. 

Result: During SAP Companion for 
desktop playback, all time 
information will be ignored for the 
page key match. 

Technical information: 
Regular expression for the search: 
([01]?[0-9]|[2][0-3]):[0-5][0-9] 

Stock/Requirements List as of 11:05 
hrs 

Stock/Requirements List as of 17:51 
hrs 
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Preset Description Examples 

Regular expression for the 
replacement: \([01]?[0-9]|[2][0-
3]):[0-5][0-9] 

Replace Specific Value 

Use this preset to replace a specific 
value by another value, for example, 
a system name or number was 
changed due to an application 
update. Enter the value you want to 
search for and enter the replacement 
value. 

Result: During SAP Companion for 
desktop playback, the new value will 
be used for the page key match. 

Technical information: 
Regular expression for the search: 
VALUE 
Regular expression for the 
replacement: NEWVALUE 

  

5.10.2.2 Restoring Page Key Attributes 

When you change a page key, the original attribute is saved. This lets you undo your changes.  

To restore a page key attribute, proceed as like this: 

1. Select Restore. 
The Restore Page Key Values dialog box is opened. 
The dialog box shows all page keys that have been edited. The Replaced Value column shows the changed 
page keys, the Original Values column shows the recorded value 

2. Restore all page keys 
Select Restore All to restore all values. 

3. Restore specific page keys 
Select one or more page keys from the list and select Restore Selection.  

5.10.2.3 Advanced Mode for Replacing Page Keys 

You can use further options for editing page key attributes if the presets do not fullfil your requirements. 



 

Producer (Cloud Edition) 
SAP Companion for desktop 

 
PUBLIC   154 

 

 Recommendation 
We recommend using the Standard Mode preset to replace page keys. The presets have been created based on 
the most common uses cases. For cases in which the presets are not sufficient, you can use the Advanced Mode, 
which has additional options. 

To replace a page key attribute by using the advanced layout, proceed like this: 

1. Select Advanced Mode  to display the advanced options. 

2. Change the settings as required:  

○ Parameter: 
The dropdown box contains all attributes parameters of the page keys. 
Select a page key parameter. 

○ Search Value: 
Select the attribute of the page key parameter you want to replace. The dropdown box displays all the 
available attributes for the selected parameter. 
You can enter an attribute in the field. 

○ Search as Regular Expression: 
Activate this option to use regular expressions. 

○ Replace Value: 
Insert the attribute to be used in the page key. 
You can enter an attribute in the field. 

○ Replace with Regular Expression: 
Activate this option to use regular expressions. 

3. Select Preview to display the found attributes and the replacement version. 
All found attributes are listed in the preview field. If a regular expression is used for the replacement, an icon is 
also displayed. 

4. Select Replace to replace the defined attributes wherever they occur. 

You can replace further attributes or you can close the dialog box. 

5.10.2.4 General Regular Expression Examples (Advanced) 

Examples of regular expressions: 

Regular Expression Description 

. any character except newline 

.+ at least one character 

.{5} at least 5 characters 

.* 0 or any number of characters 

\w \d \s word, digit, whitespace 
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Regular Expression Description 

\W \D \S not word, digit, whitespace 

[abc] either of a, b, or c 

[^abc] not a, b, or c 

[a-g] character between a and g 

Anchors   

^abc$ start / end of the string 

\b word boundary 

Escaped characters   

\. \* \\ escaped special characters 

\t \n \r tab, linefeed, carriage return 

\u00A9 unicode escaped © 

Groups & Lookaround   

(abc) capture group 

\1 reference to group #1 

(?:abc) non-capturing group 

(?=abc) positive lookahead 

(?!abc) negative lookahead 

Quantifiers & Alternation   

a* a+ a? 0 or more, 1 or more, 0 or 1 

a{5} a{2,} exactly five, two or more 

a{1,3} between one and three 

a+? a{2,}? match as few as possible 

ab|cd match ab or cd 
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5.10.2.5 Examples of Customizing Page Key Values 
(Advanced) 

1) Replace a string with another string 

 Sample page key values 
ERD(1)/110 Business Workplace of PU RC 00 Auth Test User 
ERD(1)/110 Business Workplace of PU RC 10 Auth Test User 
ERD(1)/110 Create Purchase Requisition 
ERD(1)/110 Decision Step in Workflow 

Expected Search Result Search Value Regular Expression 

All page key values containing 
"ERD(1)/110" will be listed. 

ERD(1)/110 No 

Expected Replace Result Replace Value Regular Expression  

During playback, any page key value that 
contains "ERD(2)/220" will be treated as 
correct. The rest of the page key value 
(for example, "Create Purchase 
Requisition") still has to match exactly. 

ERD(2)/220 No 

 Example of a replaced page key value 
ERD(2)/220 Create Purchase Requisition 



 

Producer (Cloud Edition) 
SAP Companion for desktop 

 
PUBLIC   157 

 

2) Neutralize any string following a specific string 

 Sample page key values 
Goods Receipt Purchase Order - John Smith 

Expected Search Result Search Value Regular Expression 

All page key values equal to "Goods 
Receipt Purchase Order - John Smith" 
will be listed. 

Goods Receipt Purchase Order - 

John Smith 
No 

Expected Replace Result Replace Value Regular Expression  

During playback, any string containing at 
least one character following the string 
"Goods Receipt Purchase Order -" will be 
treated as correct. Please be aware that 
absolutely everything (not just "John 
Smith") will be treated as correct. Thus, 
the regular expression ".+" should be 
used carefully. Otherwise, the matching 
result might become too fuzzy. 

Goods Receipt Purchase Order -

.+) 
Yes 

 Example for a replaced page key value 
Goods Receipt Purchase Order - .+ 

3) Neutralize any string preceding a specific string 

 Sample page key values 
Document1 – Microsoft Word 
Document2 – Microsoft Word 
Replace Page Key Values – Microsoft Word 
SAP Enable Now – Microsoft Word 

Expected Search Result Search Value Regular Expression 

All page key values containing at least 
one character preceding the string "– 
Microsoft Word" will be listed. 

.+ – Microsoft Word Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any string containing at 
least one character preceding the string 
"– Microsoft Word" will be treated as 
correct. 

.+ – Microsoft Word Yes 
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 Example of a replaced page key value 
.+ – Microsoft Word 

4) Neutralize any number preceding a specific string. 

 Sample page key values 
Acct Assignment Cat. 1 Entry 
BOM Usage 9 Entries 
Commodity codes 32 Entries 
Condition Type 20 Entries 
Cost Center 500 Entries 
Distribution Channel 6 Entries 

Expected Search Result Search Value Regular Expression 

All page key values containing a number 
with at least 1 digit will be listed. The 
number must precede the string "Entry" 
or "Entries". 

\d+ (Entry|Entries) Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any number containing 
at least 1 digit will be treated as correct. 
The number must precede the string 
"Entry" or "Entries". The rest of the page 
key value (for example, "Acct 
Assignment Cat.") still has to match 
exactly. 

\d+ (Entry|Entries) Yes 

 Example of a replaced page key value 
Acct Assignment Cat. \d+ (Entry|Entries) 

5) Neutralize any number following a specific string 

 Sample page key values 
Goods Receipt Purchase Order 4500000515 - Change 
Goods Receipt Purchase Order 4500000535 - Display 
Goods Receipt Purchase Order 4500000685 - Change 
Goods Receipt Purchase Order 4500000752 - Display 

Expected Search Result Search Value Regular Expression 

All page key values containing a number 
with at least 1 digit will be listed. The 

Goods Receipt Purchase Order 

\d+ 
Yes 
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Expected Search Result Search Value Regular Expression 

number must follow the string "Goods 
Receipt Purchase Order". 

Expected Replace Result Replace Value Regular Expression  

During playback, any number containing 
at least 1 digit will be treated as correct. 
The number must follow the string 
"Goods Receipt Purchase Order". The 
rest of the page key value (for example 
"Change" or "Display") still has to match 
exactly. 

Goods Receipt Purchase Order 

\d+ 
Yes 

 Example of a replaced page key value 
Goods Receipt Purchase Order \d+ - Change 

6) Neutralize any number between two specific strings 

 Sample page key values 
Hit List 1 Entry 
Hit List 2 Entries 
Hit List 56 Entries 

Expected Search Result Search Value Regular Expression 

All page key values containing a number 
with at least 1 digit will be listed. The 
number must follow the string "Hit List" 
and it must precede the string "Entry" or 
"Entries". 

Hit List \d+ (Entry|Entries) Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any number containing 
at least 1 digit will be treated as correct. 
The number must follow the string "Hit 
List" and it must precede the string 
"Entry" or "Entries". 

Hit List \d+ (Entry|Entries) Yes 

 Example of a replaced page key value 
Hit List \d+ (Entry|Entries) 
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7) Neutralize any number that contains at least 5 digits 

 Sample page key values 
Change Long text on task: 00002000103980002 Language EN 
Change Long text on task: 00002000103980004 Language EN 
Goods Receipt Outbound Delivery 70101178 - John Smith 
Goods Receipt Outbound Delivery 70101180 - John Smith 
Goods Receipt Purchase Order 4500000515 - John Smith 
Goods Receipt Purchase Order 4500000535 - John Smith 

Expected Search Result Search Value Regular Expression 

All page key values containing a number 
with at least 5 digits will be listed. The 
position of the number within the value 
does not matter. 

\d{5,} Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any number will be 
treated as correct. The rest of the page 
key value (for example "Goods Receipt 
Outbound Delivery") still has to match 
exactly. 

\d+ Yes 

 Example of a replaced page key value 
Goods Receipt Purchase Order \d+ - John Smith 

8) Neutralize any number in brackets following a specific string 

 Sample page key values 
Account Number of Vendor or Creditor (1) 
Account Number of Vendor or Creditor (2) 
Account Number of Vendor or Creditor (5) 
Account Number of Vendor or Creditor (12) 

Expected Search Result Search Value Regular Expression 

All page key values containing a number 
in brackets with at least 1 digit will be 
listed. The number must follow the string 
"Account Number of Vendor or 
Creditor". 

Account Number of Vendor or 

Creditor \(\d+\) 
Yes 

Expected Replace Result Replace Value Regular Expression  
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Expected Search Result Search Value Regular Expression 

During playback, any number in brackets 
will be treated as correct. The rest of the 
page key value ("Account Number of 
Vendor or Creditor") still has to match 
exactly. 

Account Number of Vendor or 

Creditor \(\d+\) 
Yes 

 Example of a replaced page key value 
Account Number of Vendor or Creditor \(\d+\) 

9) Neutralize a specific number only 

 Sample page key values 
Create Purchase Requisition: Item 00010 
Goods Receipt Outbound Delivery: Item 00010 
Stock/Requirements List: Item 00010 

Do not search for: 
Change Long text on task: 00002000103980002 Language EN 
Change Long text on task: 00002000103980004 Language EN 
Purchase Order 4500000010 - John Smith 

Expected Search Result Search Value Regular Expression 

All page key values containing the exact 
number sequence "00010" will be listed 
(for example "Create Purchase 
Requisition: Item 00010").  Any other 
numbers where "00010" is just a part of 
the entire number will not be listed (for 
example, "Change Long text on task: 
00002000103980002 Language EN"). 

\b00010\b Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any number will be 
treated as correct. The rest of the page 
key value (for example, "Create 
Purchase Requisition: Item") still has to 
match exactly. 

\d+ Yes 

 Example of a replaced page key value 
Create Purchase Requisition: Item \d+ 
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10) Neutralize the time 

 Sample page key values 
Stock/Requirements List as of 11:05 hrs 
Stock/Requirements List as of 11:55 hrs 
Stock/Requirements List as of 17:41 hrs 
Stock/Requirements List as of 14:53 hrs 

Expected Search Result Search Value Regular Expression 

All page key values containing exactly 
one specified time with the format  [any 
number]:[any number] (for 
example, 11:05) will be listed. 

\d+:\d+ Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any time with the 
format [any number]:[any number] (for 
example, 11:05) will be treated as 
correct. The rest of the page key value 
(for example, "Stock/Requirements List 
as of") still has to match exactly. 

\d+:\d+ Yes 

 Example of a replaced page key value 
Stock/Requirements List as of \d+:\d+ hrs 

11) Neutralize the date 

 Sample page key values 
Purchase Orders for Period 05.02.2015 to 10.03.2015 
Purchase Orders for Period 15.04.2015 to 16.04.2015 
Purchase Orders for Period 01.10.2015 to 22.10.2015 
Purchase Orders for Period 23.12.2015 to 26.12.2015 

Expected Search Result Search Value Regular Expression 

All page key values containing 
exactly one date with the format [exactly 
2 digits].[ exactly 2 digits].[ exactly 4 
digits] (for example, 05.02.2015) will be 
listed. 

\d{2}\.\d{2}\.\d{4} Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any date with the \d{2}\.\d{2}\.\d{4} Yes 
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Expected Search Result Search Value Regular Expression 

format [exactly 2 digits].[ exactly 2 
digits].[ exactly 4 digits (for example, 
17.03.2020) will be treated as correct. 

 Example of a replaced page key value 
Purchase Orders for Period \d{2}\.\d{2}\.\d{4} to \d{2}\.\d{2}\.\d{4} 

12) Neutralize any number and any string following a specific string 

 Sample page key values 
Purchase Order 70101178 - John Smith 
Purchase Order 70101180 - John Smith 
Purchase Order 70101182 - John Smith 
Purchase Order 4500000357 - John Doe 
Purchase Order 4500000515 - John Doe 
Purchase Order 4500000535 - John Doe 

Expected Search Result Search Value Regular Expression 

All page key values containing a number 
with at least 1 digit and any string 
following “-“ will be listed. The number 
must follow the string “Purchase Order”. 

Purchase Order \d+ - .* Yes 

Expected Replace Result Replace Value Regular Expression  

During playback, any number containing 
at least 1 digit and any string following "-" 
will be treated as correct. The number 
must follow the string "Purchase Order". 

Purchase Order \d+ - .* Yes 

 Example of a replaced page key value 
Purchase Order \d+ - .* 
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5.10.3 Searching and Replacing Parameters 

The function Search and Replace allows you to replace a specific attribute in the context parameters of the content. 

To do so, proceed as follows: 

1. Select Tools -> Context Administration -> Search and Replace... 

2. A dialog box opens, which contains the following parameters:   

○ Search: Specify the entry that should be searched. 

○ Replace by: Specify the entry that should be replaced.  

3. Select Ok. 

Afterwards, the search entry is replaced. 

5.11 Playing Back Content 

The basic prerequisite for playing back SAP Companion for desktop content is that the SAP Enable Now SAP 
Companion for desktop component must be installed on the operating system. Read the information on the 
following pages to find out how to start SAP Companion for desktop content. 

5.11.1 SAP Companion for desktop Preview 

At any time during the creation process, you can preview content playback and so check for errors or necessary 
improvements. Proceed as follows: 

Preview started in project editor - SAP Companion for desktop project 

For playback, proceed as follows: 

 Note 
The preview is controlled by the Producer. Therefore, the SAP Companion for desktop component and its control 
functions are not available in the preview. 

1. Open a SAP Companion for desktop project  /  in the project editor. 

2. Select Play  in the toolbar. 

3. Open the target application and go to the required application page. 
The SAP Companion for desktop displays the corresponding help content. 

4. To stop the playback, go to the project editor. 

5. Select Stop  in the toolbar. 

Preview started in explorer - SAP Companion for desktop project 

For playback, proceed as follows: 
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 Note 
An installation of the SAP Companion for desktop component is required for playback. 

1. Select a SAP Companion for desktop project  /  in the explorer. 

2. Expand the project entry to display the generated project mode. 

3. Select the mode icon . 

4. Select Play  in the object editor. 

5. The SAP Companion for desktop icon  will now appear in the task bar. 

6. Open the target application and go to the required application page. 
The SAP Companion for desktop displays the corresponding help content. 

7. To stop the playback, open the context menu of the SAP Companion for desktop icon . 

8. Select Exit. 

Preview of the SAP Companion for desktop 

For playback, proceed as follows: 

 Note 
The preview is controlled by the Producer. Therefore the SAP Companion for desktop component and its control 
functions are not available in the preview. 

1. Select a SAP Companion for desktop Object  or a SAP Companion for desktop  group in the tree of the 
explorer. 

2. Select Play SAP Companion for desktop  in the object editor. 

3. Open the target application and go to the required application page. 
The SAP Companion for desktop displays the corresponding help content. 

4. To stop the playback, go to the explorer. 

5. Select Stop SAP Companion for desktop  in the object editor. 

5.11.2 SAP Companion for desktop Project Playback 

SAP Companion for desktop projects can be started from the library or the SAP Companion for desktop. 

 Note 
For the playback it is required to publish the workarea. See also the chapter Publishing SAP Companion for desktop 

Content. 

Playback from library 

To start a project using the library, proceed as follows: 

1. Open the library. 

2. Select a SAP Companion for desktop project  /  in the tree structure. 

3. You can launch the content by clicking on the corresponding button  in the header area of the overview. 
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4. The browser dialog box for downloading files and shows you a file with the file extension *.dnt. 

5. Click on Open. 

6. The SAP Companion for desktop icon  will now appear in the task bar info area. 

7. Open the corresponding target application. The SAP Companion for desktop will now display help objects at 
the relevant points defined in the application. 

Playback from SAP Companion for desktop 

To start a project using the SAP Companion for desktop, proceed as follows: 

1. Start the SAP Companion for desktop. 

2. The SAP Companion for desktop icon  will now appear in the task bar info area. 

3. Open the corresponding target application. The SAP Companion for desktop will now display supporting help 
objects at the relevant points defined in the application. 

4. Guided tour 

1. Select a guided tour  in the tree structure of the main window. 

2. Click the mode button in the content window. 

5. Context help 

1. Activate the option Show Instant Help in the main window. 

2. Select a mini bubble on the screen. 

5.11.3 Using the DNT File 

For general use, a SAP Companion for desktop can be executed using the DNT file of the object folder. It is 
recommended that you store the published workarea on a Web server and link to the DNT file from an intranet 
page. The user can start the SAP Companion for desktop by clicking the link.  

SAP Companion for desktop projects 

A SAP Companion for desktop project (context help, guided tour) can be played back using the DNT file (*.dnt) of 
the SAP Companion for desktop project  /  . 

The path for launching a DNT file from a server should be provided as follows: 
http://<server>/[...]/workarea/project/project_id/project.dnt 

• Start Link: 
The property is available for a project mode  in the Explorer and contains the link of the DNT file. 
You can generate a start link for a URL or folder of the publication. See also the chapter Defining a Start Link. 

SAP Companion for desktop 

The SAP Companion for desktop can be played back using the DNT file (*.dnt) of the SAP Companion for desktop 
Object . Note that for playback you need to generate the SAP Companion for desktop. 

The path for launching a DNT file from a server should be provided as follows: 
http://<server>/[...]/workarea/group/group_id/group.dnt 

For further information, see the chapter Publishing SAP Companion for desktop Content. 
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• Start Link: SAP Companion for desktop: 
The property is available for a SAP Companion for desktop object in the Explorer and contains the link of the 
DNT file. 
You can generate a start link for a URL or folder of the publication. See also the chapter Defining a Start Link. 

5.11.4 SAP Companion for desktop Cache 

The SAP Companion for desktop offers a cache functionality to store resources and content locally for SAP 
Companion for desktop playback. This avoids a load latency when starting content and allows content to be played 
back without network connection. 

Cache folder 

When the SAP Companion for desktop cache is used, a folder with a generated ID as the name is created and is 
stored in the following folder: 

%localappdata%/NavigatorCache 

The cache folder stores the resources and the used SAP Companion for desktop content. The folder content is 
updated automatically every time content is stored or changed. 

Cache settings 

The settings for the cache are available in the Settings  dialog box under: SAP Companion for desktop: Playback 
Settings -> SAP Companion for desktop in the subcategory Cache. 

• Use Caching: 
Activates the cache functionality. 

• Folder Location: 
Specifies the location of the cache folder NavigatorCache. The default location is %localappdata%. 
You can specify an individual folder for the cache. If the specified folder is not available or if the field is empty, 
the default folder is used. 

 Note 
The name of the cache folder NavigatorCache cannot be changed. 

5.11.5 Playback from the Manager 

Manager can be used to save SAP Companion for desktop content to a web server, allowing them to be edited and 
published centrally. Once the author has published the content in Manager or Producer users can start the content 
from the learner view or launch them from the library. The learner view is a component of the Manager in which 
learning content is made available to learners. 

SAP Companion for desktop on the Manager 

For the playback of SAP Companion for desktop content from a Manager the following requirements are necessary: 



 

Producer (Cloud Edition) 
SAP Companion for desktop 

 
PUBLIC   168 

 

• SSO 
An activated single sign on (SSO) is necessary for the playback of assigned content. Import the active 
directory of the user and activate SSO afterwards. 

5.11.6 Displaying the Guided Tour 

During playback of a guided tour for each step a bubble is displayed next to the required object. A step list allows 
the user to get an overview of the complete guided tour and to jump to a specific step. A step preview shows the 
user a screenshot of the step. 

 

The sequence of a guided tour is as follows: 

1. Open the application with the application page where you want the process to start. Make any necessary 
settings ahead of time. 

2. Start the guided tour. 

3. Select the application so that the guided tour can recognize it. 
The bubble for the current step appears. 

4. Carry out the process in the application as shown by the guided tour. Completed actions are indicated by a 
check mark in the step list.   

○ If text is entered, it must be confirmed via the object bubble by clicking OK to complete the entry. 

5. Select Show / Hide Step List to display a list of all steps. 

6. After the process is complete, you can end the guided tour by selecting Quit in the step list. 
 
The process can be performed again by selecting Restart. The check marks are reset and you can navigate to 
the beginning of your process in the application. The object bubble is then displayed for the first step. 

 Recommendation 
If a tour step could not be found, this is indicated by an icon. Here, we recommend selecting the application page 
again so that page identification is reinitiated or switching to the correct application page. 

 Recommendation 
To make effective use of a guided tour, you should always play it back from the beginning and not start in the 
middle of the process. 

Icons of the step list 

The step list shows all steps of a guided tour with the following icons: 

  Step 

 Current step 
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 Step completed 

 Explanation 

 Optional step 

 Branch step 

 Step not found 

5.11.6.1 Dealing with Non-Standard Behavior 

When a guided tour is played back, situations can sometimes occur which prevent a process from being carried out. 
In this case, the SAP Companion for desktop provides information about the problem and how it can be solved. 
These situations are: 

• The necessary application is not open  

• The application is on the wrong page  

• The necessary control is not available  

You can then switch to the necessary application page and continue with the process or skip the step. The guided 
tour can also be terminated. 

5.11.7 SAP Companion for desktop Tracking 

To evaluate the adoption of the target application it is important to know how often the SAP Companion for desktop 
and its content has been started and shared with other users. The consumption of SAP Companion for desktop 
content can be evaluated, and a graphical report can be accessed and exported from within the SAP Enable Now 
Manager. 
You can get an idea of what is the most used content and how often it is used in daily work. The result might lead to 
improvements to encourage adoption – either by improving the product trainings or the application processes 
itself. 

 Note 
The SAP Companion for desktop content has to be started from SAP Enable Now Manager to track the usage. 

Activating the SAP Companion for desktop Tracking 

To activate the tracking for SAP Companion for desktop, proceed as follows: 



 

Producer (Cloud Edition) 
SAP Companion for desktop 

 
PUBLIC   170 

 

1. Open the Settings  dialog box. 

2. Go to SAP Companion for desktop Playback Settings -> General -> Advanced. 

3. Activate the SAP Companion for desktop Tracking setting. 

Showing the SAP Companion for desktop Usage Report 

To show the tracked data for the SAP Companion for desktop, proceed as follows: 

1. Open SAP Enable Now Manager with your SAP Companion for desktop content. 

2. Open Learning Reports -> SAP Companion for desktop Usage Reports. 

5.12 SAP Companion for desktop Macros 

Fundamentally, there are the following macros for the SAP Companion for desktop projects: 

Icon Name 

 
Context Help Style 

 
Guided Tour Style 

 
Application Context 

 
Screen Context 

 
Guided Tour Step 

 
Mouse Action 

 
Input Text 

 
Select Single 

 
Radio / Checkbox 
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Icon Name 

 
Explanation 

 

Link Tile 

Available in SAP Companion mode 

 

Page Specifier 

See Recording a Page Specifier 

 

Include SAP Companion for desktop Project 

See Merging Projects 

5.12.1 Context Help Style 

 

Used for type: Context help 

The Context Help Style defines how the context help is displayed during playback. The macro is located in the first 
step of a project. 

The following settings are available: 

• Display Variant: 
The setting defines the variants for the object bubble. See also Variants of the Object Bubble. 
The following variants are available in the drop-down list:   

○ Icon 

○ Tooltip 

○ Bubble  

• Mini Icons Style: 
Specifies a style resource for the mini bubbles of the object bubbles. 

• Highlights: 
Specifies whether highlights are displayed for the objects. 

5.12.2 Guided Tour Style 

 

Used for type: Guided tour 
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The Guided Tour Style defines how the guided tour is displayed during playback. The macro is located in the first 
step of a project. 

The following settings are available: 

• Bubble Style: 
Specifies the bubble style for displaying the object bubble. All available bubbles of the workarea are displayed 
in the dropdown list. 

• Mini Icons Style: 
Specifies a style resource for the mini bubbles of the object bubbles. 

• Highlights: 
Specifies whether highlights are displayed for the objects. 

• Start from Arbitrary Step: 
Specifies that the guided tour is started from an arbitrary step and not from the beginning. 

• Focus Layer: 
Displays a gray layer to highlight the required control of the current step. 

• Restricted Mode: 
Specifies that only the current action can be executed. The other controls of the application page are blocked. 
The setting can be used if Focus Layer has been activated. 

• Interactive Mode: 
Specifies that the user has to navigate in the object bubble to the next step. No page recognition is done 
during playback. 

• Start Automatically: 
Specifies that this guided tour will be started automatically when SAP Companion for desktop is open, and the 
page key matches the current user screen for the first time. After that, the tour can be started manually from 
the SAP Companion for desktop. 

Guided Tour Window 

The style and positioning of the window used for the guided tour can be customized in this area. 

This area contains the following settings: 

• Style: 
Specifies the style for displaying the window. 

• Alignment: 
Specifies the alignment of the window of the screen. Activate the Free option, to specify a Position. 

• Position: 
Specifies the position of the window on the screen. The values are specified in pixels and relate to the upper 
left-hand corner of the screen. 

• Size: 
Specifies the width and height of the window in pixels. If the amount of text to be displayed exceeds the area 
available in the window, a scrollbar appears automatically. 

Tour End 

The subcategory Tour End contains the information that is displayed at the end of a completed guided tour. 
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• End Window: 
Specifies that a window is shown at the end of the guided tour. The window allows the user to close the guided 
tour manually. If this option is deactivated, the window is not shown and the guided tour closes automatically. 

• Text: 
You can enter the text to be displayed in the bubble in the text box. The text box is preset with a default text. 

• Next Project: 
You can select a project that is started after the completion of the current tour. The new tour starts 
immediately and no end bubble is displayed. 

Advanced 

• Source: 
If a project was converted from a simulation, the parameter indicates the UID of the original project. 

5.12.3 Application Context 

 

The Application Context macro defines the application recorded for the SAP Companion for desktop project. The 
macro is always placed in the second step. 

Macro parameters 

The macro contains the following parameters: 

• Display Name: 
Defines the title which will be displayed during playback.  

• Program: 
Contains the name of the program as used by the operating system. The parameter can contain multiple 
entries separated by a semicolon. 

Further functions 

At the top of the macro editor, you will find the following functions for macros: 

•  Record Compatible Application: 
This function allows you to record an additional application. The executable name will be saved in the Program 
parameter. 

•  Insert Explanation: 
This function allows you to insert an Explanation macro with information about the application. 

5.12.4 Screen Context 
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The Screen Context macro defines the application page. 

Macro parameters 

The macro contains the following parameters: 

• Screen Title: 
Contains the name of the application window. 

• Screenshot (Screen): 
Contains the screenshot of the recorded screen. 

• Exclude from SAP Companion for desktop (Key): 
Specifies that the page key will not be considered for the context recognition process in the SAP Companion 
for desktop. 

• Activate Form: 
Specifies that the step is a form. All actions of the step are displayed in one bubble during playback. 

Further functions 

At the top of the macro editor, you will find the following functions for macros: 

•  Update Screen: 
This function allows you to update the recorded screen. 

•  Record Page Specifier: 
This function allows you to record a page specifier for the screen. See also the chapter Recording a Page 

Specifier. 

•  Record Object: 
This function allows you to record an object for the screen. 

•  Insert Explanation: 
This function allows you to insert an Explanation macro with information about the application. 

5.12.5 Guided Tour Step 

 

Used for type: guided tour 

The Guided Tour Step macro defines the individual steps for the guided tour. This macro can be used to define the 
tour sequence. This macro is found at the beginning of a step. 

The name of the guided tour step is defined in the Name field. This can be selected in the Next Step macro. 

5.12.6 Explanation 
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The Explanation macro allows you to add further information to your project content. 

The macro can be inserted during recording or from the macro editor. See also the chapter Inserting an Explanation. 

Parameters of the macro 

The following parameters are available: 

• Text: 
Contains the bubble text. 

• Type (Icon): 
A Type (Icon) can be assigned to the bubble, which can be selected from four different types. Each type is 
represented by an icon: 

Type Icon 

Info  

Remark  

Tip  

Warning  

• Force Display (Context help): 
Specifies, that the macro content is always displayed as instant help, even if instant help is disabled during 
playback of the SAP Companion for desktop. 

• Focus Layer (Guided tour): 
Displays a gray layer to highlight the explanation.  

5.12.7 Link Tile 

 

The Link Tile macro is available in SAP Companion mode and allows you to add external links or content to the SAP 
Companion for desktop. It can be videos or PDF documents with further information or links to an external FAQ. The 
linked content can be displayed in a separate content window or a new browser window or tab and can also be used 
as an announcement. 
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5.12.8 Properties of the Interaction Macros 

The macros for interactions are: 

 Mouse Action 

 Input Text 

 Select Single 

 Radio / Checkbox 

The interaction macros contain the following properties, which are used for the playback of a SAP Companion for 
desktop project: 

General 

• Object Name: 
Contains the recorded name of the object. You can change the text in the parameter. 

• Object Image: 
Contains the recorded icon of the object. You can change the image by clicking on Replace Image . 

• Input Text: 
Contains the input value of a text field. You can change the value in the parameter. 

• Text: 
Contains the bubble text of the object. The bubble text is a text module from the dictionaries and can contain 
the object name, object image and input text. 

Guided Tour 

• Optional: 
This option specifies whether the step is optional for the user in a guided tour. 
During playback a different icon will be shown in the step list. If the control is not visible on the page or if the 
page is wrong the step will be skipped.  

• Focus Layer: 
Displays a gray layer to highlight the required control of the current step. 

Context Help 

• Display Variant (Advanced Layout): 
The setting defines the variants for the object bubble. See also Context Help Style. 
The following variants are available in the drop-down list:   
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○ Global: 
Uses the setting from Context Help Style  macro. 

○ Icon 

○ Tooltip 

○ Bubble 

Subcategories 

• Object Bubble: 
Contains settings for the style and the behavior of the object bubble. 
See also Subcategory: Object Bubble. 

• Highlights: 
Contains settings for the style of the highlight. 

 Recommendation 
The highlights of the macros are deactivated by default. To activate the highlights, use the setting Show Highlight. 

• Next Step (Guided Tour): 
Contains settings for jumping to the next guided tour step. 
See also Subcategory: Next Guided Tour Step. 

Further functions 

At the top of the macro editor, you will find the following functions for macros: 

• Update Object : 
This function allows you to update the object. 
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6 Quizzes 

Quizzes help to focus on the users’ main tasks as well as evaluate their acquired knowledge and improve it. The 
learning experience is enhanced by the high degree of interactivity and scope of multimedia enrichment in the quiz 
items. Direct feedback and evaluation of responses maximize the learning effect and help to pinpoint and plug 
existing gaps in knowledge in an entertaining way as well as confirm correct answers. 

6.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

6.2 Quizzes in Projects 

The following section explains how to create a quiz in a project and how to integrate quiz items into a process 
simulation. 

A quiz can be created for a project with the type Simulation . The individual quiz items in projects can contain 
various media files including pictures, audio files and video files, thus allowing for a more interesting and more 
layered design. The results can be analyzed automatically. 

Presentation of a quiz 

In the Producer, a quiz can be created and used in different ways: 

• Stand-alone project 
Used to refresh knowledge or to examine a complete step 

• Help for process simulation 
Used to examine the displayed process or parts of it 

6.2.1 Settings for Quizzes 

Several quiz settings can be adjusted in the Settings dialog box which define the way the quiz is presented and 
proceeds in projects. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_97831763EC1D64AF
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Open the dialog box via the menu Tools -> Settings...  and select Playback Settings -> General -> Quiz. The 
settings will be defined for all projects, the settings can also be fine-tuned Project Overrides within a project. 

General settings 

• Allow to Skip Quiz:  
This setting lets you skip a quiz item without having to enter an answer. If this setting is deactivated, every 
quiz item must be answered in order to proceed on to the next one.  

• In Mode: 
If quiz items are to be integrated into a simulation, it is necessary to activate the view in the corresponding 
mode. Activate the desired mode.  

• Page Size: 
Specifies the width and height of the quiz page in pixel. The size is used for the quiz style of the trainer style.  

• Time Limit for Complete Quiz (Seconds):  
A time can be set in this parameter inside of which a full quiz must be answered. When a time limit has been 
set, a clock appears showing the remaining time. 
It is recommended to use this setting within a stand-alone quiz and it should not be used for quizzes inserted 
into simulations. To read more on setting individual time limits for a quiz item, go to the Options subcategory.  

Feedback settings 

After confirming a response, the learner can be shown a notice stating whether or not the quiz was answered 
correctly or incorrectly. 

• Show Feedback: 
When this parameter is set, the following feedback entries are shown.  

• Show Feedback as Popup: 
When this parameter is set, a corresponding feedback box is shown as a pop-up window in the foreground.  

• Show Correct Answers: 
When this parameter is set, in addition to Quiz Failed being shown, the correct answer will also be shown when 
an incorrect answer has been entered.  

• Quiz Passed:  
The feedback text entered is shown when a quiz has been solved correctly.  

• Quiz Failed:  
The feedback text entered is shown when a quiz has been solved incorrectly.  

• Quiz Timeout:  
The feedback text entered is shown when the time limit for answering the quiz or quiz item has expired. A 
value for this must be defined in the Time Limit for Complete Quiz (Seconds) or Time Limit (Seconds) 
parameter. 
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6.2.2 Creating a Quiz Project 

To create a quiz project, proceed as follows: 

1. In the Explorer, select New Object . 
An overview of all objects opens. 

2. Select Quiz . 
The New Project dialog box opens. For more information, see the chapter Creating a Content Object 

3. Adapt the following settings: 

1. Name: 
Enter a project name. 
The default name is the object type with an ID. 

2. Template: 
Select a Quiz Template. 
Choose Change... to open the selection dialog box and select a template from the workarea. Select No 
template to create an object without template. 
If a template has already been used, the template is selected by default. 

3. Language: 
Select a language for the project. 

4. Project Type: 
The Standard - Quiz type is selected. 
You can change the type in the dropdown box. 

4. Choose OK to create the project. 
The project opens in the project editor. 
The macros Simulation Start and Simulation End are created by default. Both macros are required for 
playback. 

5. Add steps for the quiz items. 
Select the menu Insert -> Add Step . Place the steps between the steps of the Simulation Start and 
Simulation End macros.  

6. Insert the quiz items. 
Select a quiz item from the Insert Quiz Item toolbar. 
You can insert one or more quiz items in each step. This lets you sort your quiz items by theme or insert a Quiz 
Section.  

7. Edit your quiz items. 
You can find more information about this in the following sections and in the Quiz Items section.  
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 Note 
The score parameters in the Simulation Start macro do not affect the points of the quiz items and can be ignored.  

 Recommendation 
By using a quiz in an LMS, you can stop the playback after a certain step and then restart it. In order to ensure that 
the quiz works properly, you need to create a separate step for each quiz item. If you add several quiz items to one 
step, once the playback has been stopped, all quiz items must be answered again. 

 Recommendation 
Activate the Allow to Skip Quiz option while editing a quiz project in the Settings  dialog box. The setting allows 
you to skip quiz items during playback without answering the questions. 

6.2.2.1 Integrating a Quiz in a Simulation 

As well as being able to create a quiz, you can also integrate individual quiz items into available simulations. For 
example, this can be useful if you want to ask questions relating to functions and processes directly after they are 
shown, thereby improving user knowledge. 

 Note 
First insert the quiz items into fully edited simulations for which rerecording is not planned or was already carried 
out. This is necessary as the Producer goes through the individual steps macro by macro when rerecording and 
the quiz items cannot be skipped. 

To integrate a quiz into a simulation, proceed as follows: 

1. Insert a new step:   

1. To do this, select the step after which the new step should be placed.  

2. Then go to the menu Insert -> Add Step  and insert the new step.  

2. Now create your quiz items by selecting the corresponding quiz item from the menu Insert -> Insert Quiz Item. 
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It is recommended that you insert multiple quiz items into a step. To finish, a Quiz Evaluation  can be 
inserted into the step as the last macro. In doing so you also avoid unnecessary complexity from having too 
many steps integrated into the existing simulation.  

3. Now insert the corresponding quiz items. More information on this can be found in the following sections and 
in the Quiz Items section. 

To display the quizzes in the trainer it is necessary to activate the corresponding mode in which the quizzes are to 
be shown. For more on this, see the Central Settings for Quizzes section. 

 

6.2.2.2 Quiz Section 

 

By selecting the Quiz Section macro, the display of the quiz items can be modified individually for each step. This 
makes sense in terms of depicting the quiz items incorporated in the quiz section in any desired sequence or else 
displaying only one randomly selected quiz item. 

A requirement for a Quiz Section is that multiple quiz items be contained in a step. A Quiz Section that spans 
multiple steps is not possible. 

To create a Quiz Section, continue as follows: 

1. Select a step to create a Quiz Section for all of the quiz items contained in the step. 
 
In order to set up the Quiz Section for particular quiz items only in a step, select the quiz item which is located 
in front of the start point of the desired quiz items. All successive quiz items within the step are then 
incorporated in the Quiz Section.  

2. Enter the Quiz Section macro via the menu Insert -> Insert Quiz Item. Following your selection, the Quiz Section 
Begin  macro is now inserted and the following quiz items indented. The quiz section is terminated by the 
Quiz Section End  macro.  

3. Making this selection lets you change the order and display of the quiz items contained within the Quiz Section 
macro. You can choose from the two following types:  

○ Random choice: 
The effect of the Random choice option is that only one, randomly selected, quiz item is shown in each 
case for the entire duration of the quiz section. 
Points: Enter the point value on which the individual quiz items should be based.  

○ Shuffle quizzes (all):  
This will display all the quiz items that have been selected in random order.  

○ Shuffle quizzes (number):  
This will display a specific number of quiz items that have been selected in random order. 
Number: This specifies the number of quiz items to display.  

4. Once you have set up a random choice you can define a general point value for it in the Points parameter of the 
Quiz Section Begin macro. Each quiz item within the selection is then evaluated against this points score.  
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Deleting the Quiz Section 

If a quiz section is no longer required in a Quiz Section, you have the option of removing it should you wish to do so. 
Here, only the start and end macros of the Quiz Section are deleted. The quiz items remain intact. 

You should proceed as follows: 

1. Select the Quiz Section Begin or Quiz Section End macro. 

2. Select Remove Quiz Section  in the macro editor. 

6.2.2.3 Quiz Evaluation 

  

Once the tasks have been completed, the Quiz Evaluation macro is available for evaluating a quiz. As an option, this 
can be inserted in the last step of the project or at any point within a step and thus be used for evaluating 
completely autonomous quiz projects or quiz within simulations.  

It should be borne in mind here that a Quiz Evaluation returns an evaluation of all the preceding quiz items. If a 
number of Quiz Evaluation macros are located within a project, the current quiz evaluation provides an overview of 
all the quiz items from the last Quiz Evaluation macro. 

The following settings can be selected for the Quiz Evaluation: 

• Required Result: 
The Required Result defines a value which must be reached in order to pass the quiz. This is denoted as a 
percentage value.  

Evaluation format 

You can determine the degree of detail in the evaluation by means of the Format setting. The following options are 
available: 

• Compact Detailed Feedback: 
The table additionally shows the solutions to all of the quiz items. The detailed feedback can be opened and 
closed to view all information.  

• Extended Detailed Feedback: 
The table additionally shows the solutions to all of the quiz items.  

• Extended Short Feedback: 
A table containing the title of the relevant quiz item, the result and the points score achieved is also displayed.   

• Total Score Only: 
An evaluation of the possible points achievable and the number of points actually achieved are displayed.  

Feedback 

Feedback can be put in place in each case to confirm the existence/non existence of the quiz item. This is shown 
beneath the general points evaluation. 
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The following settings are available for this: 

• Show Feedback: 
When this parameter is set, the following feedback entries are shown in the Quiz Evaluation.  

• Quiz Passed: 
The inputted feedback text is displayed if the required result was achieved.  

• Quiz Failed: 
The inputted feedback text is displayed if the required result was not achieved.  

6.2.3 Quiz Templates 

 

Quiz templates are a special type of book page, which define a layout and general objects for creating quiz content. 
Templates are useful for saving time and for ensuring consistency when creating objects. Furthermore, they 
provide flexibility when creating a quiz layout. 

6.2.3.1 Customizing a Quiz Template 

The Info Center of SAP Enable Now provides templates that you can use for your content. You also can use the 
templates to customize your own templates. For more information, see the Content Templates -> Quiz Templates 
section. 

To customize a template, proceed as follows: 

1. Download the template from the Info Center. 

2. Import the DKP file in your Producer. 

3. Open Quiz Template  book page in the book page editor. 

4. Page 
The Page uses the default Book Style  of the workarea. You can select another style in the Style setting. 
The default page size is 1024x672. 

5. Objects 
Customize the available objects that are used for the structure and the design of the template. It is 
recommended that you change the following: 

• The position of the objects 

• The text formatting of the objects 

• The design of the objects 

6. Quiz Item Template 
Customize the Quiz Item Template object. The settings of the object influence the design of the quiz item. 
See also Adapting the Quiz Item Template. 

7. Save the book page. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_79F1B8605B00659E
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 Note 
Do not change the object names. If you change a name, the quiz cannot be played back correctly. The object 
names are used to assign functionality to an object. 
See also Elements of a Quiz Template. 

Images 

The images used for the objects are added as assets to the book page. You can replace the images. Make sure that 
you adapt the assets in the controls afterwards. 

6.2.3.2 Elements of a Quiz Template 

To create a quiz template you have to assign a specific quiz function (for example: task, next quiz, time limit) to a 
book page object. To assign a quiz function to a book page enter the function's name into the name field of the book 
page object. 

 Example 

 

 Recommendation 
We recommend to use the following basic objects for your quiz templates: Text, Image, and Shape. 

The following functions and name values can be used for a quiz template: 

Type Function / Name Value Description 

General     

  
Quiz Item Template 

quiz_element 

Is used for the  Quiz Item 
Template object and is a placeholder 
for the quiz content. 

Specifies the design of the quiz 
items. 

  
Title 

title 
Contains the title text of the quiz. 

  
Task 

task 
Contains the task text of the quiz. 
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Type Function / Name Value Description 

  
Next control: disabled 

next_disabled 

Disabled button for showing the next 
quiz or feedback. 

  
Next control: enabled 

next_enabled 

Enabled button for showing the next 
quiz or feedback. 

The button shows a Next tooltip. This 
text is taken from the playback 
dictionary Standard and will be 
displayed in the current project 
language. 

  
Quiz Evaluation 

quiz_evaluation 

Contains the evaluation of a quiz. 

 Note 
The object is a placeholder for the 
position and size of the evaluation. 
The evaluation style cannot be 
changed in the template, as it uses 
the default trainer configurations. 

Feedback     

    

For quizzes there are two feedback 
types: 

• Feedback displayed on page 

• Feedback displayed as popup 

Feedback on page:     

  
Feedback text: correct 

feedback_correct 

Contains the feedback text for a 
correct answer. 

  
Feedback text: wrong 

feedback_wrong 

Contains the feedback text for a 
wrong answer. 

  
Feedback text: timeout 

feedback_timeout 

Contains the feedback text displayed 
if the time limit is exceeded. 

  
Feedback icon: correct 

feedback_passed_icon 

Specifies an icon for displaying 
feedback for a correct answer. 

  
Feedback icon: wrong 

feedback_failed_icon 
Specifies an icon for displaying 
feedback for a correct answer or a 
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Type Function / Name Value Description 

time out. 

Feedback as popup:     

  
Feedback popup: correct 

feedback_correct_popup 

Contains the feedback text for a 
correct answer (popup). 

  
Feedback popup: wrong 

feedback_wrong_popup 

Contains the feedback text for a 
wrong answer (popup). 

  
Feedback popup: timeout 

feedback_timeout_popup 

Contains the feedback text if the 
time limit is exceeded (popup). 

  
Feedback icon: correct 

feedback_correct_icon 

Specifies an icon for displaying 
feedback for a correct answer. 

  
Feedback icon: wrong 

feedback_wrong_icon 

Specifies an icon for displaying 
feedback for a correct answer or a 
time out. 

Media     

  
Media popup 

media 
Contains the media file of the quiz. 

  
Media control: show 

media_open 

Specifies a button for showing the 
media popup. 

  
Media control: hide 

media_close 

Specifies a button for hiding the 
media popup. 

  
Media preview 

media_preview 

Specifies an image as preview for the 
media file. 

Status     

  
Points 

points 
Shows the points of the quiz. 

  
Number 

number 
Shows the number of the quiz. 

  Time limit 
Shows the time limit for the current 
quiz item. 
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Type Function / Name Value Description 

countdown 

  
Global time limit 

countdown_global 

Shows the time limit for the current 
quiz items. 

6.2.3.3 Adapting the Quiz Item Template 

The Quiz Item Template is a book page object, which is used as placeholder for the quiz items in a quiz template. In 
the object, you can define the design of the quiz item controls. 

The object contains the following setting subsections: 

• Design Controls: 
Contains general settings for the controls of the quiz items. 

• The following subcategories contain additional settings specific for a quiz item.  

○ Design Multiple Choice: 

○ Design Fill in the Blanks: 

○ Design Fill in the Fields: 

○ Design Matching: 

○ Design Connection: 

○ Design Sorting: 

○ Design Slide Control: 

○ Design Grid: 

• Design: 
Contains settings for the text and the general design of the object (for example background color). 

 Recommendation 
Test your changes using an example quiz to see the settings. Create an example quiz with all required quiz items. 

6.2.3.4 Selecting a Quiz Template 

A quiz item can be selected as follows: 

• In settings dialog box 

1. Open the settings dialog box using the Tools -> Settings  menu. 

2. Select the section Playback Settings -> General -> Quiz. 

3. Go to the Template setting and select the customized Quiz Template. 

4. Confirm the dialog box with OK. 

• For each quiz item 

1. Open a project with a quiz. 
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2. Select a quiz item. 

3. Open the macro editor. 

4. Go to the Template setting and select the customized quiz template.  

6.2.4 Editing the Quiz Items 

You can set additional properties of a quiz item individually. For an overview and description of the functionality of 
quiz types, see the Quiz Items reference pages. The individual quiz items are described in more detail in their 
corresponding chapters. 

Pay attention to similarly described settings and approaches when creating quiz items so that the corresponding 
functionality can be defined. 

 Note 
In case the inputs of a quiz item are incomplete or faulty, an error message will be displayed when starting the 
simulation. When closing the trainer, appropriate corrections may be taken. 
Incomplete or faulty quiz items will be skipped while playing the simulation. 

There are a number of general settings for the quiz items which can be found in the setting subcategories of the 
quiz items. These settings can be used to personally design your quizzes. 

Further information is available in the following chapters. 

6.2.4.1 General Quiz Item Parameters 

Once you have created a quiz item you will be able to edit or add content to it. 

When setting up quiz items it is necessary to set a question as well as the number of points required. You can also 
name the quiz item. 

• Template: 
In the parameter you can select a quiz template for the quiz item. 
See also the chapter Quiz Templates. 

 Note 
If no template is selected, the active trainer Style is used. 

• Points: 
This parameter allows you to set the point value required to have achieved a correctly answered quiz item. 1 is 
set as the minimum default value for this. 
This way, you have the option of dividing your quiz items into different levels of difficulty.  

• Title: 
Enter a name for your quiz item. For example, it can be a subject area or a description of the quiz item. The 
name is displayed during playback of the project in the top section of the tasks.  

• Task: 
In the field enter a task for the quiz item. 



 

Producer (Cloud Edition) 
Quizzes 

 
PUBLIC   190 

 

 
Instead of entering a question, you can enter a media file as a question. For example, this can be a PowerPoint 
slide. To read more on this, see the Show Instead of Task setting in the Subcategory Media.  

6.2.4.2 Subcategory Media 

In the subcategory Media the Media File parameter can be used to insert a file for visual or acoustic display or 
support of task-setting. This can be a picture, video or audio file. 

To the right of the tasks section there is a media area for the Media File where it is placed after being inserted. 

 Note 
Note that for some media types corresponding plug-ins are required on the user's workstation.  

 Note 
Since video and audio files cannot be integrated into a Microsoft Word document, Media Files are not produced 
with everything else when creating a documentation. 

Advanced Settings 

• Width, Height: 
Use the Width and Height settings to change the format of the Media File after inserting a picture file. 

 Note 
For an image, enter the width and height to display the image with the correct size. 

• Show Instead of Task: 
Upon activating the Show Instead of Task setting the inserted Media File is shown instead of the task. Use this 
setting if you wish to have the quiz tasks shown as PowerPoint slides. 

The Show Instead of Task setting cannot be adjusted in the Puzzle quiz items. This is because a media file in the 
form of a picture file is already used for the display of the tasks for both of these quiz items. 

6.2.4.3 Subcategory Options 

In the Options subcategory, you have the choice of setting a Time Limit (Seconds) for every quiz item. You can use 
this parameter to set a specific time within which the quiz item is to be answered. 

This can be done individually for each quiz item or for the entire project via the central configuration dialog box. 

 Note 
If the Time Limit has been exceeded when answering a quiz item, the quiz item will be deemed to be incorrectly 
answered on evaluation. 
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When a time limit has been set, a clock appears while a project is playing, showing the remaining time. If a time limit 
has been defined in the central configuration dialog box for the entire project, an additional second clock will 
appear. 

 Note 
If you set a time in the central configuration dialog box for the entire project, then the combined individual times of 
each of your quiz items should not surpass the value for the entire project. 

There are additional individual quiz items settings available in the subcategory Options. See the corresponding 
sections in the overview section for the quiz items. 

6.2.4.4 Subcategory Feedback 

After confirming an answer of a quiz item, you can have a dialog display whether or not the quiz was correctly 
answered. In this case, the Show Feedback parameter must be selected. 

When the feedback setting is activated, the feedback texts defined in the Settings  dialog box are shown 
accordingly.  
However, you can also define individual feedback texts for a quiz item, which would be shown instead of the general 
settings. The following text fields can be used for this and can be shown by making changes to the advanced 
settings: 

• Quiz Passed: 
This text is shown when the quiz has been answered correctly.  

• Quiz Failed: 
This text is shown when the quiz has been answered incorrectly.  

• Quiz Timeout: 
This text is shown when the time for answering the quiz has elapsed. In this case, a value for the Time Limit 
(Seconds) parameter must be defined.  

6.2.5 Quiz Playback 

 

Playing back the quiz should be done by using the test mode. This is necessary to hide the trainer bar and to 
prevent navigating with the arrow keys so that a step is not skipped unintentionally. 

When displaying the mode in the library the other modes can be hidden or deactivated before the generation in the 
Save settings.  

If quiz items have been inserted into a simulation, then the modes in which the quizzes are to be shown should be 
selected in the Settings  dialog box. 
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6.2.6 Quiz Documentation 

Quiz items can also be generated as documentation, which can be a useful aid to your simulations. The quiz items 
are mostly designed as tables, which should be filled out as required. In accordance with the document’s format, 
drop-down lists and drag & drop objects are displayed as general lists. Therefore, with the documentation format, it 
is more convenient to fill information in on the computer or on a print-out. 

For generating a quiz documentation see also the quiz settings in Documentation Settings. 

Subcategory documentation 

In quiz items, there are the following settings for documentation: 

• Show Title in Documentation: 
Specifies to show the title of a quiz in a generated documentation. 

Documentation types 

A quiz documentation can be generated for the single document types Standard Document, Training Document and 
Work Document. 

6.3 Quizzes on Book Pages 

The following section explains how to create a quiz on a book page. Quiz items on book pages can be uniquely 
customized, as each object can be edited individually. The quiz items can be combined with additional book page 
objects and contents. 

Use case 

The main use case for quizzes on book pages is to provide questions for adaptive learning. The quizzes can help 
learners to show a learning path for further lessons. There is no result tracking, as the quizzes are general content 
objects. 
Quiz items on book pages can be used as stand-alone book content or as additional book content. 

 Note 
Quiz items on book pages do not support tracking (for example, SCORM 2004). If you want to use quizzes in 
combination with an LMS, then create quizzes in projects. 

Components of a quiz 

Your quiz should have the following recommended quiz components: 

• Quiz item 
This book page object specifies a particular quiz. 
It is recommended that you use one quiz item per book page. 

• Task 
A task explains to the user what needs to be done. 
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• Confirmation button 
A control confirms the quiz answer and shows feedback for the learner. 

• Feedback texts 
The feedback texts are used to show how well the user performed the task. 

6.3.1 Creating a Quiz on a Book Page 

This chapter explains how to create a book page with a quiz item and insert general objects. 

 Recommendation 
If you always want to use a specific structure and object types for your quizzes, we recommend that you insert 
them in a book page template. More information is available in the section Templates for Book Pages. 

1. Creating a book page 

To create a book page, proceed as follows: 

1. Select a Book  or a Group  in the workarea structure to insert the book page. 

2. Select New Object  in the toolbar. 
An overview of all objects opens. 

3. Select Book Page . 
The New Book Page dialog box opens. 

4. Adapt the following settings:  

1. Name: 
Enter an object name. 
The default name is the object type with an ID. 

2. Language: 
Select a language from the dropdown box. 

3. Template: 
Select a template. 
Choose Change... to open the selection dialog box and select a template from the workarea. Select No 
template to create an object without a template. 
If a template has already been used, that template is selected by default. 
See the chapter Templates for Content Objects. 

5. Choose OK to create the book page. 

The book page is opened in the book page editor. 

2. Inserting a quiz item 

To insert a quiz item, proceed as follows. 

1. Select a quiz item from the dropdown box in the toolbar. 
The quiz item is inserted. 

2. Position the object on your book page.  
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3. Design your quiz item.  
Adapt the parameters of the Design Controls section. 

4. Now specify the question and answers as described in the Quiz Items section. 

3. Inserting a task 

Create a task for your quiz. A task provides an introduction or describes what the learner needs to do. 

To insert a task, proceed as follows. 

1. Insert a Text Field. Select the object from the toolbar. 

2. Enter a task text. 

You can also use an image or a media file to create a task. 

4. Inserting feedback 

Define the feedback for the learner as described in the Configuring Feedback section. 

Further Information 

Detailed information about book pages and book page objects is available in the Books and Book Pages section. 

6.3.2 Configuring the Feedback 

You can create feedback for your quiz. This feedback is shown after a quiz item has been answered. The feedback 
informs the learner whether the quiz item was correctly answered and can be a text field, an image or a media file. 

 Recommendation 
If you always want to use specific feedback, then we recommend that you insert the feedback in a book page 
template for your quizzes. Further information is available in the section Creating a Book Page Template. 

Feedback is used as follows: 

1. Learner solves a quiz. 

2. Learner selects a confirmation control to check the quiz 

3. Quiz shows feedback for the learner. 

To create feedback for your quiz, proceed as follows: 

1. Creating a confirmation button 

Create an object to confirm the quiz: 

1. Insert a Shape or Active Area object. Select the object in the toolbar. 

2. Design the object by using the object parameters. 

3. Define a Check action for the confirmation click: 

1. Open the Actions subcategory in the object editor. 

2. Activate the On Click action  

3. Select your quiz item. 
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4. Select the Check action for the quiz item. 

After confirming a quiz, the user sees feedback. 

2. Creating feedback information 

Feedback tells your learners if an answer is right or wrong. 

Create Text Fields for the feedback information: 

1. Insert two Text Field objects for the feedback. Select the object in the toolbar. 

1. Insert a Text Field for the correct answer. 
Enter a feedback text. 

2. Insert a Text Field for the wrong answer. 
Enter a feedback text. 

2. Select Hide parameter for each object. 
This allows you to display the corresponding text. 

3. Design the quiz objects by using the object parameters.  

3. Assigning feedback actions 

Now define actions to show the required feedback text: 

1. Select your quiz item. 

2. Open the Actions subcategory in the object editor. 

3. Correct answer 

1. Activate the On Correct Answer action  

2. Select the Text Field for the correct answer. 

3. Select the Show action. 

4. Wrong answer 

1. Activate the On Wrong Answer action 

2. Select the Text Field for the wrong answer. 

3. Select the Show action. 

Further Information 

Detailed information about actions for book page objects is available in the section Object Actions. 

6.3.3 Actions and Behaviors of Quiz Items 

Quiz item actions 

Actions allow you to show information for the learner based on the status of the quiz. Select a quiz item and open 
the subcategory Actions of the object editor, to edit the actions. 

The following actions are available: 
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Action Description 

On Ready 

Specifies the action to be executed when the quiz is 
ready. 
You can use this action to display a message that the 
quiz was answered by the user. 

On Not Ready 

Specifies the action to be executed when the quiz is not 
ready. 
You can use this action to display a message that the 
quiz was not answered by the user. 

On Correct Answer 

Specifies the action to be executed when the quiz is 
answered correctly. 
You can use this action to display feedback for the 
correct answer. 

On Wrong Answer 

Specifies the action to be executed when the quiz is 
answered incorrectly. 
You can use this action to display feedback for the wrong 
answer. 

On Skip 

Specifies the action to be executed when the quiz is 
skipped. 
You can use this action to display a message that the 
quiz was skipped by the user. 

Quiz item behaviors 

If a quiz item is selected by an action (for example, in a confirmation button), the following behaviors are available: 

Action Description 

Check 
Checks the answer of the quiz item. 
You can use this behavior to check the answer of the 
user and to display feedback. 

Reset 
Resets an answered quiz item to the default status. 
You can use this behavior, if a quiz was answered 
incorrectly and needs to be answered again. 

Enable 
Enables the quiz to allow changes. 
You can use this behavior to allow the user to change the 
answer. 

Disable 
Disables a quiz to prevent changes. 
You can use this behavior to prevent the user from 
changing the answer. 
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6.4 Quiz Items 

There is a wide range of quiz items, which can be used to create interesting, multi-layered and at the same time 
comprehensive quizzes. 
The quiz items must be created and edited individually. When using quiz items, the main focus is on learner 
interaction – answering a quiz using text input boxes, dropdown boxes or moving objects using drag & drop. 

Quiz items are an optional group of items to be input manually. The following quiz items are available: 

Icon Name 

 Multiple Choice 

 Fill in the Fields 

 Fill in the Blanks 

 Matching 

 Connection 

 Sorting 

 Slide Control 

 Grid 

 Puzzle 

 Hotspot 

 Quiz Section 
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Icon Name 

 Quiz Evaluation 

In the following chapters, you will find further information about the quiz items. 

6.4.1 Multiple Choice 

  

Using the Multiple Choice quiz item, you have the option of creating a question with one answer or multiple answers. 
The quiz can be solved by selecting the correct answer. 

Here, you have a number of design options available, for example, whether or not to create a question that is 
answerable with just one correct answer, with multiple answers or with apparent multiple answers. 

To create a Multiple Choice quiz item, proceed as follows: 

1. First enter the individual answering options into the Answer x parameter.  

2. Then specify the correct answer using the Answer Correct parameter. You can activate this parameter for a 
number of answers as well.  
If you flag more than one answer as being correct, the possible selections are displayed as checkboxes or 
alternatively as radio buttons.  

Settings 

Further settings can be chosen for this quiz item in the Options subcategory. 

• Shuffle Solutions: 
When the Shuffle Solutions setting has been activated the answers entered are mixed individually.  

• Force Multiple Choice: 
Enable this parameter if you do not immediately want to show the user that there is only one correct answer 
for a question for which there is only one possible response. This converts the input fields manually from radio 
button type to the checkbox type.  

Quiz item on book page 

For a Multiple Choice quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 
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6.4.2 Fill in the Fields 

  

With the Fill in the Fields quiz item you can define a question with multiple answers. These answers should be 
entered as text inputs. 

The answer has to exactly match the string entered by the author as being the correct answer - if so much as one 
character is wrong then the answer is deemed to have been incorrectly answered. 

To create the quiz item, continue as follows: 

1. You can use the Answer x parameter to set one or more answers for this quiz item.  

2. The Input Type parameter allows the display type to be defined with which the answers are to be input. 
Overview of the types with descriptions and examples:  

Type Description 

Text The answer can be entered in any way desired. 

Text (case sensitive) 
The answer must be entered with the same 
capitalization as in the predefined answer. 

Integer 

The answer must be entered as a whole number. Here, 
mathematical characters may also be used. 

For example: 1,1-3,<4 

Floating point number 

The answer must be entered as a floating point number 
where the dots can be defined as commas or dots. 
Mathematical signs may also be used here. 

For example: 1.1;1-3.4;<4,2 

Regular Expression 
The answer must be entered as a mathematical string. 
For example: (^term$) 

Comma separated list 

The answer must be entered as a list separated with 
commas. 

For example: Answer1,Answer2,Answer3 

The answer can be entered in any way desired. 

Only one answer can be selected from the list. If identical 
answers are contained in the list, each answer may only 
be entered once. 

Comma separated list (case sensitive) 
The answer must be entered with the same 
capitalization as in the predefined answer. 
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 Note 
When creating the quiz item, the answers entered and the type selection should match functionally in order to 
allow an error-free entry. 

Quiz item on book page 

For a Fill in the Fields quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.3 Fill in the Blanks 

  

With the Fill in the Blanks quiz item you can set a quiz that has text containing gaps to be filled in where words 
should be. 

To create one of these gap texts, proceed as follows: 

1. Enter a text you wish to create as a gap text.  

2. Define the gaps. 
Here you should enter 3 underscores as placeholders for the text that is to be entered. 
Corresponding to the Interaction type selected, the necessary input and selection options will be created in 
this position in the text. 
For example: This is my___text. 

3. Select an Interaction in which the answers are to be entered:   

○ Text Input  

○ Text Input (case sensitive)  

○ Dropdown List  

○ Drag & Drop   

4. Enter the answers. 
The order of the answers must correspond to the order of the defined gaps in the text. Accordingly, Answer 1 
refers to the first gap, Answer 2 to the second, and so on.  

5. There are differences when entering answers, depending on the type selected:  

○ When working with a Text Input, insert an answer in the answer field. 
You can also add a number of possible values for an answer. Separate the answers by using a comma. 
For example: Answer1,Answer2 

○ For Dropdown List and Drag & Drop options, it is necessary to define alternative answers for selection. 
That is why a number of possible answers are to be inserted in the response field. The answers are 
separated using a comma and the correct answer should be marked with an asterisk (*) before it. 
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 Note 
To use a decimal value as answer, for example 1,5, add a backslash to escape the comma. 

For example: 1,1\,5,2,3,4 

 Note 
Make sure that the number of defined gaps matches the number of answers. 

Settings 

• Shuffle Solutions:  
Activate this setting to mix answers for the Drag & Drop and Dropdown List types into the corresponding 
selection for a gap.  

• Use Answer 1 Only: 
The use of just one answer list is possible in connection with the Dropdown List and Drag & Drop types if only 
one list with possible answers is to be made available for the entire Fill in the Blanks, to which the answers 
must be allocated accordingly. The correct answers are marked with an asterisk (*). Each answer can only be 
used once for a gap. 

Quiz item on book page 

For a Fill in the Blanks quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.4 Matching 

  

You can create a quiz item in which texts or pictures must be matched to one another using the Matching quiz item. 

To create this quiz item, proceed as follows: 

1. Set up how the answers are to be matched. Select an Interaction:   

○ Drop-Down List: 
All available answers are listed out and must be chosen according to the question.  

○ Drag & Drop: 
All answers are available as fields in any order and are to be matched to the questions.   

2. Now define the matches. Here, a Question must be entered and the matching answer must be defined in the 
Answer field. 
To do this, you must enter the corresponding question / answer text into the text fields.  
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 Note 
Make sure that the number of questions is equal to the number of answers and that an answer has been allocated 
to each question. 

Matching pictures 

Alternatively, you can add pictures to texts. This means that either the question and answer both contain pictures 
or only one of the two do. This can be done by inserting pictures using the HTML editor. You should proceed as 
follows: 

1. You may only use the drag & drop function for matching up pictures. Set up this functionality in the Type 
section.  

2. In the HTML editor of one of the questions or answers go to Insert Object  -> Insert Image File...  

3. Open the folder containing the picture you wish to insert and select the picture file. Confirm this with Open.  

4. In addition to the inserted picture you can also add text.  

5. Repeat steps 2 and 3 accordingly for the next questions / answers of the quiz item.  

 Note 
Do not use picture files that are too large (height, width) for Matching so that they display correctly and do not have 
to be cropped. 

 Recommendation 
Where there is an association between an image question and text response, the height of the text field in question 
aligns with that of the associated image. With images of different height, this results in different text field heights, 
which betrays the correct allocation of the answers. 
To align the text fields, you can modify the height of the text fields by using spaces (Return key). 

Quiz item on book page 

For a Matching quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.5 Connection 

  

This quiz item allows you to establish connections between questions and answers in text or image form. This 
involves creating a line to highlight the assignment of a selected answer to a question. 

To create a connection, select a question by clicking on it with the mouse. Then use the mouse again to specify the 
appropriate answer. 

The following is required to create a quiz item Connection: 
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• Define the content to be connected. You can use both texts and images for this purpose. 
 
Enter a Question in the appropriate field and it a corresponding Answer.  

 Note 
Ensure that the number of questions matches the number of answers and that an answer is assigned to each 
question. 

When playing back the project, questions are presented in sequence and the answers out of sequence. 

Inserting images 

To define images as a question or answer, proceed as follows: 

1. In the HTML editor corresponding to a question or answer, go to the function Insert Object  -> Insert Image 
File...  

2. Call up the folder containing the image to be inserted and select the image file. Confirm this by clicking on 
Open.  

3. You can now insert an additional text in the text box to accompany the inserted image.  

4. Repeat steps 2 and 3 for the other questions and answers in the quiz item.  

 Note 
Take care when Inserting images that you do not use image files that are too big (height, width) so that they can be 
displayed correctly when arranging the objects and do not have to be wrapped. 

Quiz item on book page 

For a Connection quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.6 Sorting 

  

Text responses can be sorted into the correct order using the Sorting quiz item. This quiz item can be used, for 
example, to ask questions about the order in which a process must be carried out where the individual steps must 
be sorted. 

To create a quiz item for sorting answers, proceed as follows: 

1. Use the Interaction option to select how the possible answers are to be displayed   

○ Drop Down List: 
All of the defined answers are displayed and should be selected accordingly.  

○ Drag & Drop: 
All answers are positioned as fields in any order and are to be sorted into the correct order.   
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2. Select an Alignment in which the answer fields are to be sorted. Vertical and Horizontal can be chosen here.  

3. Set the answers. Enter these into the answer fields in the correct order. These answers will be mixed up on 
generation of the quiz. 
Depending on the number of answers, a corresponding drop down list or drag & drop field is created.  

Quiz item on book page 

For a Sorting quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.7 Slide Control 

 

In a Slide Control quiz, you can define a range of numbers and answer value within this range. During playback, the 
learner has to choose an answer using the slide control. 

To create a slide control quiz, proceed as follows: 

1. Enter a numerical range for your slider in the Range parameter. Enter the start and end values as whole 
numbers separated by a hyphen. 
For example: 5-20 
Only one start and one end value can be defined. Additional values, for example, 2-5-9 are not permitted.  

2. Enter the Answer as a whole number. 
For example: 7 
You can only define one number as the Answer. It is not possible to select more than one number or define a 
number range for the answer. 

 Note 
Make sure that you only use integers. Using alternative numerical values or words is not permitted. 

Quiz item on book page 

For a Slide Control quiz item on a book page, further settings are available: 

• Start Value: 
Specifies a value, which is used as start position for the slider. 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.8 Grid 
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You can create tables in which questions and answers are placed opposite one another using the Grid quiz item. The 
questions can be answered by ticking one of the possible answer options. 

To create a Grid quiz item, you must create a table with rows and columns. To do so, proceed as follows: 

1. Set the possible answers in the Possible Answers section. The number of answers defines the number of 
columns. These are then displayed horizontally in the head of the table. 
When entering the answers, they must be separated by commas. 
For example: File,Edit,View,Insert  

2. Formulate the questions for the quiz item in the Question x parameter. These are then ordered vertically in the 
left rows.  

3. You can define the answers in the Position of Correct Answer field. Here, a number value must be entered, 
which refers back to an answer from the Possible Answers parameter. 
For example, if you defined three answers and want one of your questions to have Answer 2 as the correct 
answer, then enter 2 into the answer field of the corresponding question.  

Settings  

• Shuffle Solutions: 
Activate this parameter to show the Possible Answers in any order. If this setting has been deactivated, the 
entries made under possible responses are shown in the same order in which they were input in the text field.  

Quiz item on book page 

For a Grid quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

6.4.9 Puzzle 

 

The Puzzle quiz item lets you create a puzzle from a picture file. The task is to reassemble the original picture 
correctly. 

Here, an uploaded picture is divided and the separate parts are mixed randomly. The degree of fragmentation can 
be set individually. The user can then use drag&drop to arrange the image components in the correct layout and 
thus generate the original image. 

The following shows you how to go about creating a Puzzle quiz item: 

1. Insert a picture file via the Image parameter. 
The file can be inserted using the Replace Image  command.  

 Note 
Note that quiz puzzles do not contain Media File parameters. The Media File area is used to display the Help Image 
and is therefore not available for use in other media files. 

2. After inserting the picture, the puzzle must be fragmented:   
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○ Pieces Horizontal: 
The numerical value entered defines the number of parts into which the original image is subdivided 
horizontally.  

○ Pieces Vertical: 
The numerical value entered defines the number of parts into which the original image is subdivided 
vertically.  

 Note 
If, when fragmenting the puzzle, two optically identical fields are found, it may be the case that it cannot be 
recognized which picture belongs to which field. For this reason, the different puzzle parts should be fragmented in 
such a way as no identical parts appear. 
Alternatively, it is possible to use an image processing program prior to this to change an optically identical picture 
by inserting a different-colored point, the size of a single pixel, into the picture. 

3. The composition of the puzzle can be set using the Interaction selection. A difference is discerned between the 
following two modes:   

○ Arrange in One Field 

○ Arrange in Second Field 

4. This selection allows you to determine whether the user works directly within the parts of the puzzle shown or 
is shown a second, empty field into which he drags the parts of the puzzle. 

 Note 
Note that the Puzzle quiz item is not produced as well on generation of the documentation as the option of doing 
puzzles is not possible in the corresponding document format. 

Further options 

• Show Help Image: 
The original picture can be shown next to the puzzle by using the Show Help Image parameter. This parameter 
is activated in the initial setup. 

Quiz item on book page 

For a Puzzle quiz item on a book page, further settings are available: 

• Fields Side by Side (Options subcategory): 
Specifies, the source field and the answer field are positioned side by side instead of below each other. The 
parameter is used for the Interaction type Arrange in Second Field. 

• Design (Subcategory): 
The subcategory contains parameters to specify the appearance of the quiz item.  

Help Image 

For a Puzzle on a book page you can insert a help image as additional book page object. Use the Image object, to 
insert an image. 
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6.4.10 Hotspot 

 

With the Hotspot quiz item, a quiz can be created in which a pre-defined area on a picture must be specified by 
selecting it. 

To create Hotspot quiz item in a project, proceed as follows: 

1. Use the Image parameter to insert the corresponding picture file within whose area a section must be selected 
by the user.  
The file can be inserted using the Replace Image  command.   

2. After inserting the picture, it is necessary to define an area for selection. This area can only be defined in the 
shape of a rectangle. 
Select the Define Hotspot  function in the header of the macro editor.  

3. After selecting the Define Hotspot button a window will open in which the inserted picture will display. In it, you 
will find a red selection box whose size and position can be changed so that the picture section can be set.   

4. Now close the window with the Confirm Selection  button.  

Quiz item on book page 

To create a Hotspot quiz item on a book page, proceed as follows: 

1. Use the Image parameter to insert the required picture file. 
You can insert the file by using the Replace Image  command.   

2. Define an area for the hotspot selection. 
The highlight in the image box shows the current hotspot area. You can move the hotspot by drag and drop to 
another position and change the size by using the pointers on the highlighted border.  

For a Hotspot on a book page, further settings are available: 

• Hotspot: Left, Top: 
Specifies the position of the hotspot area. 

• Hotspot: Width, Height 
Specifies the size of the hotspot area. 

• Pin (Subcategory): 
The subcategory Pin offers parameters to define an individual pin to select the hotspot. You can insert an 
image. 
The image can also be a sprite image. This is an image file that combines many icons into one file. Using the 
Sprite parameters, you can define the image area of the pin on the file so that only this selection is shown. 

• Design (Subcategory): 
The subcategory contains parameters to specify the appearance of the quiz item.  



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   208 

 

7 Books and Book Pages 

Books and book pages are used to provide information, helps, tutorials and more by using multimedia elements. 
They make it possible to incorporate simulations and different media files, but also conventional documents and 
links to further information. 
Using different objects and media presents you with many and various opportunities for presenting and 
communicating information. Moreover, the book page design as well can be individually edited and customized to 
the content to be communicated. 

7.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

7.2 General 

A book page is an HTML page on which different content can be filed in different forms and accessed. 
It can accommodate various buttons for launching simulations and opening documents that can then be linked 
within a workarea. Media files for audio and video formats can also be integrated and can be presented using 
appropriate playback applications. But information in traditional form, as an image or text, can also be created on a 
book page. 

A number of book pages can be combined in a book. A book can thus be understood as a type of group. Once a book 
has been created, it can be displayed in the book reader, which the learner can use to flick through the pages and 
launch and work through content. 

Easy to create, diverse applications 

Book pages make it possible to create courses on a particular step quickly by inserting objects on the book page 
and linking them to content. 
In this way you can amalgamate the content of a number of simulations by combining different modes and 
documents. However, because of the diverse ways of presenting information on book pages, it is not absolutely 
necessary to integrate simulations into a book page. You can also design a book page using simple texts or video 
files and thus provide these to the learner in addition to the individual simulations or else integrate them entirely 
independently as an extension of the step. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_B4CB4A924F13069F


 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   209 

 

Didactic benefit 

Books and book pages promote independent learning and a stronger engagement with the facts as learners are 
able to use and discover the content individually. They allow the student to work with the content that is relevant to 
him and ensure variety due to different information formats. 

7.3 Creating a Book 

Create a book to structure your book pages. For more information, see the chapter Creating a Content Object. 

Proceed as follows: 

1. In the Explorer select New Object . 
An overview of all objects opens.  

2. Select New Object  in the toolbar. 
An overview of all objects opens.  

3. Select Book . 
The New Book dialog box opens. 

4. Adapt the following settings:  

1. Name: 
Enter an object name.  
The default name is the object type with an ID.  

2. Language: 
Select a language from the dropdown box. 

3. Template: 
Select a template. 
Choose Change... to open a selection dialog box and select a template from the workarea. Select No 
template to create an object without a template. 
If a template has already been used, that template is selected by default. 
See the chapter Templates for Content Objects. 

5. Choose OK to create the object. 

The book is inserted into the structure. You can now insert book pages into your book. 

To structure your book, you can insert further books or groups into your book to create subchapters. For correct 
tracking of books, we recommend that you use groups for subchapters. 

7.3.1 Defining a Book Page as Content Page 

You can create a page containing introductory information or a table of contents for a book. Users can access the 
page at any time in the book reader, the page can be defined as a content page for the book. The book page can 
then be launched directly in the book reader using a button in the control bar. 

To specify a Content Page, select your book in the Explorer. Then go to Content Page in the object editor's 
subcategory book reader and select the Edit Link...  option. You can now specify your book page in the open 
dialog. Confirm this by clicking on OK. 
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7.3.2 Subcategory book reader 

The subcategory book reader provides settings to specify the functionality of the book reader's control bar. This 
allows you to customize them to your book's individual requirements and hide any functions you do not want. Select 
a book  in the explorer and open the subcategory in the object editor. 

 Recommendation 
You can create objects on your book page to control the book. For example, to go to the next and the previous 
page. This allows you to hide the buttons in the control bar. 

The following settings are available: 

• Hide Book Panel: 
Activate this option to hide the book panel. 

• Open Book Directly: 
If this option is activated the book will open in the book reader as soon as it is selected in the tree structure in 
the library. If the option is deactivated, the book reader is started by selecting the Open Book button in the 
content view of the library. 

• Hide Audio Controls: 
Activate this option to hide the buttons for controlling the audio and volume. 

• Hide Navigation Controls: 
Activate this option to hide the buttons for navigating through the book pages.  

• Hide Play/Pause Control: 
Activate this option to hide the buttons for pausing and starting the playback. 

• Hide Index Page Control: 
Activate this option to hide the button for opening a content page. 

• Hide Search Button: 
Activate this option to hide the button for opening the search dialog box. 

• Hide Table of Contents Control: 
Activate this option to hide the table of contents dropdown menu. 

• Hide Progress Control: 
Activate this option to hide the progress bar for displaying how the user is progressing in the book. 

7.3.3 Alternative Navigations on Book Pages 

Actions can be used to allow navigation on book pages independently of the control bar of the book reader. These 
are universal properties and allow the user to jump between book pages and units. 
If you would like to use such navigations, it is recommended that the objects be inserted into a book page template. 
By doing so, they can be used for the entire book and ensure consistency. 

Actions as link targets 

To enter a link target, proceed as follows: 



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   211 

 

1. Insert a book page object. 
For example: Image, Active Area.  

2. Select the parameter Link -> Link to... 

3. Select Edit Link... . The editing dialog box appears.  

4. Select Actions button. 

5. Select the desired action from the Actions drop-down list. 
For example: Next book page, Play audio 

More information about link actions can be found under Link Actions for trainer and book reader. 

Object actions of the page object 

To specify an object action for a page object, proceed as follows: 

1. Insert a book page object, for example Image or Active Area. 

2. Under subcategory Actions, choose an action. 
For example: On Click, On Show 

3. Select the page object from the first drop-down list. 

4. Select a behavior from the second drop-down list. 
For example: Next, Share. 

More information about actions can be found under Object Actions. 

Disabling the book navigation 

For a book page you can specify, that the book reader control bar is deactivated. This allows you, to specify 
required content. After completing the content, navigation can be enabled. 

When selecting the page object for an object action, the following behaviors are available: 

• Disable Book Navigation: 
Disables the navigation of the control bar and other navigation controls on the book page. 

• Enable Book Navigation: 
Enables the navigation of the control bar and navigation controls. 

7.4 Creating a Book Page 

Create a book page for your book or as single book page. For more information, see the chapter Creating a Content 

Object. 

Proceed as follows: 

1. Select a Book  or a Group  in the workarea structure to insert the book page. 

2. Select New Object  in the toolbar. 
An overview of all objects opens. 

3. Select Book Page . 
The New Book Page dialog box opens. 

4. Adapt the following settings:  
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1. Name: 
Enter an object name.  
The default name is the object type with an ID.  

2. Language: 
Select a language from the dropdown box. 

3. Template: 
Select a template. 
Choose Change... to open a selection dialog box and select a template from the workarea. Select No 
template to create an object without a template. 
If a template has already been used, that template is selected by default. 
See the chapter Templates for Content Objects. 

5. Choose OK to create the object. 

The book page opens in the book editor. Now, you can insert your content. Read the following chapters on this 
subject. 

7.4.1 Specifying the Design 

After creating the book page, it is opened in the book page editor using the default style. You can use the Style 
parameter to select the design you want in the object editor and customize it accordingly. 

A style defines the background design, the design of the buttons for the linked learning content as well as the 
appearance of the text box. Selecting a different skin therefore changes all of these objects. Before you select a 
skin, it is advisable to insert some objects to be able to assess the overall design. 

Customizing the background 

You can customize the chosen background design as you like. You can use an available skin as a template which 
can then be edited once it has been selected. 

Various settings are available to you in the book page editor for displaying the book page: 

• Image: 
This parameter can be used to define an individual background image which replaces the image of the skin 
that has been set.  

• Width and Height: 
Specifies the book page's width and height. The values are stated in pixels. 

• Page Color (Design): 
Specifies the book page's background color. It is recommended that you enter a value in this field if you 
choose not to use an image for the book page's background or if you use an image that does not cover the 
entire book page itself. 
When using the Page Color, activate the Image setting without selecting an image. This is necessary to hide 
the page image or color of the book page style.  

• Background Color (Design): 
Specifies the color of the outer surface surrounding the book page. Select the color preview to open the Color 
Selection dialog box. Select Transparent , if you do not want to use any color. 
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• Border Width (Design): 
Specifies the width of the border for the book page. The value is defined in pixels. If no border is to be 
displayed, the value is to be set to 0.  

• Border Color (Design): 
Specifies the color of the book page's border. Select the color preview to open the Color Selection dialog 
box. Ensure that you have previously specified a width for the border so that it is actually displayed.  

• Border Style (Design): 
Specifies the style of the book page's border that you can select from the dropdown box.  

You can call up the design parameters at any time while a book page is being created and amend them by selecting 
the background. 

7.4.2 Table of Contents for Book Pages 

A book page can have a table of contents faded in, which is displayed on the book page background independently 
of the book reader. 

The table of contents is constructed from a bar displaying the groups or book pages belonging to the first sub level. 
The other groups and book pages can be launched from an option menu that is faded in using the button on the 
right-hand side of the book page. Clicking on a group name opens a menu displaying the group content. 

The table of contents on the book pages can be used as an alternative to the table of contents in the book reader. 
This is accomplished by deactivating the book reader table of contents. 

 Recommendation 
The width of the table of contents is restricted to the width of the book page. That is why when setting up the 
groups it is recommended that short names or chapter numbers be issued, so that as many groups as possible can 
be displayed on the bar. 

Settings 

A book page's table of contents can be defined using the Table of Contents subcategory. This offers you the 
following functionality: 

• Show: 
This function can be used to activate the table of contents for the book page. 

 Note 
The table of contents must be defined for each individual book page. If all of the book pages of a book are to 
receive a table of contents, then it is advisable to define the table of contents for one book page and then use this 
book page as a copy template when creating new book pages. 

• Position: 
The table of contents bar can be faded in directly above the book page or in the window header. Use this 
parameter to select the appropriate position. 

• Menu Structure: 
These options can be used to define the way in which the content is displayed in the menu. 
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○ Flat structure: 
The groups and book pages are displayed in a flat structure such that all groups and book pages are 
displayed on one level.  

○ Indented contents: 
The contents of a group are shown indented relative to the group itself. This improves clarity within a 
complex content structure.  

7.4.3 Hiding a Book Page in Table of Contents 

You can hide a book page in the table of contents of the control bar. This allows you to show only the main pages in 
the table of contents and to hide additional information. 

The book page is not numbered in the table of contents and is not counted in the book page progress bar. The user 
can navigate to the book page. Afterwards, the book page is shown in the table of contents. 

Proceed as follows: 

1. Select a book page in Explorer. 

2. Activate the option Hide in Table of Contents in object editor. 

7.4.4 Further Properties of a Book Page 

Show Navigation Arrows 

Instead of using the command bar to scroll through the book pages, you can do so using the buttons either side of 
the book page. This makes it possible to work more intuitively with the book. 
To display the buttons, activate the Show Navigation Arrows option for the book page in the book page editor. 

Display Duration 

This option allows you to determine the duration that a book page should be displayed in the book reader. Once the 
time has elapsed, the book reader will automatically jump to the next book page. This feature allows you to play 
books as a slide show or an automatic presentation. The value can be set in seconds. 

7.4.5 Merging Book Pages 

Merging book pages allows content from a different book page to be added to the content of the currently selected 
book page. This is sensible, for example, when applying recurring elements or to have a structure available created 
using construction lines. 
When merging book pages, the desired objects are inserted on the book page, but with the added book page 
continuing to have its own separate existence. 

This is how you add the content of a one book page to another book page: 

1. In the book page editor, open the book page to which the content is to be added. 
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2. Select the Merge Book Pages  option in the toolbar. 

3. A dialog will now be displayed with the overview of the Workarea structure in which you can determine the 
book page of your choice. The book page currently open will be shown grayed out in this structure. 
Click on the book page and then on OK to confirm. 

4. In the next step, you will be presented with a dialog displaying the objects belonging to the chosen book page. 
By making a selection in the selection boxes you can determine which objects you would like to apply to the 
open book page. Confirm your selection by clicking on OK. 

The objects are now inserted on the book page in the place in which they were located in the selected book page. 
The objects also receive the book page style of the book page to which they were added. 

7.4.6 Page Sound 

The Page Sound parameter enables background music or an audio commentary to be inserted in a book page. The 
learner can start the audio file in the book reader in the control bar. 

For information on how to add and edit an audio file, refer to the section on Editing Audio. 

7.4.6.1 Adding Audio to Book Pages 

You can insert audio as Page Sound to your book pages by using the Add Audio dialog box. See also Add Audio 

Dialog Box. 

To record audio for your book pages, proceed as follows: 

1. Select Add Audio  in the toolbar to open the Add Audio dialog box. 

2. Select a book page from the page list. 

3. Select Start Recording . 

4. Speak your audio text. 

5. Select End Recording . 

6. Select the next book page and record your next audio text. 

7. Once you have recorded all your audio texts, select OK to close the dialog box. 

Alternatively, you can insert text to speech in the Add Audio dialog box. Open the Text-to-Speech dialog box by 
selecting Edit Text-to-Speech... . 
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7.4.6.2 Importing Audio 

Importing audio files allows you to easily integrate audio files into a simulation. 

 Note 
By importing an audio file, the existing audio of a step will be overwritten. 

Proceed as follows to import an audio file: 

 Note 
During import the audio files are converted into the editing format WAV with the default audio format. 

1. Select the book page for which you want to import an audio file. 

2. In Page Sound parameter, select Import Audio File... . 
There are two options: 

• Insert Audio File... 

• Insert Audio from Workarea... 

3. A dialog box opens. Select the file. 

4. Select OK to insert the file. 

7.4.6.3 Recording Audio 

Audio recording allows you to narrate your own texts with the microphone. 

Requirement 

For audio recording, a microphone is necessary. Connect this first before starting to record. 

Recording audio 

Proceed as follows to execute the recording: 

1. Select Record Audio... . The audio editor and the recording dialog box opens. 

2. Select Start Recording . 

3. Read out your text. 
During the recording, a sound level meter shows the volume. You also see the spoken text as an audio track. 

4. Select End Recording . 

5. Select Ok to close recording dialog box. 

For more information, refer to the Recording Dialog Box chapter. 
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 Note 
During the recording of an audio file, the existing audio of a book page will be overwritten. 

Read out the full text for your recording because it is not possible to record the text in sections. Any unwanted parts 
can be cut out afterwards. If you are not satisfied with the outcome, record the text again. 

 Recommendation 
If the recording contains background noise, then it is recommended that you edit the audio file with the dynamic 
editor to improve the sound. 

7.4.6.4 Generating Text-to-Speech 

We recommend that you convert text to speech after a project has been edited. Steps should be converted 
individually. If a step contains several macros (for example, several steps are connected), then the texts will be read 
out one after the other in the order in which the macros are arranged. 
If the bubble texts of a simulation are already converted into text to speech, they are available when you open the 
editor. 

Proceed as follows to convert text to speech: 

1. Open the Text-to-Speech editor using the Edit Text-to-Speech...  button for each step. 
Refer to the chapter Text-to-Speech Dialog Box. 

2. Insert a text in the text field or edit the available text. 

3. Define the duration of the silence to be inserted at the beginning of the audio file. 

4. Confirm the input with Generate and Close. The dialog box is closed and the audio file generated. 

 Note 
If a step contains several macros, the individual actions and associated spoken texts will run asynchronously in 
relation to one another. This is because the texts are converted into an audio file and are not linked to the actions. 
It is therefore advisable to only use one macro per step. 

 Note 
Text-to-Speech generation is not available in the web-based Book Page Editor. 

7.4.6.5 Subtitles for Text-to-Speech 

For the Text-to-Speech audio of your book pages, you are able to display subtitles. The subtitle is displayed in the 
footer of the book reader and shows your Text-to-Speech text. 

Subtitle settings 

The following settings are available in Settings  under Playback Settings -> book reader -> Visual properties: 
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• Show subtitles: 
Activate the option to show subtitles for Text-to-Speech. 

• Design of the subtitles 
For the subtitle textbox you can specify the design with the following settings: 

○ Font family 

○ Font size 

○ Text color 

○ Alignment 

○ Background color 

7.4.7 Templates for Book Pages 

 

Book page templates are special types of book pages, which define a layout and general objects for creating book 
page content. Templates are useful for saving time and for ensuring uniformity for newly created objects in a 
complex book and to support the content creation of many authors. 

7.4.7.1 Creating a Book Page Template 

You should create a template before creating a book. This ensures consistency and avoids the need to make 
changes afterwards. For further information, see the chapter Creating a Content Object. 

To create a book page template, proceed as follows: 

1. Select your template group  in the workarea structure to insert the book page template. 

2. Select New Object  in the toolbar. 
An overview of all objects opens.  

3. Select Book Page . 
The New Book Page dialog box opens. 

4. Adapt the following settings:  

1. Name: 
Enter an object name.  
The default name is the object type with an ID.  

2. Language: 
Select a language from the dropdown box. 

5. Select OK to create the object. 
The book page is opened in the book editor. 

6. Select a Book Style in the Style parameter. 

7. Create your standard elements of the template. 

8. Select Save and close the book page. 
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9. Open the Explorer. 

10. Select Book Page Template  as Subtype for the created book page. 
The icon of the object changes and displays the template type. 

 Note 
An existing template cannot be used to create a new template. Always create a template without using other 
templates. 

Tips for creating templates 

• Create a group for your templates. Set the group to hidden, in order to hide it during content playback. 

• Lock the position of your objects, if you want to prevent objects from being changed accidentally. 

• Use guides to create a layout grid. 

• Define Text Styles for the content, to ensure consistency and straightforward adaptation. 

• Insert the layout and design relevant objects. 

7.4.7.2 Defining a Book Page Template 

You can use a book page template to create your book page content. There are different ways to activate a 
template for a book page: 

• Define a default template for creating new book pages 

• Select a template when creating a new book page 

• Set a template in an existing book page 

Select a default template 

You can select a default template, which is always used for creating new book pages. This can be done as follows: 

1. Open the area Producer -> Templates in the Settings  dialog box. 

2. In the Book Page parameter, select Edit Link...  
The object selection dialog box opens. 

3. Select the Book Page Template  and select OK. 

4. Confirm your changes in the Settings dialog box with Apply. 

5. Select OK to close the dialog box. 

When creating a new book page, the template is set by default. Further information is available in the chapter 
Templates for Content Objects. 

Select a template for a new book page 

When creating a book page, you can set a template in the New Book Page dialog box. If a template has been defined 
as standard, you can select an alternative template for an individual page. For further information, see the chapter 
Creating a Book Page. 
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Set a template in a book page 

The Page object of a book page contains the setting Template, which displays the activated template. If you want to 
use another template, select the book page from the dropdown box. The property only displays book pages with the 
subtype Book Page Template. 

7.4.7.3 Using a Book Page Template 

The objects of an active book page template have the following characteristics: 

• they are inherited from the template 

• they use the properties as default (green button deactivated) 

• they are highlighted in blue in the objects list 

• they are positioned on the layers behind the objects of the created book page 

• they cannot be deleted - the objects are hidden automatically 

Changing and resetting objects 

The template objects use the defined properties by default, if the template is used for a general book page. You can 
change the template objects for your content as required. 
To change an object, you have to select the specific property by activating the green control in front of the property 
name. 

If you have changed objects, you can reset your changes by choosing the Reset Template Objects in the Edit menu. 
Once reset, the parameters are unspecified (green control deactivated) and the default template is used. 

 Note 
Changed objects keep their status even when objects are changed in the template. Click on Reset Template 
Objects to change the objects in the book page to the current status of the template. 

Tips for using templates 

• If you do not need an object on a book page, hide the object by using the Hide property in the object editor. 

• We recommend that you keep the template objects when the template is used as a book page because the 
objects define a layout.  

7.5 Book Page Objects 

The following section will give you an overview on the variety of objects available for enhancing your book pages. 
The properties and editing options are described here in detail. 

Different objects offer the opportunity to provide the learner with information. You can insert these using the 
toolbar and edit them accordingly. 

They offer you the following objects: 



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   221 

 

The following section will give you an overview on the variety of objects available for enhancing your book pages. 
The properties and editing options are described here in detail. 

Different objects offer the opportunity to provide the learner with information. You can insert these using the 
toolbar and edit them accordingly. 

They offer you the following objects: 

Icon Name Icon Name 

 Arrow  Demo Mode Link 

 Shape  Practice Mode Links 

 Bubble  Test Mode Link 

 Image  Concurrent Mode Link 

 Text Box  
Guided Presentation Mode 
Link 

 Placeholder  
Free Presentation Mode 
Link 

 Active Area  Quiz Link 

 Text Pop-Up  Book Page Link 

 BPM Object  Book Link 

 Connection  Document Link 

 Time Control  QR Code 
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Icon Name Icon Name 

 Object Visibility  Video Object 

 Animation  Audio Object 

 Counter  HTML Document 

 Collector 

For further information to the objects, read the corresponding sections. 

Inserting an object 

Proceed as follows, to insert an object: 

1. Select an object type from the toolbar. 
A popup with all objects of a type opens. 

2. Select an object. 
The object is inserted on the page. Some objects will be inserted on the status bar. 

3. Edit the inserted object. 
For further information, see the chapter of each object. 

7.5.1 Arrow 

 

The Arrow object is customizable. It creates a path for which you can choose from a variety of arrow heads. The 
arrow's length, position and direction can be modified as desired. 

Positioning a path point 

There are path points at the beginning and end of an arrow that allow you to adjust its length and direction. Select 
one of the points and drag and drop it to the desired position on the book page. 

Defining an arrow 

An arrow object can be customized as follows: 

• Color: 
Specifies the arrow's color. Select the color preview to open the Color Selection dialog box. 
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• Thickness: 
Specifies the arrow's thickness. The value is given in pixels. 

• Arrow Head 1 & 2: 
Specifies the arrow's head for each side of the arrow. 
There are several types: 

Design Name 

 
None 

 
Standard  

 
Triangle - Hollow  

 
Triangle - Filled  

 
Diamond – Hollow  

 
Diamond – Filled 

 
Circle - Hollow 

 
Circle - Filled  

• Advanced (Advanced Layout): 
Specifies the width and the length of the arrow heads in relation to the arrow’s thickness. Enter a value 
between 2 and 20. 
The value defines how many times the length of the thickness should be expanded (for example, value 3 = 3x 
the arrow’s thickness). 
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7.5.2 Shape 

 

The Shape object displays a variety of shapes to choose from for the purpose of enhancing the visualization of 
learning content, process flows and sequences. Shape objects can be used in a variety of ways and can contain text. 

To insert a shape, select Insert Shape. A palette is opened in which you can select a shape type and a orientation. 
For more information, refer to the section on Shapes Overview. You can change the type with the Type and 
Orientation parameter. 

Design 

• Shape Color: 
Specifies the shapes' color. Select the color preview to open the Color Selection dialog box. Select Transparent 

, if you do not want to use any color. 

• Shape Value: 
Specifies the shape's character. Values between 0 and 100 can be entered here. The outcome will vary 
depending on the type of shape selected. For example, you can change the width of an arrow or smooth the 
corners of a square.  
Note that this setting is not available for all shapes. For more information, refer to the section on Shapes 

Overview. 

You will find descriptions on additional settings under the section on Editing Parameters. 

Effects 

Under Effects, there is a variety of settings that allow you to define the behavior and design of a shape. 

• Gradient   

○ Shape Color (Gradient) 

○ Border Color (Gradient)  

• Design Roll-Over   

○ Shape color 

○ Shape Color (Gradient) 

○ Border color 

○ Border Color (Gradient)  

• Design Click   

○ Shape color 

○ Shape Color (Gradient) 

○ Border color 

○ Border Color (Gradient)  
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7.5.3 Shapes Overview 

This section will give you an overview of the shapes that are available in the Producer and includes a list of shapes 
for which the Orientation and/or Shape Value can be defined.  

 Shape Direction / Shape Value 

Arrows     

  Arrow   

  
Arrow 
(one direction) 

Left, Right, Up, Down 

Arrow thickness 

  Chevron Left, Right, Up, Down 

  Pentagon Left, Right, Up, Down 

  
Arrow 
(two directions) 

Left Right, Up Down 

Shape thickness 

  
Arrow 
(two directions kinked) 

Left Up, Right Up, Left Down, Right 
Down 

Shape thickness 

  Triple Arrow Shape thickness 

  Quad Arrow Shape thickness 

  Notched Arrow 
Left, Right, Up, Down 

Shape thickness 

Stars     

  4-Point Star Shape thickness 

  5-Point Star Shape thickness 

  6-Point Star Shape thickness 

  7-Point Star Shape thickness 

  8-Point Star Shape thickness 

  9-Point Star Shape thickness 

  10-Point Star Shape thickness 
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 Shape Direction / Shape Value 

  12-Point Star Shape thickness 

Triangles     

  Isosceles Triangle Left, Right, Up, Down 

  Triangle Left, Right, Up, Down 

Rectangles     

  Rectangle Corner radius 

  Rounded Rectangle   

  Parallelogram 
Left, Right, Up, Down 

Shape thickness 

  Trapezoid 
Left, Right, Up, Down 

Shape thickness 

Polygons     

  Hexagon Horizontal, Vertical 

  Diamond   

  Regular Pentagon Left, Right, Up, Down 

  Heptagon   

  Octagon   

  Decagon   

  Dodecagon   

Miscellaneous     

  
Ellipse 

  
  

  Plus Shape thickness 

  Lightning   
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7.5.4 Bubble 

 

Bubbles are ideal for adding visually-appealing textual content to your projects. Similar to those used in the 
simulations, these bubbles also have a tip on them to point to a specific item on the page. 

Creating bubbles 

To create a bubble, select the option Insert Bubble. The following options will appear: 

• Text: 
Select the text field to open the HTML editor, where you can enter and format your text for the bubble.  

• Style: 
Here you can choose which bubble style you would like to use. To edit your bubble, go to the menu Tools and 
open the editing dialog box for your bubble style.  

• Alignment: 
Here you can specify in which direction the tip of your bubble should be pointing. If you choose the option 
Center – the bubble will have no point and it will be positions in the middle of the chosen area.  

• Title: 
This text field allows you to enter a title for the bubble. When using titles, it is recommended that you also 
enable the option Movable, which inserts a title bar at the top of your object. 

• Movable: 
When this option is enabled, the bubble can be repositioned on the book page during playback. An additional 
title bar will appear in the object that allows you to move the bubble per Drag & Drop. After it’s been 
repositioned, the bubble will be displayed normally with no arrow markers.  

• Closable: 
When this option is enabled, the bubble can be closed while the book page is playing. An X icon will appear in 
the corner of the bubble for you to click on. 
Under Actions, you can also manually add the icon Restore so you can quickly redisplay the bubble.  

Manually changing text bubble alignments 

A square will appear at the top of the bubble, which you can use to manually turn the object. With centrally-aligned 
bubbles that do not have a tip, the square will appear in the middle of the bubble. Select the square and hold the 
mouse button down. With the mouse button still pressed, pull the dot away from the bubble and to the desired 
position. Release the mouse button to set the new position. 

7.5.5 Image 

 

This object allows you to insert an image file to your book page. 

Inserting an image 
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To insert an image, proceed as follows: 

1. Select Insert Image in toolbar. 
The Insert Image from Workarea dialog box opens. 

2. Select an image in your workarea structure. 
or 
Use Insert File... to import an image. 

3. Select Ok. 

You can use Replace Image  to change the image file. 

See the chapter Supported File Formats on Book Pages for supported file formats. 

Parameters of the object 

The following parameters are available: 

• Image Roll-Over: 
You can use the Image Roll-Over option to insert an image that is shown when the mouse is moved over it. 

• Image Click: 
You can use the Image Click option to insert an image that is shown when the image is clicked on. 

• Keep Aspect Ratio:  
If this parameter is activated, the aspect ratio is retained when scaling an image. Deactivate this parameter if 
you want to be free to change the size of an image. 

• Zoom: 
The Zoom option allows you to zoom in and out of images on the book page. An icon will be inserted onto the 
image. By clicking on the icon, the image will be shown in its original size. This allows you to insert an image 
into the book page and save space when scaling it. 

7.5.6 Text Box 

 

The Insert Text Box is a field in which you can enter pure text. The size of this field can be varied to accommodate 
longer texts. 
Example, you can use the text field to provide general or introductory information about a step. 

7.5.7 Placeholder 

 

The Placeholder inserts a variable in order to dynamically allocate content to a specific location. For example: book 
page title, descriptions, page number, etc. The placeholder object makes it easier to keep the layout consistent 
throughout the project. 
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To use placeholders, it is recommended that you insert them into templates so that they will be available in all of 
your book pages. For example, the page number can be integrated into all of the book pages in the same position. 

Once an object has been inserted, choose the desired option from the Placeholder selection list. The respective 
content will then be displayed in the text field. 

You can choose from the following placeholders: 

• Book title 

• Book description 

• Book page title 

• Book page description 

• Chapter title 

• Chapter description 

• Page number 

• Page count 

• Text-to-Speech text 

 Recommendation 
A Text-to-Speech text placeholder can be used, to provide a closed caption for an audio with text to speech. 

7.5.8 Active Area 

 

The Active Area is a text field in which you can insert a text or image. The entire area constitutes a button that can 
be linked with an external web page or object from the Workarea. This allows further information, for example, to be 
shown. 

To create a link, go to the Link to...  function. A dialog will then open in which you can specify a link or select an 
object from the Workarea. A link to a web page or similar is to be entered in the text field under Available. This 
should be in the format http://www... Confirm your entry by clicking on OK. 

When launched, the linked page is automatically opened in a new browser window. If you would like to open the 
page in the same window, you need to deactivate the setting Open in a new window. 
If the linked page or object from the Workarea is opened in a new window, you can define properties for displaying 
the browser window that has been opened. 

Effects for active areas 

Under Effects, you will find a list of settings that allow you to add dynamic effects to active surfaces in order to 
improve its usability. The following actions can be defined: 

• Design Roll-Over 

• Design Click 
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Once one of these options has been enabled, additional settings will appear. The following settings can be defined 
to change the object’s properties: 

• Background color 

• Font color 

• Border color 
 

7.5.9 Text Pop-Up 

 

This function inserts a text pop-up which can be opened by a button. You can insert any text you like in this box as 
well as an image. 
The text pop-up can be formatted using the Text Pop-Up Position subcategory to adjust its size and position. 

 

Defining type and title 

• Type: 
Different types, differentiated by a corresponding icon, can be defined for displaying the textbox. Using 
different types enables you to highlight the text box content and present it more clearly to the user. 
The following types are available and can be selected using the parameter Type:   

○ Standard  

○ More Info  

○ Tip   

• Title: 
You can use the parameter Title to specify a title for the text box. If you do not want to display a title, you 
should leave the field blank. The default setting for the Standard type is no title whereas placeholders are 
displayed for the other types. 

Further options 

• Show on Roll-Over: 
This option allows you to define whether a text pop-up should appear when the mouse cursor rolls over the 
icon. When the mouse cursor rolls out of the icon, the text pop-up will hide again. The text pop-up behaves in 
the same way as a tooltip. 

• Fade In/Out: 
This parameter defines whether the text pop-up is displayed or hidden with a fading in effect when being 
opened or closed. Deactivate the setting if you wish to avoid this effect. 

• Hide Text Pop-Up in Editor: 
The default setting is for the text pop-up to be displayed in the book page editor. Activate the parameter to 
hide it for editing. If you would like to reinstate the text pop-up in the view, deactivate the setting. 
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7.5.10 Linking Content from the Workarea 

          

You can link simulation modes, books and book pages you have created from your workarea on your book page. 
You also can integrate different documents. For example, these can be Word or PowerPoint documents you have 
generated or else files in Excel or PDF format inserted in the workarea. 
For a quiz any simulation mode containing only quiz items can be selected. As a rule, the recommended mode is 
Test mode as it does not allow the user to influence the process in any way. 

Linking the content 

Proceed as follows, to insert a link: 

1. In the toolbar, select the relevant type which you would like to link to content. A button is then created on your 
book page.  

2. Select the Edit Link...  button (subcategory Link) adjacent to the Link to parameter in the object editor.  

3. A dialog displaying the Workarea structure will then open. Only the learning content corresponding to the type 
of button you have inserted can be selected from this dialog. Specify the learning content you want by clicking 
on it and click on OK to confirm.  

The object is now linked to the button and can be selected and opened when viewing the book page. 

 Note 
If a button is not linked, a note icon will appear on the button. Create the link as desired. This icon is only visible 
from the book page editor screen. 

Customizing an icon 

Icons for inserted objects automatically have the same Style appearance that was defined for the book page itself. 
It is, however, possible to customize an icon with your own image. To do so, click on the option Image. This can be 
an existing image file or a screenshot that has not yet been created. 
You can also define an object's icon to be used as default on all the book pages. To do so, go to Book Page 
Initialization and insert the icon. 

7.5.11 Video Object 

 

The Video object displays inserted video files on a book page in an embedded player window. The object supports 
common video formats (see chapter Supported File Formats on Book Pages). 
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 Note 
To insert and view videos, authors and users need the relevant playback applications for the required formats to be 
installed on their workstations. These applications can be downloaded from the websites of the relevant 
manufacturers. Consult your administrator if required. 
Further information on formats is available in the chapter Requirements for Video Formats. 

Inserting a video 

To insert a video in your book page, proceed as follows: 

1. Select Insert Media Objects -> Insert Video in the toolbar.  

2. Select Edit Link...  for the Source parameter in the object editor. 
The Source dialog box is opened. 

1. Select Insert File... 

2. Select the file from your directory. Select Open.  

3. Select OK.  

The video is now displayed on your book page and can be played back. The file has been copied into the book page 
folder. 

 Note 
A page with the current settings is displayed by default for inserted media objects. This is only visible for editing 
and is hidden during playback. 

Alternative source 

The object supports a wide range of video formats within HTML 5 as well as further video plugins. The Alternative 
Source parameters allow you to insert additional files in different formats for a Video object. The alternatives are 
used to display a video, if a format cannot be played back due to a missing plugin or unsupported browser. 

Further settings 

• Show Control: 
Displays the control bar. 

• Start Automatically: 
Activate this parameter to playback the video automatically after the book page has been opened. If this 
setting has been deactivated, the learner needs to start the media file manually. 

• Hide Download Button: 
Activate this parameter to hide the download button in the control bar of the media player in Google Chrome. 

• Repeat: 
Activate this parameter to start the video again after playback. 

7.5.12 Audio Object 
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The Audio object plays back audio files on a book page. 

 Note 
The Audio object itself does not have a control option; it is only responsible for playing audio files. It is an empty 
object that is not visible on the book page. You can learn how to create controls for the Audio object in the relevant 
chapter. 

Inserting an audio 

To insert an audio file in your book page, proceed as follows: 

1. Select Insert Audio in the toolbar.  

2. Select Edit Link...  for the Source parameter in the object editor.  

3. Select Insert File... in the dialog box.  

4. Select the file from your directory and select Open.  

5. Confirm the dialog box with OK.  

The audio file is now displayed on your book page and can be played back. The file is copied into the book page 
folder. 

 Note 
A page with the current settings is displayed by default for inserted media objects. This is only visible for editing 
and is hidden during playback. 

Further settings 

• Sound channel: 
This parameter determines which channel is used for sound. 

• Volume: 
This parameter defines the default value of the volume (0-100). 

• Start automatically: 
Activate this parameter if you want file playback to be started automatically after the book page has been 
opened. If this setting is deactivated, the learner needs to start the media file manually. 

• Repeat: 
Activate this parameter if you want the object to start again after playback. 

7.5.13 HTML Document 

 

The object embeds HTML documents in an IFrame on the book page. 

Insert a HTML document in your book page as follows: 

1. Select Insert HTML Document in the toolbar.  

2. Select Edit Link...  of the Source parameter in the object editor.  
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3. Insert the Link of the desired HTML document.  

4. Select OK.  

The HTML document is now displayed on your book page. 

 Note 
It is not possible to link to a local page, because of browser restrictions. 
For linking a HTML Document object with a project of the workarea use the following link form: 
For example: project!PR_B9F988F508BF12AA:standard.html 

7.5.14 QR Code 

 

The object allows you to generate a QR code for a text or a URL and to display the QR code on the book page. This 
can be used to start specific content on a mobile device or to open a web page with further information. 

The object has the following specific parameters: 

• QR Code Data: 
Enter your data to generate the QR code. The data can be a text or a URL. 

• Open Link on Click: 
Opens the link when clicking the QR code. You can use the option if you entered a URL as QR Code Data. 

• Open in New Window: 
Opens the link in a new browser window. The option is shown if Open Link on Click has been activated. 

7.6 Object Parameters 

Various parameters are available for the inserted objects, which you can use to edit the design and positioning of 
individual and multiple objects. The parameters can be edited in the object editor for a selected object. 

 Note 
Not all parameters are supported for each object. These chapters give you a general overview of the 
available parameters. 

7.6.1 Editing Parameters 

There are various parameters available in the object editor for editing objects. These depend on the object in 
question: 
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General 

• Name: 
A name is automatically allocated to each object when it is inserted into the book. The name is customizable 
and its purpose is for internal use. The name will appear in the list of objects and when actions are assigned to 
it.  

• Text: 
Enter a text that should be displayed for the object. 

• Hide: 
The parameter defines whether an object is to be displayed or not. Should you not wish to display an object on 
the page then the parameter is to be deactivated. The parameter can also be used, to hide an object and to 
show it by using actions. 
A hidden object is displayed transparently in the editing view. 

Design 

• Background Color: 
This value can be used to define an object's background color. Select the color preview to open the Color 
Selection dialog box. Select Transparent , if you do not want to use any color. 

• Border: 
Defines the width of the border. The value is defined in pixels. If no border is to be displayed, the value is to be 
set to 0.  

• Border Color: 
This parameter determines the color of an object's border. Select the color preview to open the Color Selection 
dialog box. Ensure that you have previously specified a width for the border so that it is actually displayed.  

• Padding: 
The parameter Padding defines the internal spacing between the border and the text or image. The value is 
defined in pixels.  

• Scrolling Text (text field, active area): 
When this setting is enabled, text that is inserted will be displayed as scrolling text on the book page. The 
scroll movement goes from right to left.  

Formatting texts (Area: Design) 

• Font: 
The Parameter identifies the text font. The default setting for this is Arial.  

• Font Size: 
This parameter defines the font size. The value is defined in pixels.  

• Font Color: 
This value can be used to define an object's text color. Select the color preview to open the Color Selection 
dialog box. 

• Alignment: 
This parameter determines the alignment of the text in the text field. The default setting for this is Start. 

• Vertical Orientation: 
This setting defines the vertical orientation of text. The text orientation is set by default to Top.  
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7.6.2 Size and Position 

The subcategory Size and Position offers various functions for positioning an object, modifying its size and defining 
its behavior: 

• Left / Top: 
Defines the position, measured from the left-hand edge of the book page to the left-hand edge of the object as 
well as from the upper edge of the book page to the upper edge of the object. 
An object can be precisely positioned on the book page by altering the values. The values are defined in pixels. 

• Width / Height: 
These values specify the selected object's dimensions and can be customized accordingly. The values are 
defined in pixels. 

• Lock Position: 
This setting can be used to prevent objects from being dragged and dropped on the book page. This requires 
the setting to be activated.  

• Layer: 
Specifies the level on which an object is located on the book page. The background constitutes level 0, all 
succeeding objects increase incrementally from one. The assignment of a level to an object is determined by 
the sequence in which the objects were inserted on the page. 
You can move an object in the object list to the desired level. This depicts how the objects are arranged on the 
layers. 

7.6.3 Object Shadow 

To give your objects an additional effect and contrast you can insert a shadow. Shadows are supported for a large 
number of objects (for example: Image, Text Box, Active Area) and can be defined in the object editor. 

The following parameters are available in the subcategory Shadow: 

• Show Shadow: 
Activates the shadow for the object. Then you can edit the shadow properties below: 

• Shadow Color: 
Specifies the color of the shadow. Select the color preview to open the Color Selection dialog box. 

• Shadow Opacity: 
Specifies the opacity of the shadow in percent. 

• Shadow Blur: 
Specifies the blur radius of the shadow in pixels. If the value is set to 0, no blur is displayed. 

• Shadow Spread: 
Extends the size of the shadow in pixels. The default value is 0. 

• Shadow Horizontal / Shadow Vertical: 
Specifies the horizontal and vertical position of the shadow. The position is defined in pixels. 
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7.6.4 Link Parameters 

For some of the objects, for example, Active Area, Shape, and Image, you can specify a link to another object from 
the workarea, you can select an action, or you can specify a link to an external target. 

Link properties 

In the subcategory Link you can specify the link. There are the following parameters: 

• Link to: 
Specify the link for the object. 
To create a link, go to the Edit Link...  function. A dialog box is opened in which you can specify a link or 
select an object from the workarea.  

○ Current Object: 
You can select a sub object from the current object. 

○ Workarea: 
You can select an object from the workarea. For simulation projects, you can select a mode and a step. 

○ Actions: 
You can select an action for controlling the book reader. 

○ Free: 
You can specify a link to a web page or similar. 

• Tooltip: 
Enter a tooltip for the object displayed when the object is touched with the mouse. 

• Open in New Window: 
Use this parameter to open a link target in a new browser window. 
If the linked page or object from the workarea is opened in a new window then you can define properties 
dictating the appearance of the open browser window. 

• Enforce Download of Linked Content (Manager): 
Enforces the download of the linked content if the content is saved in Manager. The setting can be used for 
downloading documents, images, or DKP files. If the setting is deactivated, the content is shown in the 
browser window. 
 

New window properties 

If the link destination is opened in a new window, you can specify the way it is displayed. The following parameters 
can be set in subcategory New Window Properties: 

• Position 
The values Top and Left are used to determine the distance of the new window from the top and left-hand 
margin of the screen area. The values are stated in pixels. 

• Size 
The values Width and Height are used to define the size of the new window. The values are stated in pixels. 
The parameter Full screen defines whether the window is to be opened in full screen view. This requires the 
setting to be activated. 
The parameter Resizable defines whether the window can be scaled or whether the defined size is to be 
retained. Scaling requires the parameter to be activated. 



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   238 

 

• Layout 
You can display the following elements of the browser window in the new window. To do so, activate the 
relevant setting:  

○ Location bar 

○ Menu bar 

○ Scroll bars 

○ Status bar 

○ Tool bar 

7.6.5 Show in Documentation 

The subcategory Documentation allows you to export your book pages as documentation. 

• Show in Documentation: 
Specifies if the object is displayed in the documentation. Deactivate the option to hide an object in the 
documentation.  
This option is activated by default. 
Hidden objects with this activated option are also displayed in the documentation. Deactivate the option, if 
required. 

7.6.6 Status Bar of Control Objects 

Some book page objects are used to control media files or other objects and do not have an influence on the design. 
The controls are placed outside of the book page in the status bar. The control objects are placed in a row with the 
icons. 

The following objects are placed outside of the book page: 

• Audio Object 

• Time Control 

• Object Visibility 

• Counter 

• Collector 

Position of the status bar 

The position of the status bar in the book page editor can be defined in the object editor of the page object. Using 
the parameter Status Bar Position, you can choose either Top or Bottom. 
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7.7 Editing Objects 

Various functions are available for the inserted objects, which you can use to edit the design and position of 
individual objects and multiple objects. 

7.7.1 Inserting an Image 

The option Replace Image  of an Image parameter allows you to insert images in an Image or Page object. The 
following options are available: 

• Replace with screenshot of window: 
By moving the mouse over the screen display, specific areas will be recognized and outlined in red. Click on 
the mouse button to select the desired outlined area.  

• Replace with screenshot of object: 
By moving the mouse over the screen display, specific objects will be recognized and outlined in red. Click on 
the mouse button to select the outlined object.  

• Replace with screenshot of area: 
With the mouse, pull the red frame over the desired area and release the mouse button.  

After selecting the area, an editing window will appear where you can make adjustments as needed. To complete 
the process, click on Confirm Selection . The dialog box will close and the screenshot will be inserted into the 
HTML editor. 

• Replace with image file... 
A dialog box will open from which you can select an image from a data medium of your choice. Select the 
desired image and click on Open (in the Editor) to insert the image.  

• Replace with image from workarea... 
A dialog box will open, displaying the contents of the workarea. Select the desired image and click on OK (in 
the Editor). 

7.7.2 Grouping Objects 

The grouping of objects allows you to group multiple objects. A Group object is created, which can be used for 
animations or to move multiple objects as one object. The group object is also displayed in the object list. 

The following buttons are in the toolbar: 

 Group Objects 

 Ungroup Objects 

To group objects, proceed as follows: 
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1. Select all required objects for the group. 
You can use the Ctrl key to select multiple objects. 

2. Select Group Objects. 

To ungroup objects, proceed as follows: 

1. Select the group object. 

2. Select Ungroup Objects. 

7.7.3 Duplicating an Object 

You can use the Duplicate  function to duplicate an inserted object. Settings and shortcuts activated in this 
object are retained and can be reused.  

Select the object and select Duplicate in the toolbar. The duplicate is placed directly above the object and can then 
be positioned and edited on the book page. 

7.7.4 Using Guides 

Guides can be used to allow elements to be positioned and aligned with precision. You can use them, for example, 
to create design grids by drawing the guides on an empty book page then using this as a template for creating the 
remaining book pages of your book. 

Guides can be drawn both horizontally and vertically. The following buttons are available in the tool bar for inserting 
the guides 

 Insert Vertical Guide  

 Insert Horizontal Guide  

Once a guide has been inserted, the sizing handle can be used to move it on the book page using drag&drop. 
Clicking on the sizing handle displays the guide. If another object is selected, the guide is deselected. 

An object is aligned with the guide by moving it on the book page. When it is on a level with the guide, the line 
appears gray and the object is automatically positioned level with it.   

 Note 
In order to ensure that objects are properly aligned when dragging & dropping, you can activate the Snap-in-place 
options for objects from the central configuration dialog. The settings can be found under Application -> Book Page 
Editor. 



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   241 

 

7.7.5 Aligning Objects 

If you have positioned a number of objects on your book page, you can arrange these on one line. The following 
functions are available to you here as a result of which the objects can be arranged on the edge in question: 

 Left Align  

 Top Align  

 Right Align  

 Bottom Align  

These functions require a reference object to be selected on which the other objects will align themselves. Select 
the reference object and then click on the objects to be aligned while holding the Ctrl key depressed. You can then 
select the desired action in the toolbar. 

7.7.6 Resizing Objects 

To obtain uniform objects, you can align their dimensions with those of a reference object: 

 Same Width 

 Same Height 

 Same Size 

To this end, select a reference object with which the other objects will align themselves. Select the reference object 
and then click on the objects to be aligned while holding the Ctrl key depressed. You can then select the desired 
action in the toolbar. 

7.7.7 Arranging Objects 

The same spacing can be assigned to objects to arrange them in a consistent horizontal or vertical plane. To do so 
you must first align the objects horizontally or vertically on one line.  

Select at least three objects to be arranged. This is required as two reference objects define a spacing with which 
other objects align themselves.  
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Select the objects by clicking on them or draw a selection mask by clicking and holding the mouse button. Then 
click on the button of the function you want. 

Arrange objects horizontally 

 

Equal Horizontal Distribution: 
The spacing between the first object and the second is used as a template for subsequent objects and customized. 

 

Distribute Horizontally: 
The first and last object retain their position. The objects in between share the space so as to maintain equal 
horizontal spacing. 

Arrange objects vertically 

 

Equal Vertical Distribution: 
The spacing between the first object and the second is used as a template for subsequent objects and customized. 

 

Distribute Vertically: 
The first and last object retain their position. The objects in between share the space so as to maintain equal 
vertical spacing. 

7.7.8 Changing the Level of Objects 

If an object is concealed by another object in the view, you can modify the level of the object in question. Select the 
desired object and then click on one of the options. 

If you would like to change an object's level by one position, select the following functions: 

 Forward One Level  

 Backward One Level  

If you would like to place the object on the first or last level of all of the objects, then select the following function: 

 In the Foreground  
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 In the Background  

Alternatively, you can move an object in the object list to the desired level. This depicts how the objects are 
arranged on the layers. 

7.8 Actions and Effects on Book Pages 

Incorporating multimedia and interactive elements by adding actions and effects will turn your book pages into a 
didactically enhanced learning environment. You can choose from a wide variety of special effects to highlight 
specific steps and objects that are sure to capture and retain the learner’s attention. By doing so, you will help your 
users better focus on the important items that should be learned, and you will simultaneously promote sustainable 
learning by creating and fostering an enjoyable, interactive learning environment in which the user can explore, 
discover and retain new information. 

Object actions can be used to add interactive effects to individual objects. These actions can be triggered manually 
by the user or can be configured to run automatically. In addition, with special object actions, you can use actions to 
define and control certain effects. 

7.8.1 Object Actions 

You can define actions for book page objects in order to trigger the behavior of an entire book's or a book page’s 
display, such as having objects automatically appear on the book page or jumping to the next page. Object actions 
give authors greater flexibility in creating interactive content. 

The actions can be defined in the object editor, in which you will find an area that is also called Actions. Specific 
actions are displayed for each object that can be used in conjunction with them in book pages. 

The components of an object action 

An object action consists of an executable action, an object that should be affected via this action, and the behavior 
to be triggered. The available actions and behaviors depend on the type of object and can be used in a variety of 
ways. You will find more information on this step below (see Overview of the Actions and Behaviors). 

The following is an example of how to insert an action into an Image object:  
On Click > Text > Show 
When the user clicks on the image, the Text object that was selected will appear.  

Multiple behaviors assigned to one action 

You can assign as many behaviors to one individual action as you would like. To trigger multiple behaviors, simply 
click on the plus icon next to the dropdown box. This allows you, for example, to fade objects in and out. You can 
remove a behavior by clicking on the minus icon next to the dropdown box. 

The following section will give you an overview of the variety of object actions that are available for enhancing your 
book pages and will describe specific use cases. 
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7.8.1.1 Fading Objects In and Out 

A fade over effect can be used to naturally and smoothly fade objects in and out. The following actions can be 
assigned to certain types of objects, in order to obtain the desired effect: 

• Animate In 

• Animate Out 

• Animate Toggle 

or 

• Fade In 

• Fade Out 

• Fade Toggle 

Depending on the object the subcategory Animation or Fade In / Fade Out might also be available. 

 Note 
For Animate In or Fade In actions the assigned object has to be set to Hide. 

Subcategory Animation 

The subcategory Animation contains the following parameters: 

• Show Effect: 
Defines the effect type for showing the object.  

○ Fade In 

○ Fly In - From Left 

○ Fly In - From Right 

○ Fly In - From Top 

○ Fly In - From Bottom 

○ Zoom In 

○ Bounce In 

• Hide Effect: 
Defines the effect type for hiding the object.  

○ Fade Out 

○ Fly Out - To Left 

○ Fly Out - To Right 

○ Fly Out - To Top 

○ Fly Out - To Bottom 

○ Zoom Out 

○ Bounce Out 

• Duration: Show Effect: 
Determines the length of the show effect. The value is defined in seconds. 

• Duration: Hide Effect: 
Determines the length of the hide effect. The value is defined in seconds.  
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Subcategory Fade In / Fade Out 

The subcategory Fade In / Fade Out contains the following parameters: 

• Fade In/Out: 
Specifies that a fade-in effect is displayed for fade-in/out. The effect is not displayed when the setting is 
deactivated. 

• Fade In Duration: 
Determines the length of the fade-in. The value is defined in seconds.  

• Fade Out Duration: 
Determines the length of the fade-out. The value is defined in seconds.  

7.8.1.2 Controlling Audio with Actions 

Actions can be assigned to individual buttons in order to control an Audio object. You can customize the functions 
to suit your specific needs. For example, you can define objects, for example, an image or a text field, to be used as 
a button. When the user clicks on the image or text button, you can define the button in such a way so that the 
corresponding audio file will automatically play. 

 Recommendation 
In the case where an Audio object should be controlled via a button, we recommend that you disable the Audio 
object’s setting Start automatically. This will allow the user to interact with the learning content and start the audio 
at the appropriate/desired time (for example, by clicking on a play button). Moreover, you should give your objects 
unique names upon inserting them into your book pages in order to create transparency and facilitate selecting 
and assigning them when creating your learning content. 

For more information, refer to the section Overview of the Actions and Behaviors. 

Control actions 

To create an object to control an audio file, such as an image, proceed as follows: 

1. Insert and position your Image object to be used for the button. (More detailed information on objects is 
provided in a further section in this document.) 

2. From the subcategory Actions, you can define the specific actions that your Image object should execute.   

1. From the first dropdown list, select the Audio object that should be used for the action, for example, On 
Click. This will automatically create a link to the Audio object. 

2. From the second dropdown list, you can define the behavior, for example, Play. You will find a variety of 
audio behaviors listed here.  

3. You can now repeat these steps for any additional buttons that you would like to add. 

Actions in an Audio object 

Under the subcategory Actions, Audio objects can be used in combination with various object actions to control the 
audio file. 
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For example, a button can be defined to switch back and forth between two different actions by clicking on it in 
order to control the audio file, just like with the standard mute/unmute or play/pause buttons. This changeover can 
be defined by inserting a second Image object and positioning this on top of the original image and then defining the 
image to fade in and out accordingly. The following is an example of how to create an Audio object for play/pause: 

• On play 
> image “pause” > show 
> image “play” > fade out 

• On pause 
> image “play” > show 
> image “Pause” > fade out 

To display or minimize the full list of behaviors to choose from for an action, click on the plus and minus icons and 
the list will appear. 

7.8.1.3 Overview of the Actions and Behaviors 

The list gives you an overview about common used types of actions and behaviors. The available types and also 
further types depend on the used and linked elements. 

Actions 

Action Description 

On Click 
Describes the action that should be carried out when 
the object is clicked on. 

On Mouse Roll-Over 
Describes the action that should be carried out when the 
object is moused over. 

On Mouse Roll-Out 
Describes the action that should be carried out when the 
mouse rolls out of the object. 

On Show 
Describes the action that should be carried out when the 
object appears. 

On Hide 
Describes the action that should be carried out when the 
object disappears. 

On Visible 
Describes the action that should be carried out when the 
object is visible after fade in. 

On Hidden 
Describes the action that should be carried out when the 
object is hidden after fade out. 

On Play 
Describes the action that should be carried out when the 
object is playing. 
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Action Description 

On Pause 
Describes the action that should be carried out when the 
object is paused. 

On Stop 
Describes the action that should be carried out when the 
object is stopped. 

On Finish 
Describes the action that should be carried out after the 
object has played. 

On Mute 
Describes the action that should be carried out when the 
sound is deactivated. 

On Unmute 
Describes the action that should be carried out when the 
sound is activated. 

On Volume Change 
Describes the action that should be carried out when the 
volume is changed. 

Behaviors 

Behavior Object 

Show Shows the specified object after an action is executed. 

Hide Hides the specified object after an action is executed. 

Toggle 
Shows/hides the specified object after an action is 
executed. 

Fade In Fades in the specified object after an action is executed. 

Fade Out 
Fades out the specified object after an action is 
executed. 

Fade Toggle 
Toggles the fade in/ fade out of the specified object after 
an action is executed. 

View Link 
Views the link target of the specified object after an 
action is executed. 
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7.8.2 Animation Objects 

Action objects can be used to add special effects and animation to your learning content to create motivating and 
interactive presentations for the learners. The action objects are found in the book page editor. Besides the basic 
actions that are available, you can define more complex actions for an object. You can influence an action’s 
behavior by configuring its settings to suit your individual needs. The objects in this case are “blank”, only serving 
as a definition for the actions and do not contain any content, such as text or images. 

 Recommendation 
Before creating an action object, you should become familiar with how actions work so that you can take 
advantage of their versatility. 

Modifying objects and their behaviors 

The following action objects are available in the book page editor: 

• Animation 

• Time Control 

• Object Visibility 

• Counter 

• Collector 

7.8.2.1 Use Cases 

Action objects can be used in combination with additional book page objects, giving you a wide variety of use cases 
and plenty of room for your own creativity. The following examples will give you an idea of how action objects can be 
used: 

Animation 

Animations can be used to creatively highlight specific pieces of information. For example: 

• To attract the learner’s focus to a certain image, this image can be defined so that its size automatically 
increases when the book page is displayed. 

• Several objects can be grouped together and displayed in a smaller format to save space. The user can then 
individually click on the images to zoom in on them. In this way, the user can concentrate more on each 
individual image and the respective learning material as needed. 

• Mouse rollovers and rollouts can be used to add effects to text and important information to enhance the 
learning experience. The original state of the text will then be automatically restored. 

Time Control 

The Time Control allows you to define how long the action should take place: 

• You can use the Time control with images to create an automatic slide show in which the images automatically 
fade in and out. 
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• You can sequentially start various animations to create complex processes and visualizations. 

• The gradual fading in and out of text allows you to optimally visualize a sequence of information. Such 
animated text is perfect for accompanying audio text, for example. 

Object Visibility 

The Object Visibility is ideal for sequentially selecting multiple objects. For example: 

• To create image galleries on book pages - the user can then click through the gallery at his own pace. 

• For visualizing process workflows in which individual steps can be selected. 

7.8.2.2 Considerations for the Creation 

When working with action objects, we recommend that you take the following guidelines into consideration prior to 
starting the creation process in order to be able to fully take advantage of their versatile functionality: 

• Before you begin, we suggest creating a storyboard to help you optimally plan which behaviors should be 
assigned to which actions and how the users should interact with them. 

• Do not go overboard with the number of effects per page. Try to limit the number so that the important 
information is highlighted, while simultaneously ensuring a transparent and user-friendly look and feel to each 
page. Simple effects, such as clicking on objects and automatically having content fade in and out can prove 
to be quite useful enhancements to your learning content as long as the page is not cluttered with so many 
animations and interactive elements that it would overwhelm the user. 

• Always make sure you assign unique names to your objects (under the setting Name). This will make it easier 
for you when selecting objects and actions so that you can quickly find the one you are looking for. 

• When inserting animations, make sure you know which level the objects are on in order to avoid accidentally 
hiding them. On the other hand, when this technique is intentionally used, you can easily hide specific objects. 

• Animations that are used repeatedly throughout your book can be predefined on a book page template to save 
you time when creating a new book page with the same animation. 

7.8.2.3 Animation 

 

Animation objects allow you to change the position and size of your animations. The Animation object defines the 
final size and position for the animation. To adjust the animation's size, the Animation object can be proportionally 
scaled in height. 

Structure of an animation 

The following explains how an animation works: 
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• Initial State 
The object to be animated (for example, an Image) is created with the same size and position as its initial 
state. 

• Final State 
When the animation is activated, the object will change to the size and position of the Animation object (red 
rectangle). 

Creating an animation 

The following is an example of how to create an animation: 

1. Create an Image object and position it as desired to serve as the initial position. 

2. Insert an Animation object (from the toolbar) and define its properties:   

1. Move the Animation object to the desired final position and adjust the frame size. If the object should be 
the same size as the image, you can enter the exact dimensions under Position. 

2. Name: 
Enter a unique name for the object to facilitate allocating actions at a later time. 

3. Target Object: 
Select the Image object as the Target Object.  

4. Duration: 
Here you can define how long the animation should run. The value is calculated in seconds.  

3. The animation can be interactively triggered by the user or defined to run automatically by assigning actions 
to the animation. 
For each action, you have to select the Animation object from the first dropdown list, and the behavior Start 
from the second dropdown list.  
For example:   

○ Action on Click – the user clicks on an Image or Text object to start the animation 

○ Action after Loading – the animation automatically plays when a book page is opened  

○ Action after Timeout – a Time control object can be used so that the animation will automatically play 
after a defined period of time  

Once you have created your animation, you can test it out by clicking on the Preview button in the book page editor. 

Stopping an animation 

In addition to the behavior Start, you can also define the animation to automatically stop. Simply select the behavior 
Stop from the list. For example, you can add start and stop buttons to your animation by inserting and defining 
Image objects. 
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Additional options 

• Easing: 
Easing effects the time duration of an object, allowing the animation a more effective and smoother transition. 
Easing can take place at the beginning, at the end or both. There are three types to distinguish between:   

○ Quadratic 

○ Cubic 

○ Sine  

• Show Debug Information: 
This setting allows an object’s status information to be displayed while the book page is playing. This will 
display additional information on the object’s action while it is being executed in test mode to give you more 
control over the action.  

• On Start (under Actions): 
When an animation starts, another action can be triggered simultaneously. For example, an additional 
animation can start, an audio file can play or a Text object can be displayed. This allows you to create 
relationships between the objects and learning content can be sequentially structured if desired. 

• On Stop (under Actions): 
An action can be defined to be executed when an animation stops. In contrast to the option Action after 
animation, this allows you to stop the animation at any time, thereby changing a button’s behavior, for 
example, a button can be defined to continue the animation. 

• On Finish (under Actions): 
Once an action has been completed, another action can be triggered, such as other animations or 
automatically jumping to the next page.  
To do so, select the desired object and the action to be allocated to it under Settings. 

 Note 
When using images with transparency, clicking on the transparent area will trigger the animation. To prevent 
undesired actions from being performed by the user, we recommend using images without any transparency. 

 Recommendation 
If you would like to re-use an animation that you have already created, you can copy and insert the respective 
objects collectively in groups. The objects are automatically recreated and allocated without requiring any 
additional post-editing work required. 
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7.8.2.4 Time Control 

 

A Time Control object allows you to precisely time your actions. Images can automatically fade in and out or 
animations can be combined to create sequences. 

 

To set up a Time Control: 

1. First create the object that you would like to start off with. This could be an animation, an Image object or a 
similar object. 

2. From the toolbar, insert the Time Control object. 

3. Next, define the time intervals and the corresponding actions. 
To obtain a clear overview of your animation projects, we recommend that you arrange your objects and 
actions according to their time control settings in chronological order.   

1. Time: 
In this field, you can enter the length of time during which the action should be carried out. The value is 
calculated in seconds.  

  Note  
Time values are not automatically combined. If you would like to have multiple actions begin simultaneously, you 
have to manually summarize and enter the time values, for example, 20, 40, 60,...  

2. On Timeout: 
In this field, you can select the action that should be triggered once the defined period of time has run 
out.  
For example: Image -> Show, Animation -> Start  

4. In order to start a Time control, an action has to be triggered by the user. This can be a button, for example, 
that starts a series of images. For this example: Actions -> Action on Click -> Time Control -> Action Start. 
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7.8.2.5 Object Visibility 

 

With the help of the Object Visibility, you can fade objects in and out, one following another, which can be triggered 
by user actions. This allows the user, for example, to click through a series of images in any preferred order. 

 

To create an Object Visibility: 

1. Create your Image objects and position them as desired. 

2. Set all images to hidden except for the first one that should appear. This allows images to fade in one by one. 

3. From the toolbar, insert the Object Visibility and define its properties:   

1. Name: 
Enter a unique name here so that you can easily identify your Object Visibility when selecting it from the 
list at a later time. 

2. Object 1-10: 
Select the objects in the order in which they should appear, from 1-10.  

4. Next, successively select the Image objects in order to assign the Object Visibility to the images. Under 
Actions, you have to define an action for each individual image in order for it to be able to switch to the next 
image, for example, Action on Click. From the first dropdown list, choose the Object Visibility and from the 
second dropdown list, select Activate 1-10 for each object. 

Once you have created your Object Visibility, you can test it out by clicking on the Preview button from the book 
page editor. 

Additional options 

• Fade In/Out: 
This setting allows you to define a smooth transition effect for objects when they fade in and out. 

• Show Debug Information: 
This setting allows an object’s status information to be displayed while the book page is playing. This will 
display additional information on the object’s action while it is being executed in test mode to give you more 
control over the action. 
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7.8.2.6 Counter 

 

The Counter object allows you to specify a sequence of different actions. One or more objects can be used to trigger 
the actions of the Counter. With each action on a triggering object the Counter counts up or down and executes the 
specified actions. For the triggering object, you can specify, how many actions are required. 

For example, you can use the object to display a different image every time you click on a button. 

To create a Counter, proceed as follows: 

 Note 
The following instructions are only an example of how to use of the Counter object. 

 

1. Insert Image objects 

1. Create your Image objects. 
See also Image. 

2. Position the images as required. 

3. Set all images to hidden. This allows the images to fade in. 

2. Insert the Counter object 

1. Insert the Counter object from the toolbar. 
The object is inserted in the status bar. 

2. Specify the parameters for each count: 

1. Count: 
Enter the number of clicks required to show the object. 

2. On Count: 
Select an Image object from the first drop-down list. 
Select a behavior from the second drop-down list, for example, Animate In. 

 Recommendation 
To hide the previously shown Image object, you can specify also an Animate Out behavior for the object in the On 
Count parameter. 

3. Start the Counter 

1. Insert an object from the toolbar, for example, a Shape. 
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2. Design and position the object as required. 

3. Open the Actions subcategory.  

4. Specify an action parameter, for example, On Click.  

1. Select the Counter object from the first drop-down list. 

2. Select Count Up from the second drop-down list. 

 Recommendation 
You can assign the Count Up action to one or more objects. 

Resetting the counter 

You can allow the user to reset the current status of the Counter to the initial status. First, create a reset control and 
then specify which objects are hidden for the used Images objects. 

To create a reset control and a behavior for all required objects, proceed as follows: 

1. Insert an object as a reset control. 

2. Select the object. 
Specify the Reset action: 

1. Open the Actions subcategory. 

2. Activate the On Click parameter. 

3. Select the Counter object from the first drop-down list. 

4. Select Reset from the second drop-down list. 

3. Select the Counter object. 
Specify the Reset behavior: 

1. Activate the On Reset parameter. 

2. Select the Image object from the first drop-down list. 

3. Select Animate Out from the second drop-down list. 

4. Repeat this for all required objects. 

7.8.2.7 Collector 

 

The Collector object allows you to specify a sequence of different actions. You can use different objects to trigger 
the actions of the Collector. When executing an action on an triggering object the Collector executes the specified 
actions. One object can only be used once to trigger specified actions of the Collector. Afterwards, another object 
can be used to trigger the next actions. 

For example, you can use the object to display an image when you click on an assigned control. 

To create a Collector, proceed as follows: 
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 Note 
The following instructions are only an example of how to use of the Collector object. 

 

1. Insert Image objects 

1. Create your Image objects. 
See also Image. 

2. Position the images as required. 

3. Set all images to hidden. This allows the images to fade in. 

2. Insert the Collector object 

1. Insert the Collector object from the toolbar. 
The object is inserted in the status bar. 

2. Specify the parameters for each count: 

1. Count: 
Enter the number of clicks required to show the object. 

2. On Count: 
Select an Image object from the first drop-down list. 
Select a behavior from the second drop-down list., for example, Animate In. 

 Recommendation 
To hide the previously shown Image object, you can specify also an Animate Out behavior for object in the On 
Count parameter. 

3. Insert a button 

1. Insert an object from the toolbar, for example, a Shape. 

2. Design and position the object as desired. 

3. Open the Actions subcategory. 

4. Specify an action parameter, for example, On Click. 

1. Select the Collector object from the first drop-down list. 

2. Select Flag 1 - 10 from the second drop-down list. 

Using Flags 

The Flag specifies, that the Collector is started for a specific action. Specify for a different Flag from 1 to 10 each On 
Click action.  
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Please note, that the number of the Flag does not indicate a specific On Count action. The On Click action of the 
objects can be executed in any order. 

If you click on an object, the On Count action with the specified number of clicks (for example, first click) is 
executed. Afterwards the object with the specific Flag is deactivated. Click on another object to execute the next On 
Count action (for example, second click).  

You can use the same Flag (for example, Flag 1) for different objects. If an action has been used for a Flag, the other 
objects with the same Flag are deactivated. 

The use of the Flags allows you to create complex combinations and conditions to show or hide objects. 

Resetting the collector 

You can create a reset control, to allow the user to reset the current status of the Collector to the initial status. 

To create a reset control and a behavior for all required objects, proceed as follows: 

1. Insert an object as a reset control. 

2. Select the object. 
Specify the Reset behavior: 

1. Open the Actions subcategory. 

2. Activate the On Click parameter. 

3. Select the Collector object from the first drop-down list. 

4. Select Reset from the second drop-down list. 

3. Select the Collector object. 
Specify the Reset behavior: 

1. Activate the On Reset parameter. 

2. Select the Image object from the first drop-down list. 

3. Select Animate Out from the second drop-down list. 

4. Repeat this for all required objects. 

Additional options 

• Show Debug Information: 
This setting allows an object’s status information to be displayed while the book page is playing. This will 
display additional information on the object’s action while it is being executed in test mode to give you more 
control over the action. 

7.9 Templates for Content Objects 

You can insert the content of objects into a book page template in order to use text units  and simulation 
projects  as well as media objects in books. This supports a separation between content and design and 
simplifies the production for a large number of content objects. During playback, the properties of the text units or 
projects with modes are inserted automatically by the book reader. Each object is displayed as a single book page, 
which shows the created content. 

Creating a template 
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Proceed as follows to insert text units or projects into a book page: 

1. Create a book using the New Book  toolbar entry. 

2. Insert the content objects, for example, projects, into the book with the required structure. You can also use 
both types in a book. 

3. Create a book page using the New Book Page  toolbar entry. To use it as a template, we recommend that 
you save the book page in a separate template group in the workarea structure. 

4. Open the book page in the book page editor.  

5. Insert an empty Text Box object as placeholder for the content properties of the object. The property 
displayed by each text box must be specified in the Name parameter of the text box, see below.  

1. Projects 
You can insert a mode link in the template to use a specific project mode by default.  
Insert the Mode Link object for the required mode and specify the use of the mode in the Name 
parameter of the object. 

2. Media object 
You can insert the media content in the template to allow users to start or to open the content. 
Insert a Text Box object and specify the required media type in the Name parameter of the object. 

6. Save the book page. 

7. Open the Settings  dialog box in the section Playback Settings -> book reader -> Templates. Specify the 
settings and confirm with OK. 

Playback settings 

For each type of content object there are two playback settings: 

• Show <object> Properties 
Activate this setting to display the content of the content object. 

• Template for <object> 
Select your created book page template for the content object. 

Name entries 

Value Description Example 

caption Name 

 

shortdesc Short Description   

description Description   

Project     
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Value Description Example 

demo_link Demo Mode 

 

uebung_link Practice Mode   

test_link Test Mode   

praxis_link Concurrent Mode   

Media object     

video Video Object   

audio Audio Object   

image Image Object   

doc Document Object   

file File Object   

7.10 Modeling Business Processes 

You can create models for business processes using the BPM Object. The versatility of creation supports complex 
models at several process levels. 

A BPM Object represents a process step here while the combination of several BPM Objects represents the entire 
process. You can use the Connection object to combine process steps in the form of arrows and visualize their 
sequence. 

7.10.1 Creating Processes 

If you want to create a process manually, proceed as follows: 

Structure of a process step 

A process is comprised of BPM Objects that are connected with arrows. You can use text boxes to insert the actions 
and information necessary for a process step via the arrows. 
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• Process step: 
Indicates the name of the process step and is displayed in the main field of the object. 

• Role: 
Indicates the role or function for the process step and is displayed in the lower field of the object. 

• Annotation: 
Additional Annotations for a process step can be entered in the respective field. The annotation is displayed by 
clicking the icon in the object. 
Icon: Bubble 

• Link to: 
A link to another book page to access more in-depth information. For example, a process can be created as an 
overview with more in-depth process steps on other book pages. 
Icon: Arrow 

• Attachment: 
Documents, projects, book pages or files can be linked by the attachment. Up to 10 attachments can be 
defined. When opened via the icon, a menu is displayed with all attachments and the selected attachment then 
opened in a new window. 
Icon: Paper clip 
The option Open link in new window allows you to define whether the attachment should open in the same or in 
a new window. The window’s appearance can be defined under New Window Properties. 

The content that is displayed via an icon can be accessed by clicking the icon. 

 Recommendation 
The icons used for the BPM Object are found in the respective book page style. If you want to use icons other than 
the standard icons, they are to be replaced in the respective folder. Make sure to keep the names and size of the 
icons. 

Design of a process step 

• Text Style Role: 
The design of the text and background for the role can be set in the Text Style Role area. 

• Design: 
The background color of the field for the process name and the border of the entire object can be changed in 
the area Design. 

7.10.2 Connecting Objects 

The inserted BPM Objects can be connected using a Connection object and the process direction shown using 
arrows. A path can be created with an arrow here. This can be either a simple line or a complex structure with 
several path items. 

Defining an arrow 

An arrow object can be customized as follows: 



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   261 

 

• Color: 
Specifies the arrow's color. Select the color preview to open the Color Selection dialog box. 

• Thickness: 
Specifies the arrow's thickness. The value is given in pixels.  

• Arrow Head 1 & 2: 
Specifies the arrow's head for each side of the arrow. 

Positioning a path point 

There are path points at the beginning and end of an arrow that allow you to adjust its length and direction. Select 
one of the points and drag and drop it to the desired position on the book page. 

Creating complex paths 

Process structures do not usually just go in a straight line but are much more complex. You can use the Connection 
object to create paths with several path points and corners. Keep in mind that the paths can only be aligned 
horizontally or vertically here. The number of path points is also limited to 10. 

Inserting a path point: 

1. Press and hold the Shift key.  

2. Select the mouse on the point where you want to add the new point.  

3. Drag this point to the position you want.  

Removing a path point: 

1. Press and hold the Alt key.  

2. Select the mouse on the point where you want to remove the point. 
Keep in mind that only points at the end or beginning may be removed. 

7.11 Importing Images as Book Pages 

When creating backgrounds for your book pages, you can save time by importing images into the Producer to use 
as a new book page. 

To import your images, proceed as follows: 

1. Select Tools -> Import-> Images as Book Pages... in the Explorer. 
A dialog box is opened. 

2. Select the images you want to import and select Open. You can select more than one image at a time. A 
separate book page will be created for each image selected.  

3. A dialog box with the following settings appears: 

○ Insert as Image Object: 
Here you can decide whether the image should be inserted as an image object on the book page or 
directly as an image on the book page's background.  

○ Orientation: Left/Top: 
This defines the position of the image on the book page if you chose to insert the image as an object.  



 

Producer (Cloud Edition) 
Books and Book Pages 

 
PUBLIC   262 

 

○ Size: Width/Height: 
This defines the image’s size. If the image has not been defined as an object, then this setting can be 
used to adjust the image's size on the book page’s background.  

○ Resample Images: 
This option will adjust the image file to the defined width and height. When this option is deactivated, the 
file will be imported in its original size.  

○ Keep Aspect Ratio: 
This option will retain the image’s aspect ratio and adjusts itself to the width of the image accordingly. 
This option ensures that the images are not proportionally distorted.  

○ Add to Current Book: 
If a book is selected to be imported from the Explorer, this option allows you to define whether the new 
book page should be inserted into the book. When this option is deactivated, the book page will be 
inserted as a stand-alone object at the end of the object tree.  

4. Select OK.  

The book page with the image will then be created and inserted into the Explorer. The book page’s name will be the 
same as the image title. 

7.12 Importing Microsoft PowerPoint Slides as Book 

In order to be able to use Microsoft PowerPoint presentations in a more versatile way, the slides can be converted in 
book pages in the Producer. This allows you to complement the slides with other objects, such as media files. The 
conversion is performed using the PowerPoint as Book… function. 

Importing a PowerPoint file 

To import a PowerPoint as a book, proceed as follows: 

1. You can use the Explorer to import your PowerPoint slides as a book. 
If you would like to incorporate these slides directly into an existing book, first select the book. 

2. Select Tools -> Import -> PowerPoint as Book... 
The settings dialog box appears. 

3. Select an Import Method and select OK. 

○ Import all slides from PowerPoint file: 
Allows you to specify a PowerPoint file in the File Name parameter. 

○ Import selected slides from PowerPoint file: 
Allows you to select PowerPoint slides in an open file. 

4. Select OK. 

5. Open your presentation and select the slides to be imported. Select OK in the dialog box displayed in the 
Producer. 

The slides are now imported into the workarea and converted into image files. Each slide is created as an individual 
book page. All the book pages are then consolidated into a book. The book is named using the name of the 
PowerPoint file and the book pages are named using the name of the corresponding slides. 
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You can add additional book pages to the book after it has been created, add additional content to the book pages, 
or simply retain the presentation in its existing form. 

Settings of the dialog box 

The dialog box for the import contains the following settings: 

• Book Title: 
Specifies the title of the book. The title of the PowerPoint file is used by default. 

• Slide Size: 
Specifies the size of the PowerPoint slides. The original size of the slides is selected. You can select a different 
size or enter a size by using the option User defined. 

• Language: 
Specifies the language of the content. Select the language from the drop-down list. 

• Book Description: 
Specifies the description of the book. You can enter a text. 

• Keywords: 
Specifies keywords for the book. You can enter keywords. 

• Notes as Book Page Description: 
Specifies whether the slide notes are inserted into the book page descriptions. 

• Notes as Text-to-Speech Text: 
Specifies whether the slide notes are inserted as text for Text-to-Speech. 

• Record Audio After Import: 
Once the PowerPoint slides have been imported, the book is opened in the book page editor. The Add Audio 
dialog box opens where you can record audio. See also the Add Audio Dialog Box chapter. 

• Add to Current Book: 
This option is available if you select a book from the tree structure. Select this option if you want to 
incorporate the PowerPoint slides into the book. 

7.13 Global Settings for Book Pages 

The standard settings for creating and editing book pages can be specified in the Settings...  dialog box. There 
are the following setting categories: 

• Templates (Producer): 
Templates can be defined for books and book pages and can be used when inserting new objects. Once the 
template has been created, you can define its settings here under Templates.  

• Book Page Editor (Authoring Settings): 
Here you can define the settings for the grid and grid lines in the book page editor as well as its behavior when 
positioning objects.  

• Book Page Initialization (Authoring Settings): 
Default settings can be defined here for book page objects. In this way, the book page objects are assigned 
values that are automatically allocated to them upon creation. 
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• Book Page Fallback Defaults (Playback Settings): 
The fallback default settings can be configured here for book page objects. The Producer uses these values 
when the respective setting is deactivated for a object.  

 Recommendation 
To only snap-in objects when necessary, you can temporarily activate this snap-in behavior by holding down the 
Ctrl key. The snap-in function overall is to be deactivated in the settings beforehand and the desired snap-in 

options activated. 

Furthermore, you can define settings for the playback of books and book pages with the book reader: 

• book reader (Playback Settings) 

7.14 Books and Book Page View 

For the book pages view it is necessary to distinguish whether these pages were inserted in a book or placed 
individually. An individual book page is opened in the library view whereas a book is presented in the book reader. 
After they are selected, modes linked on a book page are opened in the trainer. 

 Note 
If you have inserted media files in a book page, then the corresponding playback application needs to be installed 
on the users' workstations so that these files can be displayed. 

Books view 

Books that have been created are displayed in the book reader. This enables selection of, and scrolling within, 
pages. Once a book page has been called, objects in it can then be launched or opened so that they can be worked 
through. 

When a book is called in the library it is launched directly in the book reader. 

Book pages view 

Individual book pages are not viewed in the book reader as this is intended for scrolling through a number of pages. 
If you select an individual book page in the library it will be displayed directly in the learning content view. 

7.14.1 Preview in the Book Page Editor 

 

The Preview function exists in order to be able to view and use a book page during editing in the book page editor in 
the same way it is displayed to the student. If you select this in the toolbar, you will be able to test your book page's 
objects. These will then behave in the same way as they do when being presented in the library or book reader. 

In order to be able then to resume editing the objects, deactivate the button. 
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7.15 Supported File Formats on Book Pages 

Media plug-in Supported file formats 

Audio, Page Sound *.mp3, *wav 

Video *.avi, *.m4v, *.mov, *.mp4, *.mpeg, *.mpg, *.qt, *.rm, *.wmv 

Image *.gif, *.jpg, *.png, *.bmp, *.jpeg, *.svg 

Document *.doc, *.docx, *.rtf, *.ppt, *.pptx, *.xls, *.xlsx, *.pdf, *.html, *.htm 

7.15.1 Requirements for Video Formats 

The table gives you an overview of the supported video formats of SAP Enable Now and the possible operating 
systems and browsers: 

Formats  Windows 10 Apple Android 

Format Codec Desktop Mobile Safari / Webkit Webkit 

mp4 h264     

  mpeg4     

avi xvid     

  h264     

mpg mpeg2     

wmv wmv3     

  vc1     

mov       

qt       

 Supported 

 Unsupported 
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8 Text Units 

The Text Unit structure object makes it possible for you to integrate text components into your structure. Using 
different types, a text unit offers various options for incorporating additional information and content into your 
structure and using them for various output formats. 

In its structure, the text unit object is slightly based on the topic object of the DITA method for representing 
information structures. It provides a set of types to primarily target possible needs in structural creation and 
administration of didactic content. Nevertheless, it can be used as well to store project related or procedural 
information within the workarea. 

Integration in the explorer 

The text unit object can be integrated anywhere in the tree structure, keeping in mind the possibilities of other 
structure objects. Similar to the Group object, any structure object can be stored below a text unit. 

8.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

8.2 Text Unit Types 

Changing the type of a text unit changes the symbol the object is displayed by in the tree view of the Explorer. The 
following types are available. 

Icon Type Icon Type 

 General  Defect 

 Concept  Subsystem 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_7CD1E55C82CE4089
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Icon Type Icon Type 

 Task  Component 

 Reference  
Function 

  

 Problem  
Requirement 

  

 Job  
Glossary 

See also Glossary of Terms 

     

Translation Info 

See also Mass Translation 

of a Content Structure 

8.3 Structure 

Unlike, for example, projects, a text unit does not have any individual object content. Information is displayed solely 
in the areas shown in Explorer: Title, Short Description and Description and structurally by selecting a Document 
Type. The functions of the HTML editor are available for making entries in the areas Short Description and 
Description. 

You can structure your information more systematically because there is a distinction made between the input 
areas Short Description and Description. If you use the optional Short Description box, you can improve user 
orientation within the information structure with much shorter texts that summarize the topic. The Short 
Description can be used here exclusively for orientation purposes (example A) or simultaneously function as a 
thematic introduction with a smooth transition to the detailed Description (example B). 

  Example A Example B 

Title Formatting in documents Formatting in documents 

Short description 
This chapter shows you how 
formatting is applied to document 
areas and paragraphs.  

It's happened to everyone.  
An important document has to be 
read quickly and its content 
captured. However, the document is 
poorly formatted or not formatted at 
all - logical correlations disappear 
because there are no paragraphs or 
headings while a lack of visual 
information in the body text makes 
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  Example A Example B 

comprehension difficult for the brain. 

Description 

You can use formatting to 
systematically highlight the main 
content of your document for the 
reader and structure the document 
so that it is easier to read and 
capture. 

Well-formatted documents are easier 
to read and their message is clearer 
for the reader. But what do you need 
to keep in mind if you want to format 
and structure a document so that it 
is easy to read? The projects shown 
in this area... 

8.4 Content-Based Separation Through Typification 

The advantage of differentiating among different types of text units is that contents can be represented flexible but 
consistent by the content-based logic of the available types. However, you may freely determine the content 
specifications for a type different than the type name proposes but you should ensure to maintain a logic that you 
applied once for a type to each object of that type in the workarea. This allows you to combine several types in each 
structure level achieving parallel information layers to be added for example to a project. 

Example 

A group "Formatting documents" might have the following types providing different information layers for different 
use cases. 

Type Input field Text 

General Title Formatting in documents 

 Short description 

It's happened to everyone.  
An important document has to be 
read quickly and its content 
captured. However, the document is 
poorly formatted or not formatted at 
all - logical correlations disappear 
because there are no paragraphs or 
headings while a lack of visual 
information in the body text makes 
comprehension difficult for the brain. 

 Description 

Well-formatted documents are easier 
to read and their message is clearer 
for the reader. But what do you need 
to keep in mind if you want to format 
and structure a document so that it 
is easy to read? The projects shown 
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Type Input field Text 

in this area... 

   

Task Title Formatting in documents 

 Short description 
Create a formatted, easy to read 
document. 

 Description 

Create a document that uses the 
formatting described and is thus very 
easy to read. The document has to 
be at least 20 pages long with 30 
chapters. Pay special attention to 
creating header levels to maintain a 
well-structured content overview. 

   

Concept Title Formatting in documents 

 Short description 
On today's job market, being able to 
format documents is a must. 

 Description 

In an increasingly digitalized working 
world, employees who were not 
previously affected are now being 
required to create structured 
documents This affects the building 
superintendent who has to design 
notices for the bulletin board as well 
as the carpenter who wants to 
present his work. 

   

Reference Title Formatting in documents 

 Short description 
A lot of information has already been 
published about formatting. 

 Description 

Formatting documents has already 
been discussed and analyzed in 
many places. In the following section, 
you can find a selection of 
recommended books and websites: 

• ... 

• ... 
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8.5 Sample Applications 

You may adapt the use of text units and their types individually to your structure and your content model. Here are 
some examples of using text units: 

Additional information levels 

You can use text units to provide your learners with additional extensive information in the form of comments (2) or 
several chapters of extended documentation (1) for the structure display in the trainer. This makes it possible for 
you to convey processes and process-relevant knowledge/understanding without having to make extensive 
changes to project contents. 

 

Separating information levels 

You can create an additional level in your structure of dynamic learning content that, even though it follows the 
structural model, is independent content-wise and displays different information for another target group. This way, 
your structure can contain, for example, the didactic content for your learners as well as instructions and 
information for other groups of people. After all content is complete, you can publish the learning content as usual 
but also simultaneously generate a document about the steps to be followed, send it to all department heads in 
your organization, thus making it possible for them to answer individual questions. 
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Combining information levels 

The two previous examples can also be combined to show or update additional information for learners (2) and 
other target groups (1) in a structure.  
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Customizing referenced content 

Referencing makes it possible for you to always use the same object in different branch structures. The advantage 
here is that content only has to be updated once. If you now, however, want to address different learning groups 
using different branch structures, you have to clear the previous reference to import different descriptions or 
instructions into the original references. Using text units makes it possible to add branch-specific instructions and 
problems without having to dispense with the convenient added value of object referencing. 

 

Object/topic-related display of information 

Text units can also be used for additional object or branch-related information by means of additional 
documentation types when creating the learning content. You can find three examples of how to use text units as 
"notes" in the following section.  

1. Exact definition of requirements for the recording at the respective location 

2. Instructions for dealing with the respective component 

3. Goals agreed in the curriculum 
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8.6 Creating a Text Unit 

To create a text unit, proceed as follows: 

1. In the Explorer select New Object . 
An overview of all objects opens. 

2. Select Text Unit . 
The New Text Unit dialog box opens. 

3. Adapt the following settings:  

1. Name: 
Enter a text unit name. 
The default name is the object type with an ID. 

2. Language: 
Select the language for the text unit. 

3. Document Type: 
Select a type and icon for the text unit. For example: Glossary  

4. Select OK to create the text unit. 

The text unit is inserted into the structure. Now, you can edit the Description and Short Description of the object. 
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9 Documentation 

Documentation are used to provide the content of simulations, quizzes, books / book pages and text units in a 
printable format. There are different formats and document types. 

The supported formats for the documentation generation are: 

 
Microsoft 
Word,  PDF,  HTML, and  

Microsoft 
PowerPoint 

9.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

9.2 Requirements for Documentation 

The following requirements are necessary for creating documentation in these formats: Microsoft Word, Microsoft 
PowerPoint format and PDF. 

Microsoft Office version 

The following versions of Microsoft Office are supported: Microsoft Office 2010 - 2016 and Microsoft Office 365. 

 Note 
In some situations, the generation of a Microsoft Word document leads to the error message: You have modified 
styles, building blocks, or other content that is stored in template.dot. This message is caused by a COM Add-In. 
Deactivate your Add-Ins in Microsoft Word and generate the document again. 

File formats 

The default file formats for generating documentation are DOCX and PPTX. 
If you want to create the documents in the DOC and PPT format, then activate the option Use old Office formats. The 
setting is available in the Settings  dialog box under Producer -> General. 

The templates have the format DOT and POT. See also Documentation Templates. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_87E8E656FE7773B1
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PDF documents are generated by using Microsoft Word. In Microsoft Word 2010 / 2013 / 2016 the Save as 
PDF function is integrated by default. 

9.3 Documentation Settings 

The structure of a document follows a predefined model. To individually customize a document, you can define the 
structure and content to be inserted. There are numerous configuration parameters that influence the appearance 
of documents specific for each type and format (based on fragments). 

Managing documentation settings 

The documentation settings are a resource type. This means you can manage individual settings and use them in 
different workareas. 
The documentation settings are summarized in the area Documentation Settings of the Settings  dialog box. 
Alternatively, the settings can be configured by choosing Resources -> Documentation Settings  in the Explorer 
menu. 

In addition to the standard settings, you can create further settings by duplicating an existing setting and using it as 
a base type: 

1. Open the Documentation Settings section of the resource tree. 

2. Select a documentation type to be used as a base type. For example: - Standard Document. 

3. Select Duplicate...  in the object editor. 
A settings dialog box opens. 

4. Enter a name for the setting. 

5. Select OK to create the new setting. 

 Note 
The Standard Documentation setting cannot be deleted because it is the basic setting resource of the Producer. 

9.3.1 Basic Settings 

The main settings for documentation are: 

• Base Type: 
Specifies the base type for the selected settings. This is defined when the documentation is created and 
cannot be changed afterwards. 

• Name: 
Specifies the name of the selected settings. 

• Template: 
Specifies the documentation template used to generate the document. Choose Edit Link...  to select a 
template from the Documentation Style  resource. 

• HTML Template: 
Specifies the documentation template used to generate the HTML document. Choose Edit Link...  to select 



 

Producer (Cloud Edition) 
Documentation 

 
PUBLIC   276 

 

a template from the Documentation Style  resource. 
The setting is only available for the hands-on guide. 

 Recommendation 
To show the resources in the selection dialog box, select Filter Tree -> Show Resources. 

• Style: 
Specifies the documentation style used to generate the document. Select a style resource from the list.  

• Text Style: 
Specifies the text style used to generate the document. Select a style resource from the list.  

 Recommendation 
The workarea contains one default text style for all content types. You can duplicate the default text style and 
optimize the style configurations for the documentation. Afterwards, activate the text style in the Text Style 
setting. 
See also Text Style Editor. 

 Note 
Text styles are not supported for Microsoft PowerPoint documents. The text can be formatted in the template. 
See also Editing a PowerPoint Template. 

9.3.2 Fragments 

The fragments specify the basic structure of the document. There are different fragments for single documents and 
compound document: 

• Title (Single Document): 
Inserts the title of the project. 

○ Show Cover Page (PowerPoint): 
Inserts a cover page with the title of the project. 

• Description (Single Document): 
Inserts the description of the project. 

• Short Description (Single Document): 
Inserts the short description of the project. 

• Process Flow (Single Document): 
Inserts the process flow for the project. 

• Table of Contents: 
Inserts a table of content. A drop-down list appears here where you can specify the depth of the table of 
contents. 

• Content 

○ Project Content (Single Document): 
This fragment inserts the content of the project. 
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○  Content (Compound Document): 
This fragment inserts the content of the selected structure.  

• Book Page: 
This function inserts a book page in the documentation. Choose Edit Link...  to select a book page. 

• Text Unit: 
This function inserts a text unit in the documentation. Choose Edit Link...  to select a text unit. 

• Revision History (Single Document): 
This selection defines where the content from the Revision Entry macro is placed. The relevant macro has to 
be inserted into the project beforehand. 

• Input Values (Single Document): 
This selection defines where the content from the Input Values macro is placed. The relevant macro has to be 
inserted into the project beforehand. 

• Blank Line & Break: 
This fragment makes it possible to separate fragments using spacing and thus provide considerably more 
structure.   

○ Page Break 

○ Small Blank Line 

○ Medium Blank Line 

○ Large Blank Line  

• Glossary: 
This fragment inserts a table of glossary descriptions of all used glossary entries of the content. 
For creating glossaries, see the chapter Glossary of Terms. 

• None: 
Defines an empty fragment. 

 Note 
For Microsoft PowerPoint only the fragments Description, Title, Project Content, Book Page and Text Unit can be 
inserted. 

9.3.3 Settings of the Subcategories 

Settings for specifying the selected content can be made in the various areas. Not all areas are available for all 
documentation types. 

• Action Table: 
Includes settings for the structure of the action table. See the relevant chapter. 
Only BPP Document, Audit & Compliance Document 

• Screenshots: 
Includes settings for the size, style and quality of screenshots. 

• Markers: 
Includes settings for the style of highlights and arrows. 
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• Numbering: 
Includes settings for the structure and style of numberings. 

• Project Content: 
Includes settings for specifying project content. 

• Included Objects: 
Includes settings for specifying content included as fragments. 

• Quiz: 
Includes settings for the display of quiz items. 
Only Standard Document, Training, Document, Work Document 

• Revision History: 
Includes settings for specifying Revision Entry macros as revision history. 

• Input Values: 
Includes display settings for input values of interactions. 

9.3.4 Subcategory: Quiz 

The quiz settings are available for the documentation types Standard Document, Training Document and Work 
Document. 

• Show Quiz: 
The setting specifies if quiz items are displayed in a documentation. 

• Include Solutions: 
This setting allows you to generate the solutions for the quiz items. This means you can differentiate between 
a document intended for the examiner with all the correct answers and a document for the person being 
examined without any of the answers. 

9.3.5 Subcategory: Action Table 

Specific settings can be defined for the documentation types BPP and Audit & Compliance document. There is an 
additional subcategory called Action Table available with the relevant settings. 

Defining the action table 

The structure and content of the table can be defined to insert the explanations of the actions. A total of 5 columns 
can be defined as follows: 

• Hide Screenshots: 
The Hide Screenshots option allows you to set up the screenshots display in the Screen  macros. 
If the option is activated you are provided with a screenshot and a table below containing all available actions 
of the step. 
If the option is deactivated, a serial table containing the actions is displayed. The single steps are numbered 
consecutively.  
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• Action Table: 
This option specifies whether the actions are displayed as a table or as text only using a step by step 
approach. 

• Table Width: 
Defines the width of the action table in pixels.  

• Column 1 - 5: Content: 
Defines the column for the information extracted from the macro and displayed in the documentation. When a 
table is generated, the column name will be displayed in the relevant project language based on the content 
dictionary. 
The column can also have a title allocated to it, which can be entered manually in the document.  

Content Explanation 

Hide Column Hides the column. 

Numbering Creates sequential numbering for the actions. 

Text from Demo Bubble / Practice Bubble Texts from the Demo or Practice bubbles of the actions 

Object name Contains the object names of the actions. 

Value Contains the entered value from the macros. 

ROC Contains the ROC value defined for the entry macros. 

Description Contains the description defined for the entry macros. 

Result, OK, Comment, Reference Empty columns for manual creation of contents. 

• Column 1 - 5: Width (%): 
Defines the width of the column as a percentage of the total width of the table.  

9.3.6 Compound Document Settings 

For the compound document, you can specify the content types that have to be considered for the document 
generation. There are the following settings: 

Groups 

• Include Groups: 
Specifies that the group content is displayed in the document. 

• Show Description: 
Specifies that the group descriptions are displayed in the document. 

Text Units 

• Include Text Units: 
Specifies that the text unit content is displayed in the document. 
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• Show Title: 
Specifies that the group titles are displayed in the document. 

Projects  

• Include Projects: 
Specifies that the project content is displayed in the document. 

• Documentation Type: 
Specifies the documentation type used. The content and structure for single documents corresponds to the 
specified Documentation Settings for a document type. 

Books 

• Include Books: 
Specifies that the book content is displayed in the document. 

• Show Book Description: 
Specifies that the book descriptions are displayed in the document. 

Book Pages 

• Include Book Pages: 
Specifies that the book page content is displayed in the document. 

• Show Book Page Description: 
Specifies that the book page descriptions are displayed in the document. 

• Book Page Format: 
Specifies the format for displaying the book pages: 

○ Book Page as Image: 
Includes the images of the book pages in the document. 

○ Book Page as Text: 
Includes the texts of the book pages in the document. 

• Maximum Image Width: 
Specifies the maximum width of the images if the book pages are included as images. By default, the images 
are scaled to the width of the template layout. 

• Links: 
Specifies that links of book page objects are inserted into the document. 

• Background Image: 
Specifies that the background images of book page objects are displayed on the book page image. 

• Refresh Preview Images: 
Specifies that the book page images are refreshed before including the images in the document. This is 
helpful for displaying the latest changes of the book pages in the images. 

Output Options 

• Include Hidden Objects: 
When this option is enabled, hidden documents are added to the compound document. When this option is 
disabled, hidden documents are ignored and do not appear in the documentation. 
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• Show Short Description: 
Shows the short description for groups, books, book pages, and text units. For projects, the short description 
is activated in the documentation settings of a document type. 

9.3.7 Customizing Documentation Naming 

The object names of generated documents are by default the names of the relevant document types. Duplicated 
documentation settings use the defined name of the resource and do not have different content languages. 
You can change document naming and add different languages. This can be done in the entity file of a 
documentation setting resource. The entity file is an xml file that is available for each object in the workarea folder 
structure. It contains general attributes for object administration. 

Adapting the entity.xml 

Proceed as follows to adapt the file: 

 Note 
To customize naming in the entity.xml, you should have basic knowledge of editing XML files. 

1. Open the Documentation Settings tree in the Resources -> Adaptable Resources  in the Explorer. 

2. Select the required resources or duplicated resources; click the right mouse button to open the context menu. 

3. Click on the menu entry Open Folder . 

4. Open entity.xml in an editing program, for example notepad. 

5. Edit the file and enter your new naming. 

6. Save and close the file. 

7. Restart the Producer. 

Now you can generate your documents with the new naming. 

XML structure 

Example of the XML structure: 

 Note 
Only change the attributes mentioned here; otherwise errors may occur in resource administration. 
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 Syntax 
<?xml version="1.0" encoding="UTF-8"?>  
<doc_settings created_by="author_name" creation_time="date_time" caption="work_doc" 

version="resource_version" sub_type="document_type" 

cwa_recommended_sync_mode="synchronization">  
<Language name="1031">  
<Text name="work_doc">Arbeitsdokument</Text>  
</Language> 
<Language name="1033">  
<Text name="work_doc">Work Document</Text>  
</Language>  
... 
</doc_setting> 

For each language, insert these attributes: 

<Language name="language code">  
<Text name="caption name">Document name</Text>  
</Language>  

An overview of the content languages and required language codes is available in the chapter Content Languages 
Overview. 

9.3.8 Documentation for Right-to-Left Languages 

An additional Documentation Style (Right-to-Left) resource is available for creating documentation for content with 
right-to-left languages. The resource is similar to the standard Documentation Style  but includes right-to-left 
adaptations in the templates. Further adaptations to templates can be performed individually. The resource is 
located in the Adaptable Resources  tree of the Explorer. 

The following documentation formats are supported for right-to-left languages: 

• Microsoft Word 

• PDF 

• Microsoft PowerPoint 

• HTML 

Requirements 

To edit documentation in Microsoft Word / PowerPoint, you need to activate a right-to-left language under Editing 
Language and Keyboard Layout in Microsoft Office. 
Note that in some situations, the activated right-to-left editing language can influence the direction of the table of 
contents. If this is the case, you need to change the table of contents manually. Alternatively, remove the right-to-
left editing language and generate the documentation again. 
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Activation 

The resource Documentation Style (Right-to-Left) can be set individually for each document in the Documentation 
Settings. The documentation settings are available in the Documentation Settings area of the Settings  dialog box 
and in the Resources -> Documentation Settings  area of the Explorer. Further information is available in the 
chapter Managing Templates. 

9.4 Editing Single Documents 

As preparation for generating a single document the simulation project can be edited on different ways. Read the 
following chapters for further information. 

9.4.1 Subcategory: Documentation 

The macro parameters required for documentation creation are found in the subcategory Documentation.  

• Show in Documentation: 
Specifies, whether this macro is to be taken into consideration during the creation of documentation. 
Disabling this parameter makes it possible to hide certain, specific actions described by macros in the 
documentation. 

Screen macro 

For the Screen  macros, there are the following parameters: 

• Show in Process: 
Specifies to show the step in the process flow of a documentation. 

• As Heading in Documentation: 
Specifies to use the Screen Title as heading in the documentation. 

• Image Size: 
Specifies the size of the screenshot in percentage. 

• Screenshot Position / Size: 
Shows the position and size of the screenshot.  

• Border Width: 
Puts a border at your defined pixel width around the screenshot. The standard color is white and can be 
changed in Documentation Settings. 

Interaction macros 

For the interaction macros, there are the following parameters: 

• Highlight Position / Size: 
Shows the position and size of the highlight. 
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 Recommendation 
Use the Document Highlight function to change the marker position. 

• Marker Orientation: 
Specifies the orientation of the marker on the screenshot. It is recommended to adapt the markers, if the 
screenshot displays more than one marker. 

9.4.2 Cropping Screenshots 

The upper portion of the macro editor provides additional commands for the Screen  macro to edit the 
screenshot. 

• Manual Crop (Documentation) : 
This command makes it possible to define a section of the screenshot for use in the documentation instead of 
using the entire screenshot. This entails opening a dialog window in which the section can be defined using a 
selection frame. 

• Auto Crop (Documentation) : 
This command can be used to crop a screenshot automatically for the documentation. This entails setting up 
the range of the selected control as a crop with a defined distance separating it from the associated highlight. 
This distance can be set up in the central configuration dialog under Authoring Settings -> Auto Crop. 
You have the option to retain this crop when rerecording an application. Be mindful of the setting Keep Crop in 
the Parameter dialog for rerecording. 

 Note 
While rerecording a project, you can retain the crop you have applied. To do so, activate the Keep Crop option 
when starting the rerecording. Pay attention in this regard to the section rerecording. 

• Uncrop (Documentation) : 
If a section of the screenshot was manually or automatically cropped, this function allows the crop to be 
removed again. 

 Recommendation 
If you would like to automatically crop all of the screenshots in a project or remove the crops that have been 

applied, then note the Auto Crop all Screens  and Uncrop all Screens  functions in the Tools -> Automation 
menu. 

9.4.3 Documentation Macros 

Documentation macros enable the compilation of extensive process documentation in addition to the recorded 
simulation. These macros are available to document the recorded project accordingly and to supplement the 
content relevant to the documentation, as well as to structure the content. 

 



 

Producer (Cloud Edition) 
Documentation 

 
PUBLIC   285 

 

Icon Name 

 Header Information 

 Partial Screenshot 

 Note 

 Description 

 Heading 

 Document Highlight 

 Arrow 

 Page Break 

 Document Properties 

 Revision Entry 

 Input Values 

 Logon Values 

In the following chapters, you will find further information about the documentation macros. 
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9.4.3.1 Header Information 

 

The Header Information macro allows you to insert a title as well as a description in the documentation. 
The macro can be used for single documents to create a document title without numbering. It is recommended to 
hide the project title in the documentation settings. 

Parameters of the macro 

The following parameters are available: 

• Title: 
You can enter a title. The title uses the text style Title in the Microsoft Word document. 

• Description: 
You can enter a description. The description can contain a subtitle or additional text and is formatted with the 
text style Paragraph in Microsoft Word. 

9.4.3.2 Transaction Code 

 

The Transaction Code refers specifically to recording SAP applications and is created when you select a transaction 
in SAP. 
When you generate documentation, a table with details of the transaction code and the menu path is created. 

Parameters of the macro 

The following parameters are available: 

• Transaction Code: 
Contains the recorded transaction code.  

• SAP Menu Path: 
You can enter a SAP menu path for the transaction to be able to find it in the SAP system menu.  

9.4.3.3 Partial Screenshot 

 

The Partial Screenshot macro allows you to create a screenshot of a specific area of the current screenshot. The 
partial screenshot can be used, to show an area of an application page in detail. 
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Parameters of the macro 

The following parameters are available: 

• Title: 
You can enter a title for the partial screenshot. 
When no caption has been entered, a consecutive image numbering system will be used in the documentation.  

• Screenshot: 
Contains the partial screenshot image. 

• Show Actions: 
Allows you to show the recorded actions as highlights on the screenshot. The parameter hides the actions on 
the screenshot of the Screen macro. 
With activated parameter you can use the partial screenshot instead of the Page macro for your 
documentation. 

Creating a partial screenshot 

To create a partial screenshot, proceed as follows: 

1. Select a Screen  macro in the thumbnail view. 

2. Insert the Partial Screenshot macro using the Insert Documentation Macro toolbar. 
An editing window with the screenshot is opened. 

3. Define the screenshot area. 
Adjust the selection border by moving the anchor points. 

4. Select Confirm Selection  to insert the screenshot. 

Editing the partial screenshot 

To edit a partial screenshot, select Manual Crop  in the object editor. Afterwards, the editing window with the 
screenshot of the Screen macro will be opened. You can change the selection border in the editor window. 

9.4.3.4 Note 

 

The Note macro allows you to insert important information with a highlighting icon in the documentation. 

Parameters of the macro 

The following parameters are available: 

• Text: 
Contains the note text for the macro. 

Type icon 

A Type (Icon) can be assigned to the note, which can be selected from four different types. Each type is represented 
by an icon: 
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Type Icon 

Info  

Remark  

Tip  

Warning  

The images of the icons are located in the resources trainer Style and Documentation Style. You can replace these 
with your own images. 

Creating a note 

To create a note, proceed as follows: 

1. Select a macro in the thumbnail view. 
The Note will be inserted after the selected macro 

2. Insert the Note macro using the Insert Documentation Macro toolbar. 
A dialog box is opened. 

3. Select a Type (Icon) and enter a Text. 

4. Select Ok to insert the macro. 

9.4.3.5 Description 

 

The Description macro allows you to insert additional information in the documentation.  

Parameters of the macro 

The following parameters are available: 

• Text: 
Contains the description text for the macro. 

• Reset Global Index Counter: 
Defines, that the numbering of the text start with '1'. Deactivate the option to use the numbering of all macros 
in the step consecutive. 
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Creating a description 

To create a description, proceed as follows: 

1. Select a macro in the thumbnail view. 
The Description will be inserted after the selected macro. 

2. Insert the Description macro using the Insert Documentation Macro toolbar. 
A dialog box is opened. 

3. Enter a Text. 

4. Select Ok to insert the macro. 

9.4.3.6 Heading 

 

The Heading macro allows you to insert a heading in the documentation. 
The macro can be used for single documents to create an individual document title or to insert an additional title in 
the project structure. 

 Recommendation 
Use this macro for single documents to create an additional heading. The macro is not recommended for 
compound document as the headings are based on the complete content structure. 

Parameters of the macro 

The following parameters are available: 

• Title: 
You can enter a title.  

• Format Template: 
Defines format template and heading level of the title. You can enter a value between 'h1' - 'h9'. 

Creating a heading 

To create a description, proceed as follows: 

1. Select a macro in the thumbnail view. 
The Heading will be inserted after the selected macro. 

2. Insert the Description macro using the Insert Documentation Macro toolbar. 
A dialog box is opened. 

3. Enter a Text. 

4. Select Ok to insert the macro. 
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9.4.3.7 Document Highlight 

 

The Document Highlight macro allows to highlight a specific area on the screenshot. 

Parameters of the macro 

The following parameters are available: 

• Text: 
You can enter additional information to the highlight. The text is sequential numbered in the step. 

Creating a highlight 

To create a highlight, proceed as follows: 

1. Select a Screen macro in the thumbnail view. 

2. Insert the Document Highlight macro using the Insert Documentation Macro toolbar. 
An editing window with the screenshot is opened. 

3. Define the highlight area. 
Adjust the selection border by moving the anchor points. 

4. Select Confirm Selection  to insert the highlight. 

Editing the highlight 

To edit a highlight select Edit in the object editor. Afterwards, the editing window with the screenshot of the Page 
macro will be opened. You can change the selection border in the editor window. 

9.4.3.8 Arrow 

 

The arrow macro allows to mark a specific point on the screenshot. 

Parameters of the macro 

The following parameters are available: 

• Text: 
You can enter additional information to the arrow. An arrow icon is inserted in front of the text in the 
document.  

• Arrow Color: 
Specifies the color of the arrow.  

• Orientation: 
Specifies the orientation of the arrow. You can select an orientation from the drop-down list.  
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Creating an arrow 

To create an arrow, proceed as follows: 

1. Select a Screen macro in the thumbnail view. 

2. Insert the Arrow macro using the Insert Documentation Macro toolbar. 
An editing window with the screenshot is opened. 

3. Define the position and size of the arrow: 

1. Move the arrow by using drag&drop. 

2. Change the orientation by using the R key 

3. Adjust the selection border by moving the anchor points. 

4. Select Confirm Selection  to insert the arrow. 

Editing the arrow 

To edit an arrow select Edit in the object editor. Afterwards, the editing window with the screenshot of the Page 
macro will be opened. You can change the selection border as well as the orientation in the editor window. 

9.4.3.9 Page Break 

 

The Page Break macro inserts a page break in the documentation. This allows you to specify a page break at a 
specific position in the project structure. 

9.4.3.10 Document Properties 

 

The Document Properties macro assigns contents to field functions of a Microsoft Word document. This involves 
defining document properties and inserting these as field functions in the template. 

Parameters of the macro 

The following parameters are available: 

• Name: 
Contains the field function of the template. 

• Value: 
Contains the content for the field function to be displayed in the document. 
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Defining a field function in Microsoft Word 

A field function in Microsoft Word is defined as follows: 

1. Open the template where you want to insert the field function.  

2. Open the File -> Info page. 

3. Click on Properties -> Advanced Properties to open the properties dialog box. 

1. Navigate to the Custom tab.  

2. Insert the property into the Name field and the corresponding content into the Value field. You can use 
the same entry. 
The content will be replaced by the macro.  

3. Click on Add. 

4. Confirm the dialog box with OK. 

4. Then insert the field function into the template under Insert -> Quick Parts -> Field... 

1. Select the entry DocProperty as the Object Name. 

2. Select your defined field function as the Field Property.  

5. Now save your template.  

 Note 
If you insert the Document Properties macro for a BPP or Audit & Compliance document in your project, the field 
functions which are contained in the particular templates are read automatically and displayed in the macro editor. 
See also the chapter Process Documents. 

9.4.3.11 Revision Entry 

 

The Revision Entry macro allows you to document modifications in processes. For each modification a macro can be 
created and grouped below one another.  
All revision entries are created as revision history table in the documentation. 

Parameters of the macro 

The following parameters are available: 

• Revision Date: 
Indicates the date of the revision. 

• Change: 
Contains a description of the revision. 

• Changed by: 
Indicates the author of the revision. 

• Revision ID: 
Contains a reference number of the revision. 
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Documentation settings 

The revision history can be activated as fragment in Documentation Settings . In the subcategory Revision 
History, there are further settings: 

• Hide in Project Content: 
Defines, that the revision history only inserted as fragment. 
Deactivate the setting to display the revision history at the position as it is inserted in the project. 

• Sorting: 
Defines the sort order of the table, if several revision entries have been created. 

9.4.3.12 Input Values 

 

The Input Values macro creates a table including all available entries of the Input Text macros in a project. As a 
result, they can, for example, be clearly subdivided at the beginning of a document to make them directly available 
in a work process. 

Parameters of the macro 

The following parameters are available: 

• Show Object Name: 
Inserts the content of the object name parameters as column in the table. 

• Show Value: 
Inserts the content of the value parameters as column in the table. 

• Show Bubble Text: 
Inserts the content of the bubble text parameters as column in the table. 

• Show ROC: 
Inserts the content of the ROC parameters as column in the table. 

• Show Description: 
Inserts the content of the description parameters as column in the table. 

Input values as fragment 

Instead of this macro, you can also insert the input values as fragment in Documentation Settings . In the 
subcategory Input Values you can specify the content. 
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9.4.3.13 Logon Values 

 

The Logon Values macro allows creating a table including the necessary data requested by a process to log on to 
the particular system. 

Parameters of the macro 

The following parameters are available: 

• User ID: 
Defines the ID of the user. 

• Role: 
Defines the role of the user, for example, administrator, learner. 

• Application: 
Defines the application or system to log on to. 

• View: 
Defines the corresponding application page or view, which has to be selected for the process. 

9.4.4 Process Flow 

The process flow provides a visualized overview of the recorded project, its steps and sequence. It clearly shows the 
most important components of a step in a brief overview.  
The process flow helps orient learners about which action steps take place at what point in the process when 
working with a document. 

The process flow can be generated for Word documentation and, if needs be, can also be edited at a later date. A 
process flow is not generated for the Job Help Word file because this already contains a tabular overview of the 
working steps.  

Design of the process flow 

Each step is shown in its own individual field in the process flow. These show the step name, the screenshot of the 
Screen  macro as well as the Object Name of the action. 
If a action does not have an Object Name, the Producer will automatically insert the relevant Object Image. 

The individual fields of the steps are linked to one another with arrows, which make clear the progression. Should 
there be a page break, a bending arrow is inserted instead of a straight one. 

 Note 
The picture files in the Object Image are not scaled when being shown in the process flow. For this reason you 
should make sure that these pictures are not too large. Here, it is recommended that you enter a Object Name so 
that it is shown in place of the Object Images in the process flow. 
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The start and end macro of the Form Structure  or from Branches  as well as the Simulation Start  and 
Simulation End  macros are not shown, but only the steps. 
Documentation macros contained within a project are also not inserted into the process flow, as they are only used 
in the design of the documentation and are not relevant to the process as a whole. 

Settings for the process flow 

The process flow can be shown individually for the documentation of a project. The setting is made in the central 
configuration dialog as a Basic Settings and Fragments for the respective documentation type. You can determine 
the position for the process flow here. 

Every step of a project is shown in a process flow. Steps can also be individually deactivated for output if they are 
not to be displayed in the process flow.  
In this case, select the corresponding Screen macro. Then deactivate the Show in Process setting in the 
subcategory Documentation of the macro editor. 

Picture files of the arrows 

The arrows of the process flow can be found in the resource Documentation Style . Both the straight arrow 
(arrow.bmp) and the curved arrow (arrow-long.bmp) are located in the resource folder. 
These graphics can also be replaced with own pictures. You should ensure that the names and sizes of the picture 
files remain the same. 

9.4.5 Heading Levels 

When generating a master document, the project and group structure in the Explorer is transferred to the 
document and displayed as headings and a table of contents. 

In order to render the numbering of the various headings correctly, the outline level of the project and step titles is 
to be defined for each project before being generated as a single document. To this end, a Heading Level is defined. 
The required level is to be decided from the level of the project in the Explorer’s tree structure. 

This value needs to be stipulated as the Producer does not differentiate the level at which the project resides nor 
whether it is located in a main or sub folder when issuing single documents. Moreover, it is possible that only certain 
projects are issued and that the heading levels vary as a result. This may be the case, for example, if only the 
projects in a subordinate group folder are considered. The Heading Levels can make this explicit. 

Depending on the Heading Level, the project and step titles are assigned to the relevant heading template in the 
Microsoft Word template when a document is issued. These are predefined for the various numberings and outline 
levels. 

 Note 
When generating a compound document the heading level is set automatically based on the content structure. 
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9.4.5.1 Setting the Heading Level 

Heading levels for a single document 

The Heading Level is to be defined in the Documentation Settings  in the area Project Content with the Heading 
Level parameter. 

In a single document the structure is created with the project title and its steps. This yields a two-tier outline 
structure. 
To define a structure with the project title on the first heading level and its steps on the second level requires the 
heading setting to be set to 1. The value 1 is to be used as a matter of course if a single document is not intended for 
inclusion in a master document. 

 Example 
1 Project name 

1.1 Step name 

1.2 Step name 

1.3 ... 

 Recommendation 
If the project title should use the Title formatting of Microsoft Word without a numbering, then change the Heading 
Level to 0. 

Heading levels for a master document 

When generating a master document, the Producer issues the group and project structure from Explorer. A three-
tier outline structure is formed comprising the group, project and step titles. 

Before work can be begun on generating the master document, the group and project structure needs to be defined 
in the Explorer. This is crucial for the layout of the master document. 
The heading levels given to the single documents can be inferred from the structure. 

 Example 
1 Group name 

1.1 Project name 

1.1.1 Step name 

1.1.2 Step name 

1.1.3 ... 

1.2 Project name 

1.2.1 Step name 

1.2.2 ... 

Each project envisaged for the master document is then issued as a single document. Define the relevant Heading 
Level for each project before proceeding with generation. 
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• A project that is assigned to a group located on the first level is to be found on the second level. So, that the 
headings in the single document began at that level, the setting must be set to 2.  

• If a project that resides within a subgroup in the Explorer is to be issued, then the Heading Level should be set 
to 3. The numbering then starts on level 3.  

• For greater project or group depth, the Heading Level setting needs to be increased accordingly by the 
appropriate depth.  

• If a project is not assigned to any group or if it resides at main folder level, then the Heading Level is to be set 
to 1.  

 Note 
The headings are capped at 9 in the document templates as only nine levels of numbering can be set up in Word. 
The highest setting for a Heading Level should therefore be 8. That means that the project titles receive a level 8 
number and the steps, level 9. Therefore, ensure that your project structure has a depth not exceeding eight levels. 

9.4.6 Process Documents 

In the Producer different documentation types are available for process documents according to certain criteria. 
These documents are: 

BPP document 

 

The BPP document (Business Process Procedure) allows generating files of recorded projects for a more detailed 
description and demonstration of business processes.  

Audit and Compliance document 

 

The document supports the verification and compliance of certified working processes. 

Generating documentations 

The documentation types BPP and Audit & Compliance documents can be generated in Word, PDF and HTML 
formats. In order to create one of these documents a certain procedure is required. This should be done as follows: 

1. Set up configurations in the documentation settings for the type.  

2. Insert macros for the documentation type.  

3. Edit inserted documentation macros.  

4. Define ROC value and Description in the interactions.  

5. Generate the documentation.  
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Documentation macros 

Predefined documentation macros can be inserted for the documentation types BPP and Audit & Compliance 
documentation. This is done in the Insert -> Insert Documentation Macro -> Insert BPP Macros or Insert Audit and 
Compliance Macros menu. The macros are inserted automatically during the first and last step. 

The documentation macros are predefined default settings and can be customized after insertion. 

9.4.6.1 BPP Macros Structure 

In order to create a BPP document the particular BPP macros can be inserted in the project via the Insert -> Insert 
Documentation Macro -> Insert BPP Macros  function. 

The structure of the BPP macros is as follows: 

 Macro Document Properties  

 Macro Revision Entry  

 

Macros Description with titles. 

1. Overview (1st level title) 

2. Purpose (2nd level title) 

3. Business process overview (2nd level title) 

4. Input data (2nd level title)  

 Macro Input Values 

 
Macro Description with title Procedural Steps (1st level) for the actual cycle. 

The process follows afterwards.  

  
Title and text for scenarios associated with the process: Results / Related Scenarios  
(in the last step) 

In the macros with titles the titles and texts can be modified or texts can be added. 

9.4.6.2 Audit and Compliance Macros Structure 

In order to create an Audit and Compliance document the particular Audit and Compliance macros can be inserted 
in the project via the Insert -> Insert Documentation Macro-> Insert Audit and Compliance Macros  function. 

The structure of the Audit and Compliance macros is as follows: 
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 Macro Document Properties 

 Macro Revision Entry  

 Macro Page Break  

 

Macros Description with titles (1st level title). Explanations can be inserted.  

1. Purpose  

2. Scope  

3. References  

4. Definitions  

5. Document contents  

6. Steps  

In the macros with titles the titles and texts can be modified or texts can be added. 

9.4.6.3 Predefined Document Properties 

 

The Document Properties macro allows allocating predefined variables of a document template to a particular 
content. 

The predefined variables define the macro when the BPP or Audit & Compliance macros are inserted automatically. 

The template for the particular document type within the Producer contains the following variables: 

BPP document properties 

Name Value 

_bpp_id ID 

_bpp_owner Author 

_bpp_status State 

_bpp_description Description 
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Audit and Compliance document properties 

Name Value 

_ac_title Title 

_ac_docnumber Document number 

_ac_versionnumber Version number 

_ac_effectivedate Effective date 

_ac_requestedby Requesting person requested by 

_ac_approvedby Approving person approved by 

Assigning contents to variables 

In the Document Properties macro, the field Name and the field Value are available for a variable. Insert the content 
that is to be generated into the Value field. 

 Note 
When generating a HTML document, the variables of the Document Properties macro cannot be executed in HTML 
as these field functions are Microsoft Word specific. 

 Note 
The Document Properties can only be output for single documents as they relate to the corresponding document 
templates. Avoid the use of this macro in a master document for this reason. 

9.4.6.4 Settings in Interaction Macros 

For some simulation macros, which require an entry or a selection from the user additional information for the 
action tables of the BPP and Audit and Compliance documents can be added. These settings can be found in the 
Documentation subcategory of the macro editor for the Input Text , Select Single  and Radio/Checkbox 

 macros. 

In order to display the Description and the ROC value in the action table a column has to be defined for it in the 
central settings. 

The following settings are available: 

• ROC (Required/Optional/Conditional): 
The value defines the necessity of an action, whether it is required (R), optional (O) or conditioned by 
something (C). The particular type can be selected in the choice box of the option and the character R, O or C 
is displayed accordingly in the table.  

• Description: 
Additional information about a macro can be provided in the description field. 
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9.5 Generating Single Documents 

After a process has been recorded you can generate a documentation. At least one Screen  macro and one 
interaction should be available for this purpose for capturing a result in the document.  

You also have the option of designing your documentation using documentation macros. This allows you to 
incorporate additional information. 

 

To create a single document, proceed as follows: 

1. In the Project Editor, open the project for which you would like to create a single document.  

2. If you want to generate a Word document, you should first define a Headings Level for organizing the headings. 
This is to be set up in the documentation settings under Documentation Settings  -> Project Content.  

3. Commence generation by means of the Documentation menu or in the toolbar by means of the corresponding 
document type button:   

○ Generate Word Document : 
There are various document types available for Word documents. Select from the menu the type you 
would like to create.  

○ Generate PDF Document : 
There are various document types available for PDF documents. Select from the menu the type you 
would like to create.  

○ Generate HTML Document : 
There are various document types available for HTML documents. Select from the menu the type you 
would like to create.  

○ Generate PowerPoint Document    

The generated document is now displayed in the corresponding project in the Explorer and can be launched from 
that location. 

 Recommendation 
Various settings can be made which affect the document display when the individual document is created. You can 
find more information in the section on configuring the individual document. 

 Note 
In some situations, the generation of a Microsoft Word document leads to the error message: You have modified 
styles, building blocks, or other content that is stored in template.dot. This message is caused by a COM Add-In. 
Deactivate your Add-Ins in Word and generate the document again. 

9.5.1 Types of Single Documents 

There are different document types available for Word, PDF and HTML documents. The types are: 

Standard 
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This document is not intended for a special use case and shows all project information (such as step names, 
actions, advice, screenshots) and documentation macros that are not special prepared. 

Job-Help 

   

The document supplies a short and clearly structured project overview with step names and actions to be carried 
out. The document does not contain any screenshots, documentation or Explanation macros and is thus ideally 
suited for practical use of an application. 

Training Document 

   

When generating a training manual, all relevant project information, including documentation macros (for example, 
step name, actions, notes, screenshots…), will be automatically exported and formatted accordingly. This type of 
documentation is ideal for supplementing training materials for learning processes. 

Test Sheet 

   

This document adds a table that is suitable for testing the user's experience. It is possible to make an inquiry about 
actions, inputs and the expected results of the respective step. Also, the tutor has additional fields for evaluation of 
the deliverables. 

Work Document 

   

This document supports the editing of projects and gives an overview about project details, its execution and 
content. To do so, steps, screenshots, scores, task description, notes and the project language are read out. 

Process Guide 

   

This document explains processes in a clear and simplified manner. Its user-friendly and visually appealing layout 
makes it easy for the users to follow. There are three columns which display the following information: 

○ What to do – Text in demo bubble  

○ What to see – screenshot with highlights  

○ What to say – explanations, macros for notes and tips, etc.  

Hands-On Guide 
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This document explains processes with a focus on the screenshots. It allows the users to follow the instructions on 
the screen. There are two columns which display the following information: 

• Explanation– texts of bubbles and explanations 

• Screenshot – images of screen macro 

BPP Document 

   

The BPP document (Business Process Procedure) allows you to use recorded projects for describing and 
illustrating business processes in greater detail. A unique macro structure is created with specific instructions for 
the documentation’s properties, modifications, headings, and descriptions. It is also possible to create a 
customized table to illustrate the process steps. 

Audit & Compliance Document 

  

The purpose of this document is to verify and ensure compliancy with certifications and audits. Its “generic” format 
can be customized to meet your specific requirements. A unique macro structure is created with specific 
instructions for the documentation’s properties, modifications, headings and descriptions. It is also possible to 
create a customized table to illustrate the process steps. 

9.6 Compound Document 

A compound document summarizes all of the content from one workarea into one document. Whereas a 
centralized document only contains content from projects and groups, a compound document also includes the 
following possibilities: 

• Groups 

• Text units 

• Projects 

• Books 

• Book pages 

 Note 
When generating documentation, note that not all types of objects can be exported into the documentation. Audio, 
video and animated objects cannot be used in this case. 



 

Producer (Cloud Edition) 
Documentation 

 
PUBLIC   304 

 

9.6.1 Generating the Compound Document 

To create a compound document, proceed as follows: 

1. Make any adjustments in the documentation settings of the Compound Document Settings for your 
documentation.  

2. Select the start object of the content structure - group or book. 

3. Go to Documentation -> Generate Compound Document...  

4. A dialog box with the following settings will appear.   

○ Start from: 
This defines the starting point for generating the document. The selected object will be displayed here. 
You can select a different object by clicking on Edit Link... . 

○ Use Settings: 
This defines the resource of the documentation settings.  

○ Generate as: 
This defines the format for your document: HTML Document, Word Document or PDF Document  

5. Select Ok. 

The documentation is generated. 

 Note 
The heading level is automatically set in the document based on the structure level and the single documents for 
projects are generated independently. The heading level option therefore does not have any effect. 

9.7 Master Document 

The various documents in the entire workarea or a specific selection of them can be merged into a master 
document. This document is generated from within the Explorer and can be created in Word or PDF format. 

Preparations for creating a master document 

The following preparations must be made for creating a master document: 

• Before you generate the master document, make sure you have created your individual documents with the 
right header level so that the outline of the documents in the master document can be properly displayed. 

• If you want to insert the documents into the master document without descriptions and titles, this information 
must be deactivated already when you generate the individual documents. 

• You can deactivate documents that you do not want to include in the master document using filters or the 
Hide function. 
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9.7.1 Generating the Master Document 

To create a master document, proceed as follows: 

1. You can create a master document for either the entire workarea or an individual selection. To do this, the 
respective group is to be selected in the tree structure or defined in the dialog for creating the master 
document   

○ To create a master document for the entire workarea, the Content  group at the top of the tree 
structure of the Explorer must be selected. 

○ To create a master document for a special group, this is to be selected in the tree structure. Then only 
the individual documents within the group are included.   

2. Select the Documentation -> Generate Master Document...  menu. 

3. A dialog opens where you can define your master document. Make the settings you want. 
You can find explanations about the dialog in the section on settings for the master document. 

4. Select Ok. 

The document is generated. 
After creation, the master document is inserted at the bottom of the tree structure and can be opened from there. 

See the respective section for information on displaying the master document in Word. 

9.7.2 Settings for the Master Document 

The following settings can be made in the dialog for generating a master document. 

• Starts from: 
This selection determines the point in the tree structure starting at which the documents are to be output to 
the master document. This lets you create a master document for a specific group. The object selected in the 
tree structure is automatically displayed in the setting. 
If another starting point is to be selected, this can be done using Edit link... A dialog box opens where an 
object can be defined in the tree structure. Select Ok. 

• Type: 
This selection determines the documentation type for the master document. 

• Format: 
This selection defines the format the master document is to be created in: Word, PDF or both formats 

• Insert individual documents: 
Which content is to be output to the master document can be defined in this area.  

○ Projects 

○ Other Documents: 
The setting adds Word documents imported to the workarea to the master document. 

○ Insert Hidden Objects: 
The setting adds documents from hidden objects. 

• Include Titles and Descriptions: 
Whether titles and descriptions are to be output for the content can be defined in this area. They are not 
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included if this option is deactivated. With the exception of the project, the title and the description are always 
inserted together for other objects because fragments can be defined for projects.   

○ Project title 

○ Project description 

○ Group 

○ Book 

○ Book Page 

○ Text Unit 

 Note 
If you do not want to insert Titles and Descriptions, these must be deactivated already when the individual 
documents are created. For more information, see also the sections on Basic Settings and Fragments. 

9.7.3 Displaying the Master Document in Microsoft Word 

Once the master document has been opened in Microsoft Word, it is displayed with its cover page, table of contents 
and linked single documents. 

Displaying single documents 

When generating the master document, the single documents are not attached directly but shown as a link. You can 
have these shown in the master document: 

1. Select the Outline view to be able to continue editing the document. 

2. Activate the Show Document option in the toolbar. 

3. Select Collapse Subdocuments. 

Attaching single documents 

The presentation of displayed single documents is not stored in the master document. You will get the links back 
when you reopen the document. Further editing steps are required in order to obtain a complete document 
incorporating the single documents. 

 Note 
It is recommended that you only proceed with incorporation once the editing of your master document has been 
fully completed and it is ready for publication. This will avoid duplication of effort in the event of any additions 
where you will have to repeat these steps. 

1. Activate the Outline view and click the Collapse Subdocuments button (see above).  

2. You will find a document icon in front of each single document. Click on it to select the associated single 
document. This process will only ever allow you to select one document.  

3. Now click on the Remove sub document button in the toolbar. The document has now been incorporated.  

4. Repeat items 2 and 3 for each additional single document. You can then switch to the Print preview (or another 
view).  
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 Note 
After adding the subdocuments, update the table of contents. 

After the single documents have been incorporated, you should resave the document so that the original Master 
Document is still available. 

9.8 Documentation Templates 

Documentation templates are used to generate Microsoft Word, PDF and Microsoft PowerPoint documents. The 
templates are stored in the Documentation Style  resource in the Adaptable Resources section of the Explorer. 
The resource Documentation Style (Right-to-Left) contains the same templates with support for right-to-left 
languages. 

The following file formats are supported: 

• .dot (default) and .dotx for Microsoft Word and PDF documents 

• .pot (default) and .potx for Microsoft PowerPoint documents 

• .html for HTML documents 

A workarea includes the following standard templates: 

File Format Document Name 

Microsoft Word / PDF Single Document 

  Single Document with Title 

  Master Document 

  BPP Document 

  A&C Document 

Microsoft PowerPoint Power Point (4:3) 

  Power Point (16:9) 

HTML HTML Document 

  
Responsive HTML Document 

(Hands-On Guide only) 
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9.8.1 Managing Templates 

Selecting a documentation template 

• Single document, Compound document 
The templates can be individually set for every documentation type on the relevant settings page. 
To select the documentation templates, proceed as follows:  

1. Select the Edit Link...  button next to the Template setting. 
A dialog appears that shows the workarea structure.  

2. Select a template from the Documentation Style  resource. 

3. Select OK. 

• Master document 
You can configure the template for a master document in the settings dialog box when generating a master 
document. 

Integrating a template 

To insert a documentation template into a workarea, proceed as follows: 

1. Select the Documentation Style  resource in the Explorer. 

2. Select Insert File...  in the object editor. 
The file selection dialog box is opened. 

3. Select the required file. 

4. Select Open. 

The template will now be integrated in the Documentation Style and can be used for generating documentation. 

Copying a template 

If you want to create your own template, it is recommended that you use an existing standard template as a preset. 
To do so, proceed as follows: 

1. Open the context menu of a Documentation Style resource. 

2. Select Open Folder  to open the docstyle folder.  

3. Open the dot folder. 

4. Copy the needed template to a separate folder and rename it. 

Once you have adapted a template, import the file by using the Insert File...  function in Explorer. 

 Note 
Do not paste the file directly into the dot folder, because the file will not be recognized by the resource structure. 
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9.8.2 Editing a Microsoft Word Template 

For Microsoft Word templates you can edit the layout and the text styles. 
Go in to the folder of your copied .dotx file. Open the template in Word by right-clicking the file and clicking Open  
in the context menu. 

Note that changes in the page setup could affect the complete layout. We recommend that you test templates after 
creating them. 

Edit background 

The background of a template is defined using the Header & Footer view. Double click the header or footer area to 
change the view. You can then change the images and texts of the header and footer area. 

Edit text styles 

Text styles of the content use the same style defined in the text style editor. In the document templates, we 
recommend that you only adapt the template-specific styles, for example, header and footer texts. 

 Note 
For the headings there are parameter, which are used from the template: numbering of heading, page break of 
heading 1. 
You are able to change this in the template. 

The used default text styles are: 

• Numberings of headings 

• _Cover_Subtitle 

• _Cover_Title 

• _Title_Header 

• Footer 

 Recommendation 
If you want to adapt a Word template for a document type, it is recommended that you adapt all templates to have 
a consistent design in all documentation. 

9.8.3 Editing a Microsoft PowerPoint Template 

PowerPoint templates are generally used to create documentation for simulations. When a document is generated, 
the content is inserted with the project title on the top, the bubble texts on one side and the screenshot on the other 
side of a slide. 

Customizing a template 

Open your template in Microsoft PowerPoint. A PowerPoint template can be adapted in the Slide Master view. 
Select the view in the View tab. 
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You can customize the following parts of the template: 

• design slide master 

• layout pages 

 Note 
The layouts in the template are supported with version 9.5 of the Producer. If you are using a customized template 
of an older version, replace it with a newer template. 

Design slide master 

The design slide master contains the basic design of the template used for all layouts. It is the first page in the 
structure. 

You can adapt: 

• Background 

• Footer 

Layout pages 

The layouts contain different placeholders, which define the position and the size of the included content as well as 
the formatting of the text. They are subpages of the design slide master. 

You can adapt: 

• Cover page background: 
You can change the position and formatting of the title as well as the background. 

• Position and size of placeholders: 
You can change the position and formatting of the placeholders for title, text and image.  

To change a text formatting highlight the texts in the text field. You can then change the Font settings in the Home 
tab. 

 Note 
Do not delete a layout or placeholders of a layout to insert the content correctly. 
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9.8.4 Explanation Icons 

The explanation icons are used for explanation macro types in a simulation. To customize images, replace the 
default images with your own images. 
The images have the size 80x80 pixels and are in BMP format. 

You can adapt the explanation icons of the simulation playback in the trainer Style  additionally. 

Type Icon 

Info  

Remark  

Tip  

Warning  

Replacing an image 

This is necessary to assign the correct image file to the active explanation type. 

To replace an explanation image in a workarea, proceed as follows: 

1. Select the icon file in the Documentation Style  resource of the Explorer. 

2. Select the Replace File...  button in the object editor. 

3. This opens the file selection dialog box. Select the required file. 

4. Select on Open. 

The icon is now integrated into the Documentation Style and can be used for generating documentation. 
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10 Content Languages and Translation 

The learning content is often used across locations in different countries and language regions and therefore 
consists of multiple language versions. Therefore, consistent training material must be available in the relevant 
languages. The following chapters explain how the content can be used in different languages and how to handle 
translations. 

10.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

10.2 Content Languages and Dictionaries 

Each object in the workarea has an active content language. It is used to specify the included content's language 
and to define the language for the interfaces of the trainer, library and book reader. For projects, the language 
attribute defines the language of the text modules. Furthermore, when using filters you can define a language in 
your search criteria. Each content language of the Producer is defined in the dictionaries. 

You can select a content language when creating a content object using the Language parameter. The active 
language of an object is displayed in the object editor. 

Dictionary resources 

The dictionaries are text resources of the workarea containing the content languages. The resource files are located 
in the resource structure in the Explorer. There are two main dictionary types: 

• Playback Dictionary  
The dictionary contains runtime texts for playback. These texts are the start & stop pages, the user interface 
texts for the trainer bar, the book reader bar, the library and for the SAP Companion for desktop.   

○ SAP Companion for desktop - includes the texts for SAP Companion for desktop projects 

○ Standard (Simulation) - includes the texts for simulation projects and books 

• Recording Dictionary  
The dictionary contains the text modules of the content languages for the projects and documentation.   

○ Simulation - simulation projects and documentation 

○ SAP Companion for desktop - SAP Companion for desktop projects 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_335F535475BFD5B9
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For the information on adapting dictionary texts, refer to the Dictionary Editor section. 

View content language in tree 

In the tree structure of the Explorer, you can show the content language of each object. This allows you to see the 
language and sort the objects. There are two functions in the View menu: 

• Show Language - displays the language code 

• Show Language Icons - displays the flag icon of the language 

10.2.1 Generating Texts in Projects 

During the recording or rerecording (only simulation) of a project, texts modules in different content languages are 
inserted into the projects and thereby generate project content automatically. The text modules are part of the 
content glossaries for simulation and SAP Companion for desktop. 
For simulation projects there are different texts for the demo mode and the practice mode. The texts in demo mode 
contain explanations to complement the simulation being demonstrated. The texts in Practice mode contain clear 
instructions for users on what they should do to continue with the simulation. 
For SAP Companion for desktop projects there are one basic text type. 

Translating text modules 

When text modules are translated, the texts of a content language are replaced by those of the new language. 
Text modules can be translated as follows: 

•  Automated translation 
With this function, you can change the content language of a project. 
For further information, see the Automated Translation... (Project Editor) section. 

•  Rerecording (only simulations) 
With this function, you can change the content language and also record the application with the appropriate 
language automatically. 
For further information, see the Rerecording a Simulation section. 

Translate manually option 

The Translate Manually option indicates if the texts of macros with text modules have been changed. These texts 
will not be replaced with another language during rerecording or automatic translation. When you export a 
translation template, the texts are also exported. 
The setting is available in interactions (Demo Bubble and Practice Bubble subcategory of the macro editor). 
If a text needs to be translated, you can set the option Translate Manually. 
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10.2.2 Content Languages Overview 

The following table gives an overview about the available content languages: 

 

Language Code Language 

ar-SA Arabic 

bg Bulgarian 

cs Czech 

da Danish 

de-CH German (Swiss) 

de-DE German 

el Greek 

en-GB English (United Kingdom) 

en-US English (United States) 

es-ES Spanish 

es-CO Spanish (Colombian) 

et Estonian 

fi Finnish 

fr-CA French (Canada) 

fr-FR French 

he Hebrew 

hi Hindi 

hr-HR Croatian 

hu Hungarian 

id Indonesian 

it-IT Italian 
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Language Code Language 

ja Japanese 

kk Kazakh 

ko Korean 

lt Lithuanian 

lv Latvian 

ms-MY Malay 

nb Norwegian 

nl-NL Dutch 

pl Polish 

pt-BR Portuguese (Brazil) 

pt-PT Portuguese 

ro Romanian 

ru Russian 

sk Slovak 

sl Slovenian 

sr-SP Serbian 

sv-SE Swedish 

th Thai 

tr Turkish 

uk Ukrainian 

vi Vietnamese 

zh-CN Chinese (Simplified) 

zh-TW Chinese (Traditional) 
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10.3 Translating Learning Content 

The Producer offers different possibilities for translating content. The main difference is between the translation of 
text modules and the translation of manually created texts: 

• Translation templates – used for manually created texts of all content types 

• Machine translation - used for the translation of texts of all content types 

• Automated translation – used for the translation of text modules in simulation and SAP Companion for 
desktop projects 

• Rerecording – used for the translation of text modules in simulation projects and to record the interface in the 
new target language 

For further information, see the relevant sections. 

Preparing for translation 

The following steps are recommended as preparation for translation: 

• Translation should be done after creating and editing the source content, to ensure that all of the texts that 
need to be translated can be edited fully. 

• Duplicate a content object before translating it, to ensure that the original content is not overwritten. 

• If you want to translate a project, first use the Automated Translation  function to translate the text 
modules. 

10.4 Translating Simulation Projects 

The Tools -> Translation menu contains functions for executing an automated translation and version change for 
simulation projects. 

10.4.1 Revise Input Values (Project Editor) 

The Revise Input Values...  function allows the text box entries or choices made in the project to be revised prior 
to a project being automatically translated or rerecorded. The text stored in each Input Text  macro and the 
selected entries from list boxes are all listed in a dialog box and can be edited. 

This function is useful if, because of the target language, entries need to be adapted or an existing piece of data 
cannot be deleted after the original recording without additional effort. 

 Recommendation 
For the rerecording, the project values can be revised directly via the parameter dialog box when starting 
rerecording. 
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10.4.2 Modify Project Language (Project Editor) 

The Modify Project Language...  function allows you to switch a project to another project language. The project 
language determines in which language the text templates for the automatic generation of the bubble texts will be 
used. 

10.4.3 Automated Translation (Project Editor) 

In some cases, it is not necessary to record the whole project again if only the contents of the bubbles need to be 
translated into a different target language. 

The command Automated Translation...  replaces the text modules inserted automatically into the bubbles of the 
interactions with text modules of a different language offered by Producer. 

In the dialog that appears the desired target language can be chosen. 

Selecting OK replaces all text modules with the text modules of the new target language. 

The Automated Translation does not replace the contents of a bubble if the options Interactive Translate manually in 
the subcategory Bubble of the macro editor are activated. These options are activated automatically if either the 
text of bubble was changed manually or was altered by the function Search & Replace Bubble Content. However, it 
also can be activated or deactivated manually at any time. 

10.4.4 Automated Translation All (Explorer) 

The Automated Translation All... allows you to translate one or more projects in a number of languages. The projects 
are duplicated for each language, to keep the original project. The text modules of the interaction bubbles are 
replaced with text modules for the selected languages. 

Translate the projects as follows: 

1. Select a project or group with projects in the Explorer. 

2. Select Tools -> Translation -> Automated Translation All... menu. 
A dialog box opens. 

3. Select the languages for translation. 

4. Select OK. 

The projects are duplicated and translated. 

The automated translation does not replace the contents of a bubble if the option Translate manually is activated 
the subcategory Bubble of the macro editor. This option is activated automatically if the bubble text was changed 
manually or was altered by the function Search & Replace Bubble Content. The Translate manually option can also be 
activated or deactivated manually at any time. 
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10.5 Translating Using Translation Templates 

The Producer provides the option of creating translation files, to enable you to translate the texts of your content 
objects. All translatable texts are exported in a suitable format for translation. After translation the texts can be 
imported to the content objects. 

Translation file formats 

Translation files simplify the translation process, as all texts can be accessed and edited directly. There are two 
translation file formats that can be used: 

• Microsoft Word 
Translation can take place in the Microsoft Word documents without any problems since the texts can be 
edited directly without a translation program. 
The translation file contains the texts as well as the identifying descriptions of the content objects. The 
identifying descriptions are formatted in red and allocate a text to the corresponding content object. This 
should not be changed. 
The available texts can be replaced by using the translated texts. Delete the original text and replace it with 
the required translation. 

• XLIFF 1.2 
XLIFF (XML Localization Interchange File Format) is an XML-based format developed for generating texts for 
translation from an application. This format is used especially for translation with the help of translation 
programs. 
The translation file contains the texts as well as the identifying descriptions of the content objects. To 
translate texts using an XLIFF file, import the file to a suitable translation program. 

Translatable content 

The following content objects and properties can be exported for translation: 

• All content objects 

○ Title 

○ Description 

○ Short description 

○ Keywords 

• Projects 

○ Texts of the project objects 

• Book pages 

○ Texts of the book page objects 

10.5.1 Exporting Translation Files 

Translation files can be exported from the Explorer, as well as for individual content in the project editor or book 
editor. 

To export a translation file, proceed as follows: 
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1. Duplicate the source object. 

2. Select Tools -> Translation -> Export Translation File… 
The Export Translation File dialog box is opened. 

3. Modify the settings in the dialog box. See the chapter Settings for the Translation Export. 

4. Select OK. 
A dialog box shows the export process. 

5. Afterwards, a dialog box appears where you can open the exported files or the target folder. 

The translation file is exported and uses the object or group as the file name. The texts in the translation file can 
now be translated into the required languages. 

10.5.2 Settings for the Translation Export 

For exporting translation files, the following settings are available in the Export Translation File dialog box: 

• Format: 
Specifies the format of the translation files:   

○ XLIFF 1.2 

○ Microsoft Word 

• Structure: 
Specifies the export starting point in the tree. The objects below this point are exported.   

○ Subtree 

○ All (including "Unsorted") 

• Current object 

• Export as One File: 
Combines the texts in one translation file, instead of exporting several translation files for each content object. 
You can use this setting to reduce the number of translation files. 

• Include Object Name in Filename: 
Allows to add the object name to the exported translation filenames. When activated, the translation 
filename looks as follows: Your Object Name_GR_B26A82EF6B44C685.xlf. This option does not work when 
Export as One File is activated. 

• Only Object Properties: 
Exports the name, description, and short description of the objects. No project or book page content will be 
exported. 

• Include Control Names: 
Exports the control names of the action macros. This allows you to translate the control names if no 
rerecording is used. 

• Include Generated Project Texts: 
Exports the generated project texts. This is useful for translators to see the context of the complete text. 

• Target Folder: 
Specifies the target folder for storing the translation files. Select Browse to choose a folder. 
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• Export Objects with Status: 
Exports only objects with an assigned SAP Enable Now Manager status. This allows you to translate content in 
an authoring workflow. 

• Change Status of Exported Objects: 
Changes the status of exported objects to another status. Thus, you can mark the objects as exported and you 
exclude the objects for another translation export. 

10.5.3 Importing Translation Files 

Once translation is completed, you can import the translated texts to the designated object or structure. 

Importing a translation file for one object 

To import a translation file, proceed as follows: 

1. Open the project explorer. 
You also can open a specific project in the project editor or a book page in the book editor. 

2. Select Tools -> Translation -> Import Translation File… 
The Import Translation File dialog box is opened. 

3. Choose the translation file: 

1. Select Browse. 
The Select File dialog box is opened. 

2. Choose your translation file with the UID of the object. 

3. Select Open. 

4. Select Ok to import the translations 

The texts are imported and replace the original content of the object. 

Importing translation files for multiple objects 

To import multiple translation files, proceed as follows: 

1. Open the project explorer. 

2. Select Tools -> Translation -> Import All Translations… 
The Import Translation File dialog box is opened. 

3. Choose a folder with translations files: 

1. Select Browse. 
The Select File dialog box is opened. 

2. Choose your folder with all translation files. 

3. Select Open. 

4. Select Ok to import the translations. 

The texts are imported and replace the original content of all objects. 
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10.5.4 Settings for the Translation Import 

For exporting translation files, the following settings are available in the Export Translation File dialog box: 

• Translation File: 
Specifies a translation file for the import when importing one translation file. Select Browse to choose a file. 

• Target Folder: 
Specifies a folder with translation files when importing a number of translation files. Select Browse to choose a 
folder. 

• Duplicate Objects: 
Duplicates the objects for the target languages automatically before importing the translated texts. See also 
the chapter Mass Translation of a Content Structure. 

• Update Status of Imported Objects: 
Changes the status of imported objects to another SAP Enable Now Manager status. This lets you mark the 
objects as translated. 

• Target Language (Microsoft Word only): 
Specifies the target language for duplicated objects when importing translation files in Microsoft Word format. 
This is required as the translations files do not have an indicator of the translated language. 
Enter the language code for your target language, for example, de-DE. See also the chapter Content 

Languages Overview. 

10.5.5 Mass Translation of a Content Structure 

For a large number of contents that have to be translated in different languages, you can export translation files 
without duplicating the source objects. The target objects will be duplicated for each language when importing the 
translations. The texts of duplicated objects will be updated with changed translations. 

Exporting the translation files 

To export the translation files, proceed as follows: 

1. Select a content structure in the tree. 

2. Insert a Text Unit with the type Translation Info as first sub-object. The text unit is used to indicate the root 
object for duplicating the tree during import. 

3. Select Tools -> Translation -> Export Translation File… 
The Export Translation File dialog box is opened. 

4. Modify the settings in the dialog box. See the chapter Settings for the Translation Export. 

5. Select OK. 
A dialog box shows the export process. 

6. Afterwards, a dialog box appears, where you can open the exported translatable files or the destination folder. 

The translation file is exported and uses the object or group as the file name. The texts in the translation file can 
now be translated into the required languages. 
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 Example Structure 
A source structure is as follows: 

 Group (English) 

  Translation Info 

   Simulation (English) 

   Simulation (English) 

Importing the translation files 

To import the translation files, proceed as follows: 

1. Select the content structure for the exported translation files in the tree. 

2. Select Tools -> Translation -> Import All Translations… 
The Import Translation File dialog box is opened. 

3. Choose the Target Folder with translations files. 

4. Select the Duplicate Objects setting. 

5. Select Ok to import the translations. 

The target objects are duplicated and the translations are imported. The texts of available objects are updated. 

 Example Structure 
A translated structure is duplicated as follows: 

 Group (English) 

  Translation Info 

  Simulation (English) 

  Simulation (English) 

 Group (German) 

  Translation Info 

  Simulation (German) 

  Simulation (German) 
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10.6 Machine Translation (Explorer) 

You can translate the content structures by using the Machine Translation tool in Producer. 

Translatable content 

The following content objects and properties can be machine translated: 

• All content objects properties 

○ Title 

○ Description 

○ Short description 

○ Keywords   

• Projects 

○ Texts of the project objects 

○ Control names 

• Book pages 

○ Texts of the book page objects. 

10.6.1 Prerequisites 

To use Machine Translation functionality, you need an SAP Translation Hub license. SAP Translation Hub is a service 
that runs in the Neo environment and allows you to translate the texts by using a repository of SAP-approved 
translations and terminology as well as machine translation. 

You can find information about the SAP Translation Hub in SAP Help Portal and about subscription model in SAP 
Store.   

For details about the license agreement see the SAP Cloud Platform Agreement. 

You will also need access data for the Document Translation Service. For details about the service see SAP Help 
Portal. 

You can find a tutorial on getting started with Document Translation Service on SAP Blogs and a tutorial on how to 
create server instance for Document Translation on SAP Tutorials. 

Note 
See SAP Translation Hub documentation for the limitations on the translated document size and supported 
languages. 

The translation service is trained mainly on the SAP texts and terminology, therefore, we recommend to test the 
functionality on sample texts before productive usage. 

https://help.sap.com/viewer/product/SAP_TRANSLATION_HUB/Cloud/en-US
https://www.sapstore.com/solutions/40076/SAP-Translation-Hub
https://www.sapstore.com/solutions/40076/SAP-Translation-Hub
https://cloudplatform.sap.com/capabilities/price-list.cpea.europe.html
https://help.sap.com/viewer/9f73362817cd48339dd8a6acba160f7f/Cloud/en-US/ca7a5887c3d9437f813940b938c6c1e6.html
https://help.sap.com/viewer/9f73362817cd48339dd8a6acba160f7f/Cloud/en-US/ca7a5887c3d9437f813940b938c6c1e6.html
https://blogs.sap.com/2020/08/07/getting-started-with-document-translation-service-in-sap-cloud-foundry/
https://developers.sap.com/tutorials/sth-enable-document-translation.html
https://developers.sap.com/tutorials/sth-enable-document-translation.html
https://help.sap.com/viewer/9f73362817cd48339dd8a6acba160f7f/Cloud/en-US/c07bd4ee447b477b9ccb31b3abf5dae3.html
https://help.sap.com/viewer/9f73362817cd48339dd8a6acba160f7f/Cloud/en-US/6fc2e5ab04a94da4a0c3d0740a9bb2ff.html
https://help.sap.com/viewer/9f73362817cd48339dd8a6acba160f7f/Cloud/en-US/6fc2e5ab04a94da4a0c3d0740a9bb2ff.html


 

Producer (Cloud Edition) 
Content Languages and Translation 

 
PUBLIC   324 

 

10.6.2 Process 

To use the Machine Translation function for your content: 

1. Insert a Text Unit with the type Translation Info as first sub-object. The text unit is used to indicate the root 
object for duplicating the tree during translation. 

2. Select a group you want to translate in the Explorer. 

3. Select Tools -> Translation -> Machine Translation. 

4. A Machine Translation: Authorization dialog box opens. Here you need to provide the details to connect to the 
document translation service. You can save the password by selecting the relevant checkbox, and the data 
you have provided will be saved for the next times. Select OK. 

5. Select the languages for translation. Only languages that are supported by SAP Translation Hub are shown in 
this list. For each language that you choose, a duplicate structure will be created. If you have already 
translated a structure, then it will be updated. 
Note: new objects are always added to the bottom of the translated structure! Make sure to check the 
translated structure and adjust the sequence of objects.  
There are the following additional options: 

• Show All Languages 
If you select this option, the language selection list shows all languages supported by SAP Enable Now 
and not SAP Translation Hub. If you choose to translate your text into such a language, the fallback 
language of SAP Translation Hub is used. For example, German (Switzerland) is translated as German 
(Germany) but receives the language property German (Switzerland) in the Producer structure. 

• Only Object Properties 
If you select this option, then only the properties of your objects will be translated. The content of book 
pages, texts and controls of projects will be taken over in the original language. 

• Include Control Names 
Select this option to machine translate the control names in your projects. 

• Include Generated Project Texts 
Select this option to include automatically generated texts in projects into the translation. 

• Translate Objects with Status: 
Translates only objects with an assigned SAP Enable Now Manager status. This allows you to translate 
content in an authoring workflow. 

• Change Status of Translated Objects: 
Changes the status of translated objects to another status. Thus, you can mark the objects as translated 
and exclude the objects from further translations.  

6. Select OK. 

 The content is duplicated and translated. 

Note 
If you delete an object from the structure and repeat the machine translation, this object will not be deleted in the 
target language. You need to maintain it manually.  
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10.7 Dictionary Editor 

You can customize predefined bubble text modules and the texts used in the trainer; the Producer allows you 
opportunity to edit these text files individually. That means that you can use terminology or sentences specific to 
your own texts, which conform to your company's corporate language, or you can set up an additional project 
language, which is not included as standard in the Producer. 

The Edit Dictionary dialog box is available to you for editing the texts. That means that direct access to the text files 
is not necessary. 

You can use the dialog box to edit the following texts: 

• Playback texts 
These are the texts for the user interface of the trainer bar, the book reader bar and the library as well as for 
the SAP Companion for desktop. 
Resource: Playback Dictionaries   

• Recording texts 
These are the content languages for the texts of the projects and documentation. 
Resource: Recording Dictionaries   

Open dialog 

You can open the Edit Dictionary dialog box using the resources in the Explorer and thereby access the required text 
files directly. To do this, select the corresponding dictionary and then click on the Open Dictionary button in the 
object editor. 
Once the dialog box has been opened, the texts are automatically loaded from the relevant text file. By default, the 
dialog box is opened with the dictionary in the active Producer language. 

10.7.1 Structure and Functions 

The basic parts of the dictionary editor are: 

• Toolbar 
The toolbar includes the functions for editing the dictionary texts. 

• Text list 
The text list displays the dictionary texts with IDs, states and values. 

The dictionary editor includes several functions for managing texts: 

• New: 
Creates a new dictionary entry. 

• Save: 
Saves the changes of an edited dictionary. 

• Import as Excel File: 
Imports an Excel file of the texts into the dictionary. 

• Export as Excel File: 
Exports the texts of a dictionary into an Excel file for external translation. All languages are exported. 
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• Cut, Copy, Paste: 
With these functions, you can edit the texts of a dictionary. 

• Undo, Redo: 
With these functions, you can switch between editing states. 

• Search: 
With this function, you can search for an entry in the dictionary. 
Selecting the button opens a dialog box where you can enter a search value and search criteria. 

• Filter: 
With the function, you can filter the entries of a dictionary. 
Selecting the button opens a dialog box where you can enter filter values and criteria. 
To display the complete list again, remove the entries in the filter dialog box. 

• New Language: 
Creates a new dictionary language. 

• Language List: 
With the language list, you can switch between the languages of a dictionary. The selected language is shown 
in the text list. 

10.7.2 Setting up a Dictionary 

To edit the texts, first create a new dictionary. This involves copying the standard dictionary, which you use as a 
template for editing the texts and IDs. 

 Note 
You cannot change the texts in the standard dictionaries of the workarea. Always set up a new dictionary. 

1. Select the appropriate dictionary group in the Explorer resources. 

2. Select New Dictionary in the object editor. 

3. Enter a name in the dialog box. Select OK. 
The Standard dictionary will now be copied. 

10.7.3 Editing an Entry 

To customize the texts, open your dictionary in the Edit Dictionary dialog box. You can edit the text in the dialog as 
follows: 

 Note 
The text IDs cannot be changed as they are used to assign the texts in the content or user interface. 
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 Caution 
Do not change any variables or scripts contained in texts. These are used for allocating or formatting applicable 
content. Changes can cause implementation errors. 
Placeholders for assigning object names and object images can be found in square brackets [] in the text modules. 
The variables are indicated by an @ sign or in curly brackets {...}. HTML / CSS scripts have diamond brackets <...>.  

1. Double-click on the line of the text you want to edit.  

2. The editing dialog box opens and contains the following areas:  

○ Language of translation template: 
The upper field displays the original text. 
You can view this text in another language by clicking on the Other... button.  

○ Target language (Value): 
Enter your text in the Target language field.  

○ State: 
Specify the State of your text. This allows you to manage texts for editing and translation. 
The following statuses are possible: new, needs-translation, translated, needs-review, needs-fix, final 
The standard texts have the status final. 

○ Comment: 
Enter a comment needed for editing a particular text.  

3. Select Close. 

The text is replaced in the dictionary. 

10.7.4 Creating a New Entry 

In addition to using existing texts, you can also add further IDs for new texts, thus enlarging the recording 
dictionary. These entries allow you to insert the texts using placeholders in your content. For further information, 
refer to the chapter Inserting a placeholder in the Producer manual. 

Set up new IDs as follows: 

1. Select New in the toolbar. 
The Edit dialog box is opened. 

2. Enter a name in the ID field. You can only enter an ID that does not already exist.  

3. Use the setting Add to all languages to specify whether you want to add the new entry only in the chosen 
content language or in all content languages to the dictionaries. 
To ensure consistency between content languages, the setting should be retained.  

4. Select OK.  

Once the dialog box has been closed, the editing dialog box for the text opens. Now enter your text. Read the 
section on editing texts.  

For the IDs, you can then enter the texts in the other content languages you are using. To do so, select the language 
you want from the drop-down list. 
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10.7.5 Creating a New Language 

If you would like to add an additional language to those provided by the Producer, you can do so using the New 
Language function. 

Creating a new language 

1. Select New Language in the toolbar. 
The New Language dialog box is opened. 

2. Enter the following values:   

○ Language: 
Select the new language you would like to set up from the list. In this list you will find an overview of 
different languages with their associated flags.  

○ Copy from: 
Select which project language you want to use as a template for your new language. This is required to 
assign the texts to the corresponding IDs.   

3. Select OK. 

A text file in the Dictionary for the new language is created. 

Translating a new language 

You can now amend the texts or export them as an Excel file to have them translated into the corresponding 
language by a translator. Once the Excel file has been translated, you can reimport it. The Export Excel and Import 
Excel functions in the toolbar to allow you to do this. 

10.7.6 Activating a Dictionary 

The dictionary resources for simulation and books can be activated as follows: 

Activating the Playback Dictionary 

The created Playback Dictionary can be activated using the Playback Settings in the Producer. 

1. Open Tools -> Settings...  menu. 

2. Select the section Playback Settings -> trainer - Global -> Visual properties. 

3. Select your created dictionary in the Playback Dictionary setting. 

4. Select OK. 

The trainer - Global section activates the dictionary for the whole trainer. It is also possible to select an individual 
dictionary for the book reader, library or a simulation mode on the relevant settings page. 

Activating the Recording Dictionary 

The created Recording Dictionary can be activated using the Playback Settings in the Producer. 

1. Select the dictionary resource in the resource tree of the Explorer. 



 

Producer (Cloud Edition) 
Content Languages and Translation 

 
PUBLIC   329 

 

2. Select Set as Default in the object editor. 
The resource name is now displayed in bold. 

10.8 Spell Checker 

The spell checker enables automatic correction of the texts contained in the HTML editor. The text is checked 
according to which project language is set. This requires a spell checker, accessed by the Producer, to be installed 
in Microsoft Word in the relevant language. 

In the same way as is familiar from Microsoft Word, a misspelled word is underlined with a red wavy line. You can 
now either correct the spelling or else select the correct spelling by right clicking to call up the context menu. 

Activating spell checker 

There is an option available to you in the Settings  dialog box for activating the spell checker. This option is 
located in the Producer -> General category. 

The Default Language for Spell-Check option can be used to define a language to be used if there is no language 
package available in Microsoft Office for a language being used in a project. 
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11 Publication 

You can publish a workarea to give your learners the files required for playing back the course content. Besides the 
content to be published, a workarea contains files, which are not required for playing back after publication and 
which unnecessarily increase the size of the published workarea. For this reason, a copy containing only the files 
required for playing is created in a target directory that you need to specify whenever you publish a workarea. 

Publishing can be in different formats and be stored directly on a server or a file share. In addition to this, you can 
specify rules for publication to avoid the need to reenter details when republishing. 

11.1 Training Available 

 

Publishing content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

 

Publishing SCORM/AICC is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

11.2 Publication Types 

A variety of publication types are available for publishing workarea or individual objects. These are: 

Type Description 

 

Standard 

This is the standard format for publishing workarea. This 
creates HTML and JavaScript files in a folder structure, 
which can be played back using the trainer. 
Incremental publishing is available for the Standard 
format; this enables adding, removing and updating of 
objects in the published content. 

 

EXE (Executable) 

The formats are for executable files and support direct 
execution of content. The whole workarea is stored in a 
file and this facilitates an exchange of files. 
You can define a filename for this format. 

https://sap.sharepoint.com/sites/119781/Shared%20Documents/Documentation/Manuals_Guides/Docu_2206/Producer/HANA_Cloud/'https:/enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_C14EC3D44D1F7595
https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_C342173940F03E80
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Type Description 

 

SLC (SAP Learning Content) 

 

Documents 

The type lets you export all the documents available in a 
workarea to a folder and thus deposit directly on a file 
system. You can publish the documents into a folder 
structure or all files in one folder with the names of the 
content objects as file names. 

 

SCORM 

See the chapter Publishing SCORM/AICC. 

 

SAP Learning Solution (SCORM) 

See the chapter Publishing SCORM/AICC. 

 

SuccessFactors Learning (SCORM) 

See the chapter Publishing SCORM/AICC. 

 

AICC 

See the chapter Publishing SCORM/AICC. 

 Note 
For the playback of published content in SLC format an installation of the SLC Player is required. The SLC Player is 
the playback component for SLC files. 

11.3 Publishing Individual Objects 

It is not always necessary to publish the entire workarea. You can also output individual objects. To publish an 
object, proceed as follows: 

1. Select an object in the tree structure. 

2. Select Publish Selected Object...  in the object editor. 
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3. A dialog box now opens where you can specify the Type and the Target Folder/Target File. 
More information on the settings is available in the chapter Publishing Settings. 
Other functions in the dialog box:   

○ Show Objects for Publishing: 
Shows all dependent content and resource objects. After you click the button, all objects are listed in the 
box above. 

○ Save as Publishing Rule: 
Select this option to save the defined settings for further publishing. The settings are stored as a 
Publishing Rule  resource.  

4. Select OK. 

After publishing is completed, a dialog box opens, where you can Start the publication or Open the target folder. 
Select Close to finish publishing. 

11.4 Preparations for the Publishing 

The following chapters give you an overview about preparations for the publishing. 

 Note 
For learning content to be played in the browser, the PC concerned must be capable of certain settings. For 
information on these, read Learner Settings in this manual. 

11.4.1 Tree Structure for Publishing 

Before publishing a workarea, the content's tree structure must be defined in the same way as it should be used for 
the publication. Besides the ability to move and categorize objects within the structure, you can also use the Filter 
and the function Hide to more precisely define the content to be published. This will allow you to hide any content 
that should not be published. 

To read more on how to use the Filter, refer to the section on Filters and Search in the Workarea. 

 Note 
Make sure that the filtered and hidden objects will not be needed for displaying your learning content. For example, 
linked projects or a group for managing image objects should be made visible before publishing your content. 

11.4.2 Using Start Links 

The Start Link function provides you with an easy way of generating a link to learning content or the library. The 
Start Link can then be attached to a webpage, for example, which can be used to launch learning content. This is 
necessary if a workarea was published on a web server or file share. 
The Start Link can be defined for all objects available in the Explorer. If you link a group, the library is opened when 
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the group is launched to display the associated content. An object's Start Link is displayed in the object editor's 
Start Link parameter when an object is selected. 

 Note 
Use the SAP Companion for desktop Prefix setting in the publishing settings to publish SAP Companion for desktop 
content to a web server. This option assigns the workarea storage location to the content so that the SAP 
Companion for desktop can find and launch the content when called. 

General settings 

When selecting the workarea in the Explorer tree structure, a general rule can be defined in the Start Links 
subcategory which is then used for creating all start links.  

• Prefix: 
The prefix defines a general URL or path preceding the Start Link. This can be the link to a web page, for 
example.  

• Use Prefix: 
Activating this option uses the defined prefix to generate the start link.  

• Use Dialog Box: 
With this option activated, a dialog box for defining the link is opened when you select Copy Start Link function 
in an object's context menu. If the option is deactivated, the link is copied directly and generated using the 
general criteria previously defined.  

Selecting an object's start link 

To copy the Start Link for an object, right click in the Explorer tree structure to open the context menu for this 
object. Now select the Copy Start Link… function. 

• If prior to this the Use Dialog Box option was deactivated, the Start Link will be copied directly.  

• If prior to this the Use Dialog Box option was activated, a dialog box will open in which you can define the 
prefix. The link is then copied by clicking on Copy.  

The copy of the Start Link can now be inserted in the desired file and made available to users. 

11.5 Publishing Rules 

Publishing rules make it easier to publish a workaround multiple times because you only need to make entries once. 
The rules can be created and edited in the Edit Publishing Rules  dialog box. 

For publishing SCORM or AICC see also the chapter Publishing SCORM/AICC. 

11.5.1 Creating Publishing Rules 

To create publishing rules, proceed as follows: 
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1. Open the Edit Publishing Rules dialog box by choosing Workarea -> Publish -> Edit Publishing Rules...  in the 
menu. 
The dialog box lists all the existing publishing rules of the workarea. 

2. To create a publication rule, use one of the following buttons:   

○ Add: 
Creates a new publishing rule. 
A new publishing rule has a standard name in the Name field. After you click OK, the name is changed for 
the resource.  

○ Duplicate: 
Creates a publishing rule using an existing resource.  

3. When selecting a publishing rule from the list, you see the parameters on the right-hand side of the dialog box. 
Now you can edit the publishing parameters explained in the chapter Publishing Settings.   

○ Name: 
Defines the name of the publishing rule. The name is used as the display name of the resource. 

○ Generate Rule Name: 
Generates a name. The name includes the defined root object and target folder/target file.  

4. After you have finished your modifications, click one of the following buttons:   

○ Publish: 
Saves the created publishing rule and executes publishing. 

○ Close: 
Saves the created publishing rule and closes the dialog box.  

The publishing rules created can be executed by selecting the rule set name in the Workarea -> Publish menu. 
Alternatively select the resource and click on Publish  in the object editor. 

11.5.2 Publishing Settings 

The following settings are available for publishing a workarea or specific content: 

• Type: 
Specifies the publication format for the workarea. 
See the chapter Publication Types.  

• Start from: 
Specifies the starting point in the content tree structure from which you want to publish content. This enables 
you to publish a specific group or the whole content. 
Use the Edit Link... option to change the root object. A dialog box in which you can specify an object in the 
tree structure opens. Confirm this by choosing OK. 

• Use Filter: 
You can select an existing filter to be applied to the publication. 
See the chapter Filters in the Workarea.  

• Include Dependent Objects: 
Specifies, that all dependent content and resource objects are published. 
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• Target Folder / Target File: 
Specifies the storage location in which you want the workarea to be published or the folder and file name for 
an EXE / SLC file. Use the Search for folder  button to select a folder as the storage location. 

• Clean Up Target Folder: 
If this setting is activated, the target folder is always cleaned up before publishing. This setting is only 
available for the Standard  type. 

• SAP Companion for desktop Prefix: 
This option lets you define the location of the workarea for the SAP Companion for desktop content. The prefix 
is necessary for playback from a web server or a file share. 
See the chapter Publishing SAP Companion for desktop Content. 

• HTTP Port: 
You can specify an HTTP port for the internal playback server. Do not enter a value if you want to use 
automatic port numbers. This setting is only available for the Executable and SLC  types. 

 Note 
The settings Include Dependent Objects and Clean Up Target Folder are mandatory for creating a publishing rule.  

Settings and Styles 

In the Settings and Styles subcategory, you can specify resources for the content playback: 

• Use Workarea Configuration: 
This option lets you see existing configuration of the current workarea. Select a Configurations  resource. 

○ Configurations: 
Select a Configurations  resource or multiple resources from your workarea for your publication. 
Select Add to open the selection dialog box. Double-click a resource to specify the default configuration. 
The default configuration is used during playback. Another resource has to be selected for the playback 
with the URL parameter ?style=. 

• Playback Settings: 
Specifies the playback settings for playing back simulations and books or book pages. If you use different 
settings, you can activate the required resource. 

• SAP Companion for desktop: Playback Settings: 
Specifies the playback settings for playing back SAP Companion for desktop content. If you use different 
settings, you can activate the required resource. 

• Text Styles: 
Specifies the text styles of the created content. If you use different styles, you can activate the required 
resource. 

• Text Styles for SAP Companion: 
Specifies the text styles for playback of SAP Companion. 

Project Modes 

In the Project Modes subcategory, you can specify settings for the project modes: 

• Filter Project Modes: 
Lets you specify the project modes required for your publication. 
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• Include Mode: 
For each project mode, a setting is displayed. Select the modes for publishing. 

11.5.3 Publishing SAP Companion for desktop Content 

The ability to launch SAP Companion for desktop content from a web server or file-share requires you to specify the 
location where the workarea is held when publishing. The SAP Companion for desktop Prefix text field is available to 
you when publishing content. Enter the URL and workarea name in this field.  

Web server example: http://yourwebserver/[...]/Workarea 

File-Share example: …\Workarea\index.html 

 Note 
Note that following publication the workarea storage location is to be retained with the SAP Companion for 
desktop content as otherwise the defined prefix will no longer match the storage location. If you would like to file a 
workarea in a different location, then it needs to be republished with a modified prefix. 

11.5.4 Publishing Documents 

Publishing documents allows you to store all the documentation files from your workarea in a folder. To do this, 
select Documents  as the publishing type in the publishing rules. 

Besides the general Publishing Settings, there are further settings available in the Include Formats section: 

• Document format: 
Activate the required document format to publish all available documents with the format:   

○ Word / PowerPoint Documents 

○ HTML Documents 

○ PDF Documents 

• External Documents: 
In general, only generated documents are published. Activate the setting if you also want to publish imported 
documents. 

• Flat Structure: 
Specifies that all documents are stored in the main folder. A content object name and the content type are 
generated for each document. The document name starts with the content name. For example: projectname - 
documenttype.docx 
HTML documents and master documents cannot be published in a flat structure. 

○ Sort by Type: 
Specifies that the generated document name starts with the document type when a flat structure is 
published. For example: documenttype - projectname.docx 



 

Producer (Cloud Edition) 
Publication 

 
PUBLIC   337 

 

11.5.5 Multifile for Optimized Playback 

A multifile can be created when publishing content. The multifile collects all relevant playback files from the 
published content and resources, and stored in the publication. This allows the content to be started faster and is 
recommended when storing content on a Web server or a file share. 

The generated multifile depends on the content you want to publish and can be used for the publishing types 
Standard , Executable  and SLC . Select the required multifile setting: 

• Pack Structure: 
Includes the workarea structure information in the multifile. 

• Pack Resources: 
Includes the resource information in the multifile. 

• Pack Projects: 
Includes the project information in the multifile. 

• Pack Book Pages: 
Includes the book page information in the multifile. 

The required multifile information depends on your content. In general, you can use all the settings. The following 
overview shows you different use cases for activating or deactivating a setting: 

 Note 
SAP Companion for desktop projects 
In some cases, a multifile for a large workarea with SAP Companion for desktop projects cannot be loaded. 
Deactivate the Pack Projects setting, to not generate the multifile. 

Setting Status Content 

Pack Projects Activate 

• Simulation projects are published. 

• SAP Companion for desktop projects are 
published. 

Pack Projects Deactivate 
• Simulation projects are not published. 

• Projects are started from another workarea. 

Pack Book Pages Activate • Book pages are published. 

Pack Book Pages Deactivate • Book pages are not published. 

Pack Structure Activate • A complex structure is published. 

Pack Structure Deactivate 
• Only one object or a small number of objects 

are published. 

Pack Resources Activate 
• A large number of resources are used for the 

content. 

Pack Resources Deactivate • Fewer resources are used for the content. 
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11.5.6 Publishing Rules Resource 

 

Created publication rules are stored as resources in the resource tree. This allows you to create general rules for a 
content project and use the resources in an authoring environment. You can also export the resources as an 
archive, which can be imported into another workarea. 

Functions in the object editor 

The following functions are available in the object editor for a selected resource: 

• Edit Publishing Rule : 
Opens the Edit Publishing Rules dialog to change the rule settings. 

• Publish : 
Executes the publishing with the defined rule settings. 

• Open Target Folder : 
Opens the folder with the published content. 

11.5.7 Publishing by Using Command Line 

You can use the command line to publish your content directly by using predefined publishing rules. This allows you 
to publish content in an automated process. 

Prerequisite 

Create publishing rules to specify the content structure, the publishing format and the publishing location. For 
further information, see chapter Publishing Rules. 

For the publishing you can use a virtual machine with a running Producer. In the Task Scheduler of Microsoft 
Windows, you can specify how to execute the publishing. 

 Note 
Make sure, to keep the session open during publishing. 

Command 

The command for the command line is as follows: 

 Syntax 
producer.exe -wa "<wa_path>" -deploy:<deploy_id_list> -migrate:enforce 
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 Example 
producer.exe -wa "C:\Producer Workarea\Workarea Name" -

deploy:5428446A6D128082,5B4BEA8BF1A43EBA12 -migrate:enforce 

• wa 
Specifies the folder of your local workarea with the content and publishing rules for your publishing. 

• deploy 
Specifies the ID of the publishing rule. You are able to define a number of publishing rules separated by a 
comma or a semicolon. 
The ID can be read out from the object or the folder of the publishing rule: 

○ Object 
Select menu View -> Show UIDs to display the UID next to the name of the publishing rule resource. 

○ Folder 
The workarea folder has the UID as name. Select a publishing rule in the resource tree, open the context 
menu and click on Open Folder. 

• migrate:enforce (optional) 
Specifies, that a workarea of an outdated version will be migrated automatically. This is required, if the 
workarea was used in an older Producer version. 

 Note 
When using a workarea with a Manager connection, the write permissions of the resources are required for the 
migration. For further information, see chapter Manager Workarea. 

Usage 

• If no Producer is running, the Producer will be opened and closed automatically. 

• If Producer is running, the workarea cannot be changed by the command. Open the workarea of your 
command. 
If Producer is closed, the workarea is selected automatically. 

11.6 Publishing SCORM/AICC 

Producer supports the publishing of workareas to SCORM and AICC for the import into a corresponding Learning 
Management System (LMS). To find out which standard your LMS supports and which conditions must be met, ask 
the person in your IT department who is responsible for administering your system. 

SCORM Publishing 

To import learning contents into LMS with SCORM, a compliant IMS manifest can be produced or exported from 
Producer. In addition to the SCORM file, a ZIP archive of the contents and the corresponding resources for direct 
import into the LMS is created. 

The following formats are supported: 

• SCORM 1.2 

• SCORM 2004 3rd Edition 
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• SCORM 2004 4rd Edition 

• SAVE 1.0 (SCORM 1.2) 

AICC Publishing 

To import learning contents into LMS with AICC, the files lms.au, lms.crs, lms.cst and lms.des are all stored in the 
parent directory of the workarea. Under certain circumstances, they need to be adapted to the target system. 

The Producer supports the AICC HACP format - the format AICC PENS is not supported. 

Publishing process 

The following process is recommended for the publishing of SCORM or AICC: 

1. Create and structure the content. 

2. Adapt settings in the central configuration dialog. 

3. Adapt the settings in the publishing rule. 

4. Publish the workarea. 

After the publishing, the ZIP file or the workarea folder with the included format-specific files can be imported into 
LMS. 

 Note 
Note that SAP Companion for desktop content cannot be used in LMS. 

11.6.1 Preparation 

To make the export possible, some preparations have to be made. 

Content Structure 

To export a SCORM file, the output structure of the contents needs to be defined in exactly the way it is supposed 
to be displayed in LMS later on. It is possible to export multiple groups and projects, books with book pages and 
projects, as well as single projects. 
The workarea content exports depend on the group selection. If you want to export all the content in a workarea, 
select the Content  group and then start the export. If you only want to export a specific group, only select this 
group. Furthermore, the structure can be influenced by filter or with the Hide option to filter or hide content objects 
that are not wanted. 

 Note 
Note that correct tracking is only possible, if unused contents and modes are set to hidden. 

Recommendations 

Make sure that a text for the Task Description is entered for the Test mode. It can be edited in the macro Simulation 
Start  of the project. 
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11.6.2 Central Configuration 

The settings can be found in the Playback Settings of the Settings dialog box. Open the dialog box about the Tools -> 
Settings...  menu. The settings can be set globally for the trainer and individually for each simulation mode. 

The following setting areas are relevant for the export: 

• Tracking (General) 

• Tracking (SCORM) 

• Tracking (AICC) 

• New window properties 

11.6.2.1 Tracking (General) 

The Tracking (General) area contains general settings for tracking. The activation of the SCORM or AICC backend 
for the communication interface can be done in the option Tracking backend. The following entries define the 
tracking backend and have to be set globally in the trainer settings: 

• SCORM (automatic) 

• SCORM 1.2 

• SCORM 2004 

• AICC 

11.6.2.2 Tracking (SCORM) 

The Tracking (SCORM) area contains detailed settings for SCORM tracking: 

• Progress and result tracking: 
Activates tracking of the status of the learning progress to calculate the results. Specify whether you want to 
keep progress or calculated results only or both values.   

○ none 

○ only progress 

○ progress as result 

○ result and progress 

○ result and progress - incomplete when failed  

• Send success status: 
Specifies when the information about a successful performed action is sent to LMS.   

○ never 

○ based on score 

○ when completed  
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• Resume simulation: 
Defines whether a simulation can be resumed after closing. Optionally a warning can be displayed when the 
user tries to resume a completed simulation since this might reset the result.   

○ Yes 

○ No 

○ Show warning, if completed  

 Note 
The option Show warning, if completed is only supported for SCORM 1.2. When using SCORM 2004 no message is 
displayed. 

• Result type: 
Specifies the form in which the result is transferred to LMS. Decide whether your LMS expects point-based or 
percentage-based results.   

○ Points 

○ Percentage  

• Score precision: 
Specifies the decimal places for the result. The standard value is two decimal places (for example, 0.95). 

• Commit data only once: 
Transfers the results to LMS only when a simulation is exited. Use this setting to reduce the network traffic. 

• Track objective data: 
Generates SCORM objectives for the subunits of the library or a book. 

• Allow restart of simulations: 
Defines whether a restart button is shown on the stop page of a simulation. 
The option should be deactivated if LMS does not support internal content playback. 

 Note 
Note that the display of objective data differs from the used LMS and cannot be shown in every system. 

11.6.2.3 Tracking (AICC) 

The Tracking (AICC) area contains detailed settings for AICC tracking: 

• Progress and result tracking: 
Activates tracking of the status of the learning progress to calculate the results. Specify whether you want to 
keep progress or calculated results only or both values.   

○ none 

○ only progress 

○ progress as result 

○ result and progress  

• Send success status: 
Specifies when the information about a successful performed action is sent to the LMS.   

○ never 
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○ based on score 

○ when completed  

• Resume simulation: 
Defines whether a simulation can be resumed after closing. Optionally a warning can be displayed when the 
user tries to resume a completed simulation since this might reset the result.   

○ Yes 

○ No 

○ Show warning, if completed  

• Cross-domain support: 
Defines the support for cross-domains for AICC tracking.   

○ disabled 

○ Flash  

• Allow restart of simulation: 
Defines whether a restart button is shown on the stop page of a simulation. 
The option should be deactivated if LMS does not support internal content playback. 

11.6.2.4 New Window Properties 

The option Fullscreen in the New Window Properties must be always deactivated and disabled to prevent the preview 
of a separate window. The browser window is regulated by the corresponding LMS. This selection ensures smooth 
communication between the content and LMS. 
The deactivation of the fullscreen should be done for the project modes and the book reader individually about the 
appropriate setting pages. 

 Note 
Note that the Fullscreen parameter should always be deactivated for the SCORM export to enable trouble-free 
communication with LMS. 

11.6.2.5 Tracking Settings Recommendations (SCORM) 

For tracking of learning content in LMS, the SCORM specification uses a learning object as a sharable content 
object (SCO). Only the SCO communicates with LMS, which means it sends status and score information and 
requests data. 

The following learning contents are distinguished for the SCO of a Producer workarea: 

• project mode 

• book with book pages 

• book with book pages including links to the project modes 

To define the tracking of the content's completion there are different settings necessary for the learning contents: 
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 Note 
The following settings are recommendations for the use of learning contents in a LMS. Depending on the LMS in 
use, other setting combinations may achieve the expected tracking result. 

• Global settings - trainer 
The following settings should be defined in the global settings of the trainer:   

○ Tracking backend 

○ Commit data only once  

• Completion of content 
A book is completed if all contained book pages and project modes have been completed. 
To exclude a project mode from tracking, set the option Progress and result tracking to none in the specific 
mode settings. The setting also allows you to define whether the result or completion should be tracked. 

• Start linked mode in new window 
The modes of a project can be linked on a book page with the book page object Mode Link. For the object, the 
option Open Link in new Window needs to be activated. During playback, the mode starts in a new window and 
not in the window of the book page. 

• Tracking of objective datas 
With the in the central configuration dialog activated option Track objective datas detailed tracking information 
will be send to the LMS additionally to the SCO tracking data. The setting can be used for groups and books 
with included contents. 

 Note 
Note that the objective data cannot be displayed in every LMS. 

11.6.3 Publishing Rules for SCORM/AICC 

After the preparation of the content and the adaptation of the settings in the central configuration dialog, the 
workarea and the LMS files can be published - see the chapters Publishing Rules. For SCORM  and AICC  there 
are further settings in the publishing rules. 

11.6.3.1 SCORM Settings 

The subcategory SCORM includes the following settings for the SCORM  publishing: 

Version 

Various format versions are available for the output of a SCORM file; you can select them from the Version 
dropdown menu for the export process. When you select a version, the IMS manifest of the corresponding format is 
generated to reflect the requirements. The versions are: 

• SCORM 1.2 

• SCORM 2004 3rd Edition 

• SCORM 2004 4rd Edition 

• SAVE 1.0 (SCORM 1.2) 
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SAVE 1.0 settings 

Activate the version SAVE 1.0 (SCORM 1.2) to produce meta information in the IMS Manifest in accordance with the 
SAVE 1.0 specifications. See also the chapter Using SAVE 1.0. 
Further options for SAVE 1.0 are: 

• Copyright: 
Indicates in the IMS Manifest's meta information whether the learning content is covered by copyright. 

• Version: 
Indicates in the IMS Manifest's meta information the version of the issued content. 

XML schema files 

In some cases, LMS may need XML schema definitions, to be integrated into the SCORM packet. These contain 
SCORM-specific structure definitions for XML documents and require correctly formatted files to work properly.  

• Include XML Schemas: 
All XML schema files are added to the SCORM packet.  

• Insert XML Schema Locations: 
Attributes are integrated into the IMS Manifest file as a reference to the XML schema files.  

Start Parameters 

In the generated manifest file, each simulation is given its own URL from which it can then be accessed. 
In LMS, a simulation is sometimes opened using the query string of the URL. Here, corresponding attributes are 
necessary. The selected Start parameters can be used to set which attributes are to be considered when entering 
the starting URL. These are entered in the IMS manifest according to the selection.  

• Only"href“ attribute: 
Standard setting for SCORM export. 

One of the following settings should be used if a simulation cannot be accessed with the standard setting.  

• "href“"and "parameters" attributes:  
A parameter attribute is also inserted which contains the query string. This starts with a question mark "?". 

• "href" and "parameters" without ‘?’: 
A parameter attribute is also inserted which contains the query string. 

Book Display 

The option allows you to enable the publishing of books and book pages. 
The available options define the structure for representation in LMS. This gives you the ability to reduce complex 
books to a specific structural level, or display the whole book as an object. This setting has no influence on the book 
structure in the book reader.  

• Ignore books: 
This selection does not export the books available in the workarea into the SCORM manifest. 

• Show only books: 
This section displays the books as book objects in LMS.  

• Show books and direct sub objects: 
This option displays the books in LMS on two levels, namely a book and its subordinate objects on the first 
level.  
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• Show books and all sub objects: 
This selection displays the complete structure of the books with all subordinate objects.  

Further settings 

• Include Documentation: 
This option allows you to export the generated documentation. Imported documents are always exported. 
Do not deactivate the setting, if a documentation is linked in your content. The link will be broken. 

 Note 
Note that documentation and imported files cannot be tracked in LMS. 

• Persistent Organization IDs: 
This option allows you to create persistent organization IDs to create different versions of the same course in 
the LMS during publishing. Deactivate the option to create globally unique IDs. 

11.6.3.2 SCORM for SAP Learning Solution 

The settings in the subcategory SAP Learning Solution of the publishing rule for SAP Learning Solution  are used 
for the connection and login with the SAP Learning Solution system. 

General Settings 

• Learning Net Type: 
Defines an ID for the publication. The ID is used in the SAP Learning Solution backend for the identification of 
the learning net and different versions. 

○ Generate: 
The button allows you to generate a new ID for the learning net type. The ID has to be added after the 
publishing in the SAP Learning Solution backend.  

• Repository URL: 
Defines the URL of the master repository of the SAP Learning Solution system. 

• Content Path: 
Defines the path for the content upload, relative to the repository URL. If it does not exist, the path will be 
created automatically.  

Without Load Balancing 

With deactivated parameter Load Balancing the following parameter for connecting the SAP Learning Solution are 
available: 

• Application Server 

• System Number 

• Router 

With Load Balancing 

With activated parameter Load Balancing the following parameter for connecting the SAP Learning Solution are 
available: 
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• Message Server 

• System ID 

• Group 

• Router 

Secure Network Communication (SNC) 

For the use of the Secure Network Communication there are the following settings: 

• Secure Network Communication: 
Defines, if the Secure Network Communication is used.  

• No Single Sign-On: 
Defines, that the Secure Network Communication is used without Single Sign-On. It is required to specify a 
user and a password during the publishing. 

• SNC Name: 
Defines the identification prefix for the backend system. 

• Quality of Protection (QoP):Defines the protection level for the Secure Network Communication. 

○ Authentication only 

○ Integrity protection 

○ Privacy protection 

○ Default of backend system 

○ Maximum security settings available 

Further information about the Secure Network Communication is available in the SAP Help Portal. 

11.6.3.3 SCORM for SAP SuccessFactors Learning 

Prerequisites 

• For publishing content to SAP SuccessFactors Learning the version Q3 2015 or higher is required; 

• Setup a deployment location in  SAP SuccessFactors Learning by going to Learning Administration > System 
Administration > Configuration > Content Deployment Locations and creating a new location for SEN there, for 
example, with the ID SENiContent; 

• After setting up a new deployment location, go to Learning Administration > System Administration > 
Configuration > System Configuration > Workforce Performance Builder Configuration and add the line 
contentDeploymentLocationID=[your location ID], for example, 
contentDeploymentLocationID=SENiContent to be able to publish SAP Enable Now content to SAP 
SuccessFactors Learning. 

Publishing settings in Producer 

The settings in the subcategory SuccessFactors Learning of the publishing rule for SuccessFactors Learning  are 
used for the connection and login with the SAP SuccessFactors LMS. 

• OAuth URL: 
Defines the URL for SAP SuccessFactors authentication. 

http://help.sap.com/saphelp_sm70ehp1_sp23/helpdata/en/e6/56f466e99a11d1a5b00000e835363f/frameset.htm
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• LMS URL: 
Defines the URL of the SAP SuccessFactors Learning Management System. 

• Launch URL Prefix: 
Defines the launch URL prefix for the course content. 

• Company ID: 
Defines the company ID for the OAuth authorization to the SAP SuccessFactors Learning Management 
System. 

• Client ID: 
Defines the client ID, also known as the API key, for the OAuth authorization to the SAP SuccessFactors 
Learning Management System. 

• SAML Assertion: 
Defines the SAML assertion that is bound to the client ID and the SAP SuccessFactors Learning user for the 
OAuth authorization to the SAP SuccessFactors Learning Management System. 

11.6.3.4 AICC Settings 

The subcategory AICC includes the following settings for the AICC  publishing: 

• File Prefix: 
Defines the prefix of the server for the AICC package that is inserted into the lms.au file. 

• AICC Creator: 
Defines the creator of the AICC package. 

The information about whether a file name prefix or an AICC Creator needs to be specified should be requested 
from the responsible system administrator of the target LMS. 

11.6.4 Using SAVE 1.0 

SAVE 1.0 (SCORM-Anwendung in der Versicherungswirtschaft - Using SCORM in the Insurance Industry) is a 
recommendation for defining universal meta information and variables in the IMS Manifest. These specifications 
are an extension of the SCORM 1.2 standard. 

 Note 
Note that SAVE 1.0 can only be used for the SCORM 1.2 standard and not for SCORM 2004. 

The purpose of meta information defined using SAVE 1.0 is to define learning content issued in a SCORM package 
in greater detail. The following parameters can be defined in the Producer: 

Meta information Description 

title Object name. 

description Object description - also used for associated modes. 

keyword Defined object search words - these are also used for 
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Meta information Description 

associated modes. 

version 
Version of the resources issued - the value can be 
amended manually. 

copyright 
Definition of a copyright for the issued content. The 
required information in the IMS Manifest is Yes or No. 

The meta information title, description, keyword for an object can be defined in Explorer; the meta 
information version and copyright are available as options in the publishing rules for SCORM. 

 Note 
When using the SAVE 1.0 standard you need to make sure that this is supported by the LMS you are using. 
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11.7 Generating a Video 

Video is an additional format for simulation playback in demo mode. This allows you to use the simulation in a 
portable format and to publish it on media platforms. 

Videos can be created for simulation projects with or without audio in the AVI and MP4 formats. The video includes 
all playback resources. 
A video does not display the trainer bar because the video can be controlled by using the player’s playback window. 

Video types 

For videos, there are the following types: 

 

Simulation Video 

The simulation video shows your actions as simulated 
mouse with highlights and explanations. 

 

Screencast Video 

The screencast video shows all your actions as realistic 
videos instead of simulating the actions. No highlights 
and bubbles are displayed. When you have recorded a 
simulation using the quick recording and with the Record 
Screencast Video option, you can generate a screencast 
video. 

For further information, see the chapter Starting the 

Recording. 

Generating a video 

To generate a video, proceed as follows: 

1. Select a simulation project in the tree of the Explorer. 
OR 
Open a simulation project in the project editor. 

2. Select Tools -> Generate Video...  
The Generate Video dialog box opens. 

3. Select a video type. 
The buttons are only available if a screencast has been recorded. 

• Simulation Video 

• Screencast Video 

4. Change the settings in the dialog box as required. 
See also the chapter Generate Video Dialog Box. 

5. Select Generate Video to generate the video. 
Video generation starts and a progress bar displays the status. 

6. Afterwards, a dialog box is displayed. The dialog box allows you to play back the video or to open the folder. 
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The video is stored in the project structure as demo.avi/mp4 or screencast.avi/mp4. You can open the project 
folder by using the Open Folder  button in the object editor. 

 

Deleting screencast frames 

While recording a simulation, all actions are stored as detailed frames to generate the video. The frames are stored 
in the project and increase the size of the project. You can delete the frames if you do not want to generate any 
more screencast videos. Select Tools -> Delete Screencast Frames. 
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11.7.1 Crop Size and Video Size 

The image shows you the use of the Crop Size and the Video Size for the video generation: 

 

The full image is kept in the generated video. During playback of the video the focus moves to the position of the 
current highlight and bubble. 

The video size can be smaller as the crop size - the image is scaled. 
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11.7.2 Generate Video Dialog Box 

The Generate Video dialog box is used to generate video for simulation projects. The dialog box contains settings 
and commands for video generation and video preview and can be opened by using the Tools -> Generate Video... 

 menu. 

The dialog box has the following areas: 

Preview 

This area displays a preview of the current frame for video generation. When the dialog box is opened, the image 
displays the first frame. 

Video Settings 

The area contains the following settings for video generation: 

• Presets: 
Contains different formats to allow a video generation regarding specific use cases. 

• Video Codec: 
Displays the active codec for video generation. The codec defines the format of the video. 

○ Settings...:  
Opens a dialog box to configure the active codec. The dropdown list displays all installed codecs. 
Only compatible codecs are displayed. 

• Crop Size: 
Specifies the size of the displayed image area of the simulation pages in pixels. Select a percentage value to 
change the size.  

○ Custom Size...:  
The option allows you to enter an individual crop size. The text fields are activated. 

○ Show... / Hide: 
Opens a window for resizing the video manually. 
Changing the size of the window also changes the image. Once you have finished resized, close the 
window to apply the changes. 

• Video Size: 
Specifies the size of the video in pixels and scales the images. Select a percentage value to change the size. 

○ Custom Size...: 
The option allows you to enter an individual size of the video. The text fields are activated. 

• Frame Rate (Frames per seconds): 
Specifies the number of images displayed in one second. The initial value is 30. 
Note that a high frame rate leads to a longer generation time and a larger file size.  

• Audio Format: 
Displays the active output format of the audio. The active audio format can be changed in the Change Audio 
Format dialog box. 

Progress 

The area contains information about the generation process. 



 

Producer (Cloud Edition) 
Publication 

 
PUBLIC   354 

 

Buttons 

The bottom of the dialog box contains the following buttons and button statuses: 

Icon Description 

 

Reload: 

Reloads the project after video generation was canceled. 
This allows you to change the settings and start 
generation again. 
A reload can be necessary, if changed settings are not 
applied correctly. 

    

 
Generate: 

Starts video generation. 

 
Pause: 

Pauses video generation.  

 

Continue: 

Continue video generation from the paused status with 
the current settings. 

   

 

Cancel: 

Cancels video generation. You can reload the project 
afterwards. 

Closes the Generate Video dialog box after video 
generation was canceled. 

 

Finish: 

Closes the Generate Video dialog box after video 
generation was finished successfully. 

11.8 Creating a Context-Sensitive Help File 

In order to use the context-sensitive help file, you first have to define which specific information you would like to 
add to the help file. Linking information according to its contents allows users to quickly and easily search for and 
find the specific information they need for any given situation within the application. For example, the current 
“transaction” (TCODE) or the “mandant” (MANDT). 
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Once the context-sensitive help file has been created, it can be integrated directly into the help menu in your SAP 
system. The learners can then access this help file and its contents at any time. 

Supported applications 

The following applications are supported for the implementation of a context-sensitive help: 

 

Application Version Parameter 

SAP GUI for HTML 
Dependent on specific SAP kernel 
versions 

Client, Dynpro, Transaction 

SAP GUI for Windows 
Dependent on specific SAP kernel 
versions 

TCODE, DBSYS, DYNPRO, 

PROGRAM 

Further information about the implementation of the context-sensitive help in the applications are available in the 
accordant installation guides. 

11.8.1 Context Configuration 

During the recording, the Producer analyzes the existing SAP environment and extracts the relevant context 
information from the system. This information is then displayed in the Context setting. 

 Note 
For the use of further context parameters contact your SAP consultant. 

The contextual information is entered under the Context setting which can be opened by clicking on the button 
Advanced Layout of the object editor in Explorer. The individual pieces of information contain a description of the 
type and its corresponding value, linked via an equal sign (PARAMETER=VALUE). 

Editing the context 

Additional information can be entered in the field, separated with a comma. For example: 
TCODE=SBWP,MANDT=906,DYNPRO=SAPLSINWP 

Multiple context parameters will be separated with a vertical bar: 
TCODE=SU01|SE80|SE63 

Wild cards can also be defined for any contextual information. Wildcards accelerate and facilitate searching for 
specific content within the help file. Example of a wildcard: 
TCODE=SU* 

 Note 
The language of the context information depends on the language of learning content and is defined automatically. 
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11.8.2 Exporting a Context File 

Once the contextual information has been defined and the workarea has been published, the context file can be 
generated in the Producer. All the object information used for the help file content is entered into a context.html file. 

To export a context file, proceed as follows: 

1. Select the root group of the content or a specific sub-group in the Explorer. 

2. Choose Workarea -> Publish -> Export Context File... 

3. The settings dialog box opens:   

○ Enter the Target Folder for storing the file. 

○ Enter the Workarea URL of the published workarea with the included content,  
for example http://server/workarea. 

○ Select a mode or the complete project in the Mode setting. The selected mode is started with the 
relevant context-sensitive information.  

4. Select OK. 

5. The parameter dialog box opens and displays the available context parameters. 
Select the parameters that you want to include in the context file. 

6. Select OK to export the file. 

 Note 
If a Webserver requires administrator permissions, then it is not possible to write directly to the target folder. 
Export the context.html to a local folder and then copy the file to the target folder. 

Manager workarea of a Manager 

The context.html can also be exported for the Manager workarea of a Manager. In the URL setting, enter the 
workarea location in this format: http://server/manager/wa/workarea_name/~tag/published. Specify 
published content of the workarea by adding ~tag/published . 

To access the content of the Manager workarea, users need to log on. 

11.8.3 Testing a Context File 

The function Test Context File allows you to test a created context file. To do so, proceed as follows: 

1. Start the function with the Tools -> Context Administration -> Test Context File… menu entry. 

2. Choose the context file in the opened dialog box. 

3. Select OK. 

4. The next dialog dox shows the available context information of the context file. 
Enter the test values. 

5. Select OK. 

Afterwards, the preview page opens and shows the available contents for the defined values. 
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11.9 Use Cases for Publishing 

There are different settings and requirements regarding your use cases for publishing and using content. See the 
following chapters for further information. 

11.9.1 Publication on a Server 

To publish your content on a Web server (for example, Apache or IIS), the entire published workarea is copied to the 
specified location on the server or the content is published directly into the target directory of the specified server. 

Opening the library 

To open a library belonging to a particular workarea, call up the published content. 

 Example 
http://<yourwebserver>/[...]/workarea/index.html 

http://<yourwebserver>/[...]/deployment.exe 

Starting an object 

To start an individual content object, call the object directly. 

 Example 
• Simulation 

http://<yourwebserver>/[...]/workarea/index.html?show=project!PR_6FFA2A8FC6E5AAB5:de

mo 
Use for a mode: demo, uebung (practice), test, praxis (concurrent), presentation or guided 
Starts the simulation mode in the trainer. 

• SAP Companion for desktop 
http://<yourwebserver>/[...]/workarea/project/PR_E6E2A661CC71AB92/project.dnt 
Starts the SAP Companion for desktop content in the SAP Companion for desktop by using the dnt file. 

• Group 
http://<yourwebserver>/[...]/workarea/index.html?library=library.txt&show=group!GR_E

503495E904892B4 
Opens the group content in the library. 
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• Book 
http://<yourwebserver>/[...]/workarea/index.html?library=library.txt&show=book!BO_32

9F30366A3DD19B  
Opens the book in the book reader. 

• Book Page 
http://<yourwebserver>/[...]/workarea/index.html?show=slide!SL_D41C25D36B3716A2 
Opens the book page in the book reader. 

• Text Unit 
http://<yourwebserver>/[...]/workarea/index.html?library=library.txt&show=cdoc!CD_55

3B6BB3C5C1A4A4 
Opens the text unit content in the library. 

Playback SAP Companion for desktop content by using HTTPS 

If SAP Companion for desktop content is stored on a server, then these can be accessed using a Hypertext Transfer 
Protocol Secure (HTTPS). Noted that HTTPS protocols use certificates to show their trustworthiness and are 
stored in the browser so that applications can be opened correctly. If a certificate is not deposited as trustworthy in 
the browser, with the call of a SAP Companion for desktop a certificate error is displayed. Using this note you can 
continue to load or close the SAP Companion for desktop content. 

In order to avoid certificate errors from the outset, the specific certificate for the HTTPS protocol must be installed 
as trustworthy in the browser. This can be done under Tools -> Internet Options -> Contents -> Certificates in the tab 
Trusted Root Certification Authorities. The installation should be carried out by an administrator. 

11.9.2 Publication on an Intranet Share 

When you publish your content on the file share of an Intranet server, the entire published workarea is copied to a 
specified location on the server or the content is published directly into the target directory of the specified server. 

Opening the library 

To open a library belonging to a particular workarea, open the published content. 

 Example 
\\<yourserver>\<example_share>\[...]\workarea\index.html 

\\<yourserver>\<example_share>\[...]\deployment.exe 

Starting an object  

To start an individual content object, call the object directly. 
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 Example 
• Simulation 

\\<yourserver>\<example_share>\[...]\workarea\index.html?show=project!PR_6FFA2A8FC6E

5AAB5:demo 
Use for a mode: demo, uebung (practice), test, praxis (concurrent), presentation or guided 
Starts the simulation mode in the trainer. 

• SAP Companion for desktop 
\\<yourserver>\<example_share>\[...]\workarea\project\PR_E6E2A661CC71AB92\project.dn

t 
Starts the SAP Companion for desktop content in the SAP Companion for desktop by using the dnt file. 

• Group 
\\<yourserver>\<example_share>\[...]\workarea\index.html?library=library.txt&show=gr

oup!GR_E503495E904892B4 
Opens the group content in the library. 

• Book 
\\<yourserver>\<example_share>\[...]\workarea\index.html?library=library.txt&show=bo

ok!BO_329F30366A3DD19B  
Opens the book in the book reader. 

• Book Page 
\\<yourserver>\<example_share>\[...]\workarea\index.html?show=slide!SL_D41C25D36B371

6A2 
Opens the book page in the book reader. 

• Text Unit 
\\<yourserver>\<example_share>\[...]\workarea\index.html?library=library.txt&show=cd

oc!CD_553B6BB3C5C1A4A4 
Opens the text unit content in the library. 

 Note 
If an anti-virus software is active when you access an Intranet share, scanning all the files required for simulation 
playback (as the files are opened) can result in a considerable delay between opening a simulation and the starting 
the simulation. It is therefore recommended that you always publish simulations on a Web server, wherever 
possible. 

11.9.3 Publishing for Mobile Devices 

The following settings are recommended when publishing content for mobile devices: 

• trainer style 
Use the trainer Style (Medium) for your content. The size of the style and buttons is optimized for mobile 
devices. 
Activate the style in the central configuration dialog box (menu Tools -> Settings... ): Playback Settings -> 
trainer - Global / Content type -> Visual properties -> Style. 
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• Publishing format 
Use the Standard or SLC format for your publishing. 
You can set the format in the publishing settings, when publishing content or creating a publishing rule. 

○ Standard - Publish on a server and link to content. 

○ SLC - Use SAP Mobile Documents for playback. 

 Note 
Check the browser requirements when playing back content on mobile devices. See the chapter Browser 

Requirements. 

11.10 Content Accessibility 

This chapter contains various information for authors about creating content with SAP Enable Now to support 
people with special needs by using the content. 

User groups 

Accessibility support for your content is particularly important for the following groups of users: 

1. Those who use a screen reader program 

2. Screen magnifier users 

3. Users with visual impairments who do not use any electronic assistive technologies 

4. Users with motor impairments 

Accessibility support is implemented in specific ways, depending on the available technology. Detailed information 
about accessibility is included in the dedicated documentation for the UI technologies and applications. 

 Note 
SAP does not itself provide the user with any of the assistive technology (for example, screen readers, screen 
magnifiers, and dedicated hardware resources) required for working in accessibility mode. 
The declarations about accessibility in the SAP disclaimers apply in particular to all accessibility documentation.  

Main topics 

The document includes these main topics: 

• Content creation 
Recommendations for authors on how to create accessible content. 

• Content playback 
Information about the playback of content, for example configuration and use of keyboard shortcuts. 
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11.10.1 Accessibility Features 

SAP Enable Now supports the following accessibility features for the content playback: 

Area Type Status 

Simulation Content 

  

Keyboard navigation in content 

Navigating in the content by using 
the keyboard. 

 

  

Keyboard navigation in trainer 

Navigating the trainer UI by using 
the keyboard. 

 

  
Screen reader 

Using a screen reader. 
 

  

Text-to-Speech 

Creating content with Text-to-
Speech. 

 

  

Text sizes 

Using content with different text 
sizes. 

 

  

High contrast 

Using a high contrast theme for UI 
and Content. 

 

Book Pages 

  

Keyboard navigation in content 

Navigating the content by using the 
keyboard. 

 

  

Keyboard navigation in book reader 

Navigating in the book reader UI by 
using the keyboard. 

 

  
Screen reader 

Using the screen reader. 
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Area Type Status 

  

Text-to-Speech 

Creating content with Text-to-
Speech. 

 

  
Text sizes 
Using content with different text 
sizes. 

 

  

High contrast 

Using a high contrast theme for UI 
and Content. 

 

library 

  

Keyboard navigation 

Navigating in the content by using 
the keyboard. 

 

  
Screen reader 

Using the screen reader. 
 

SAP Companion for desktop 

  

Keyboard navigation 

Navigating the content by using the 
keyboard. 

 

  
Screen reader 

Using the screen reader. 
 

 Supported 

 Partially Supported 

11.10.2 Creating Accessible Content 

In SAP Enable Now you can create content based on the requirements for accessibility. 

Book pages 

These are the parameters and features for creating accessible content for book pages: 

• Alternative Text 
You can enter a short description of what is shown on the image that is used by screen readers. 
The parameter is available for the Image, Hotspot, and Puzzle objects. 
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• Tooltip 
You can enter a tooltip text for objects that let you enter a link. You will find the parameter in the Link section. 

• Tooltip for links in HTML editor 
You can enter a tooltip text for linked texts in HTML editor. You will find the parameter in the Insert Link dialog 
box. 

• Tab Index 
Specifies whether the object can be focused when navigating with the Tab key. The objects are focused based 
on the order of the objects in the book page. To specify an individual order, enter a tab index. For example, if 
an object has the tab index 2, the object will be focused before the object with tab index 3. To exclude an 
object from keyboard navigation, enter '-1'. 

Simulations 

These are the parameters and features for creating accessible content for simulations: 

• Tooltip for links in HTML editor 
You can enter a tooltip text for linked texts in HTML editor. You will find the parameter in the Insert Link dialog 
box. 

• Alternative Text 
You can enter a short description about what is shown on the image that is used by screen readers. 
The parameter is available for the Image object and the quiz items. 

• Alternative text in Microsoft Word documentation 
When generating documentation about a simulation project, the title of the screenshot is used as the 
Alternative Text in Microsoft Word. You can enter a description in the Title parameter of the Screen macro to 
describe the image. 

Styles 

The default settings and styles for the playback may not be compliant with accessibility requirements. You can 
configure own settings and styles to support compliance requirements. For example, you can create Text Styles 
with a bigger text size, or a trainer Style with an optimized color contrast. 

The settings and styles are managed within the Resources -> Adaptable Resources area of the workarea. These 
resources are available: 

• Authoring Settings 

• Playback Settings 

• SAP Companion for desktop: Authoring Settings 

• SAP Companion for desktop: Playback Settings 

• Text Style 

• trainer Style 

• SAP Companion for desktop: Style 

• SAP Companion for desktop: Mini Icons 

• Documentation Style 

• Bubble Styles 

• Border Styles 

• Color Palette 
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For more information about the customization of styles, see the Customization Guide. 

Book page template 

Book page templates are special types of book pages that define a layout and general objects for creating book 
page content. Templates save time and ensure consistency of newly created objects in a complex book and support 
the content creation of many authors. Templates can help users to navigate and to find content easily. 

For more information about creating book page templates, see the Producer Manual. 

11.10.3 Keyboard Shortcuts - library, trainer, book reader 

These are the keyboard shortcuts for using the library, trainer, or book reader: 

 Note 
Enter the keys in lower case. 

UI Element Action Keyboard Shortcut 

Play Starts the simulation playback.  Space  

Pause Pauses the simulation playback.  Space  

Stop Stopes the content playback.   

Back 
Jumps to the previous simulation 
page or book page. 

 Left  

Next 
Jumps to the next simulation page or 
book page. 

 Right  

Feedback Opens the feedback dialog box.  Ctrl  +  F1  

Show Highlight Shows the highlight.   

Set Focus to Bar Moves the focus to the trainer bar. 
 Ctrl  + F2   

  

Set Focus to Panel Moves the focus to the side panel.  SHIFT  + F2   

Set Focus to Content Moves the focus to the content area.  F2   

Changing the keyboard shortcuts 

You can specify the keyboard shortcuts in the Settings  dialog box under Playback Settings -> trainer - Global -> 
Function Keys. You can also specify the keyboard shortcuts for the book reader, library, or individual modes. 
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11.10.4 Keyboard Shortcuts - SAP Companion for desktop 

These are the keyboard shortcuts for using the SAP Companion for desktop: 

UI Element Action Keyboard Shortcut 

Minimize Minimizes the main window.  Ctrl  +  F12  

Abort 
Aborts the SAP Companion for 
desktop. 

 CtrL  +  Alt  +  a  

Restart 
Restarts the SAP Companion for 
desktop. 

 Ctrl  +  Alt  +  r  

Select Next Tab 
Selects the next tab in the main 
window. 

 Ctrl  +  Alt  +  End  

Go to Next Screen 
Navigates to the next screen for a 
selected project. 

 Ctrl  +  Alt  +  Right  

Go Back 
Navigates back to the previous 
screen for a selected project. 

 Ctrl  +  Alt  +  Left  

Start SAP Companion for desktop 
Project 

Starts a selected project.  Ctrl  +  Alt  +  n  

Execute Step Executes a step in a guided tour.  Ctrl  +  Alt  +  Space  

Start Demo Mode 
Starts the demo mode for a selected 
project. 

 Ctrl  +  d  

Start Practice Mode 
Starts the practice mode for a 
selected project. 

 Ctrl  +  p  

Start Test Mode 
Starts the test mode for a selected 
project. 

 Ctrl  +  t  

Start Concurrent Mode 
Starts the concurrent mode for a 
selected project. 

 Ctrl  +  c  

Start Book Starts a selected book.  Ctrl  +  b  

Start Book Page Starts a selected book page.  Ctrl + Alt + l 

Open in library Opens a group in the library.  Ctrl  +  g  

Select Next Entry 
Selects the next entry in the current 
window. 

 Ctrl  +  Alt  +  Page Down  

Select Previous Entry Selects the previous entry in the  Ctrl  +  Alt  +  Page up  
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UI Element Action Keyboard Shortcut 

current window. 

Show Warning Dialog 
Shows the warning dialog box of the 
SAP Companion for desktop. 

 Ctrl  +  Alt  +  w  

Toggle Context Recognition 
Toggles the context recognition of 
the SAP Companion for desktop. 

 Ctrl  +  Alt  +  s  

Toggle Standby Mode 
Toggles the standby mode of the 
SAP Companion for desktop. 

 Ctrl  +  F11  

Copy Link 
Copies the link of the selected 
content. 

 Ctrl  +  Alt  +  f  

Share Via E-Mail 
Opens the dialog box for sharing 
content of the selected entity via e-
mail. 

 Ctrl  +  Alt  +  i  

Start Default Content 
Starts a simulation mode or a 
document that has been specified as 
the default content. 

 Ctrl  +  Alt  +  j  

Show SAP Companion for desktop 
Help 

Opens the SAP Companion for 
desktop help. 

 Ctrl  +  Alt  +  h  

Request Content 
Opens the dialog box for requesting 
content for an application page. 

 Ctrl  +  Alt  +  k  

Search Content 
Opens the search depending on the 
search type selected. 

 Ctrl  +  Alt  +  m  

Show Hidden Help Elements Shows hidden help elements.  Ctrl  +  Alt  +  o  

Show / Hide Sidebar Toggles the visibility of the sidebar.  Ctrl  +  Alt  +  u  

Maximize Content Window Maximizes the content window. Ctrl  +  Alt  +  Home  

Open Media Opens the selected media file. Ctrl + Alt + e 

Changing the keyboard shortcuts 

You can specify the keyboard shortcuts in the Settings  dialog box under SAP Companion for desktop: Playback 
Settings -> SAP Companion for desktop -> Function Keys. 
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12 Workarea and Administration 

The following chapters give you an introduction to the workarea and the server workarea as well as to the editing 
and administration of resources and contents. 

12.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

12.2 Workarea 

The workarea is the base directory for working with the Producer. It contains all the necessary files for creating and 
playing back learning content as well as the actual files of the learning content that has been created. 
Producing learning content always requires one workarea to be selected. 

The Producer automatically creates all the relevant data and directories when a new workarea is set up. These files 
deposited in the workarea are available via the Explorer's tree structure, which can be used to organize, edit and 
replace them. The files for creating and playing back learning content are filed as resources. The learning content is 
created as projects and book pages and organized in groups and books. 

When selecting the workarea within the tree structure, the path to the relevant folder is displayed on the right in the 
object editor. If a server workarea was set up on a server, then this path will be displayed there as well. 

 Note 
So that contents can be created and played back free from errors, no alteration to files and the workarea directory 
structure is permitted. 

The following sections will give you an overview of the workarea, how it is presented and used in the Explorer and 
with what objects and how it is set up in the folder structure. 

 Note 
The workarea contains a mechanism that prevents multiple users in the same network from opening and using the 
same workarea. 
If multiple users are to use a common structure for their projects, the use of a server workarea should be 
considered. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_27FA4B035C834FB9
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12.2.1 Structure and Objects 

The objects contained within the workarea are displayed in the Producer in the Explorer tree structure. This is 
broken down into the following areas and content: 

Main Level Level 1 Level 2 Level 3 

 

Workarea 
The topmost entry in the 
tree structure shows the 
local and server workarea 
selection. 

   

 

Resources 
List of all of the resources 
available in a workarea for 
organization and editing. 

   

 
 

Resource Group 

  

  
 

Resource 

 

 

Content 
The Content group is the 
base group with all of the 
workarea's available 
learning content. 

   

 
 

Group 
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Main Level Level 1 Level 2 Level 3 

 

Subtype: SAP Companion 
for desktop 

  

Project: Standard 

 

Simulation 

 

 Quiz 

 

   

 

Modes 

 

Documents 

  

Project: SAP Companion 
for desktop 

 

Context Help 

 

Guided Tour 

 

   
 

Mode 

  

 

 

Project: SAP Companion 
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Main Level Level 1 Level 2 Level 3 

 

Context Help 

 

Guided Tour 

 
 

Book 

  

  

 

Book Page 

  

Subtype: Book Page 
Template 

 

Subtype: Quiz Template 

 

 
 

Text Unit 

  

 
 

Master Document, 
Compound Document 

  

   

Media Object 
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Main Level Level 1 Level 2 Level 3 

 

Shortcuts 
These objects are 
shortcuts to objects filed in 
another location within a 
tree structure which allow 
these objects to be 
launched directly. 

 

Unsorted 
Unsorted are where 
workarea objects that are 
not assigned to any base 
group are filed.  

   

 

Local Trash 

Contains the locally 
deleted objects. 

      

12.2.2 Refreshing Workarea and Objects 

To reduce the loading time of the workarea the structure is not reloaded permanently. With the refresh functions, 
you are able to refresh the structure or individual objects manually to the current status. This can be done before 
uploading a structure to the server workarea or after the checkout of sub-structures. 

The following functions are available: 

Function Menu / Button Description Example Use Case 

Refresh Workarea  

Button in toolbar 

or 

Menu Workarea 

Refreshes the workarea 
structure. 

After changes in structure. 

Refresh Workarea and All 
Objects  

Menu Workarea 
Refreshes the workarea 
structure and the object 
references. 

After changes in structure 
and editing of many 
objects. 
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Function Menu / Button Description Example Use Case 

Refresh Object  Object -> Context Menu 
Refreshes the object 
references. 

After change of 
screenshots in interactions 
of simulations. 

12.2.3 Adapting the Workarea Structure Externally 

Independent to the editing and structuring of content objects in the Explorer you can edit the workarea structure in 
an exported CSV file. This can be done, for example, as preparation for a content project to create a first structure 
of the objects or to have an overview of a complex content structure for a cleanup. 
The functions Export Structure and Import Structure are available in the menu Tools -> Workarea Structure. 

The editing in the CSV file can be done for all content objects: 

• Group 

• Project 

• Book 

• Book page 

• Text unit 

• Media object 

• SAP Companion for desktop object. 

The following actions can be executed for an object: 

• Update: 
The action changes an available object. 
Can be used to insert further object information, for example, Keywords, Tags, or to change the position of an 
object in the structure. 

• Add: 
The action creates a new object. 
Can be used to add further objects or object structure with initial attributes, for example, name, language. 

• Delete: 
The action deletes an object and moves it to Unsorted. 
Can be used for a cleanup of a structure. 

12.2.3.1 Editing a Structure 

The export and import of a workarea structure can be done with the following steps. 

Consider the following recommendations to allow correct editing: 

• before editing, export a new workarea structure with the up-to-date objects 

• do not move any objects in the Explorer in the meantime 

• do not edit any object attributes in the Explorer in the meantime 



 

Producer (Cloud Edition) 
Workarea and Administration 

 
PUBLIC   373 

 

1. Export of a workarea structure 

To export a structure, proceed as follows: 

1. Select the root group of a structure or sub-structure. 

2. Click on the menu entry Tools -> Workarea Structure -> Export Structure... 
A dialog box opens. 

3. Select a folder as target directory. 

4. Enter a File Name. 

5. Select Save to export the structure. 

2. Editing of the CSV file 

Edit the workarea structure and the object information in the CSV file as needed and update, delete or add your 
objects. 

For further information about the structure and attributes of the CSV file see, the Structure of the CSV File chapter. 

3. Import of a workarea structure 

To import or reimport a structure, proceed as follows: 

1. Select the root group of a structure or sub-structure. 

2. Select Tools -> Workarea Structure -> Import Structure... 
A dialog box opens. 

3. Select a CSV file with the needed structure. 

4. Select Open to import the structure. 

5. A dialog box with the actions to be executed opens. 
Select Yes to import the file. 
Select No to cancel and to change the CSV file. 

 Note 
When adding new objects, do not enter a UID. The UID will be created during import. 

 Recommendation 
When adding new objects, it is recommended to specify the object type, the name and the language. 

12.2.3.2 Structure of the CSV File 

The CSV file includes the following columns: 

• Action 
Contains the action which is executed during import. 
Possible values:   

○ update - also default if no value is set 

○ add 
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○ delete 

• UID 
Contains the UID of an object. 
Do not change the UID to avoid an incorrect assignment. 
When creating a new object, the field has to be empty. The UID will be generated during the creation of an 
object. 

• Class 
Contains the object type. 
Possible values:   

○ group (group) 

○ project (project) 

○ book (book) 

○ slide (book page) 

○ cdoc (text unit) 

○ media (media object) 

○ da (SAP Companion for desktop object) 

• Caption 
Contains the name of an object. The position in the column visualizes the position in the structure. 
Insert a further column to create deeper structure. Leave the column headers empty. 

• Template 
Contains the UID of a template object. 
When creating a new object, the UID for a template can be inserted. 

• StartLink 
Contains the link for playing back the content object. 

• Description 
Contains the description of an object in HTML format. 

• ShortDesc 
Contains the short description of an object in HTML format. 

• Keywords 
Contains the keywords of an object. 

• Hidden 
Defines the visibility of an object. 
Possible values:   

○ FALSE (object is visible) 

○ TRUE (object is hidden) 

• Language 
Defines the language of an object. 
For possible values, see Content Languages Overview chapter. 

• categories (Tags) 
Contains the tags of an object. 

• content_categories 
Contains the content categories of an object. 
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• Roles 
Contains the roles of an object. 

• modification_time 
Contains the modification time of an object. 

• creation_time 
Contains the creation time of an object. 

• sub_type 
Contains the sub type of an object. 

• macroset 
Contains the used macroset of an object. 

• doc_type 
Contains the document type on a text unit. 

• da_stark_link 
Contains the link for playing back the SAP Companion for desktop. 

• SAP Companion properties 
Contain properties of the SAP Companion projects. The properties use h4_ in the property name. 

• SAP Solution Manager properties 
Contain properties of the SAP Solution Manager groups. The properties use sm_ in the property name. 

• ARIS® properties 
Contain properties of the ARIS® groups. The properties use aris_ in the property name. 

In the rows, the objects are ordered according to their position in the Explorer. 

12.2.3.3 Exporting a Reference List 

Exports an overview of the existing references on the workarea into a CSV file. The objects are listed in the order in 
which they appear on the workarea. In addition to this, the superordinate reference and the UID are displayed. 

To export a reference list, proceed as follows: 

1. Select Tools -> Workarea Structure -> Export Reference List... 
A dialog box is opened. 

2. Select a folder as target directory. 

3. Insert a File Name. 

4. Select Save to export the reference list. 

Structure of the CSV file  

The CSV file includes the following columns: 

• Referenced Object: 
Contains the objects of the workarea. 

• Referenced by: 
Contains the referenced object. 

• UID: 
Contains the UID for the objects. 
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12.2.4 Cleaning up the Workarea 

The Producer uses a local trash to store locally deleted content objects of the local workarea. This allows the author 
to see all deleted content objects and to restore content objects if required. 

Consider the following: 

• Content objects in the trash are read-only. The object parameters cannot be edited. 

• If you have multiple references of a content object, then a deleted reference is not moved to the trash. Only 
the last deleted reference of a content object is displayed in trash. 

• Imported or generated files of a content object, for example, images  or documents , are deleted 
directly. The files are not moved to the trash. 

Local Trash tree 

 

The Local Trash tree is displayed in the Explorer after a content object has been deleted. The tree contains all locally 
deleted content objects. 

The tree displays the following function in object editor: 

•  Empty Trash: 
Use the control to delete all content objects in the trash from the workarea permanently. 

 Recommendation 
You can show and hide the trash tree in Explorer with View -> Show Trash. 

Object in trash 

A deleted content object displays the following functions in object editor: 

•  Restore: 
Use the control to restore a content object from the trash to the original position in the tree. 

 Note 
If you restore a content object without a parent object in the tree, then the content object is moved to Unsorted . 

•  Delete: 
Use the control to delete the content object from the workarea permanently. 

Working with the server 

The trash is used for the local workarea only. When using a server workarea, deleted content objects are displayed 
in the Explorer of the server. 

When deleting a content object in Producer, there are the following scenarios: 

• Deleting local objects: 
Delete will move the object to Local Trash. 
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• Deleting centrally managed objects with a managed parent: 
Delete on Server will delete the object locally and move it to Trash on server. 
Remove Locally will delete the object locally, but leave it in the local structure with an empty cloud icon. The 
object is moved to Unsorted on server. 

• Deleting centrally managed objects with a local parent or with no parent: 
Delete on Server will delete the object locally and move it to Trash on server. 
Remove Locally will delete the object locally and not show it in the local structure. The object is moved to 
Unsorted on server. 

• Deleting centrally managed root folder: 
Centrally managed root folder can only be removed locally. You can create a local root folder or check out the 
central root again. 

If a content object has been deleted by another author in the server workarea, the local instance of the content 
object in your local workarea will be moved into your local trash. 

12.2.5 Opening the Workarea Folder 

The Workarea -> Administration -> Open Base Directory function opens the workarea's base directory in Microsoft 
Windows Explorer. The workarea folder contains the folders of the content objects and the resources as well as the 
components of trainer needed to directly playback offline content. 

12.3 Resources 

The Resources  area is where you have access to all the workarea files and settings you need for creating and 
playing back learning content. These are broken down into resource groups, each with their own individual 
resources. 

You can use the structure to apply settings for individual resources and to save resources to a server workarea. 

 Recommendation 
You can show and hide the resource tree in Explorer with View -> Show Resources. 

12.3.1 Resource Overview 

The table provides you with an overview of the standard resources available in the workarea: 

Resource Description 

 

Adaptable Resources 

Contains adaptable resources of styles and settings. See 
Adaptable Resources for further information. 
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Resource Description 

 

Application Profiles 

Contains the application profiles for recording the 
applications. 

 

Book Styles 

Contains the design of the background and the controls 
for book pages. 

 

Bubble Styles 

Contains the various bubble designs. 

The Edit Bubble Styles... button in the object editor can 
be used to launch the bubble style editor for editing the 
bubbles. 

 

Configurations 

This resource contains the configuration files for the 
content authoring and playback. 

If additional resources were added, the resource to be 
used can be defined via the Set as Default function. 

 

Documentation Settings 

Contains the settings for the generation of 
documentation of all types. 

You will receive the following functions when you select a 
resource: 

• Open Settings - Opens the selected setting 
resource in the central configuration dialog. 

 

Filters 

Contains the created filter definitions. The resource type 
is visible after a filter is defined. 

You will receive the following functions when you select 
the resource group: 

• New Filter - Opens the Edit Filter dialog for the 
creation of a new filter.  

If you select a resource, you will receive the following 
functions: 

• New Filter - Opens the Edit Filter dialog for the 
editing of the selected filter.  

• Apply Filter - Activates the filter or search for the 
content tree.  

 
This resource contains the help files for the library, 
trainer and book reader in the available languages. 
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Resource Description 

Help 

 

Macrosets 

Contains the macroset files. These are:  

• SAP Companion for desktop 

• Standard (Simulation and Quiz) 

• SAP Companion 

 

Playback Dictionaries 

This resource contains text blocks that can be used in a 
content’s playback. Here we differentiate between: 

• Standard - library, trainer and book reader 

• SAP Companion for desktop 

You will receive the following functions when you select 
the resource group: 

• New Dictionary - Setting up a new dictionary. This 
causes the original folder to be copied, as a result 
of which the standard texts can be transferred into 
the new ones.  

You will receive the following functions when you select 
the resources: 

• Open Dictionary - Opens the dialog for customizing 
the texts. 

 

Publishing Rules 

Contains the publishing rules for the publishing of 
content. The resource type is visible after a publishing 
rule is defined. 
See also the chapter Publishing Rules Resource. 

You will receive the following functions when you select 
the resources: 

• Edit Publishing Rule - Opens the dialog for editing 
the publishing rules. 

• Publish 

• Open Target Folder 

 

Recording Dictionaries 

The dictionary contains the bubble text modules for the 
project types. These can be edited using the Edit 
Dictionary dialog. 

Here we differentiate between: 

• Simulation 

• SAP Companion for desktop 

You will receive the following functions when you select 
the resource group: 
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Resource Description 

• New Dictionary - Setting up a new dictionary. This 
causes the original folder to be copied, as a result 
of which the standard texts can be transferred into 
the new ones. 

If you select a resource, you will receive the following 
functions: 

• Open Dictionary - Opens the dialog for customizing 
the texts.  

• Set as Default - If a number of resources are 
available, this allows you to determine which one is 
to be used.  

 

Playback Application Profiles 

Contains the application profiles for playing back the 
SAP Companion for desktop. 

 

Scripts 

The Scripts resource contains all the scripts that activate 
special functions. 

 

trainer  

Contains the trainer configuration files. 

Which trainer version is to be used can be defined in the 
object editor using the Set as Default function. 

12.3.2 Adaptable Resources 

The Adaptable Resources  are part of the workarea resource tree and are located on top of the resource 
structure. They contain customizable resources such as styles, templates and settings.  

The standard resources of the Adaptable Resources including the following: 

 Authoring Settings 

 Playback Settings 

 SAP Companion for desktop: Authoring Settings 

 SAP Companion for desktop: Playback Settings 

 Book Style Flat 

 Border Styles 

 Bubble Styles 

 Color Palette (if created) 
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 Content Categories 

 SAP Companion for desktop Style (different styles) 

 SAP Companion for desktop: Mini Icons 

 Documentation Style 

 Documentation Style (HTML) 

 Documentation Style (Right-to-Left) 

 Master Tags (if created) 

 Text Styles (different styles) 

 Text Styles: SAP Companion 

 trainer Style (different styles) 

Customizing adaptable resources 

Resource Customizing  

 Styles 

Customize the resources in style editor. Open the style 
editor by using the Edit Style Resources... control. 

See also Style Editor. 

 Text Styles 

Customize the resources in text style editor. Open the 
text style editor by using the Edit Text Styles...  
control. 

See also Text Style Editor. 

 Color Palette 

Customize the resources in color palette editor. Open 
the editor by using the Edit Color Palette...  control. 

See also Color Palette. 

 Settings 

Customize the resources in settings dialog box. Open the 
dialog box by using the Open Settings...  control. 

See also Settings Dialog Box. 

 Master Tags 
Customize the resources in master tags dialog box. 
Open the dialog box by using the Manage Master Tags... 

 control. 

 Content Categories 
Customize the resources in content categories dialog 
box. Open the dialog box by using the Manage Content 
Categories...  control. 
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12.3.3 Managing Resources 

You can import and update resources or manage them in the server workarea: 

Note 
The first version of newly created or uploaded resources is always published automatically. All further versions 
need to be published manually by the authors. 

Importing resources 

In addition to the existing resources, you can import additional resources into the workarea as an archive. 

To import resources, proceed as follows: 

1. Select Workarea -> Import Archive... menu.  

2. Select your archive file in the open dialog box. Select Open.  

3. You then see the files contained in the archive displayed in a dialog box. You can now select which content is 
to be imported into your workarea. Select OK to import the selected resources.  

4. The import is displayed by a progress dialog box. After completion, confirm this with OK.  

The imported resource is now available in the relevant resource group in the resource overview. Some resources 
need to be activated so that they can be used as the default. See also the Resource Overview. 

Note 
Since SAP Enable Now 2105 new and imported resources are not automatically kept for offline editing anymore. 
After they are saved to server, master authors can directly work on them. You can stil manually keep the necessary 
resources for offline editing through context menu. 

Duplicating resources 

In addition to the standard resources, you can create further resources by duplicating an existing resource and 
using it as a base type. 

To duplicate resources, proceed as follows: 

1. Open a resource section of the resource tree. 

2. Select a resource type to be used as a base type. 

3. Select Duplicate...  in the object editor. 

4. A settings dialog box opens. Enter a name for the resource. 

5. Select OK to create the new resource. 

Updating resources 

If you have installed a new version of the Producer, you will need to migrate the standard installation resources. 
Also pay attention here to the chapter in the Upgrade Guide for migrating workareas. 

https://help.sap.com/viewer/p/SAP_ENABLE_NOW
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Server workarea 

When using a server workarea, resources can be managed via the tree structure to make them available to all 
authors. Individual authors can then download the resources for their own local workarea. A local workarea's 
resources can also be transferred to the server workarea and exchanged.  
This is done by using the context menu when selecting a corresponding resource group or by means of the Server 
Workarea menu. 

12.3.4 Copy Over a Bubble Style 

The Copy Over function for a bubble style can be used, to replace a used bubble style with another resource. A case 
can be, to update an outdated bubble with a new created resource. Thus, not each bubble must be changed in the 
whole content. 

To copy over a bubble, proceed as follows: 

1. Select the source bubble in the resource tree, which should override the old bubble. 

2. Select Copy Over... in object editor. 

3. In the opened dialog box, adapt the following parameters:   

○ Copy "Bubble Name" over: 
Select the bubble style, that should be overridden. 

○ Name: 
Insert a name for the bubble. 
The general name form is: Old Name (New Name)  

4. Select Ok, to execute the override. 

To restore a changed standard bubble style, use the Update Resources function. 

12.3.5 Replacing Bubble Styles 

The replacing of bubble styles allows you to change the bubbles of a project easily and not to edit each macro 
individually. The function can be used for simulation and SAP Companion for desktop projects. 
The replacing of the bubble style does not influence the content of a project. 

To replace a bubble style, proceed as follows: 

1. Select a project or a content tree in the Explorer. 
or 
Open a project in the project editor. 

2. Select Tools -> Replace Bubble Styles... 

3. A setting dialog box opens. Adapt the following settings:   

○ Starts from (Explorer): 
This selection determines the point in the tree structure starting at which the bubble styles should be 
replaced. This lets you replace the bubble styles for a specific group. The object selected in the tree 
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structure is automatically displayed in the setting. 
If another starting point is to be selected, this can be done using Edit link...  

○ Only selected Macros (Project Editor): 
With this setting only the bubble styles of the before selected macros will be replaced. 
The setting will be displayed, if the dialog was opened in the project editor for a specific project. 

○ Subcategories 
The dialog contains subcategories for the project types and modes.   

○ Demo Mode (Simulation) 

○ Practice Mode (Simulation) 

○ SAP Companion for desktop  

○ Settings 
Each subcategory contains settings, to define the specific content.   

○ Set Action Bubbles: 
Select a bubble style from the drop-down box. 

○ Set Explanation Bubbles: 
Select a bubble style from the drop-down box. 

○ Use Fallback: 
Activate the setting, to use the fallback bubble style.   

4. Select OK, to replace the bubble styles. 

12.4 Content 

Various objects for creating content are available in the Producer. Each of these objects in the tree structure is a 
reference to the actual object in the particular workarea folder. This enables individually specific organization and 
use of the objects in the local and server workarea. You can refer to, or create a shortcut to, an object multiple times 
as well as manage its structure accordingly in conjunction with a server workarea. 

The Content  group is the highest learning content group and is created automatically when setting up a 
workarea. This is where all the learning content is filed. Furthermore, the structure contained in the group is used 
for presentation in the library. 
This group can be amended via Group options in the context menu with each available group capable of being 
defined as the root group. This is necessary when using a server workarea so that the corresponding root group can 
be set up locally. 

 Note 
Bear in mind that only objects contained in the root group are displayed in the library. Shortcuts and unsorted 
objects are not available in the library. 

Root group in the server workarea 

The root group of a server workarea cannot be changed. 
It is therefore necessary, when working with a server workarea, to define the root group locally: 

1. Select the Check Out Objects... function in the Server Workarea menu. Define the workarea contents in the 
open dialog and select Ok. 
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2. A dialog opens where you can choose to use the server's root group as your local root group. 
Select Yes. 

The group is now set up as the root group, the previous group is moved down in the structure and bacomes a 
shortcut.  

If you selected not to set the server root as local root, the server objects are moved to Unsorted. You can still set the 
server root as you local root through context menu. 

Setting a group as root group 

To set any group as root group: 

1. Select the group you want to have as root group. 

2. Open the context menu and go to Group options -> Set root.  

12.4.1 Content Objects 

The following objects for creating and managing content are available in the Producer: 

Process Tutorials and Documentation   

 

Simulation 

Record your application to create process tutorials and 
documentation. 

This content object is a project type and you can edit the 
project in project editor. 

Further information: Simulations - Recording, Simulations 

- Editing 

 

Text Unit 

Create and structure text fragments or create 
glossaries. 

Further information: Text Units 

Rapid Learning   

 

Quiz 

Create a quiz with different types, for example, multiple 
choice or fill in the fields. 

This content object is a project type and you can edit the 
project in project editor. 

Further information: Quizzes in Projects 

 

Book Page 

Create multimedia learning content by using texts, 
images, animations, videos, audio, and more. 

You can edit a book page in the book editor. 

Further information: Creating a Book Page 
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Process Tutorials and Documentation   

In-App Help   

  

 

SAP Companion for desktop - Context Help 

Create context-sensitive help for your application 
supplied by the SAP Companion for desktop. 

This content object is a project type and you can edit the 
project in project editor. 

Further information: Context Help 

 

SAP Companion for desktop - Guided Tour 

Create step-by-step guides for your application 
processes supplied by the SAP Companion for desktop. 

This content object is a project type and you can edit the 
project in project editor. 

Further information: Guided Tour 

 

SAP Companion - Context Help 

Create context-sensitive help for your application 
supplied by SAP Companion. 

This content object is a project type that you can edit in 
the project editor. 

Further information: SAP Companion - Authoring Guide 

 

SAP Companion - Guided Tour 

Create step-by-step guides for your application 
processes supplied by SAP Companion. 

This content object is a project type and you can edit the 
project in project editor. 

Further information: SAP Companion - Authoring Guide 

Content Structuring   

 

Group 

Use groups to structure your content in the Explorer 
tree. 

 

Book 

Use books to structure your book pages in 
the Explorer tree or Book Explorer. 

Further information: Creating a Book 

 

SAP Companion for desktop Object 

Create your content and generate your SAP Companion 
for desktop. 

Further information: SAP Companion for desktop 
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Process Tutorials and Documentation   

 

Media Object 

Use media objects to store media files as a content. 

Further information: Media Objects 

12.4.2 Creating a Content Object 

To create a content object, proceed as follows: 

1. Select a group in the workarea structure. 

2. Select New Object  in the toolbar. 
An overview of all objects opens. 

3. You can create an object based on the type or on a template. 
Select an object or a template. 
A dialog box for object-specific settings opens. 

4. Adapt the settings in the dialog box.  

5. Choose OK to create the object. 

The object is inserted into the structure. 

Content object settings 

For a new content object, there are the following settings: 

• Name: 
Enter an object name.  
The default name is the object type with an ID. 

• Language: 
Select a language from the dropdown box. 

• Template: 
Select a template. 
Choose Change... to open a selection dialog box and select a template from the workarea. Select No template 
to create an object without a template. 
If a template has already been used, that template is selected by default. 
See the chapter Templates for Content Objects. 

• Save to Server as well: 
Select whether the object shall be directly connected to the server workarea or not. 

These setting are available for some content objects: 

• Project Type (Projects only): 
The project type is selected. 
You can change the type in the dropdown box. 
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• Use Audio (Simulations only): 
This option lets you create an audio project. You can record audio, assign audio files, or convert bubble text to 
Text-to-Speech. The following settings appear:   

○ Output format: 
Defines the audio format for playing back a project.  

○ Editing format: 
Defines the audio format for editing a project. The format can be changed in the Change Audio Format... 
dialog box (menu Audio) 

• Document Type (Text units only): 
Select a type and icon for the text unit. For example: Glossary 

12.4.3 Media Objects 

Media Objects can be used to insert media content, for example, PDFs, images, or videos, into the workarea. You 
can use the objects to reference them in other content or to show the objects in the library directly. You also can 
manage the objects with a server workarea.  

You can insert the following media types: 

Icon Type 

 Microsoft Word Document 

 PDF 

 Image 

 Video 

 Audio 

12.4.3.1  Creating a Media Object 

To create a media object, proceed as follows: 

1. In the Explorer select New Object . 
An overview of all objects opens. 
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2. Select Media Object . 
The New Media Object dialog box opens. 

3. Adapt the following settings:  

1. Name: 
Enter a media object name. 
The default name is the object type with an ID. 

2. Language: 
Select the language for the media object. 

3. File: 
Shows the location of the selected file. 

4. Media Type: 
Shows the media type of the selected file. 

4. Select OK to insert the media object 

The media object is inserted into the structure and shows the icon of the media type inserted. In the object editor, 
further properties of a media file are displayed, for example, duration for videos or size for images. 

12.4.3.2 Converting Files to Media Objects 

Media objects have capabilities which imported files do not have. For example, media objects can be tracked or can 
be used as SAP Companion or SAP Companion for desktop content. These object types can also be relevant for 
publications when the export takes all dependent resources and objects including assets not directly used. For 
example, you have a group with 10 images and you have referenced 2 of them. In this case the whole group will be 
taken into publication. This happens because files are stored in a group, as opposed to media objects which are 
independent objects.  

You can convert your imported files, for example, images and videos, to media objects in your workarea. The media 
files will be created as new objects. 

Converting the files 

To convert files to media objects, proceed as follows: 

1. Select a group in the tree structure which you want to convert your imported files from. 

2. Open Tools -> Workarea Structure -> Convert Files to Media Objects... 

3. A dialog opens with the following settings: 

1. Start From: 
This field is prefilled with the name of the group you have selected in Step 1. If you want to convert files 
from a different group, select it here. 

2. Include Images, Audio, Video, Other Files: 
Specifies file types for the conversion. By default all types of files are selected. Deselect the boxes of 
types that you do not want to convert to media objects. 

3. Update references (Advanced section): 
Specifies that all references of the imported files will be changed to the converted media 
objects.Deselect this option if you do not want references to be updated. Note, if you choose not to 
update references, then do not remove the originals. Otherwise the references will be broken. 
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4. Remove converted files (Advanced section): 
Specifies that the converted files are deleted. By default files will be replaced by media objects and the 
originals are deleted fully and are not moved to trash either on Producer or on Manager. To keep the 
original files deselect this option. 

5. Collect all Media Objects into (Advanced section): 
You can select a group to collect the converted media objects. This will create subgroups by media type: 
Converted Images, Converted Audio, etc.  

4. Once you have chosen the settings, select Ok. 

Note 
Note, that after conversion your original files will be deleted completely and will not be moved to trash either on 
Producer or on Manager. Deselect the option Remove converted files in the Advanced section of the dialog. 

Your files have now been converted to media objects are inserted into the structure. They will show the icon of the 
media type. For example, for images you will see  instead of . 

There are further properties of a media object displayed in the object editor, for example, duration for videos or size 
for images. 

Note 
Note, that the functionality to Update Externally Loaded Files will not work for the converted media objects. This is 
due to the Original File property, that now points at the converted object instead of the original source file. 
Updating externally loaded files is only available for unconverted files or for manually created media objects. 

12.4.4 Standard Parameters of Content Objects 

For the content objects, there are the following standard parameters: 

Parameter Description 

Name 
Contains the name under which an object is shown in 
Explorer, the library and the documentation. 

UID 

Contains the unique identifier for the selected object and 
can be accessed in Advanced Layout. It consists of an 
abbreviation of object type followed by underscore and 
unique ID of the object. This parameter is non-
modifiable. 

Language 
Specifies the language of the content. Defines the used 
text modules for projects. 

library Autostart 

Allows a particular mode, book page or document to be 
started or opened automatically when selecting an 
object in the library. This function is useful, for example, 
if only one mode is to be displayed in the library for a 
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Parameter Description 

simulation or else to highlight a particular mode or 
particular document. When the mode has been 
terminated or the document closed, the user is free to 
select the project content as usual. 
This function can also be defined for groups, for example 
in order to display a document or book page when 
selecting the group, the book page is hidden in the 
library structure. 

Short Description 

Allows you, to edit a short information for the content 
object. The text is used in the library, for the SAP 
Companion for desktop or when generating a 
documentation. 

For the editing the HTML editor is opened, when clicking 
into the edit field. 

Description 

Allows you, to edit a descriptive text for the content 
object. The text is used in the library, for the SAP 
Companion for desktop or when generating a 
documentation. 

For the editing the HTML editor is opened, when clicking 
into the edit field. 

Hide 
Allows you, to hide an object in the library. It can also be 
used to hide objects when generating a documentation 
or when publishing a workarea. 

Start Link 
Contains a link, which can be used to start the playback 
of the specific content object. 

Tags Allows you, to define tags used for the creation of filters. 

Keywords 

Allows you, to specify keywords for an object. The 
learners can use these to search for specific learning 
content in the library or in the book reader. 

To define a number of search terms separate them by a 
semicolon (for example: 
search_term1;search_term2). 

Context 
Contains the recorded context of an application and 
application page. The context is used for SAP 
Companion for desktop content. 

Roles 
Allows you, to define roles used for the filtering of 
content during playback 



 

Producer (Cloud Edition) 
Workarea and Administration 

 
PUBLIC   392 

 

Parameter Description 

Duplication Source 
Contains a link to the source object used for the 
duplication. 

Duplication Master 
Contains a link to the original duplicated object, if an 
object has been duplicated from a duplicated object. 

Imported UID 
Contains the UID of the original object if the content has 
been imported. 

12.4.5 Individual Parameters of Content Objects 

For the content objects, there are the following individual parameters: 

Parameter Description 

Group   

Subtype 

Contains subtypes for a group which will be used for 
different content scenarios. The subtypes is set 
automatically. 

For further information about the types, see the SAP 
Solution Manager integration guide and the ARIS® 
integration guide on the SAP Help Portal. 

Project (Simulation)   

LMS 
(Subcategory) 

To evaluate the learning success in Test mode within an 
LMS (Learning Management System), the Maximum 
Score and the Required Score can be specified in 
Explorer for the project. 
To do this, enter the corresponding percentages for the 
project concerned in the subcategory LMS of the object 
editor. The project must be selected in the tree 
structure. The preset values are 100 and 80. The values 
entered are used later on by the Simulation Start macro 
to calculate the numeric values for the Maximum Score 
and the Required Score for the project. 

Book   

Subtype 
Allows you to specify a book page as book page 
template. 

Book Style Allows you to specify a Book Style resource for the 

https://help.sap.com/viewer/product/SAP_ENABLE_NOW
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Parameter Description 

complete book. 

Book Page   

Preview Displays a thumbnail view of a created book page. 

Text Unit   

Document Type Allows you to specify the type of the text unit. 

12.4.6 Templates for Content Objects 

Templates can be made for objects that are created for workareas in Explorer. The templates are useful for saving 
time as well as for ensuring uniformity for newly-created objects when more than one author is working on the 
content. 

Templates can be created for the following objects: 

• Projects 

• Groups 

• Book pages 

• Books 

• Text Units 

• SAP Companion for desktop 

Creating a template 

To create a template, proceed as follows: 

1. Create a new object by selecting New Object  from the toolbar in the project editor. It is recommended that 
you save this in a folder in your workarea that is specifically for templates. 
A dialog box for object-specific settings opens. 

2. Enter a name for the template, for example, Standard template. 
Choose OK to create the object.  

3. Configure your content object as desired. For example, you can specify the layout for book pages, you can 
insert default objects in book pages or projects, or you can specify object-specific authoring settings. 

4. Save the content object.  

Specifying a template for the New Object dialog box 

You can use a set of different templates to create new objects by using the New Object dialog box. This allows you 
to set up templates for different content types and use cases. 

To display a template in the Template section of the New Object dialog box, proceed as follows: 

1. Select a template in the tree view. 
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2. Select Template setting in the object editor. 

3. Enter a description text in the Description setting. 

The template is now displayed in the Template section, and the group is displayed as a title in the Template section. 

Specifying a template in the Settings dialog box 

You can use a template to create a new object or it can be specified as a general template for creating new objects, 
which will then serve as the default settings for the new objects. 

To use an existing template, proceed as follows: 

• For an individual object 
Create a new object. In the New Object dialog box select your template under Template. Select Change...  to 
choose a template from your workarea. Select your template from the opened dialog box and select OK. 

• As a general template 
If you would like to use a template for all the objects, open the settings dialog box from the menu Tools -> 
Settings...  in the area Producer -> Templates. Select the desired template to be used for the object and 
select OK. 

12.4.7 Duplicating Objects 

The Duplicate  function allows you to duplicate an object or an object structure. Through that, you can use the 
available content for adaptations and variations and do not change the source object. 

To duplicate an object, proceed as follows: 

1. Object in explorer 

1. Copy an object or a content tree in the Explorer. 

2. Select a group of the content tree. 

3. Paste the copied object. 

4. A dialog box opens. 
Select As Duplicate... 

2. Single project or book page 

1. Open a project in project editor or a book page in book editor. 

2. Select Edit -> Duplicate... 

3. A dialog box opens. 
Adapt the following settings:  

• Name: 
With this setting, you can change the name of the duplicate. 
Select an option from the dropdown box to edit the name: 

○ Keep Original Name: 
Uses the original name of the object and subobjects. 

○ Add Sequential Number: 
Adds a sequential number to the original object name of the object and subobjects. For example: 
Name (2) 
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○ Enter New Name: 
Allows you to enter a new name for the object or the root object of a content tree. 

○ Transform Original Name: 
Allows you to replace the name or parts of the name for a content tree. 
Use replace by to enter a name value and a replace value. 
Use Prefix or Suffix to add a name part in front or at the end of the name. 

• Set Language: 
With this setting, you can change the content language of an object. 
The setting does not influence the content and no automatic translation is executed. 

• Duplicate subobjects: 
With this setting, you can also duplicate the subobjects of a selected content tree. If the setting is 
deactivated, the subobjects are created as a reference. 
The setting is shown if you select a tree in the Explorer. 

4. Confirm the dialog box with OK to duplicate the object or content tree. 

12.4.8 Using References 

The physical object of a learning content can be referred to as often as necessary. If changes are made in a 
reference, these are also contained in the other references. 
The opportunity therefore exists to use a particular object for different parts in a project structure. This is the case, 
for example, if an object is to be offered for different target groups in conjunction with different additional content. 

Creating a reference 

 Note 
Bear in mind that only one reference can be created for an object within a group. Create object references only in 
different groups. 

1. To create a reference, select the desired object in the tree structure. 

2. Then, with the right mouse button held down, move the object to the appropriate position using drag&drop.  

3. A context menu is opened when you release the mouse button. Select the Reference menu option to create the 
reference.  



 

Producer (Cloud Edition) 
Workarea and Administration 

 
PUBLIC   396 

 

 Note 
If your references contain Microsoft Word documents and you use them to create a master document, this master 
document will include all the documents referred to. If you wish to block the publication of duplicate documents, 
then you can hide them while the central document is being published or define the contents by means of filters. 

 Recommendation 
You can use filters to define the way objects are depicted for different users so that content is not displayed to a 
user multiple times. 

12.4.9 Creating Shortcuts 

Shortcuts allow you to access any string within a complex project structure. For example, a project can be filed 
locally as a reference from the server workarea so that it can quickly be made available for editing. 

 Note 
As shortcuts refer to an object and are therefore not contained in the base group, they are not displayed in the 
library. 

Creating a shortcut 

To create a shortcut, select the desired object and right click on the context menu to open it. Then click on New 
Shortcut . 

The shortcut is now placed beneath the base group and flagged with a shortcut symbol . If the object is a group 
or book, then it will be displayed with the associated sub objects. 

Deleting a shortcut 

To remove a shortcut, select the object with the shortcut symbol and delete it using the Delete (Del) key or via the 
Edit -> Delete  menu. 

Linking a shortcut 

To make it easy to link objects, up to five links are displayed in the Insert link dialog. This way, content used multiple 
times can be selected quickly and directly. 

12.4.10 Unsorted Objects 

As the Workarea objects are references, objects may in certain circumstances be displayed in the Explorer as being 
unsorted. This will be the case if an object is not assigned to the topmost or to a subordinate group.  
Unsorted objects can arise for the following reasons: 

• by objects migrating  

• when importing archives  
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• by downloading objects from a server workarea  

• by setting a new topmost group  

The Unsorted  are arranged at the bottom of the tree structure. 

 Note 
Unsorted objects are not displayed in the library. To display them, subordinate the objects to the topmost group. 

Inserting unsorted objects in the topmost group 

You can assign unsorted objects to the topmost group and thus relocate them to the desired position within the 
tree structure. This is done by dragging and dropping the object in question. 

If you want to assign an object to a specific group or book, then you can do so using the Append Unsorted . To do 
so, select an object, open the context menu and click on Append Unsorted. All objects filed as being unsorted, are 
then assigned to the group or book. 

Unsorted objects when using the server workarea 

Unsorted objects may appear in a server workarea for a variety of reasons. This is how you deal with a base group in 
the server workarea: 

• Unsorted objects may occur when using a server workarea if an object is downloaded without the referenced 
objects. 
You can now also check out the referenced objects. These will then be located within the base group in their 
actual position.  

• Unsorted objects can also occur if a server workarea has changed. This is then to be reallocated accordingly.  

• It is not possible to use multiple topmost groups in a workarea. When downloading additional topmost groups, 
these are set as unsorted objects. 
When using a server workarea, always create a new workarea.  

12.4.11 Replacing Content 

In some cases, you are required to keep the UID of a content object but to use a different content. For example, a 
simulation is linked and the link contains the UID. To change the content of the simulation you can replace the 
content with the content of another project. 

You can replace the content of each object in the workarea with the content of an object of the same type. For 
example, the content of a project can be replaced with the content of another project. You can also replace the 
content and structure of a group or book. 

 Note 
After you replace the content, it is not possible to change the content back to the previous status by using undo. 

You can use Revert Object to change the object back to a previous version. 

To replace content, proceed as follows: 

1. Select the object in the tree whose content you want to replace. 
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2. Select Edit -> Replace Content... 
The Select Source Object dialog box is opened. 

3. Select the object with the required content. 

4. Select OK. 

The content of the object is replaced. If you have selected a group or book the structure is replaced also. 

12.4.12 Generating All Content 

The function generates all project modes and preview images of the book pages in the current workarea. This is 
especially important for migrated workareas or for a large number of imported content objects. 

Open the dialog box in the Explorer from the Workarea -> Generate All Content... menu. The following settings can be 
configured: 

• Structure: 
Defines the structure for generating the content.   

○ Subtree – a selected subtree 

○ Root Group – the complete content structure 

○ All (including “Unsorted”) – the complete content structure and the unsorted objects 

• Content filter: 
Defines specific content to be generated.   

○ Project Modes 

○ Book Page Previews 

• Update files for library: 
Specifies that the library files are updated to include the generated modes for display in the content structure. 

Confirm the dialog box with OK to generate the contents. 

12.4.13 Reducing the File Size of the Content 

The table contains tips for reducing the file size of the content: 

Recommendation Explanation Function 

Reduce screen resolution 

(Simulation) 

Reduce the recording screen 
resolution  
(1024 x 768 is usually sufficient). 

Settings : 
Authoring Settings -> Recording - 
General -> Size 

See also chapter Recording - General 

Merge identical Screenshots 

(Simulation, 
Documentation) 

Merge Screen macros in a project. 

Project Editor: 
Tools -> Bulk Changes -> Merge 
Screens 

See also chapter Merge Screens 
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Recommendation Explanation Function 

Publish content 

(Simulation) 

Publishing the content will 
automatically remove all files not 
required for playback. 

Explorer: 
Menu Workarea -> Publish -> Publish 
Content... 

See also chapter Publishing a 
Workarea 

Cropping the screenshots for 
documents 

(Documentation) 

Use auto crop to reduce the 
screenshot size for documents. 

Project Editor: 
Tools -> Bulk Changes -> Auto Crop 
all Screenshots  

See also chapter Auto Crop all 

Screenshots 

Reduce the color depth for 
documents 

(Documentation) 

Reduce the color depth for 
documentation screenshots. 
Besides RGB quality, you can also 
choose Indexed Color or Grayscale. 

Settings : 
Documentation Settings -> 
Documentation Type -> Screenshots 

• Quality in Word/PDF 
documentation 

• Quality in HTML documentation 

See also chapter Settings of the 

Subcategories 

Use referenced content 

(Books) 

Create a media folder in a book. The 
folder is published with the book but 
should not be visible to the learner. 

You can add media files to the media 
folder at any time. If a large quantity 
of media files is used, the folder can 
be divided into images, videos, audio 
and so on. 
Insert any media file into a book page 
by importing it directly from the 
workarea media folder as a reference 
to avoid redundant files. 

  

Check media content size before 
importing 

(Books) 

Before importing media files into the 
content folder, check the size of each 
file and reduce the file size if 
necessary (by compressing images 
or using a different video or audio 
codec). 

  

Use templates 

(Books) 
To avoid redundancies caused by 
background images, create a 

Settings : 

Application -> Templates 



 

Producer (Cloud Edition) 
Workarea and Administration 

 
PUBLIC   400 

 

Recommendation Explanation Function 

template for each book page. See also chapter Templates for 

Content Objects 

Explorer: 
New Book Page dialog -> Template 

See also chapter New Book Page 

Example 

Steps to reduce the size of documents Result in KB 

Standard project with 20 recorded steps & 
documentation 

4850 

+ Merge Screens 4065 

+ Merge Screens 

+ Auto Crop 
2414 

+ Merge Screens 

+ Auto Crop 

+ Grayscale 

1374 

+ Merge Screens 

+ Auto Crop 

+ Indexed Color 

935 

12.5 Server Workarea 

A server workarea helps groups of authors to collect and manage workareas centrally. This allows uniform 
resources to be made available to all authors. It also allows content to be set up centrally and assigned to the 
respective authors for recording. A server workarea is created using the Manager, which is a server-based 
productive environment. 

Further information about the Manager is available in the manual and the guides for the product. 

12.5.1 Menus and Functions of the Server Workarea 

If you are connected with a server workarea, these additional settings and functions are available in the Producer: 

Server Workarea Menu 
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In the Explorer, there is an additional menu Server Workarea display, which contains functions for managing the 
objects in the local workarea and the server workarea. Specific functions are also available in the context menu of 
an object as well as in the object editor. 

For more information, see the Server Workarea Menu chapter. 

Settings 

There are settings that influence how you work with the server workarea. Open the Settings...  dialog box in the 
Producer -> Server Workarea area. 

Further information is available in the chapter Server Workarea. 
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Object Icons 

After a connection to a server workarea has been made, the objects in the tree structure will have these additional 
icons: 

Icon Description 

 Object is locked and cannot be edited. 

 Write permission is available and object is not edited. 

 Object is kept for offline editing and not edited. 

 Write permission is available and object is edited. 

 Object is server object, but locally not loaded. 

Synchronization 

To upload and download content and resources, the Producer uses the synchronization between the local workarea 
and the server workarea. The toolbar of the Explorer contains the button Synchronize Workarea  to start 
synchronization. 

Further information is available in the chapter Synchronization of a Server Workarea. 

12.5.2 Reusing Content from Other Workareas  

You can reuse content and resources from another workarea to support content alignment between different 
workareas. This is very helpful for the central management of, for example, templates, styles, or to reuse content in 
different content senarios. For this you can use the workarea extensibility functionality which needs to be set up 
from SAP Enable Now Manager.  

Prerequisites 

Enable the workarea extensibility functionality and set up an overlay for your workarea. 

For information on how to set it up see the chapter Reuse content from other workareas in SAP Enable Now Manager 
Manual. 

Fetching an object 

Once you have configured the workarea overlay, you can start reusing the content from another workarea. You can 
recognize inherited content by an orange dot in front of the name. 

To edit an object that comes from a workarea overlay, you need to fetch this object to your local workarea. 

https://help.sap.com/doc/304bd227b95241d49b3132c7fbbc8195/latest/en-US/Manager_Manual_en-US.pdf
https://help.sap.com/doc/304bd227b95241d49b3132c7fbbc8195/latest/en-US/Manager_Manual_en-US.pdf
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To fetch an object, proceed as follows: 

1. Select the object you want to edit that comes from a workarea overlay. 

2. From the context menu or Server Workarea menu select  Start Editing. 

3. The Fetch inherited objects dialog opens: 

1. Select Yes to fetch the data and to edit the object. 
 

2. If you want to keep the object untouched and to abort the editing, select No. 

4. The object is now fetched to your local workarea and becomes part of it. You can edit it. 

 Note 
The fetched object will not be synchronized with the base workarea anymore. Changes that are done in the base 
workarea will not take effect in your workarea. 

Resetting the content 

To reset the changes you have made and return the original object from a base workarea, you need to delete your 
locally edited object from the Manager interface. Once you delete it, the original object is restored and you see an 
orange dot in front of the object name again. 

12.5.3 Server Workarea Menu 

The menu contains commands for the management of objects between the local and the server workarea. 

This menu is available only if the local workarea is connected with a server workarea. Use the menu Workarea -> 
Administration -> Connect with Server...  to connect with a server workarea. 

12.5.3.1 Opening Producer from Manager 

When you Open Producer from the Manager for the first time, the resources and must-have objects are 
automatically checked out.  

• If you have objects assigned to your user, there is a dialog asking if you want to checkout these objects. 

• If no objects are assigned to your user, there is a dialog asking if you want to checkout content from the 
Manager. You can specify which content you specifically want to checkout in the next step of this dialog.     

12.5.3.2 Check Out Assigned Objects 

The Check Out Assigned Objects  command allows you to download all objects contained in a server workarea to 
the local workarea which are assigned to you. However, you don't have to check out the complete structure. When 
the objects are checked out, you can choose which ones to work on and start editing them manually. 
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12.5.3.3 Check Out Objects... 

The Check Out Objects...  command lets all of the objects in a server workarea be downloaded to the local 
workarea. Selecting the command opens a list containing all the objects in the server workarea. The objects that are 
not yet located in the local workarea are selected. Once the desired objects have been selected, they can be copied 
to the local workarea using the Check Out Objects... function. 

12.5.3.4 Synchronize Workarea... 

The Synchronize Workarea...  command synchronizes the objects in the local workarea with those in the server 
workarea. 

12.5.3.5 Save to Server 

The Save to Server  command saves the object currently selected in the explorer to the server workarea. 

12.5.3.6 Revert Object... 

The Revert Object...  command replaces the local version of the object with the most recent version deposited in 
the server workarea. This requires the write permission for the object. 

12.5.3.7 Start Editing 

The Start Editing  command gets the write permission for the object selected in the explorer from the server 
workarea and updates the version available in the local workarea. The object can then be edited in the local 
workarea. 

An object for which no write permission is available is indicated by a blue cloud  on the object icon. If you 
possess the write permission a green pencil  appears on the object icon. 

 Note 
You can only acquire the write permission for an object if it has not already been checked out by another author 
from the server workarea into their local workarea. 

 

 Note 
If you start editing an object that comes from a workarea overlay, the object is fetched to your local workarea and 
becomes part of it. You can then adjust it. This fetched object will not be synchronized with the base workarea 
anymore. For more information see Reusing content from other workareas section. 
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12.5.3.8 Finish Editing 

The Finish Editing  command returns the write permission for the object selected in the explorer to the server 
workarea and saves the changes made in the local workarea within the server workarea. 

The relinquished write permission is then symbolized on the object by a blue cloud . 

12.5.3.9 Change Workflow... 

The Change Workflow...  command allows an object's workflow to be edited. It opens a dialog box that you can 
use to enter a comment and to assign the object to another user. It is still possible to amend the status, set flags, 
and publish the object. 

12.5.3.10 Keep Object for Offline Editing 

The Keep Object for Offline Editing  command allows you to "pin" a server object to your local workarea. 
Subsequently, the selected object will not be automatically finished during workarea synchronization before 
shutting down the application or switching the workarea. 

Use this command if you want to start editing an object even without an internet connection. If you haven’t started 
editing the selected object yet, this command automatically allows you to start editing the object. 

 Recommendation 
To ensure consistency of the content structure as well as to enable other authors to process the content, please 
remember to release the object after you’ve finished editing or when you’re online again. Use the Release Object 

for Online Editing  command to do so. 

12.5.3.11 Release Object for Online Editing 

The Release Object for Online Editing  command releases a server object previously kept for offline editing, 
finishes editing automatically, and saves the modifications, if there are any, to the server. The command appears 
only for local server objects. 

12.5.3.12 Update from Server 

The Update from Server  command updates the object that has just been selected in the explorer with an up-to-
date copy of the object from the server workarea. 
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12.5.3.13 Remove Locally... 

The Remove Locally...  command removes the data (like assets) of the currently selected as well as all objects in 
the subtree below from your local workarea and excludes the object and sub objects from future server 
synchronizations. This allows you to keep only objects you need for your authoring work without messing up your 
structure nor your local hard drive space while keeping the server structure intact. The command appears only for 
local server objects. 

To load the object data back into the local workarea right-click the object and select Load from Server . 

12.5.3.14 Save All Objects to Server... 

The Save All Objects to Server...  command saves a number of local workarea objects to the server workarea. It 
does so by opening a dialog box in which the available objects can be selected. 

12.5.3.15 Start Editing All Objects... 

The Start Editing All Objects...  command checks out the write permission for the objects available in the local 
workarea. It does so by opening a dialog box displaying the objects contained in the server workarea. You can select 
these objects and then the objects' write permission is checked out using the Start Editing button. This involves 
copying the current versions of the objects to the local workarea. 

The objects for which write permission has been checked out are indicated by a green pencil  on the object icon. 

 Note 
You can only acquire the write permission for an object if it has not already been checked out by another author 
from the server workarea into their local workarea. 

12.5.3.16 Finish Editing All Objects... 

The Finish Editing All Objects...  command returnes the write permission for all objects in the local workarea and 
saves the changes applied in the local workarea to the server workarea. When you choose this command, a dialog 
box opens. It displays the objects with local write permission. The write permission for the selected objects can now 
be saved in the server workarea using Finish Editing. 

A blue cloud  on the object symbolizes that you’ve given up your write permission. 
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12.5.3.17 Change Workflow for All Objects... 

The Change Workflow for All Objects...  command enables the editing of the workflow for all objects. A dialog box 
opens in which you can select the objects available in the local workarea. Choose OK to open a dialog box in which 
you can enter a comment along with the user you want to assign the objects to. It is still possible to amend the 
status, set flags and publish the objects. 

12.5.3.18 Keep All Objects for Offline Editing... 

The Keep All Objects for Offline Editing...  command allows you to "pin" multiple server objects to your local 
workarea. It opens a dialog box displaying all objects located in the subtree of the currently selected tree object. By 
using the checkboxes you can select and deselect individual objects. When you choose OK, all selected objects are 
"pinned" to the local workarea. Objects you have not started editing yet, will be automatically started editing. 

Subsequently the selected objects will not be automatically finished on workarea synchronization before shutting 
down the application or switching the workarea. Use this command in case you want to proceed editing multiple 
objects even without having an internet connection. 

 Recommendation 
To ensure consistency of the content structure and to enable other authors to process the content, please 
remember to release the objects when you’re finished editing or when you’re online again. Use either the Release 

All Objects for Online Editing...  command to do so or release objects individually by using the Release Object for 

Online Editing  command. 

12.5.3.19 Release All Objects for Online Editing... 

The Release All Objects for Online Editing...  command lets you release multiple server objects previously kept for 
offline editing. A dialog box that displays all objects kept locally in the subtree of the currently selected tree object 
opens. By using the checkboxes, you can select and deselect individual objects within the selection. By choosing 
OK, all selected objects will be released to the server. This finishes the editing and the modifications are saved to 
the server. 

12.5.3.20 Update All Objects from Server... (without 
Synchronization) 

The Update All Objects from Server...  command updates the objects available in the local workarea with an up-to-
date copy from the server workarea. It does so by opening a dialog displaying the objects contained in the server 
workarea which are to be updated. These objects can then be selected and copied to the local workarea using the 
Update from Server button. 
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12.5.3.21 Manage 

The menu contains commands for the advanced management of objects in connection with a server workarea. 

12.5.3.21.1 Manage Tags... 

The Manage Tags...  command opens a dialog box in which new tags can be created and existing tags can be 
deleted. 

12.5.3.22 Manage Tasks... 

The Manage Tasks...  command opens a dialog box that displays the object tasks. By double clicking a task, you 
select the object in the explorer and close the dialog box. 
When you choose Filter..., you call a dialog box in which you can select various filter criteria for filtering a list. Reset 
Filter returns the original state. 

12.5.3.23 Work Offline 

If you use Manager to launch a server workarea, the Work Offline  function allows the connection with the 
Manager to be severed while work is in progress. The connection is intended only for downloading objects and for 
saving objects on the server. While the connection is severed, entries in the Server Workarea menu are grayed out. 

12.5.3.24 Open Object in Manager 

The Open Object in Manager command opens the currently selected object in Manager interface in a browser 
window.  

12.5.3.25 Open Manager 

The Open Manager command opens the currently connected workarea in Manager interface in a browser window. 
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12.6 Synchronizing a Server Workarea 

Synchronization supports the communication between the local workarea in the Producer and the server workarea. 
The contents and resources can be shared easily, available changes and new objects can be checked out or saved 
to the server, and it only takes one click to start editing. 

The following chapters give you an overview of the settings and the use of synchronization, and shows you use 
cases for your daily work. 

12.6.1 Synchronizing a Workarea 

You can synchronize of a workarea by using the Synchronize Workarea  toolbar button in the Explorer. With the 
click of a button, the Producer synchronizes the server objects in the local workarea with the server workarea 
regarding available changes. Subsequently local server object modifications are saved centrally and the local 
workarea is updated with central changes. This means, the synchronization runs in both directions. 

 Recommendation 
Depending on the number of objects and the available changes in a workarea the synchronization can take a while. 
The synchronization should be done as preparation of the editing as well as after the editing of a number of 
objects. 

 Note 
After the synchronization your changes are visible on the Manager with some minutes delay. This depends on the 
Caching Time Range in your server settings. 

Locally changed objects 

In a workarea, edited objects are highlighted with a star icon . This shows you whether changes are only 
available locally. 

Synchronizing when closing Producer 

When closing the Producer, a dialog box with the buttons Synchronize and Keep Object for Offline Editing is shown. 
Clicking the Synchronize button triggers the synchronization. This means, available changes are saved to the server 
and the editing of local edit server objects is finished automatically, except for server objects which have been kept 
explicitly for offline editing. 
When you choose Keep Object for Offline Editing, no synchronization takes place. This means local changes and 
editing information will not be exchanged with the server. 

You can predefine this behavior in the Settings  in Producer > Server Workarea, as well as for the events of 
switching to another server or the workarea. 
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12.6.2 Keeping Objects for Offline Editing 

Objects can have two states, either they are local without connection to a server or they are connected to a server. 
To edit objects with a server connection, objects can be kept for offline editing regardless of the automatic Finish 
Editing on Producer shutdown or workarea switch. This excludes them from the object collection and from being 
touched by server synchronization. 

Keep object for offline editing 

This is how you can keep objects for offline editing: 

• Single objects 

○ Select an object in the Explorer tree. 

○ Select Keep Object for Offline Editing  in the upper section of the Object Editor. Or use the object’s 
context menu to select this option. 

• Multiple objects 

○ Select the root item of the branch containing the objects. 

○ Extend the Show Tree Operations  menu in the upper section of the Object Editor and choose Keep All 
Objects for Offline Editing... . Or use the object’s context menu -> More... to select this option. 
A dialog box in which you can select objects opens. Confirm with OK. 

Release object for online editing 

To enable objects synchronization again and for being edited by other authors, offline objects can be released like 
this: 

• Single objects 

○ Select an object in the Explorer tree. 

○ Select Release Object for Online Editing  in the upper section of the Object Editor. Or use the object’s 
context menu to select this option. 

• Multiple objects 

○ Select the root item of the branch containing the objects. 

○ Extend the Show Tree Operations  menu in the upper section of the Object Editor and choose Release 
All Objects for Online Editing... . Or use the object’s context menu -> More... to select this option. 
A dialog box in which you can select objects opens. Confirm with OK. 

12.6.3 Additional Synchronization Settings 

For each object there are additional settings that specify how the object is handled for other users. In general, the 
master author uses the settings to provide predefined content or resources for the authors. 

The settings are: 

• Must Have: 
Activate this setting if the object has to be downloaded automatically. 
The setting can be used for content objects and resources. 
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• Create Shortcut: 
Activate this setting if the object has to be added to the users’ workareas as a shortcut. 
This setting can be used for content objects. 

12.6.4 Samples for Using Synchronization 

The following samples show you how to use synchronization in different situations. 

Download new objects from Manager that are not in a local workarea 

Steps to do: 

• Synchronize Workarea  (if your local workarea has only a subtree with all of the content, you will get new 
objects only for your subtree but not outside your tree) 
or, 
as an alternative, use the menu Server Workarea -> Check Out Objects…  (a dialog box shows all new objects 
and you can select the objects you want to download). 

Retrieve all changed objects from Manager (changes of other authors) 

Steps to take: 

• Synchronize Workarea  
or, 
as an alternative, Start Editing All Objects…  (and Finish Editing All Objects… ) for the required subtree. 

12.7 Preview library 

You can generate a library for your content based on the workarea structure. Only objects that have not been set to 
Hidden are included in the library. In the workarea defined filters are also used for the open library. The library is 
displayed in a new browser window. 

There are the following buttons in the toolbar: 

•  Preview library: 
Generates a library for the complete workarea tree. 

•  Preview library from Selected Group: 
Generates a library for a selected group along with the included content. 

12.8 Filters in the Workarea 

The ability to set up filters is offered to enable large workareas to be better administered. These can be applied to 
the tree view in the Explorer, for publishing workareas or for the use in the library by the learners. 
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A filter is based on one or more properties that you can freely create using conditions and assign to the desired 
learning content. These kinds of properties can be master tags or tags as well as language or type of objects. If a 
filter is selected, only those objects are displayed in the tree view that correspond to the filter. 

12.8.1 Master Tags and Tags 

Tags are terms or strings that are specified by authors for content objects and can be used to create filters. There 
are two types of tags: 

 

Master tags 

Master tags are created centrally by master authors and are stored as Adaptable Resources 
resource. Authors can use the master tags to assign them to their content objects. 
The type is recommended for globally-used tags for consistent use in filters. 

For more information, see Managing Tags. 

 

Author Tags 

Author tags can be created individually by authors and are stored in assigned content objects 
only. If the tag is not assigned to a content object, if it is not available anymore. 
The type is recommended for object-specific tags which are used temporarily. 

For more information, see Assigning Tags. 

12.8.1.1 Managing Tags 

Author tags  and master tags  are managed in the Manage Master Tags dialog box. To open this dialog box, 
choose Tools -> Manage Master Tags...  in the menu. 

In the Master Tags dialog box, you can create, rename, and delete master tags and author tags. 

Creating master tags 

To create a master tag, proceed as follows: 

1. Select the Add  button. 
A dialog box opens. 

2. Enter the name of the master tag.  

3. Confirm with OK. 

The new master tag is displayed in the list. 

Renaming tags 

You can change the name of a master tag. Proceed as follows: 

1. Select the Rename  button. 
The Rename Master Tag dialog box opens. 

2. Change the name of the master tag. 

3. Confirm with OK. 
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The tag is displayed with the new name. 

 Note 
When renaming a master tag that has been assigned to content objects you have the following options: 

Master and All References 
Renames the master tag and all assignments in the content objects. 

Master Only 
Renames the master tag only. For the assignments a new author tag with the previous name of the master tag is 
created. 

Removing tags 

To remove a master tag, proceed as follows: 

1. Select the author tag in the list. 

2. Select the Remove  button. 

Once you have edited your master tags, close the dialog box by clicking OK. 

 Note 
When removing a master tag that has been assigned to content objects you have the following options: 

Master and All References 
Removes the master tag and all assignments in the content objects. 

Master Only 
Removes the master tag only. For the assignments a new author tag with the name of the master tag is created. 

Replacing tags 

You can replace the assignments of a tag in your content objects with another tag. To replace a master tag or 
author tag with another tag, proceed as follows: 

1. Select the master tag or author tag in the list. 

2. Select the Replace  button. 
The Replace Master Tag dialog box is opened. The selected tag is displayed in the Replace field. 

3. Select a master tag or author tag in the With dropdown box. 

4. Select OK. 

The tag in all objects are replaced with the replace tag. 

Changing author tags to master tags 

You can change your created author tags to master tags. Proceed as follows: 

1. Select the author tag in the list. 

2. Select the Change to Master  button. 

The tag is displayed with Master Tag type and icon. 
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12.8.1.2 Master Tags Resource 

When you create master tags, a Master Tags  resource is created in the Adaptable Resources  of the resource 
tree. This resource includes all master tags. 
The resource allows you to use the master tags consistently in different workareas and you can also handle the 
resource in an authoring environment with a server workarea. 

Type Description 

Icon  

Master Tags resource 

Basic properties 

The object editor contains the following parameters: 

• Name: 
Specifies the name of the resource. 

• Object Type: 
Specifies the type of the resource. 

• Content: 
Shows the available master tags of the resource. 

Object functions 
The object editor contains the following control: 

•  Edit Master Tags... 
Opens the Manager Master Tags dialog box. 

Merging master tags 

In some cases, more than one Master Tags resources is available in your workarea. This can happen when different 
users creating master tags in their local workareas. 

To merge Master Tags resources, select Tools -> Merge Master Tags . 

 Note 
The merged Master Tags resource cannot be undone. The merged resources are moved to the Trash . 

12.8.1.3 Assigning Tags 

If you have defined master tags, you can assign them to the objects within your tree structure: 

1. Select the object in the tree structure to which you would like to assign a master tag.  

2. Select Edit Tags...  next to the parameter Tags in the object. 
The assignment dialog box is opened.  

3. You can now assign one or more master tags to the object. To do so, select the corresponding checkbox.  

4. Select OK to confirm the dialog box. 
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Creating a tag 

You can create additional tags in the Edit Tags dialog box. This allows you to provide a filter with more complex 
criteria.  
The tags created in this manner are not available in the Edit Master Tags...  dialog box and are only used for the 
object. 

To do this, enter a tag in the text box and select Add. You can then assign the tag to your object. 
If you want to delete the tag from the object, deselect the tag in the dialog and confirm with OK. 

Used tags 

In the Manage Master Tags dialog box, you can see whether a tag is assigned and how often. A number is displayed 
in the References column of the tags list. 

12.8.2 Creating Filters 

To create a filter for your workarea, proceed as follows: 

1. Select Filter Tree  -> New Filter... beside the search field. 
The Edit Filter dialog box opens. 

2. Select New. 

3. Enter a Filter Name in the upper text box. 
If you do not enter a name, the combination of the filter criteria is inserted for it. 

4. You can specify the filter using the dropdown box. 
You can find examples in the following section:   

○ Selecting properties 
You can select properties which are used to define the filter from the drop-down list on the left:   

○ Tag: 
You can select an existing master tags or tags using the drop-down list on the right.  

○ Name 

○ Language: 
You can select a language using the drop-down list on the right.  

○ Description 

○ Short Description 

○ Context 

○ Context: SAP Companion for desktop 

○ Roles 

○ Keywords 

○ UID 

○ Duplication Master 

○ Duplication Source 

○ Object Type 
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○ Creation Time: 
You can select a date using the calendar on the right. 

○ Modification Time: 
You can select a date using the calendar on the right. 

○ Selecting conditions 
Conditions can be specified to further specify the filter in the drop-down list in the middle:   

○ is (not for Description, Short Description) 

○ contains 

○ begins with (not for Description, Short Description) 

○ ends with (not for Description, Short Description) 

○ does not contain (not for Description, Short Description) 

○ is not (only for Creation Time, Modification Time) 

○ is lower (only for Creation Time, Modification Time) 

○ is higher (only for Creation Time, Modification Time) 

○ is between (only for Creation Time, Modification Time) 

○ is not between (only for Creation Time, Modification Time) 

○ Entries 
Entries can be made (for example, Name, Description) to describe the filter in accordance with the 
properties. These are not saved and must be reentered if the filter is used again.  

5. After a filter definition is created, the and / or buttons are activated that you can use to include other 
definitions to refine the filter.   

○ and: 
All definitions have to correspond to the objects to be displayed. 

○ or: 
One of the definitions has to correspond to the objects to be displayed. 

6. Select OK to save your filter. 

The created filter is now available in the Filter Tree  menu in the Explorer. 

12.8.2.1 library Settings 

The library Settings define how a filter affects the display of the library and whether the filter is to be displayed in the 
library or is only intended for editing in the Explorer. The settings affect both the local as well as a published 
workarea. 

• Generate prefiltered library with filter: 
By this setting the library opens in a filtered structure matching the active filter in the Explorer. If the setting is 
deactivated the library displays all content, independent from the active filter. 

• Use filter in unfiltered library: 
By this setting the filter is displayed both in the Explorer and in the library. If the setting is deactivated, the 
filter can only be used in the Explorer. 

• Use filter in prefiltered library: 
By this setting the filter is also available for selection in a prefiltered library. In case the filter will not return any 
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matches, it will not be available within selection. By deactivating the setting, only the filter necessary for the 
prefiltered status can be used. 

12.8.2.2 Examples of Filter Definitions 

The filter definitions can be combined any way you want. Several typical uses are described in the following section: 

• Language – is – en-US 
Objects are filtered according to their language with this filter. The language code has to be entered in this 
case. 
You can find the language code for your objects in the Language field of the object editor. 

• Description – contains – description text 
Objects that contain a specific word or text passage as a description can be filtered out with this filter. 
(similar to Name and Short description) 

• Context – contains – context name 
Objects can be filtered using their context information with this filter. 

• Keywords – is not – keyword 
Objects can be filtered using their keywords with this filter. In this case, objects that contain this term are 
filtered out. 

• Object type – is – project 
Objects can be filtered using their type with this filter. The object types that can be used are:   

○ group - Group 

○ project - Project 

○ book - Book 

○ slide - Book Page 

○ cdoc - Text Unit  

12.8.3 Filter Resource 

Filters are stored in the Filters resource type. This means you can use the filters consistently in different workareas 
and you can also handle the resource in an authoring environment with a server workarea.  

The Filters  resource is stored in the resource tree of the Explorer. The resource is available once a filter has been 
created. 

Functions in the object editor 

The following functions are available when selecting the Filters resource or a filter definition in the resource tree: 

• New Filter... (Resource group) 
Opens the Edit Filter dialog box, where you can create a new filter. 

• Edit Filter... (Single resource) 
Opens the Edit Filter dialog box where you can edit the selected filter. 
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• Apply Filter (Single resource) 
Activates the selected filter in the Explorer. 

12.9 Searching in the Tree Structure 

The search function enables you to perform specific searches for content in the tree structure of the Explorer. The 
search field is above the content tree. 

Searching content 

You can enter a search term in the search field. A dropdown box allows you to select a search term from your 
previous searches. The relevant content is displayed as soon as a search term is entered.  

When you select the Next button or Enter key, the tree selection jumps to the next found entry in the tree. 
To clear a search, choose Clear in the text field or press the ESC key. 

Search options 

Select the Search Options  button to display settings, that further specify the content you are searching for: 

• Match Case: 
Use this option to search a search term case sensitive. 

• Match Whole Word Only: 
Use this option to search for whole words and not for parts of words. 

• Search Mode: 
Specify the detail level for your search: 

○ Search Name Only 

○ Search in Visible Attributes 

○ Search Custom Selection of Attributes 

○ Search All Attributes 

• Select Search Attributes... 
Show and hide the search attributes to specify the search. 

• Highlight Results: 
Highlights the search results in the complete content tree. 

• Filter Results: 
Filters the content tree and shows the search results only. 

• Result List: 
Shows the search results in the list view. 

Search attributes 

You can specify the object properties in which you want to search. Select Search Mode -> Select Search Attributes... 
to show the available search attributes. The list closes when you select Select Search Attributes... again. 

Select one of the following options and enter a search text: 
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Option Search text 

Name Enter an object name. 

Description Enter a word or a sentence to search in the description. 

Short Description 
Enter a word or a sentence to search in the short 
description. 

Keywords Enter a keyword from the Keywords parameter. 

Object Type 

Enter the technical name of a content object:  

○ group - Group 

○ project - Project 

○ book - Book 

○ slide - Book Page 

○ cdoc - Text Unit 

UID Enter the UID of an object. 

Language 
Enter a language code to search for a language. See 
Content Languages Overview. 

Context Enter a context parameter. 

Context: SAP Companion for desktop 
Enter a context parameter for a SAP Companion for 
desktop. 

Roles Enter a role name from the Roles parameter. 

Any Other Properties 
Use this option to search in the other properties of the 
objects. 

12.10 Glossary of Terms 

A glossary of terms allows you to add term definitions to your content. During playback the learners have the ability 
to select a specific term in a text and afterwards the glossary entry appears in a pop-up window. 
The glossary of terms is a group with text units for the term definitions that are applied to the content. 

Additionally, you can display the glossary entries in a glossary view in the library. See chapter Glossary View in 

library. 
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12.10.1 Creating a Glossary 

To create a glossary, proceed as follows: 

1. Create a group using the New Group  toolbar entry. 
You can use several sub-groups to structure (for example, alphabetic) the content in the Explorer or for the 
glossary view in the library. 

2. Create the text units using the New Text Unit  toolbar entry. Insert the text units into the group. 

3. Define the glossary entries. Each text unit includes an own term definition:   

○ Name: Insert the term. A term can consist of up to four words.  

○ Document Type: Select the type Glossary . 

○ Description: Insert the term definition. 

4. Afterwards, apply the glossary group to the workarea:   

1. Select the Tools -> Glossary -> Apply Glossary… menu. 
A setting dialog box opens. 

2. Adapt the settings in the dialog according to your needs. 

3. Confirm the dialog with OK. 

 

Settings of the apply glossary dialog box 

The settings dialog box contains the following settings: 

• Use Glossary from Group: 
Defines the glossary group containing the glossary text units. 

• Specific Language Only: 
Defines, whether the glossary will only be applied to content with a specific content language. 

• Language: 
Defines the content language for the setting Specific Language Only. 

• Apply Recursively: 
Defines, whether the glossary is also used for the sub-objects of the selected content structure. 

• Apply to Descriptions / Short Descriptions: 
Defines, whether the glossary will be applied to the respective object properties. 

• Apply inside Projects / Book Pages: 
Defines, whether the glossary will be applied to the content of the respective objects. 

 Note 
Make sure to use a consistent spelling in your content. To display a glossary entry correctly, the spelling of a term 
in a text has to be equal with the glossary entry. 
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12.10.2 Removing a Glossary 

The applied links of a glossary can be removed from the content or a specific group, when no longer needed or 
outdated. 

To remove a glossary, proceed as follows: 

1. Select the group in the Explorer. 

2. Select Tools -> Glossary -> Remove Glossary… menu. 
A setting dialog opens. 

3. Adapt the settings in the dialog box according to your needs. 

4. Confirm the dialog with Ok. 

Settings of the remove glossary dialog box 

The settings dialog box contains the following settings: 

• Use Glossary from Group: 
Defines the glossary group with the contained text units. 

• Specific Language Only: 
Defines, that the glossary will only applied to content with a specific content language. 

• Language: 
Defines the content language for the setting Specific Language Only. 

• Apply Recursively: 
Defines, that the glossary is also used for the sub objects of the content structure. 

• Apply to Descriptions / Short Descriptions: 
Defines, that the glossary will be applied to the parameters. 

• Apply inside Projects / Book Pages: 
Defines, that the glossary will be applied to the content of this objects. 

12.10.3 Importing a Glossary 

For the easy creation of a glossary you can import a list (CSV file) of glossary entries. During the import the 
Producer creates a text unit with the type Glossary  for each glossary entry and inserts the texts contained in the 
CSV file. Thus, you do not have to create each text unit individually. 

The list of glossary texts should be a simple CSV file with the following structure: 

• first column: term 
will be imported into the Name parameter 

• second column: term definition 
will be imported into the Description parameter 

To import the CSV file, proceed as follows: 

1. Create a group using the New Group  toolbar entry. 



 

Producer (Cloud Edition) 
Workarea and Administration 

 
PUBLIC   422 

 

2. Select Tools -> Glossary -> Import Glossary… menu. 
A setting dialog opens. 

3. Adapt the settings:   

○ Import into Group: 
Defines the glossary group in which to import the glossary. 

○ Language: 
Defines the content language for the text units. 

4. Confirm the dialog with Ok. 

If you want to apply the glossary, see the chapter Creating a Glossary. 

12.10.4 Using the Glossary 

Glossary view in library 

The created glossary can be displayed as glossary view in the library. Via a button in the header bar the learner can 
open the view. The course structure displays the contained groups of a glossary and the content view displays the 
content of all text units for a selected group. The glossary root group will not be shown in the content tree of the 
library. 
Learners can use the glossary view to look up specific terms and descriptions, which are part of the learning 
content. 

Activate the glossary view as follows: 

1. Open Tools -> Settings...  

2. Select the section Playback Settings -> library -> Glossary. 

3. Select the created glossary in the Glossary group setting. 

4. Confirm the dialog with Ok. 

Further settings 

• Use library language (Playback Settings -> library -> Glossary): 
Defines, that only glossary entries with the language of the root group will be shown in the library. Deactivate 
the option to show the glossary entries of all languages. 
If the root group uses the language Multiple languages all glossary entries will be shown. 

Glossary in documentation 

When you generate a documentation, you can define the glossary as fragment to include all used glossary entries 
as table into the document. All glossary entries are linked in the document and the user can jump to the definition in 
the glossary table. 
See the chapter Fragments for further information. 
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12.10.5 Glossary Styles 

A glossary uses different styles for text and bubbles during the playback of content. This is necessary to distinguish 
this type of content from the general content and to make it clearer to read for the user. 

Glossary link 

A special text style is available for the display of a glossary link in a text. The style is used automatically after the 
glossary is applied. 
The text style Glossary Link can be edited in the text style editor (menu Tools -> Customization -> Edit Text Styles... 

) and is located in the section Inline Styles. 

Glossary in trainer 

When you play back the library, a simulation or a book, the trainer functionality displays a glossary entry in a 
window. The style of the window is defined using the current trainer style. 

Glossary in a SAP Companion for desktop 

When you play back SAP Companion for desktop content, you can define an individual bubble in the settings to 
display a term entry. The Settings  under SAP Companion for desktop: Playback Settings -> SAP Companion for 
desktop -> Glossary Bubble contains the following settings: 

• Style: 
Defines the appearance of the glossary bubble. Here you can select a bubble style resource from the drop-
down list. 

• Size: 
Defines the width and height of the glossary bubble in pixels. 

12.11 BPM Import and Export 

To structure your business processes in the Producer, you can import BPM structures (built in Business Process 
Model (BPM) applications) into the workarea. A group and project structure with relevant object names is created 
in the Explorer. A tree based on the structure is available where you can create the required content. 
The structures of the following BPM applications can be imported: 

• ViFlow 

• Nimbus 

• ARIS 

• Signavio 
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12.11.1 Training Available 

 

Signavio integration is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

ARIS integration is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

12.11.2 Importing a BPM Structure 

Import your BPM structure as follows: 

 Note 
The import process can differ depending on the BPM application you are using. 

1. Create the required process model in your BPM application. 

2. Publish this:   

○ ViFlow 
Publish the process model under Edit -> Publish from ViFlow. The structure.xml is created here as part of 
the ViFlow web model in the html folder. 

○ Nimbus 
Publish the process model as a simplified XML structure (Simplified XML) to add all the process steps to 
a file. 

○ Signavio 
Publish the process model as BPMN file. 

3. Open the Producer. 

4. In the Explorer, open the Tools -> Business Process Models menu and select the corresponding import 
command for the required structure. The import dialog box opens. 

5. Select the published structure file and select Open. 

6. A settings dialog opens (not for all BPM types). Modify the following settings and confirm with OK:   

○ Import type: new structure, update structure 

○ Create empty projects 

The folder structure is then created in the Explorer, where you can edit it and start creating content. 

 Note 
For Signavio a XML file of the imported structure is inserted in the workarea. The file is used for the export of the 
Signavio structure. Do not delete the XML file. 

https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9#group!GR_192608E6927D86B1
https://enable-now.sap.com/ic/auth/ext/index.html?show=slide!SL_18C04E319B6F7D93
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12.11.3 Updating a BPM Structure 

Updating a BPM structure in the Producer allows you to insert modified or new content from a BPM application into 
an existing structure. This can be done using the import function by importing the updated structure. See the 
chapter Import of a BPM structure. 
To perform the update, you need to select the import type Update Structure in the import settings dialog.  

The update is recommended for unmodified structures of the Producer, because manually created objects will be 
moved into Unsorted. In the structure changed objects will be resorted like in the import structure. 

12.11.4 Exporting a Structure 

Exporting Signavio links 

The export Signavio function allows you to export the content structure of a workarea to a BPMN file for use in 
Signavio. The file includes the links of the groups. 

Signavio links can be exported as follows: 

1. Open the Tools -> Business Process Models -> Signavio Export... menu in the Explorer. 

2. Enter a Server Name for the content location. Confirm with OK. 

3. Select the target directory and insert a file name. 

4. Select Save to export the file. 

12.12 Inserting a File 

In addition to the learning content and documentation that has been created, you can insert other files. The Insert 
File...  function in the Producer is available to you for this purpose. For example, these files can be Word or PDF 
files containing additional or general information but images and media files are also possible. 

Inserting a file 

This is how you insert a file: 

1. Select an object in your tree structure of the Explorer.  

2. Select Insert File...  in the object editor. 
The Select external document dialog box is opened. 

3. Select a file that you want to insert. Select Open.  

The file is inserted in the last place within the object. 
After they have been inserted, the files integrated in this way can be selected both in the Explorer and the library 
and can also be inserted in book pages. 
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 Recommendation 
Instead of using the function to insert files, you can also drag and drop them to the Explorer. This inserts the file in 
the currently selected object. 

Updating a file 

An imported file can be re-imported and updated by selecting Update File . The Producer accesses the original 
file location – this is the path that was entered and saved upon importing the file under the setting Original Path.  
The setting Last Import displays the date and time that the file was last imported so that you can verify whether the 
file is up-to-date.  

Note 
This option is only displayed if the original file is available. Otherwise, you can import a new file by selecting the 

option Replace File... . 

Updating multiple files 

If you need to update multiple files at once, you can do it with the Update Externally Loaded Files functionality: 

1. Select a group that you want to update files from.  

2. Select Tools -> Workarea Structure -> Update Externally Loaded Files... 
 

3. A dialog opens where you can confirm or change the group to update files from. Select Ok.  

4. An information window with the number of successfully updated objects and failed updates is shown. Confirm 
with Ok. 

Note 
Failed updates are quite likely to happen because the original file is not available. If it is the case, you can import a 

new file by selecting the option Replace File... . 

Your files are now updated. 

Note 
The functionality to Update Externally Loaded Files will not work for converted media objects. For converted files 
the original file is not available in the Original Path setting. Only unconverted files or for manually created media 

objects can be updated. 

12.13 Reference Counter and Reference View 

The reference counter displays all existing object references from a workarea in the Explorer. This allows you to find 
and manage references for your objects. 

• Structure reference 
Displays how often an object is used in the content structure. 
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• Content reference 
Displays how often a content object is linked in other content objects. 

Activating the reference counter 

To enable the reference counter, select menu View -> Show Structure Reference Counter or Show Content Reference 
Counter. A number will appear in front of an object in the tree structure to indicate how often it has been referenced. 

Referenced by 

The Referenced by parameter in the object editor shows you the existing references for each selected object. An 
entry displays the tree path and is linked with the object. You can select a link to jump to the object in the tree. The 
selected reference is bold marked. 

A structure reference is highlighted in blue and a content reference is highlighted in green. 

The Dependencies... button opens a dialog box with a list of all existing dependencies for an object within a 
workarea. See also Dependencies Dialog Box. 

12.13.1 Reference Counter 

The reference counter shows the number of references for an object. There are two types: 

•  Structure reference counter 
The reference counter displays how often an object is available in the structure. For example, a simulation 
project that is used multiple times in different parts of the structure. 
The physical object of a learning content can be referenced as often as necessary. This means, that each 
object in the tree is a reference. If changes are made in a reference, the changes are also contained in the 
other references. See also Using References. 
 

•  Content reference counter 
The reference counter displays how often an object is linked in the content. For example, an imported image 
that is used in different content descriptions. 

12.13.2 Reference View 

The reference view displays the content tree and, next to it, a tree or list of references. You can select an object in 
the content tree to display the corresponding references. 

You can open a reference view from the Change Workarea View control in the toolbar. There are two views: 

• Object reference tree 
The reference view displays the references in a tree structure. You can see the objects and the position of the 
objects in the structure. 

• Object reference list 
The reference view displays the references in a list. You can see the objects and you can sort the columns. 
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 Recommendation 
We recommend that you activate only the required reference counter to reduce the displayed references. 

12.13.3 Dependencies Dialog Box 

The Dependencies dialog box displays all existing dependencies for an object within a workarea. This could be other 
objects, files, and resources. Displaying dependencies will provide you with an overview of existing references, 
which is useful for publishing purposes and for object management. 

The dialog box can be opened from the context menu entry Dependencies... for each object. If you activate the 
menu entry View -> Show References Counter, a Dependencies… control is displayed in the object editor for the 
Referenced by parameter. 

Display type 

The following settings allow you to specify the displayed dependencies: 

• Show Dependencies: 
Displays the dependent objects and resources of the object. 
For example: Macroset, Bubble Style, linked content. 

• Show Publishing Dependencies: 
Displays the dependent objects and resources of the object for the publishing. 
For example: Playback Settings, subobjects. 

• Show Referrers: 
Displays the dependencies in accordance with the individual objects that reference a content or resource. 
For example: All dependent projects using the Standard macroset. 

• Show UIDs: 
Displays the UIDs of the objects as well as the name. 

• Show Advanced Options: 
Displays further options for showing or hiding dependencies in the list. 

Advanced options 

If you activate the Show Advanced Options setting, the following settings are displayed: 

• Use Options: 
Allows you to specify the displayed information of the list. Further options are enabled. 

• Use Options and Rescan: 
Allows you to specify the displayed information of the list and rescans the dependencies of the object. Further 
options are enabled. 
If outdated dependencies are displayed, we recommend a rescan. 

• Recursive: 
Also displays the corresponding sub-objects for the selected object. 

• References in Structure: 
Displays existing references that have been directly allocated to an object. 
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• References by Parameter: 
Displays existing references that exist due to certain settings that have been defined. 

• Resources Only: 
Displays resources that have been referenced. 

• Resolve Fallback Values: 
Displays resources that are specified as fallback. 

Using the list 

In the dependencies list of the dialog box, you can use the following actions to show a specific object: 

• Jump to object in explorer 
Double-click a list entry to show the object in Explorer. 
The object is selected in Explorer tree. 

• Jump to object in dependencies list 
Press Ctrl and double-click a list entry to show a referenced object in the list. Only possible, if Show Referrers 
is activated. 
The object is selected in the dependencies list. 

12.13.4 Updating the Dependency Cache 

The Tools -> Update Dependency Cache function allows you to update the dependencies of your workarea. This can 
be necessary after the migration of a workarea or the import of an archive with resources from an older version. The 
update is executed after you select the menu entry. 

12.14 Using Archives 

Archives can be used to transport an entire workarea, individual learning content or resources simply and 
compactly. An archive is saved in the form of a DKP file (*.dkp).  

12.14.1 Exporting an Archive 

Proceed as follows, to export an archive: 

1. Select Workarea -> Export Archive...  menu. 
or 
Select an object in the tree and select Export Archive...  in the context menu. 
The Export Archive dialog box is opened. 

2. In the area on the left you will find all of the content and resources located in the workarea. These are selected 
by default.  
To deselect the entire workarea, you need to deactivate the Workarea option. To deselect the resources or 
content, deselect the relevant resource folder or topmost group.  
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3. Compression type: 
This parameter determines whether the files are to be compressed or not. Compression is recommended to 
reduce the file size.  

4. Max. size before splitting volumes: 
The technical size limit for a DKP file is 4GB. The drop-down list allows you to define a maximum volume size 
of the DKP files generated. Once an archive file's maximum size has been reached, a new one will be created 
automatically. As many archive files will be generated as are required to store the entire Workarea. This allows 
large workareas to be broken into a number of parts for transport, which can then be spread across a number 
of DVDs or CDs, for example.  

5. Select references: 
With the options Select referenced resources and Select referenced content the referenced items are 
automatically selected for the specific content.  

6. Select OK to confirm the settings.  

7. The dialog box for specifying the destination path and file name will then open. Select a target destination and 
enter a file name. 

8. Select Save to create the archive.  

12.14.2 Import an Archive 

You can insert an archive in the current workarea using Import Archive. This may be individual projects or 
customized resources, for example. 

Proceed as follows, to import an archive: 

1. Select the Workarea -> Import Archive... menu. 
The dialog box for selecting the archive. 

2. Select the file and select Open.  

3. The archive content is displayed to you in an overview. You can select whether you would like to import all the 
archive content or only a part of it. 

4. Select OK to insert the files in your workarea.  

Learning content inserted by importing the archive are filed as unsorted objects and can then be assigned to the 
project structure. 

If the same resources or learning content already exist in the workarea, you are alerted to this and asked whether 
they are to be overwritten or duplicated. 
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13 Interface and Components 

This chapter describes the structure of the Producer. This involves going into the Producer interface's different 
areas and functions. 

The interface of the Producer switches between three main views:  

• The Explorer, which is used to edit the currently selected workarea. 

• The project editor, which is used to edit an open project. 

• The book page editor, which is used to edit an open book page. 

13.1 Explorer 

The Explorer serves to organize the content objects and resources in a workarea. 

 

The Explorer window is divided into the areas: 

A. Menus 
Contains the functions of the explorer separated in categories. 

B. Toolbars 
Contains the most common menu commands to access the functions directly. You can shown and hide 
toolbars by using the View menu. 
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C. Tree structure 
Structures the resources and content objects. 

D. Object editor 
Includes the object properties. 

The structure built for the workarea within the Explorer is also the structure displayed later on in the library of the 
published workarea. 

13.1.1 Tree Structure 

The tree structure displays and structures the resources and the content of a selected workarea. 

View of the objects 

The tree shows all objects with an icon and name. 

You are able to show further information by using the View menu. The available information is: 

• Unknown References 

• UIDs 

• Language 

• Language Icons 

• References Counter 

Administration of the objects 

The individual objects in the workarea can be edited directly in the tree structure. The following actions are 
possible: 

• Select an object to display the object parameters in object editor. 

• Context menu: 
The context menu of an object provides object specific functions for editing the object. 

There are the following ways to move or to create an object in the tree: 

• Drag&drop 
Moves the object from one position in the tree to another. 

• Drag&drop + Shift key 
Creates a duplicate of the object at the dropped position. 

• Drag&drop + Ctrl key + Shift key 
Creates a reference of the object at the dropped position. 

• Drag&drop + right mouse button 
Opens a context menu, which allows you to move, duplicate or reference an object. 

 Note 
The order of the resources cannot be changed. 
The modes of a project cannot be moved to another project.  
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Using the second tree 

Beside the general tree an additional second tree can be shown. It supports you to edit the structure of a complex 
tree. You can use the second tree to compare parts of the tree or to move or create objects. 
Note, that when selecting an object in the second tree, there are no parameters displayed in the object editor. 
Always use the default tree. 

On the top of the tree there are the following controls: 

• Second Tree - Horizontal 

• Second Tree - Vertical 

Activate or deactivate the control to hide or to show the second tree. 

13.1.2 Object Editor 

The object editor allows you to edit the settings for an object selected in the Explorer. Information on the object as 
well as the current settings are displayed in the editor. In addition, actions are displayed in the editor's heading that 
can be used for the selected object. 

Server actions 

For server objects the editor's heading area provides as well the server actions that can be used for the selected 
object. 

In case the selected object is parent to a subtree of objects the additionally displayed item Show Tree Operations 
 provides a menu with corresponding actions to be applied on the currently selected object and its sub objects. 

All tree operations initially provide a dialog in which you can redefine your object selection. 

13.2 Project Editor 

The project editor can be used to record, create and edit projects. The project editor displays macros, settings and 
screenshots as well as specific functions for the editing. 
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The project editor’s main components are: 

A. Menus 
Contains the functions of the project editor separated in categories. 

B. Toolbars 
Contains the most common menu commands to access the functions directly. You can shown and hide 
toolbars by using the View menu. 

C. Thumbnail view 

D. Step view / documentation view 

E. Macro editor 

Navigation in the project editor 

An alternative and user-friendly way to navigate in the project editor is by using the mouse's scroll wheel and the 
keyboard. This facilitates scrolling up and down in the workarea and alternating between objects from the step view. 
In addition, the keyboard allows you to easily jump between steps and select macros. The following shortcuts can 
be used: 

• Home: jumps to the first step  

• End: jumps to the last step  

• Page Up / Page Down: alternates between the steps or macros, depending on the currently selected 
object. 
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13.2.1 Thumbnail View 

The thumbnail view sequentially displays the steps with their screenshots and corresponding macros. When 
selecting a macro, the corresponding screenshot is displayed in the step view with its highlights and bubbles, and 
the macros settings are displayed in the macro editor. 

Changing the display size 

The display size of the screenshots can be adjusted by changing the size of the thumbnail view of by using the 
mouse wheel with pressed Ctrl key. 

Changing the order 

The order of the macros or the steps can be changed using drag & drop. You can even move one or more macros 
within a step or all steps as a whole as well as assign new positions to one or more steps in the project. 

 Recommendation 
Changing the order of steps or macros always results in a subsequent change to the project itself. For this reason 
you should make sure the project is still a coherent unit. 

13.2.2 Steps of a Project 

A project uses steps to organize the content in sections. Generally, a step contains a screen and an interaction 
macro and can contain further macros. All steps are numbered consecutively and have a step name. 

Steps are automatically inserted into the project during recording for each new screenshot. You can add further 
steps by using the menu entry Insert -> Add Step  or during recording. 

The order of the steps can be changed in the thumbnail view. A step can be previewed in step view.  

Basic attributes 

A step has the following attributes: 

• Name: 
Contains the name of the step. In general, the name of the application window is entered during recording. 
You can change the name for your content. 

• Translate Manually: 
Specifies, that the name will be used for translation when exporting a translation file. The parameter is 
activated when a name has been changed. 
You can activate the option manually to translate the name. 

Steps in simulation projects 

The step names are displayed in the progress display of the trainer during playback in demo mode. You can hide the 
step names in Playback Settings. 

• Show in Progress Display: 
Specifies, that the step is displayed as control in progress display of trainer bar. 
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• Jump Target: 
Specifies, that the step can be used as jump target for creating a branch. 

 Note 
Within a recorded project, the first step has a special status. It generally includes only the Simulation Start macro 
in order to properly initialize the project for playback. For this reason, it is never set as a Jump Target. 

The step names can also be used as chapter title in a generated documentation. Active the use of the step name in 
Documentation Settings. 

13.2.3 Step View 

The step view displays the screenshot of the Screen macro and the content of the macros for a step. It allows you to 
edit the size and the position of the highlights and the bubbles directly on the screenshot. You can also add 
additional macros by using the toolbar. 

Step view display 

From the step view, different views can be activated to facilitate editing and positioning objects. A variety of options 
are available from the toolbar: 

• The Modes button allows you to switch over to selected bubbles for editing purposes, allowing you to preview 
the bubbles in each of the different modes. This setting will have an effect on the activated preview mode.  

○  Edit Mode (for each mode) 

• For steps with more than one macro, all bubbles can also be viewed simultaneously. This facilitates 
positioning bubbles and ensures that other areas in the application are not hidden by the bubbles by accident.   

○  Show Bubbles for Step  

○  Show Bubble for Macro   

Position objects 

There are two ways to position objects: 

• Via Drag & Drop  

• Via a keyboard using the arrow keys  

13.2.4 Documentation View 

The documentation view is a WYSIWYG editor for editing documentation in simulations. A document is displayed in 
HTML format so that you can preview the content and structure. This editor allows you to quickly and easily make 
any necessary changes to your documentation. 

The documentation view only displays project content that can be inserted into documentation. Content that is 
stored in another location other than in the project editor, such as description text, will not be displayed here. 
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Opening the documentation view 

The Documentation View  can be enabled from the toolbar and used instead of the step view. Alternatively, you 
can open this from the menu View -> Components -> Documentation View. 

Editing documentation 

The following editing options are available from the documentation view: 

• Hide macros for output into documentation 
Click on Hide in Documentation so that the selected macro will not appear in the document. In order to display 
a hidden macro, click on Show in Documentation. 
Note that documentation macros cannot be hidden. 

• Adjusting highlights 
Macro highlights can be changed individually. Such changes have only effect on documentation - the 
highlights for the simulation remain unchanged. 

• Changing text 
Text that can be edited is highlighted in yellow when the macro is selected. To make modifications to text, 
double-click on the desired text from the HTML editor. 

 Note 
Editing text in the documentation view can affect the different modes. Only make changes here when you are sure 
that the changes should also be applied to the other modes. 

13.2.5 Macro Editor 

The parameters for a macro are displayed in the macro editor and can be directly edited there as well. At the top of 
the editor, there are additional options for enhancing your macros. Select a macro in thumbnail view to display the 
settings. 

The parameters are divided into subcategories which you can open and close by clicking on the plus and minus 
symbol. By selecting a parameter, a description will be displayed at the bottom of the macro editor. 

Activating a parameter 

The green button located in front of each setting indicates whether the setting is active  or inactive . Select the 
button to activate or deactivate the setting. 

Layout selection 

A Layout Selection in the title bar allows you to show and hide detailed settings for a macro. You can choose 
between Standard Layout and Advanced Layout. The settings of the Advanced Layout are recommended for 
advanced users, who need a detailed set of settings. 

In macros that contain text the HTML editor is opened when selecting the text box. 
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Selecting multiple macros 

If you would like to edit a specific setting for a type of macro, it is now possible to select several macros at one time, 
which will display the common setting to be edited for all the macros at once. 

If the settings vary for the selected macros, a note will automatically appear on the screen. From here, you can save 
the setting, edit it for all the macros or deactivate it. To make changes to the setting, click on the button in front of 
the name. This will open a menu with the options Determine joint value and Delete values. Select the desired action 
and edit the value as desired. 

13.2.6 History 

The History can be viewed as the memory of the Producer. It chronologically documents all actions that are taken, 
starting with the opening of the project. This allows the user to return to any stage in the editing of the document, 
going back to the opening or creation of the project. With a click on the History list item, it is possible to directly 
undo or redo one or more actions. To provide the user with a better overview, the actions taken since the document 
was last saved are marked with a plus. The history is used as the basis for the Undo and Redo commands in the Edit 
menu. 

13.2.7 Project Menu 

The Project menu contains functions for the administration of a project. 

13.2.7.1 Save 

The Save  function saves the project currently open and displayed. In addition to the saving, the different modes 
will be generated. 

13.2.7.2 Export Archive... 

You can use this feature to export an entire project folder from a workarea to an archive file, allowing you to easily 
move and integrate it into other workareas. The archive file is saved in the *.dkp format. 

13.2.7.3 Publish... 

This command allows you to publish an individual project. That means that it is not necessary to issue numerous 
resources and projects; projects can be distributed individually instead. 

For further information, see the chapter Publishing Individual Objects. 
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13.2.7.4 Open Project Directory 

This causes Microsoft Windows Explorer to open the folder of the currently active project in the workarea 
containing the folders for the project files. 

13.2.7.5 Duplicate... 

The Duplicate... function allows you to duplicate the project together with the content it contains and the project 
configuration. 

1. Select the Duplicate... function in the Project menu. 

2. A dialog box is opened in which you can name the duplicate. 

3. Select OK to create the duplicate. 

13.2.7.6 Close 

Closes the project, which is currently open and displayed. 

If you do not save the project before closing it, a dialog box will appear, prompting you to do so. 

13.2.8 Edit Menu 

The Edit menu contains all the general features that directly manipulate objects. 

General functions 

Function Description 

 Undo 
This command is used to undo, i.e. reverse, an action 
and can be repeated until the first item in the history has 
been reached. 

 Redo 
This command is used to reverse the undo action, and 
can be repeated until the last item in the history has 
been reached. 

 Cut 

The command cuts the selected macro or object and 
places it in the Windows clipboard. This command can 
be applied to almost all macros, objects and input fields 
in explorer and project editor. 

 Copy The command copies the selected macro or object to the 
Windows clipboard. This command can be applied to 
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Function Description 

almost all macros, objects and input fields in explorer 
and project editor. 

 Paste 

Executing the Paste command inserts the clipboard 
content at the insertion point in Producer. Note that 
clipboard content must be compatible with the location 
into which it is inserted. 

 Delete 

This command deletes the object or macro which has 
just been selected. It can be applied to almost all 
macros, objects and input fields in explorer and project 
editor. 

Select All 

Select All highlights the largest possible selection in the 
context of the currently active focus in Producer. It can 
be applied to almost all macros, objects and input fields 
in explorer, project editor or book page editor. 

13.2.8.1 Select Macros by Type... 

This command gives you the ability to select all the objects of a specific macro type in the thumbnail view. The 
dialog shows you all the macros available in the currently accessed course content and shows you a count. When 
you select a macro type, all objects of this type are selected in the thumbnail view. This gives you the ability to make 
settings for all macros of one type in the macro editor. 

13.2.8.2 Search & Replace Bubble Content... 

Words or passages of text in all the bubbles contained in a project can be replaced using the Search & Replace 
function. 

In the field Search the term or text string is entered which is to be found within the bubbles of the project; in the field 
Replace by the text string is entered which is to replace the original one. 

For more complex tasks, the Search & Replace functionality of Producer can also be used with a regular expression. 
In order to do so, activate the option Search & Replace using Regular Expressions. 

After triggering the function by clicking OK, an additional dialog informs you how many times the search string was 
found and replaced. 
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 Note 
Searches performed by the search engine are case-sensitive. 

If the content of a bubble has been modified by the command Search & Replace, it is considered to have been edited 
manually, and the appropriate option is ticked in the subcategory Rerecord of the macro. This has an effect on the 
automated translation and the export of a translatable. 

13.3 Book Editor 

The book editor is where the book pages are edited. This is where you can define the book pages' design and create 
the content.  
After a book page has been created in the Explorer, it is opened in the book editor. You also have the option of 
opening the book editor in the Explorer by double clicking on a book page. 

 

The book editor is broken down into the following areas: 

A. Menus 
Contains the functions of the book editor separated in categories. 

B. Toolbars 
In the toolbar you will find a complete object overview from which you can insert the objects. Functionality is 
also provided for editing the objects and book page. You can show and hide toolbars by using the View menu. 

C. Object editor 
The object editor is where you can define the individual objects' properties. To this end, when you select an 
object you are offered corresponding parameters that are subdivided into various areas. 
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D. Object overview 

○ Book pages list 
The book pages list shows the book pages and subbooks of a book.  

○ Object list 
The object list provides you with an overview of all the objects inserted on the book page.  

E. Book page view 
The book page view is where the book page is shown for editing. Select the inserted objects to edit them. You 
can use drag and drop to place the objects in the desired position. 
The book view operates on the “what you see is what you get” (WYSIWYG) principle. That means that your 
book page will be displayed in the book reader or library in the same way you created it. 
In order to be able to test the objects, select the Preview function in the toolbar. The Producer will then 
activate the corresponding functionality, such as launching a mode.  

13.3.1 Object List 

The object list provides you with an overview of all the objects inserted on the book page. You will find the book 
page's background in the topmost position. Select this entry to edit the background. 
The objects that have been inserted are itemized in a list and appear in the same order as they do on the respective 
level. Selecting an object from the list will highlight this object on the book page. It is now ready to be edited. 

Changing an object's level 

To position an object on a different level in a book page, simply drag & drop it to the desired position and level. 

Hiding objects 

From the list of objects, you can define whether objects should be hidden or visible on the book page. This is an 
important setting to remember to use with actions. An Eye icon is displayed for each object, indicating its current 
status: Show or Hide. To change an object's status, click on the desired status icon. 

Filtering objects in tree 

The Filter  function allows you to show and hide objects in the object list. This makes it easier to edit objects for a 
complex book page. Open the filter menu to activate the objects types to be shown in the object list. 

13.3.2 Book Pages List 

The book pages list is a component of the book editor and displays the structure of a book with book pages and 
substructures. This supports the editing of a book and be used for the following actions: 

• Selecting a book page 
Selecting a book page in the structure shows it in the book page view and can be edited. You can scroll with 
the mouse wheel through the structure to display the pages. 
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• Creating a book page 
Select a book to create a new book page. A command is displayed in the book page view. Select it to open the 
New Book Page dialog box. 

• Deleting a book page 
A selected book page can be deleted by using the Del key. 

• Changing the structure 
The order of book pages or substructures can be changed with drag & drop. 

• Saving a book 
When the book is saved, all changes to all book pages in the book are saved and not just the currently 
displayed book page. 

13.3.3 Add Audio Dialog Box 

The Add Audio dialog box is part of the book page editor and can be used to record audio for book pages. You can 
access this functionality only in book editor if there are book pages available. It is deactivated for separate book 
pages that are not part of a book. 

The audios will be inserted as Page Sound. The Add Audio dialog box can be opened using the Add Audio  toolbar 
button. 

The dialog box has the following settings and functions: 

• Toolbar: 
The toolbar contains the following functions: 

○ Previous Book Page / Next Book Page: 
Use the buttons to navigate up and down in the page list for selecting a book page. 

○ Play Audio / Stop Audio: 
The Play Audio  button allows you to play back the text and then make changes afterwards. 
With the Stop Audio  button, you can stop the playback. 

○ Delete Audio: 
Use the button to delete the audio for the current book page. 

○ Edit Text-to -Speech 
Opens the Text-to-Speech dialog box for creating audio with Text-to-Speech services. 
See also the chapter Text-to-Speech Dialog Box. 

○ Generate Text-to-Speech Audio Files 
Opens a dialog where you can select for which pages you want to generate Text-to-Speech audio. 
You can also configure the voice and Text-to-Speech service parameters here, see the chapter Text-to-
Speech Dialog Box for more information. 

○ Start Recording / End Recording: 
Click Start Recording  to begin recording and then click End Recording  to stop recording. 
Once the recording is finished, the recording dialog is closed. 

○ Volume Level: 
The Volume Level displays the current volume of the spoken text during the recording. 
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• Pages: 
Displays a list of all book pages of the book. Select a book page to record audio or use the Previous Book Page 
/ Next Book Page buttons. 

• Preview: 
Displays a preview of the selected book page. 

• Silence in ms (global setting for all pages): 
The setting defines a silence, which is inserted at the beginning of an audio file before the Text-to-Speech 
starts. The value is defined in milliseconds. If you do not want any silence at the beginning, then enter the 
value '0'. 

• Notes: 
Allows you to insert notes for the selected book page. Text for text to speech will also be inserted into the 
Notes field. 

13.3.4 Book Page Menu 
The Book Page menu combines the basic functions required for editing a book page file. 

13.3.4.1 New Book Page 

This creates a new book page in the workarea under the item that is currently selected. 

After clicking on New Book Page  from the Workarea menu or the toolbar, a dialog box will appear. You have the 
following options: 

• Name: 
Enter a name for your book page in this field. The default setting is the type of object with an ID.  

• Template: 
This option allows you to use an existing book page as a template for a new book page. Using predefined 
settings from an existing book page will save you loads of time when creating a new book page. 
You can select additional templates by clicking on Change... A dialog box will appear. Select template for the 
current object or the entire workarea. Click on the option No template if you do not wish to use any templates 
for your book page. 
If a template has already been used, this template will act as the default and will be automatically selected 
upon creating a new book page.  

 Recommendation 
You can make templates your default setting from the main configuration dialog box. Refer to the section on 
Templates for Content Objects for more detailed information. 

• Language: 
Here you can select a content language.  

• Save to server as well: 
If you are using a server workarea, you can use this option to save the new book page directly to the server 
workarea. 

Confirm by clicking on OK and your book page will be created. The Producer will automatically switch to the project 
editor. 
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13.3.4.2 Add Audio... 

Opens the Add Audio dialog box for recording audio for the book pages. See also the chapter Add Audio Dialog Box. 

13.3.4.3 Save Book Page 

The Save  functions saves the book page opened and displayed at that time. 

13.3.4.4 Export Archive... 

This function enables a book page to be exported from a workarea into an archive file to facilitate the transport of 
this file and be able to integrate it into other workareas. The archive file is in the *.dkp format. 

Select the Export Archive... function to create an archive. Then enter a name in the open dialog and select a 
destination. Confirm the data you have entered by clicking on Save. 

 Note 
Outputting an archive using this function excludes the workarea's linked modes and documents. Therefore, only 
use the function for book pages in which you have not created any links. 
Alternatively you can use the function Export Archive… in the explorer. 

13.3.4.5 Publish... 

This command allows you to publish an individual book page. That means that it is not necessary to issue numerous 
resources and book pages; book pages can be distributed individually instead. 

For further information, see the chapter Publishing Individual Objects. 

13.3.4.6 Open Folder 

This is used to open the directory of the currently active book page in the workarea, which contains the relevant 
book page files. 

13.3.4.7 Close 

Closes the book page opened and displayed at that time in the book page editor. 

If a book page has not been backed up before closing it, you will be alerted to the absence of a backup via a dialog. 
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13.4 View Menu 

The View menu offers various options to configure the display of the program window. This makes it possible to 
customize the general display of program parts, as well as the display of the various functions. 

General 

• JavaScript Console 

 

Explorer 

• Show Unknown References 

• Show UIDs 

• Show Language 

• Show Language Icons 

• Show Reference Counter 

Project Editor 

• Layouts 

• Components 

• Floating Windows 

• Zoom 

• Set Preview Mode 

• Set Bubble View 

13.4.1 JavaScript Console 

This command opens the JavaScript Console of Producer. A significant portion of the mechanics for recording in 
Producer is based on JavaScript. The console can help track down problems that may occur in the course of 
working on a project. In the case of an inquiry, Support may ask you to open the JavaScript Console and describe its 
contents. You can also easily copy the contents into a text file. Right-click in the console window and select the 
command Copy all. The contents are now on the clipboard and can be pasted into a text document. 

13.4.2 Layouts 

You can choose a layout to organize your standard components in the project editor. Layout changes influence the 
thumbnail view, the step view and the macro editor. The layouts make it possible for you to change the look of your 
project editor to fit your needs. 

The following layouts are available: 
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• Horizontal Layout: 
The components are aligned horizontally.  

• Vertical Layout: 
The components are aligned vertically.  

• Divided Layout - 1: 
The thumbnails and steps are aligned side by side, with the macro editor below it.  

• Divided Layout - 2: 
The thumbnail view is displayed horizontally and the macro editor and the step view appear below next to one 
another.  

• Divided Layout - 3: 
The thumbnail view is displayed horizontally and the macro editor and the step view appear below next to one 
another. 

13.4.3 Components 

From the View menu, you can define which components should be made visible in your layout. The following 
components can be made visible or hidden: 

• Toolbars  

• Timeline  

• Thumbnail view  

• The WYSIWYG view is subdivided into two views:   

○ Step View  

○ Documentation View   

• Macro Editor  

• History: 
To display the list, the macro editor must also be made visible.  

13.4.4 Floating Windows 

The option Floating Windows makes it possible to position specific components from the project editor as desired, 
independent of the main window on the screen, for example, components can be repositioned onto a second 
monitor. This function allows you to keep the main window free from too much clutter for your work comfort. 

To enable this option, go to View -> Floating Windows and select the desired components. The selected components 
will then be displayed in a new window that you can move freely or change its size. When the new window is closed, 
the components will be automatically displayed in their original location. 

The following components can be used in a floating window: 

• Audio Editor 

• Thumbnail View 

• Macro Editor 
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• WYSIWYG View (step view, documentation view) 

13.4.5 Zoom 

The Zoom functions allow you to zoom into a screen or a page of the edit view. This makes it easier for you to edit 
and to position objects. 

 

The following functions are available in the editor toolbar: 

•  Zoom In: 
Zooms in to the screen.  

•  Zoom Out: 
Zooms out of the screen. 

•  Show Selection: 
Zooms to display the selected object in the editor view. 

•  Zoom to Fit: 
Zooms to display the full screen in the editor view. 

•  Zoom to 100%: 
Zooms to display the screen with a size of 100% in the editor view. 

13.4.6 Set Preview Mode 

The Set Preview Mode menu determines in which mode the preview of your project starts in the trainer. The 
following menu entries are available: 

•  Edit Mode 

•  Documentation View 

13.4.7 Workarea Details 

The submenu Workarea Details has the following entries: 

1. Show Language 
Selecting this function displays the project language abbreviation in the tree structure. This allows you to see 
at a glance which project is in which project language. 

2. Show Language Icons 
Selecting this function displays the project flags in the tree structure. This allows you to see at a glance which 
project is in which project language. 

3. Show UIDs 
Selecting this function displays the corresponding UIDs behind the name for the objects in the workarea. With 
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projects that share the same name, this allows you to see whether these are references for one object or for 
different objects. 

4. Show Structure Reference Counter 
The structure reference counter displays how often an object is available in the structure. For example, a 
simulation project that is used multiple times in different parts of the structure 

5. Show Content Reference Counter 
The content reference counter displays how often an object is linked in the content. For example, an imported 
image that is used in different content descriptions. 

6. Show Unknown References 
Select this function to display a workarea's Unknown References. In a situation when objects are deleted on 
the server but the local structure is not yet updated, such objects are shown with a bin icon when you activate 
this feature.  

7. Show Locally Removed Objects 
Selecting this function displays objects which have been removed locally with an empty cloud icon.  

8. Show Resources 
Activate this function to see the resources tree in the explorer. 

9. Show Trash 
Activate this option to display the local trash tree in the explorer. 

13.5 HTML Editor 

The HTML editor allows you to create and to edit the text of your content. The text is created in HTML format. 

Select a text field to open the HTML editor in a pop-up window. 

13.5.1 Functions of the HTML Editor 

The HTML editor offers the following functions: 

Function Description 

Text styles   

 

Paragraph Style 

Contains the paragraph and list styles of the Text Styles. 

Select a style from the dropdown box to specify a style 
for a selected paragraph. 

 

Character Style 

Contains the character styles of the Text Styles. 

Select a style from the dropdown box to specify a style 
for selected text. 

 Contains the block styles of the Text Styles. 
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Function Description 

Block Style Select a style from the dropdown box to insert a block. 

 

Table Style 

Contains the table styles of the Text Styles. 

Select a style from the dropdown box to specify a style 
for a selected table. 

Text formatting and structure   

Font Type 

Contains a list with all the available fonts that are 
installed on your PC. 

Select a font type from the dropdown box to change the 
font type of a selected text. 

Font Size 

Contains a list with predefined font sizes. 

Select a font size from the dropdown box to change the 
font size of a selected text. 

   

Bold / Italic / Underlined 

Changes the format of a text. 
Select a button to set or to remove the format of a 
selected text. 

 

Font Color 

Changes the color of a text. 

Select the button to open the Color Selection dialog box. 
Select a color to change the font color of a selected text. 

See chapter Color Selection Dialog Box. 

 

Remove Formatting 

Resets a text back to its original format. 

Select the button to reset the format for a selected text. 

  

Numbered List / Bulleted List 

Creates a list of the selected type for a paragraph. 

The list uses the default styles for bulleted and 
numbered lists. You can also select a list style from the 
Paragraph Styles. 

Select a button to set or to remove the list of a selected 
text. 

For numbered lists, you can define a start value. Double-
clicking a list opens a dialog to determine that value. 

   

Align Left / Center / Align Right 

Changes the alignment for a paragraph. 

Select a button to set or to remove the alignment of a 
selected text. 
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Function Description 

  

Outdent / Indent 

Increases or decreases the indent for a paragraph. 

Select a button to indent a selected text. Select a button 
again to indent the text to the next level. 

Edit and insert controls   

 

Table Operations 

Opens a dropdown menu with functions to edit a table. 

 

Cell Operations 
Opens a dropdown menu with functions to edit cells. 

 

Show/Hide Outline 

Shows the structure of the content as well as of 
borderless tables for editing. 

 

Insert Object 

Opens a dropdown menu with functions to insert objects 
in a text, for example, tables, links, placeholders, or 
images. 

Further controls   

  

Left to Right / Right to Left 

Toggles the text direction for a corresponding language. 

 

Toggle Background Color 

Switches the background color from yellow to grey to 
view and edit text better with lighter or darker font colors 
as needed. 

13.5.2 Using Tables 

You can insert tables into your content. A table uses a table style that can be specified in the Text Styles . 

Inserting a table 

To insert a table, proceed as follows: 

1. Select the position for your table in your text. 

2. Select Insert Object  -> Insert Table... 
The Insert Table dialog box is opened. 

3. Specify the following parameters: 
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1. Columns: 
Enter the number of columns. 

2. Rows: 
Enter the number of rows. 

3. Alignment: 
Select a text alignment: 

• Auto 

• Left 

• Center 

• Right 

4. Width: 
Enter a value and select percent % or pixel px as unit. 

5. Header: 
Select a header type: 

• No Header 

• Header Row 

• First Column 

• Header Row and First Column 

6. Table Style: 
Select a table style. The dropdown box shows the table styles of the Text Styles. 

4. Select OK.  

The table is inserted in your text. 

13.5.2.1 Editing a Table 

To edit a table, there are the following options: 

Updating a table 

To update the parameters of a table, proceed as follows: 

1. Select a table in your text. 

2. Select Table Operations  -> Update Table...  
The Update Table dialog box is opened. 

3. Edit the following parameters: 

1. Alignment: 
Select a text alignment. 

2. Width: 
Enter a value and select percent % or pixel px as unit. 

3. Table Style: 
Select a table style. 

4. Select OK. 
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The table is changed. 

Changing or removing a table style 

To change or to remove a table style, proceed as follows: 

1. Select a table in your text. 

2. Select the Table Styles dropdown box: 

• Select another style to change the style. 

• Select None to remove the table style and to keep the text only. 

The style of the table is changed. 

Deleting a table 

To delete a table, proceed as follows: 

 Note 
When deleting a table, the content of the table will also be deleted. 

1. Select a table in your text. 

2. Select Edit Table  -> Delete Table . 

The table is removed. 

Converting a table to text 

To convert a table to text, proceed as follows: 

1. Select a table in your text. 

2. Select Edit Table  -> Convert Table to Text . 

The table is removed and each text of a cell is inserted as paragraph. 

13.5.2.2 Editing Rows and Columns 

To edit rows and columns, there are the following options: 

Inserting a column or row 

To insert a column or row, proceed as follows: 

1. Select a cell in your table. 

2. Select Cell Operations . 

3. Select a menu entry:  

•  Insert Column Left 

•  Insert Column Right 

•  Insert Row Above 

•  Insert Row Below 
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The column or row is inserted next to the selected cell. 

Duplicating a row or column 

To duplicate a column or row, proceed as follows: 

1. Select a cell in your table. 

2. Select Cell Operations . 

3. Select a menu entry:  

•  Duplicate Column 

•  Duplicate Row 

The column or row is inserted next to the selected cell and contains the text and configuration of the source. 

Deleting a column or row 

To delete a column or row, proceed as follows: 

1. Select a cell in your table. 

2. Select Cell Operations . 

3. Select a menu entry: 

•  Delete Column 

•  Delete Row 

The column or row of the selected cell is deleted. 

13.5.2.3 Editing Cells 

To edit cells, there are the following options: 

Updating a cell 

To update the parameters of a cell, proceed as follows: 

1. Select a table in your text. 

2. Select Cell Operations  -> Update Cell...  
The Update Cell dialog box is opened. 

3. Edit the following parameters: 

• Column Width: 
Enter a value and select percent % or pixel px as unit. 

• Row Height: 
Enter a value and select percent % or pixel px as unit. 

• Cell Background 
Select Choose Color... to open the Color Selection dialog box. Select Transparent to remove the color. 

• Horizontal Alignment: 
Select a horizontal text alignment. 
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• Vertical Alignment: 
Select a vertical text alignment. 

4. Select OK. 

The cell is changed. 

Merging cells 

To merge cells, proceed as follows: 

1. Select two or more cells of a table. 

2. Select Cell Operations  -> Merge Cells  

The cells are merged to one cell. 

Splitting cells 

To split a cell, proceed as follows: 

1. Select a merged cell of a table. 

2. Select Cell Operations  -> Split Cell  

The merged cell is separated into the original cells. 

13.5.3 Inserting Objects 

The Insert Object menu allows you to insert additional objects into your text. 

You can insert the following objects: 

•  Table 

•  Link 

•  Placeholder 

•  Image or screenshot 

•  Video 

13.5.3.1 Link 

You can insert a link into your text or for an object in order to call up a website or an object from your workarea. 

Inserting a link 

To insert a link, proceed as follows: 

1. Select a text or a position in the HTML editor. 

2. Select Insert Object  -> Insert Link... . 
The Insert Link dialog box is opened. 

3. Select one of the options: 
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• Current Object 

• Workarea 

• Free 

4. Select an object from the workarea tree. 
or 
Enter a link in the Link Target text field. 

5. Enter a tooltip in the Tooltip text field, if required. 

6. Enter or change the Display Text, if required. 

7. Confirm with OK. 

Editing a link 

To edit a link, proceed as follows: 

1. Select a linked text in the HTML editor. 

2. Select Insert Object -> Edit Link... . 
The Insert Link dialog box is opened with the linked object or the entered link. 

3. Edit the link. 

4. Confirm with OK. 

Inserting a link to a step 

If you are working within a project, you can insert a link within the project to jump to another step: 

1. Select Insert Object -> Insert Step Link... . 
A Select Step dialog box is opened. 

2. Select a step from the dropdown box. 

3. Confirm with OK. 

Removing a link 

To remove a link, proceed as follows: 

1. Select a linked text in the HTML editor. 

2. Select Insert Object -> Remove Link . 

13.5.3.2 Placeholder 

The placeholder inserts a variable that is dynamically assigned to specific content. This allows you to reuse 
available content and to change information centrally. The inserted texts can be individually formatted. 

The following placeholders can be inserted:  

• Object Type: Name 

• Object Type: Description 

• Object Type: Short Description 

• Macro: Object Image (within project) 
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• Macro: Object Name (within project) 

• Macro: Hotkey (within project) 

• Macro: Input Text (within project)  

• Book Page: Text-to-Speech Text 

You can only insert content from the objects themselves or the objects at the next higher level in the content 
structure as placeholders in this case.  

Inserting a placeholder 

To insert a placeholder, proceed as follows:  

1. Select Insert Object  -> Insert Placeholder... . 
The Select Placeholder dialog box with the available placeholders is opened. 

2. Choose a placeholder. 

3. Select Insert. 

 Note 
If no content can be assigned to a placeholder, no content is displayed in the HTML editor. In this case, check the 
selected placeholder and the desired content. 

Editing a placeholder 

To edit a placeholder, proceed as follows: 

1. Select a placeholder in the HTML editor. 

2. Select Insert Object -> Edit Placeholder... . 
The Select Placeholder dialog box is opened with the inserted placeholder. 

3. Edit the placeholder. 

4. Select Insert. 

Inserting dictionary texts 

Dictionary texts can be inserted from the recording dictionary as placeholders. The texts are displayed in the 
activated object language. 
The placeholders are to be entered manually in the Placeholder dialog box. You can find the respective dictionary ID 
in the dialog box for editing dictionary texts.  

A placeholder should be written as follows: 

• Pure text:  

• HTML text:  

Inserting individual content 

In addition to the standard placeholders, you can also specify placeholders for specific objects. The respective UID 
of the object and an exclamation mark are to be added to the displayed placeholder variables in the text box. This 
should have the following form: 

• Standard:  

• Extended:  
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13.5.3.3 Image 

You can insert images into your text to extend the content with further information. The following options are 
available: 

•  Insert Image File... 
Allows you to insert an image that will be imported into your workarea. 

•  Insert Image from Workarea... 
Allows you to insert an image that is available in your workarea. 

Inserting an image 

To insert an image, proceed as follows: 

1. Select a position in the HTML editor. 

2. Select Insert Object  -> Insert Image...  or Insert Image from Workarea . 

• Insert Image from Workarea 
The Insert Image from Workarea dialog box is opened. Select one of the options: 

• Current Object 
Select an image from the current selected object. 

• Workarea 
Select an image from the workarea tree. 

• Insert File... 
Use the option to import an image into your content object. 

• Insert Image 
The Insert Image dialog box is opened. 

1. Select an image file. 

2. Select Open. 

3. The Insert Image dialog box is opened. 
In the dialog box you can specify how the image is inserted. Change the following settings: 

1. Source: 
Shows a preview of the selected image. 
You can use the Replace Image button to select another image. 

2. Size: 
Shows the size of the image. 
You can change the size in pixel (px) or in percent (%) for Width and Height. 

3. Margin: 
You can enter a margin to add more space between the image and the text field border as well as the 
other content. You can enter a value in pixels for Top, Right, Bottom, or Left. 

4. Float: 
You can specify if the text floats around the image. Select the position of the image in the text, Left or 
Right. 
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5. Alternative Text: 
You can enter an alternative text, that is shown if no image can be displayed, and is also used for screen 
readers. 

6. Show Border: 
Select the option to display a border around the image. 

7. Enable Zoom: 
Select the option to allow zooming of the image if the image is smaller than the original size. 

4. Select OK to insert the image. 

Editing an image 

To edit an image, proceed as follows: 

1. Select an image in the HTML editor. 

2. Select Insert Object -> Edit Image...  
The Insert Image dialog box is opened with the current parameters of the image. 

3. Edit the image. 

4. Confirm with OK. 

13.5.3.4 Screenshot 

You can create screenshots from various views to insert them into your text. The following options are available for 
creating a screenshot: 

•  Insert Screenshot of Window: 
Allows you to create a screenshot of an application window.  

•  Insert Screenshot of Object: 
Allows you to create a screenshot of an application object, for example, a toolbar or control. 

•  Insert Screenshot of Area: 
Allows you to create a screenshot of a specific area of your screen. This can be used to create a screenshot of 
parts of an application or for multiple applications. 

Inserting a screenshot 

To insert an image, proceed as follows: 

1. Select a position in the HTML editor. 

2. Select Insert Object  -> Insert Screenshot...  

• Insert Screenshot of Window 
By moving the mouse over the screen display, specific areas will be recognized and outlined in red. 
Select the desired outlined area.  

• Insert Screenshot of Object 
By moving the mouse over the screen display, specific objects will be recognized and outlined in red. 
Select the outlined object. 

• Insert Screenshot of Area 
With the mouse, pull the red frame over the desired area and release the mouse button.  
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3. The Crop Image window is opened. 
The window shows the made screenshot and you can make adjustments as needed. 

1. Change the size of the selection border to crop the screenshot. 

2. Select Confirm Selection . 

4. The Insert Image dialog box is opened. 
In the dialog box, you can specify how the image is inserted. Change the following settings: 

1. Source: 
Shows a preview of the selected image. 
You can use the Replace Image button to select another image. 

2. Size: 
Shows the size of the image. 
You can change the size in pixel (px) or in percent (%) for Width and Height. 

3. Margin: 
You can enter a margin to add more space between the image and the text field border as well as the 
other content. You can enter a value in pixels for Top, Right, Bottom, or Left. 

4. Float: 
You can specify, if the text floats around the image. Select the position of the image in the text, Left or 
Right. 

5. Alternative Text: 
You can enter an alternative text, that is shown if no image can be displayed, and is also used for screen 
readers. 

6. Show Border: 
Select the option to display a border around the image. 

7. Enable Zoom: 
Select the option to allow zooming of the image if the image is smaller than the original size. 

5. Select OK to insert the image. 

13.5.3.5 Video 

The option Insert Object allows you to insert videos from your workarea into your text. 

Prerequisite 

To use a video, import it into your workarea before inserting the video in your text. 

Inserting videos 

To insert a video, proceed as follows: 

1. Select a position in the HTML editor. 

2. Select Insert Object  -> Insert Video... . 
The Insert Video dialog box is opened. 

3. Select the video source from the following options and confirm: 
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• Current Object 
Select a video from the current selected object. 

• Workarea 
Select a video from the workarea tree. 

• Embed 
Enter an embedded link from a video streaming platform with the desired configurations. 

4. Depending on your selection, the Insert Video dialog box may be opened. 
In the dialog box, you can specify how the video is inserted. Change the following settings: 

1. Source: 
Shows the file of the selected video. 
You can use the Edit Link... button to select another video. 

2. Preview Image: 
You can insert an image that is shown as a preview before starting the video. 

3. Size: 
Shows the size of the video. 
You can change the size in pixels (px) or in percent (%) for Width and Height. 

4. Margin: 
You can enter a margin to add more space between the video and the text field border as well as the 
other content. You can enter a value in pixel for Top, Right, Bottom, or Left. 

5. Play Automatically: 
Allows you to start the video automatically after the content has been loaded. Deactivate the option if the 
user has to start the video manually. 

6. Show Controls: 
Allows you to show controls for controlling the video. 

7. Enable Zoom: 
Select the option to allow zooming of the video if the video is smaller than the original size. 

5. Select OK to insert the video. 

Editing videos 

To edit a video, proceed as follows: 

1. Select a video in the HTML editor. 

2. Select Insert Object -> Edit Video...  
The Insert Video dialog box is opened with the current parameters of the video. 

3. Edit the video. 

4. Confirm with OK. 

13.5.4 Pasting Texts and Images 

When pasting copied text or images into the HTML editor, in some cases it may be possible that the formatting is 
displayed incorrectly. The HTML editor is equipped with several options to prevent this from happening. Copy your 
text or image and click on the right mouse button in the HTML editor. The context menu option Paste in Format will 
appear with the following options: 
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For inserting text: 

• Formatted Text – the formatting will be preserved  

• Unformatted Text - removes any existing formatting  

For inserting images: 

• Formatted Text – the formatting will be preserved  

• Bitmap Image – inserts the image as a bitmap  

 Recommendation 
Since the HTML Editor displays text in HTML coding, a new paragraph (<p>...</p>) will be created by clicking on 

the Enter key, which should normally give you larger line spacing. If, however, you would like to create a line break 

(<br />), then click on the keys Shift + Enter. 

13.5.5 Searching for Text Strings 

If there are longer and more complex text strings in the HTML editor, there is a text search function to facilitate 
finding specific text strings. Select Search text to open the Search dialog box.. 

Dialog box for searching text 

A text field appears where you can enter one or more words to search for. The search function has several options 
to choose from to quicken the search: 

• Match whole word only: 
If this option is deactivated, possible matches will be shown directly during the search. If this option is 
activated, the results will be displayed only when the entire word is found in the text.  

• Highlight all matches: 
If this option is activated, all the matches found will be highlighted. If this option is deactivated, only the first 
match will be highlighted.  

• Match case: 
This defines whether the search should be case sensitive. If this option is activated, the search function will 
only find exact matches. If this option is deactivated, capital or lowercase letters are irrelevant for the search. 

The buttons Next and Previous allow you to switch between the displayed results. If no matches are found, a 
message will appear at the bottom of the dialog box. 

13.6 Audio Editor 

The audio editor is used to create and edit audio files in the project editor or book page editor. 
In the project editor, the audio editor can be opened using the menu: View -> Components. 
In the book page editor, the audio editor can be opened using the Edit Audio...  button in the object editor of the 
Page object. 
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Structure of the audio editor 

Area / Icon Description 

Toolbar 
In the toolbar of the audio editor, there are several 
functions for creating and editing an audio file. 

 Import Audio File 

 Record Audio 

 Edit Text to Speech 

    
Playback functions 

Play, Pause, Stop, Repeat 

    
Editing functions 

Cut, Copy, Insert, Delete 

 Insert Silence 

 Trim Audio 

  Fade In / Fade Out 

 Normalize Audio 

 Change Dynamics 

    
Zoom functions 

Zoom In, Zoom Out, Show Selection, Zoom to Fit 

Audio track The audio track is displayed below the toolbar. 
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13.6.1 Text-to-Speech Dialog Box 

The Text-to-Speech dialog box allows you to create and convert texts into spoken audio files. The editor can be 
opened using the Edit Text-to-Speech  button. 

The editor includes the following settings and functions: 

• Enter text section: 
 

○ Silence: 
The setting defines a silence, which is inserted at the beginning of an audio file before the Text-to-
Speech starts. The value is defined in milliseconds. If you do not want any silence at the beginning, then 
enter the value '0'. 

○ Text: 
Here you enter the text that you want to generate as an audio file. 
In simulation projects, the current bubble text of the step is available in the dialog and can be edited. 
When a text is edited, the macro Text-to-Speech Override  is created automatically. 

• Configure voices section: 
 

• Voice for your language: 
The setting defines the voice used for the generation of Text-to-Speech. 
You can configure the pitch and speed of your selected voice as well. 

• Preview Audio/Stop: 
The Preview Audio  button allows you to play back the text and then make changes afterwards. 
With the Stop  button, you can stop the playback. 

• Configure Text-to-Speech Services 

In this section you can choose between Windows Text-to-Speech and Google Text-to-Speech and configure 
the Google service API URL and API Key parameters. 

You can also choose to Show only language specific voices in voice selection, in this case you will see only the 
voices available for your current Producer language.  

Choose Generate and Close to convert the text to audio. 

13.6.2 Recording Dialog Box 

The recording dialog for audio is used for recording spoken text. The dialog can be opened using the Record 
Audio...  button. 

The editor has the following settings and functions: 

• Volume Level: 
The Volume Level displays the current volume of the spoken text during the recording. 

• Start Recording / End Recording: 
Click Start Recording  to begin recording and then click End Recording  to stop recording. 
Once the recording is finished, the recording dialog is closed. 
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• Settings: 
Click Hide Settings / Show Settings buttons to hide or show the options for configuring the recording device. 
Use the Recording Device dropdown menu to select an available device. Choose the Configure... button to open 
a system dialog with further settings for the device. 
The book page editor has additional settings for the recording audio in these formats:   

○ Output Format 

○ Editing Format  

13.6.3 Dynamic Editor 

The dynamic editor allows you to edit the sound and dynamic of an audio file. The dialog can be opened using the 
Change Dynamics… button. 

The editor has the following settings and functions: 

• Graph: 
The graph is located on the left side of the editor and shows the amplitude level of the audio track. The graph 
is structured as follows:   

○ Path 

○ Horizontal axis: input level 

○ Vertical axis: output level  

• The axes are defined in decibels (dB).  

• Presets: 
The presets enable you to easily set your required dynamic settings. There are default presets available and 
you can also create your own presets.   

○ Name: 
The text field displays the name of the selected preset. A name can be defined for a new preset. 

○ List: 
The list displays the available presets. When you select a preset, the defined settings are used and the 
amplitude is modified. 

○ Add: 
Click this button to add a new preset. 

○ Delete: 
Click this button to delete a preset. 

○ Reload Preset: 
Click this button to reload the primary settings of the preset, if the settings have been changed.  

• Performance Detector: 
The performance detector modifies the performance of the amplitude. The values are defined in milliseconds 
(ms).   

○ Attack Time: 
Defines the time needed to apply the filter to the amplitude. 

○ Release Time: 
Defines the time needed to remove the filter from the amplitude.  



 

Producer (Cloud Edition) 
Interface and Components 

 
PUBLIC   466 

 

• Gain Processor: 
The Gain Processor modifies the gain of the amplitude. The values are defined in milliseconds (ms).   

○ Attack Time: 
Defines the time needed to apply the filter to the amplitude. 

○ Release Time: 
Defines the time needed to remove the filter from the amplitude.  

• Lookahead: 
Specifies the time that elapses before a filter is used. This means the start area of a filter can be excluded. The 
value is defined in milliseconds (ms). 

• Play / Stop: 
The Play button allows you to play back the audio with the defined settings and make changes afterwards. 
With the Stop button, you can stop the playback. 

Editing the path 

A linear path shows the primary level. The path can be edited as follows: 

• Add a path point by left-clicking on the path 

• Delete a path point by right-clicking on the point 

• Move a path point by drag and drop 

13.6.3.1 Creating and Deleting Presets 

In addition to the presets provided, you can create your own presets, to quickly apply frequently used settings. The 
presets are available for the complete workarea. 

To create a preset, proceed as follows: 

1. Enter a name in the relevant field. 

2. Change the path and enter the values as required. 

3. Click on the Add button. 
The preset is created with the defined values and is available in the list. 

To delete a preset, proceed as follows: 

1. Select a preset in the list. 

2. Click on the Delete button. 

3. Confirm the dialog that appears. 

13.7 Insert Link Dialog Box 

The Insert Link dialog box is shown, when inserting a link. You can select an object from the workarea or you can 
enter a link. To open the dialog box, select Insert Object  -> Insert Link... in the HTML Editor or Link to -> Edit 
Link...  for an object parameter. 
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 Note 
If you have linked content from the workarea, then take care when publishing or issuing archives that you issue the 
object you have linked to as well. 

The dialog box contains the following buttons: 

• Current Object: 
Displays the content of the current object. For example, modes and documents of a project.  

• Workarea: 
Displays the content of the workarea.  

• Free: 
You can use this option to define a link to a web page. 

• Shortcut: 
Shows linked content in the tree structure for direct selection. Up to five links are displayed here.  

• Actions: 
You can select actions for controlling the trainer or book reader. 

• Insert File... 
You can insert a file into the content which will be linked. 

If you have selected learning content or a link, then confirm the dialog with OK. The link destination is now displayed 
as a link in the bubble. 

 

Importing files 

When you select Current Object you are given access to the Insert File... button. Select this button to import a file 
into your project. This can be a document or audio file, for example. A link with the file will be established 
automatically after it has been imported. 

You can remove a selected file from the workarea by clicking the Delete button. 

Open in a new window 

The option Open in new window allows you to determine whether the object is to be opened in the same project 
window or a new one. Activating the option opens the link destination in a new window. 
Selecting the option activates the Parameter button. This button displays a dialog box in which you can define 
properties for the new window. 

Searching and filtering 

Performing a search or selecting a filter in the header of the dialog makes it easier to find content in a complex tree 
structure. The respective content is displayed directly when a keyword is entered. You can also start the search by 
clicking the Search button. The filter list contains filters that have been created for selection. If you want to reset the 
filters, select (no filter). 
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13.7.1 New Window Options 

If you have activated the option Open in new window you can use the Parameters... button to call a dialog containing 
options for displaying the window. You have the following options at your disposal: 

Position 

The values Top and Left are used to determine the distance of the new window from the top and left hand margin of 
the screen area. The values are stated in pixels. 

Size 

The values Width and Height are used to define the size of the new window. The values are stated in pixels. 

The parameter Fullscreen defines whether the window is to be opened in full screen view. This requires the setting 
to be activated. 

The parameter Resizable defines whether the window can be scaled. This requires the parameter to be activated. 

Layout 

You can have the following macros of the browser window displayed in the new window by activating the relevant 
setting: 

• Titlebar 

• Menubar 

• Toolbar 

• Scrollbar 

• Statusbar 

13.8 Style Editor 

The style editor is the component for editing style resources in the Producer. The editor allows an individual 
adaptation of interfaces for the playback functionalities, contents and bubbles based on style templates. 

The dialog box can be opened with the Tools -> Customization -> Edit Style Resources...  menu. 

The customizable style types for the style editor are: 

• trainer Style 
Includes trainer bar, library, popup window, task window, book reader bar and quiz. 

• SAP Companion for desktop Style 
Includes windows of the SAP Companion for desktop and guided tour. 

• Book Styles 
Adaptation of background, buttons and pop-up window. 

• Bubble Styles 
Adaptation of bubbles based on different bubble styles. 

• Border Styles 
Adaptation of borders based on different border styles. 
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• Manager Style 
User interface of the Manager – the style has to be implemented in the Manager after creation. 

• SAP Companion for desktop: Mini Icons 
Adaptation of icons used for mini bubbles of a context help. 

• Avatars 

In the style editor, adapted styles are stored in the Adaptable Resources  section of the Explorer’s resource tree. 
Bubbles are also stored in the Bubble Styles  section and book styles are also stored in the Book Styles  
section. 

The created styles are always used for the current workarea. To use the styles in other workareas, export the 
resources as an archive file. 

13.8.1 Structure and Functions 

The basic parts of the style editor are: 

• Style list 
The style list on the top left shows the created styles. 

• Settings page 
The settings page on the bottom left shows the settings for the selected style. 

• Preview 
The preview on the right shows the selected style and the executed changes. 

The style editor includes several functions for style management: 

• New…: 
Creates a new style based on a template. 

• Delete: 
Deletes a style from the style list and the resources. 

• Update Preview: 
Updates the style preview to make changed style attributes visible. 

• Save: 
Saves the changes of the currently opened style. 

• Close: 
Closes the style editor. 

Style preview 

The preview of the style editor shows the selected style in the final status. It allows you to see executed changes 
directly in the style components. After changing a style attribute, you need to update the preview to make the 
changes visible in the view. 

13.8.2 Creating a New Style 

Before you adapt a style, you first need to create a new style in the style editor. This can be done as follows: 
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1. Click on the New… button. A dialog box opens with the following settings:   

○ Template: 
The setting shows the available style templates of the Producer. 

○ Name: 
The setting defines the name of the style. 

○ Style ID: 
The Style ID is used internally and cannot be changed afterwards.  

2. Confirm your settings with OK. 

Once you have created a new style, a style resource will be created in the Adaptable Resources section of the 
resources. The style editor shows the style in the preview and in the style list. 

13.8.3 Style Attributes 

Style editing in the style editor is based on the structured attributes and behaviors that allow resources to be 
adapted quickly and easily. The attributes are located under Style Definition. 

 Note 
It is not possible to change the size of a complete style or for parts of a style. This is to avoid functional errors. 

 

Colors 

The basic adaptable attributes for styles are colors. The colors can be specified as hexadecimal values or using the 
Color Selection dialog box. This dialog box can be opened by selecting the color preview o a parameter. 

Connected colors 

The color attributes with a star ( * ) are set and changed automatically, when a higher-ranking color is changed. For 
this behavior, do not specify the attribute. The green button is set to inactive. 
This practice allows you to create a well-balanced color style and to reduce the effort for adaptations. Therefore it is 
recommended that you only change the colors without a star. 
This means each color of a default style only needs to be changed once and this change is applied to all other color 
instances. Other color instances can also be changed but this makes editing much more complex. 

Images 

In some cases, images are used (mostly for logos). To change an image, you need to consider the size of the original 
image. The new image should have the same size to fit in the layout. The used image size appears after the attribute 
name. 
The typical file formats for images are GIF, JPG, PNG, BMP. The default images are in PNG format. 

Layout types 

The settings area has two layout types: Standard Layout and Advanced Layout. You can change the layout by 
activating or deactivating the Advanced Layout option. 
The standard layout shows the higher-ranking colors of the style. It is sufficient to only change these colors to get a 
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complete defined style. 
In the advanced layout, there are a lot more colors visible that allow you to specify the used colors in greater detail. 

 Note 
After adapting the settings, press the Update Preview button to see the changes. 

13.8.4 trainer Style (including library and book reader) 

The trainer is the playback component for simulations. The trainer style includes the following components: 

• trainer bar 

• library window 

• popup window 

• task window  

• book reader bar 

• quiz style 

• start, stop, load and error page 

trainer style templates 

The templates for trainer Style in style editor:  

• trainer Style (small) 

• trainer Style (medium)  

• trainer Style (big) 

13.8.4.1 Attributes of the trainer Style 

This chapter describes the basic settings and sections for adapting the trainer style. 

• Name: 
The setting defines the name of the style. 

• Logo: 
Specifies the logo for the library, control bars and dialog boxes. The size of the logo depends on the selected 
template. 
Select Replace Image  to change the logo. 

 Recommendation 
You can hide the logo for the playback in the Playback Settings. The Show Logo setting is available for the control 
bar of each playback component. 

The first settings are the basic color settings for the trainer style. When you change these colors, the gradation of 
the other colors changes automatically. 
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• Fill color: 
The setting defines the basic fill color. The gradients are set automatically. 

• Active / Selection: 
The setting defines the basic color for active and selected controls and texts. 

• Background color (Advanced layout): 
The setting defines the background color of the library, book reader, and trainer. 

 Recommendation 
We recommend that you change the basic color settings first, because the settings influence all of the style's other 
colors. All other settings can be changed afterwards, to adapt the details. 

Standard layout 

The standard settings sections let you specify the colors for the style's basic components.  

• Application Icon section: 
These settings define the colors of the trainer's application icon. The application icon is used as favicon. 

○ Show Color Bar: 
With this setting, you can show or hide the color bar at the bottom of the header. 

• Dialog windows section: 
These settings define the colors of the dialog boxes. 

• Text colors section: 
These settings define the colors for the texts and the different statuses. 

• Tree / list section: 
These settings define the color of the content tree in the library. 

○ Show Object Icons: 
With this setting, you can show or hide the icons of the content objects in the tree. 

• Buttons icons / text section: 
These settings define the color of the icons and the different statuses. 

• Buttons section: 
These settings define the color of the buttons and the different statuses. 

 Recommendation 
The Next button of an Explanation bubble also uses these button configurations. You can change the button in the 
Playback Settings -> General. In the parameter Explanation Link (Forward) you can enter a text or a link to an image 
in your workarea. For example: <img src="group!GR_3B86D0D06A9D5EAB:next.png" border=0 > 

• Navigation path buttons section: 
These settings define the color of the breadcrumbs in the library. 

• Start buttons section: 
These settings define the color of the start buttons for the modes or a book in the library. 

○ Multi-color icons: 
With this setting, you can deactivate the use of the default mode icons. Instead, icons with the same 
color as the text are used. 

○ Use custom icons: 
With this setting, you can specify custom images for the mode and book icons. The size of the icon 
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depends on the selected template. 
Choose Replace Image  to change a specific icon. 

 Recommendation 
Insert the PNG image file with black icon and transparent background:  

The icon is colorized with the same color as that of the Text parameter. 

Advanced layout – additional sections 

The advanced layout sections and settings let you define parts of the style in detail. 

• library section: 
These settings define the colors in the area under the library's top bar. 

• Dialog splitter section: 
These settings define the color of the splitter between the tree and content view in the library. 

• trainer bar section: 
These settings define the color of the library's and book reader's top and bottom lines. 

• Progress indicator section: 
These settings define the color of the progress indicator for the trainer and book reader bar. 

In addition to the advanced layout sections, there additional settings are available in the standard layout sections. 

Color overview 

The color overview is an HTML page that includes all options with the corresponding colors in a table. This provides 
you with an overview for proof of design standards. 
To use the color overview, go to the style folder and open the colors.html file. 

13.8.4.2 Explanation Icons 

The explanation icons are used for explanation macro types in a simulation. To customize images, replace the 
default images with your own images. 
The images have the size 32x32 pixels and are in GIF format. 

You can adapt the explanation icons of the documentation in the Documentation Style additionally. 

Type Icon 

Info  

Remark  

Tip  
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Type Icon 

Warning  

Replacing an image 

This is necessary to assign the correct image file to the active explanation type. 

To replace an explanation image in a workarea, proceed as follows: 

1. Select the icon file in the trainer Style resource of the Explorer. 

2. Click on the Replace file... button in the object editor. 

3. This opens the file selection dialog box. Select the required file. 

4. Click on Open. 

The icon is now integrated into the trainer Style and can be used for simulations. 

13.8.4.3 Activating the trainer Style 

The trainer uses the standard style of the workarea. A different style can be activated by using the Playback Settings 
in the Producer: 

1. Open the central configuration dialog using the Tools -> Settings menu. 

2. Select the section Playback Settings -> trainer - Global -> Visual properties. 

3. In the Style setting, select the created style resource. 

4. Confirm the dialog with OK. 

The trainer - Global section activates the style for the whole trainer. It is also possible to select an individual style for 
the book reader, library or a simulation mode on the relevant settings page. 

13.8.5 SAP Companion for desktop Style 

The SAP Companion for desktop style is used for the playback of SAP Companion for desktop content. The style 
includes the image files and colors for the SAP Companion for desktop windows and the guided tour windows as 
well as for the sidebar. 

13.8.5.1 Attributes of the SAP Companion for desktop Style 

This chapter describes the basic settings and sections for adapting the SAP Companion for desktop style. 

• Name: 
Specifies the name of the style. 
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The first settings are the basic color settings for the SAP Companion for desktop style. When these colors change, 
the gradation of the other colors changes automatically. 

• Main Color: 
The setting defines the basic fill color. The gradients are set automatically. 

• Text Color: 
The setting defines the basic color of the window texts. 

• Active / Selection: 
The setting defines the basic color of active and selected controls and entries. 

• Text (Selected): 
The setting defines the color of selected text. 

Standard layout 

The standard settings let you define the components of the windows and sidebar. 

• Sidebar section: 
These settings define the size and the color of the status bar. 
There are three sizes: Small, Medium (default) and Big 

• Sidebar Buttons section: 
These settings define the colors of the sidebar's buttons. 

• External Search Icon section: 
In this setting, you can exchange the default icon of the external search with another icon. The icon size is 24 x 
24 pixels. 
It is recommended that you use a PNG file with a transparent background. 

• Window section: 
These settings define the colors of the windows and window icons. 

• Tabs section: 
These settings define the tab colors. 

• Content section: 
The settings define the colors of the content areas. 

• List section: 
These settings define the colors of the object and step lists. 
With the Inside Borders setting you can show or hide the borders between the objects and steps. 

• Footer section: 
These settings define the color of the footer and footer buttons. 

• Start Button section: 
These settings define the colors of the button for starting content. 

• Systray Info Popup section: 
These settings define the colors of the system tray's info popup. 

Advanced layout – additional sections 

The advanced layout sections and settings let you define further style parts in more detail. 

• Sidebar Grip section: 
These settings define the colors of the sidebar's grip. 
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• Checkbox section: 
These settings define the checkbox colors. 

• Scroll Bar section: 
These settings define the scroll bar's colors. 

In addition to the advanced layout sections, additional settings are available in the standard layout sections. 

13.8.5.2 Activating the SAP Companion for desktop Style 

The SAP Companion for desktop uses the workarea's standard style. A different style can be activated as follows: 

SAP Companion for desktop 

1. Open the Settings dialog box using the Tools -> Settings...  menu. 

2. Select the section SAP Companion for desktop: Playback Settings -> SAP Companion for desktop -> SAP 
Companion for desktop - Style and Windows. 

3. In the Style setting select the created style resource. 

4. Choose OK to confirm the dialog box. 

 

Guided Tour 

1. Open the guided tour project. 

2. Select the Guided Tour Style macro in the first step. 

3. Open the Guided Tour Window subcategory in the macro editor. 

4. Select the style resource in the Window Style option. 
If the setting is deactivated, click on the green button. 

5. Save the project. 

You can define the style as a default of the Guided Tour Style macro for each new guided tour project. 

1. Open the Settings dialog box using the Tools -> Settings...  menu. 

2. Choose SAP Companion for desktop: Authoring Settings -> Macro Initialization -> Guided Tour Style. 

3. In the Style setting select the created style resource. 

4. Choose OK to confirm the dialog box. 

13.8.5.3 SAP Companion for desktop (SAP Companion 
mode) 

This chapter describes the basic settings and sections for adapting the SAP Companion for desktop (SAP 
Companion mode) style and how to activate it. 

To see how the changes will look like, Update Preview in the Preview section on the right of the dialog. 
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With the Copy functions in the Preview section you can copy the customized parameters and paste them in the SAP 
Companion configuration. 

Standard layout 

The standard settings let you define the components of the windows and sidebar. 

• Name: 
Specifies the name of the style. 

• SAP Companion Theme: 
The setting defines the basic theme. Depending on your choice, the color parameters are adjusted 
automatically, but you can also customize individual colors using Customize Colors function. 

• Preview Background Color: 
This color is only used for the preview area. You can set it to the background color of your target application to 
test your current theme settings. 

• Sidebar Size: 
Define the size for the Sidebar. The default size is Medium. 

• Customize Colors: 
If you want to use the default colors of your selected theme, keep this checkbox deactivated. Activate the 
checkbox to customize individual colors. 
When activated, the following list of customizable elements appears: 

• Accent Foreground 
This color is used for text and icons of selected elements, such as the hotspot outline color or text and 
icon color for the mouseover state. 

• Accent Background 
This is the background color for selected elements and the hotspot fill color. A lighter shade of this color 
is used for the mouseover state. 

• Bubble Header Text 
This color is automatically set to the Accent Foreground color. The color must be different from Bubble 
Header Background so that the heading of the bubble is visible. 

• Bubble Header Background 
This color is predefined in the selected theme. 

• Help Panel Header Text 
This color is predefined in the selected theme. 

• Icon 
Icon color for the Help Panel and bubble button icons. This color is predefined by the selected theme. 

• UI Foreground 
Text color for the Help Panel and bubble buttons. This color is predefined by the selected theme. 

• UI Background 
Background color for the Help Panel and bubble. For bright background colors, choose the SAP 
Companion theme Light to get dark bubble text. 

• Sidebar section 
These settings define the colors of the sidebar. 
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Advanced layout  

The advanced layout section lets you define further style parts. 

• External Search Icon: 
Activate the checkbox to customize the external search icon in the sidebar. 
Choose or upload a PNG image with transparency. Recommended size: 64 x 64 pixels or 256 x 256 pixels. The 
image is recolored with the sidebar icon colors. 

Activating SAP Companion Style for SAP Companion for desktop 

1. Open the Settings dialog box using the Tools -> Settings... menu. 

2. Select the section SAP Companion for desktop: Playback Settings -> SAP Companion for desktop 

3. Select the option Use SAP Companion Mode. 

4. In the SAP Companion Mode section choose the Style that you want to apply. 

5. Confirm. 

For more details on settings, follow the chapter SAP Companion for desktop - SAP Companion Mode.  

13.8.6 Book Page Style 

You can define specific book page styles to customize books. This can reflect the topic of the content or can have a 
company design. 
The book style can be selected for a book page in the Style parameter in the book page editor. 

The following components are included in the style: 

• background 

• buttons 

• pop-up window 

Book style templates 

The templates for books in style editor:  

• Standard 

• Flat 

Book style resource 

A book style is divided into two resource types: 

•  Adaptable Resources: 
Contains the files used for the customizing of the book style. 

•  Book Styles: 
Contains the files used for the playback of content. 

 Note 
When exporting an archive with the book style, make sure to export both resources. 
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13.8.6.1 Attributes of the Book Style 

This chapter describes the basic settings and sections for adapting the book style. 

• Name: 
Specifies the name of the style. 

The first settings are the basic color settings for the book style. When these colors are changed, the other colors will 
be changed automatically in their gradation. 

• Button border: 
The setting specifies the basic color for the borders of the buttons. 

• Button fill: 
The setting specifies the fill color of the buttons. 

• Multi-color icons: 
The setting specifies the colors of the icons of the buttons. In general, the icons are multi-color icons. 
With deactivated setting further parameters are available to define icons with a single color. 

The setting areas allow you to define the components of the book page. 

• Page background: 
These settings specify the image of the book page background. 

• Text pop-up - Window: 
These settings specify the colors of the window for the text pop-up. 

• Text pop-up - Button: 
These settings specify the colors of the buttons for the text pop-up. 

13.8.7 Bubble Styles 

You can define specific bubble styles for the individual customization of simulation or SAP Companion for desktop 
content as well as book pages. 
The general structure of bubbles is a text field with a spike and header bar for the feedback bubble. 

Bubble templates 

The templates for bubbles in the style editor: 
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Bubble Preview Notes 

Edge Bar 

 

The template is used for the Blue 
Sunset bubble style. 

Gloss Effect 

 

  

Rounded Corners 

 

The template is used for the Blue 
Ocean and White Island bubble 
styles. 
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Bubble Preview Notes 

Shadow 

 

  

Gray 

 

  

Sticky Note 

 

The template is used for the Yellow 
Note bubble style. 
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Bubble Preview Notes 

Thick Border 

 

  

Big Title Bar 

 

The template is used for the Black 
Forest bubble style. 

Rectangular 

 

The template is used for the White 
Island bubble style. 

Bubble resource 

A bubble style is divided into two resource types: 

•  Adaptable Resources: 
Contains the files used for the customizing of the bubble style and for the content editing. 

•  Bubble Styles: 
Contains the files used for the playback of content. 

 Note 
When exporting an archive with a bubble style, make sure to export both resources. 
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13.8.7.1 Attributes of the Bubble Styles 

The available bubble settings depend on the bubble style and characteristics. 

Typical bubble style attributes for defining the main characteristics: 

• Name: 
This setting specifies the name of the style. 

• Border: 
This setting defines the color of the bubble’s border. 

• Content fill: 
This setting defines the color of the bubble including the content part. 

• Header fill: 
This setting defines the color of the bubble’s header. 

Advanced layout – additional sections 

The advanced layout sections and settings allow you to define parts of the style in detail. 

• Title text section: 
The settings define the text style for the text in the bubbles title bar. 

• Content text section: 
The settings define the text style for the text of the bubble content. 

13.8.8 Border Styles 

You can define specific border styles for the objects Text Box, Placeholders and Active Area on book pages, in order 
to highlight content or to use the boxes as design elements. 

The border styles can be selected individually for each object by using the Border Style parameter. 

Border style templates 

The templates for border styles in the style editor: 
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Border Style Preview 

Decor 1 

 

Highlighter 

 

Text Box Shadow 
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Border Style Preview 

Warning 

 

13.8.8.1 Attributes of Border Styles 

The available border settings depend on the border style and characteristics. 

Typical border style attributes for defining the main characteristics: 

• Name: 
This setting specifies the name of the style. 

• Background color: 
This setting specifies the color of the text box. 

• Fill background: 
This setting activates the specified Background color of the text box. 

Decor 

The style includes the following further parameters: 

• Line color: 
This setting specifies the color of the text box border. 

Highlighter 

The style includes the following further parameters: 

• Color: 
This setting specifies the color of the highlighter. 

Text Box Shadow 

The style includes the following further parameters: 

• Shadow: 
These settings specify the shadow of the text box and allow you to change the characteristic. 

• Shadow color: 
This setting specifies the color of the defined Shadow. 
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• Add Effects (Advanced Layout): 
These settings activate and specify the color effects in the text box. 

Warning 

The style includes the following further parameters: 

• Border: 
This setting specifies the color of the outer border (2px). 

• Inner border: 
This setting specifies the color of the inner border (1px). 

• Stripe color 1: 
This setting specifies the first color of the stripes in the top and bottom bar. 

• Stripe color 2: 
This setting specifies the second color of the stripes in the top and bottom bar. 

• Content fill: 
This setting specifies the color of the text area. 

13.8.9 Manager Style 

You can create a Manager style to customize the Manager interface for your company design or specific use cases. 

The Manager style must be implemented in the Manager installation. 

Application name 

For your Manager installation (HANA option) you can customize the application name that is displayed in the 
Manager UI, in the browser, and in e-mail notifications which are sent when working with the Manager. 

To enter your own application name, proceed as follows: 

1. Open your Manager. 

2. Go to Administration -> Server Settings. 

3. Go to the GUI settings. 

4. Enter your application name in the Application Name parameter. 

13.8.9.1 Attributes of the Manager Style 

This chapter describes the basic settings and sections for adapting the Manager style. 

• Name: 
This setting specifies the name of the style. 

• Logo: 
This setting specifies the logo image that will be used in the header of the Manager. 
The default size is 300 x 48 pixel. For high-resolution a size of 600 x 96 pixel is recommended. 
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• Content Background: 
The setting defines the background color of the application screen. 

• Screen Title: 
The setting defines the text color of the title of the application screen. 

• Active / Selection: 
The setting defines the basic color for active and selected controls and texts. 

• Marked Text: 
The setting defines the text color for a selected control, list entry or tree entry. 

Standard layout 

The standard settings sections allow you to specify the colors for basic components of the Manager style.  

• Application Icon section: 
These settings define the color of the Manager icon. 

• Header section: 
These settings define the color of the background and texts for the header. 

• Menu bar section: 
These settings define the color of the buttons and texts of the menu bar with different statuses. 

• Submenu dropdown section: 
These settings define the color of the menu and texts of the dropdown for the submenu. 

• Buttons section: 
These settings define the color of the buttons and the different statuses. 

• Links and Tabs section: 
These settings define the color of the links and tabs and the different statuses. 

Advanced layout – additional sections 

The advanced layout sections and settings allow you to define parts of the Manger style in detail. 

• Tree selection: 
These settings define the color for the status of the tree entries. 

• Table selection: 
These settings define the color for the status of the table entries. 

• Dialog windows: 
These settings define the color of the bars and texts for the dialog boxes. 

Color overview 

The color overview is HTML page that includes all options with the corresponding colors in a table. This provides 
you with an overview for proof of design standards. 
To use the color overview, go to the style folder and open the colors.html file. 
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13.8.9.2 Implementing the Manager Style (SQL Option) 

The Manager styles that you create are stored in the Explorer under Resources -> Adaptable Resources. To include 
the style in a Manager installation, proceed as follows: 

1. Right-click on your Manager Style (UI) resource. 

2. In the context menu, select Open Folder. 

3. Open the version-'number' folder of the resource. 

4. Open the Manager files in the webapps folder of your Tomcat installation, for example:  
…\Apache Software Foundation\Tomcat6.0\webapps\Manager_Installation 

5. Copy the files from the resource folder into the folder of your Manager installation, replacing the existing files. 
Keep the other files in the installation folder untouched. 
The files and folders are: images, release, unprotected, webclient and index.htm 

13.8.9.3 Implementing the Manager Style (HANA 
Option/Cloud Edition) 

Using a Manager, HANA option or Cloud edition instance you can upload and change your style to the running 
instance without redeployment or server downtime. 

Requirement 

To implement the Manager style, you need the following: 

• Role Master Author or higher 

• Workarea permission Edit Workarea for default workarea System (_system) 

Procedure 

The Manager styles that you create are stored in the Explorer under Resources -> Adaptable Resources. To include 
the style in your Manager instance, proceed as follows: 

1. Right-click on your Manager Style (UI) resource and select Export… 

2. Save the DKP file on your PC. 

3. Open the Manager interface in your browser. 

4. Go to Workareas -> System. 

5. Expand the workarea tree to Workarea -> Resources -> Adaptable Resources. 

6. Select the resource item Manager Style (UI). 

7. Select Start Editing in the upper right corner. 

8. Select Import Archive and choose the exported DKP file. 

9. Select Upload. 

10. Check that the resource is checked in the Import Archive dialog box and select OK. 

11. Select Publish to apply the modified style to the Manager. 
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 Note 
Changes are only applied if the resource is published. To switch back to default style, you can unpublish the 
source. 

Alternative procedure 

Using Manager, HANA option, or Cloud edition you can connect the Producer directly to the System workarea 
(HANA option) or use the Cloud Producer (select Open Producer in the System workarea) to create/modify your 
individual Manager style. 

13.8.10 SAP Companion for desktop: Mini Icons 

You can define a set of icons used for the mini bubbles of the object bubbles for SAP Companion for desktop 
projects. The icons can be selected individually for each action macro by using the Mini Icon Type parameter. 

The style contains the following icon types: 

 

• Help 

• Info 

• Warning 

• Maintenance 

• Update 

• New 

• Training 

• Attachment 

• Link 

• Tip 

• Note 

• Compliance 

Mini icon templates 

The templates for bubbles in the style editor: 

• SAP Companion for desktop: Mini Icons 

• SAP Companion for desktop: Mini Icons (Big)  

13.8.10.1 Attributes of the Mini Icons 

This chapter describes the basic settings and sections for adapting the Mini Icons style. 
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• Name: 
Specifies the name of the style. 

• Background color: 
This setting specifies the background color of the preview. 

Master colors 1 and 2 

The master colors define the initial colors for the icons. There are two master color sections to define two different 
icon types. 

The master colors have the following parameters: 

• Symbol: 
Defines the color of the symbol. 

• Background: 
Defines the background color of the icon. 

• Symbol (mouse over): 
Defines the color of the symbol in mouse over status. 

• Background (mouse over): 
Defines the color of the background in mouse over status. 

• Symbol (pressed): 
Defines the color of the symbol in pressed status. 

• Background (pressed): 
Defines the color of the background in pressed status. 

Icons types 

The settings define the shape and the color of the icons.  

Each icon has the following parameters: 

• Background Shape: 
Defines the shape of the icon. The following shapes are available: 

○ Square 

○ Circle 

○ Diamond 

○ Triangle 

○ Note 

○ Explanation 

○ Symbol with Border 

○ Plain Symbol 

• Colors: 
You can adapt the symbol and background colors for each icon individually. Each icon uses a definition of the 
master colors by default. 
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13.8.11 Avatars 

You can create avatars for the use in your content. An avatar has different gestures and poses and is stored as style 
resource in Adaptable Resources. 
Adding avatars to the content provides different possibilities to enhance the learning experience. They can be used 
to present content, to guide through a story, pose questions or to speak directly to the learner. 

Avatar templates 

The templates for avatars in the style editor: 

 

Avatar Preview 

Comic Man 

 

Comic Woman 
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Using an avatar 

To select an avatar in your content, proceed as follows: 

1. Insert an Image object or open the HTML editor. 

2. Select Insert image from workarea. 
A dialog box opens. 

3. Open the workarea tree Resources -> Adaptable Resources -> Comic Man / Comic Woman in the dialog box. 

4. Select the required image of the avatar. 

5. Select OK to insert the image. 

 Recommendation 
To show the resources in the selection dialog box, select Filter Tree -> Show Resources. 

13.8.11.1 Attributes of the Avatars 

The available settings depend on the avatar and characteristics. 

Typical avatar attributes for defining the main characteristics: 

• Name: 
Specifies the name of the style. 

• Hair / Hat: 
Specifies the type of head or hair. Select a type from the dropdown box. 

• Skin 

• Hair 

• Eyes 

• Mouth 

• Clothes attributes 

• Shoes 

You can change the colors of the settings to customize your avatar. 

Logo / Details 

The settings in the subcategory Logo / Details allow you to add images on the clothes of the avatar. For examples: 
logo of a company. 

• Add Logo / Images: 
Activate the setting, to display further image parameters. 

• Front: 
Specifies the front image of the avatar. (60 x 60 pixel) 

• Back: 
Specifies the back image of the avatar. (60 x 60 pixel)  

• More Images: 
For the avatars which are looking left or right you can add further images. This is helpful to use an image with 
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the correct perspective of the avatar. 
The recommended image rotation is 4 degree.  

13.9 Text Style Editor 

The text style editor is the component for editing text resources in the Producer. The editor allows you to customize 
texts for consistent use in the content. 

In the text style editor, adapted styles are stored in the Adaptable Resources section of the Explorer’s resource tree. 
The created styles can be used in the HTML editor during content creation. 

Opening the text style editor 

The text style editor can be opened with the Tools -> Customization -> Edit Text Styles...  menu. The editor is 
opened with the current default text style. 
To edit a specific text style, choose Text Styles resource in the Adaptable Resources  and select Edit Text Styles... 
in the object editor. 

 

 Note 
The created text styles are always used for the current workarea. To use the styles in other workareas, export the 
resources as an archive file. 
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Duplicating text styles 

You are able to use more than one text style for different uses cases, for example, to create an optimized text style 
for documentation. 

Duplicate a resource as follows: 

1. Select a resource in resource tree. 

2. Open the context menu. 

3. Select Duplicate... . 
A dialog box opens. 

4. Enter a Name and change the ID, if required. 

5. Select OK. 

13.9.1 Structure and Functions 

The basic parts of the text style editor are: 

• Preview 
The preview on the left of the screen shows the available styles and the executed changes. 

• Settings page 
The settings page on the right of the screen shows the settings for the selected style. 

The style editor includes several functions for managing styles: 

• New…: 
Creates a new style based on an available style. 

• Duplicate: 
The function duplicates the selected style. The duplicated style and the source style use the same base style. 
A default style cannot be duplicated. 

• Inherit: 
Inherits the selected style. The inherited style uses the source style as base style. 

• Delete: 
Deletes a style from the style list and the resources. 

• Save: 
Saves the changes of the currently opened style. 

• Close: 
Closes the text style editor. 

13.9.2 Text Style Categories 

The text style editor has the following style categories in the preview view. Each section includes default styles and 
can contain created or duplicated styles. 
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• Default Style: 
Includes the default text style for all style definitions. The default text style only includes the Font Family and 
Font Size. 

• Paragraph Styles: 
Includes the paragraph and heading styles. 

• List Styles: 
Includes styles for lists and list level. 

• Character Styles: 
Includes styles for formatting a text inside a paragraph. 

• Block Styles: 
Includes styles for specifying text boxes and the formatting of the text. 

• Table Styles: 
Includes styles for specifying tables, the table headers and the formatting of the text. 

• Link Styles: 
Includes styles for linked text.  

13.9.3 Creating a Text Style 

Before you can adapt a text style, you first need to create a new text style in the text style editor. This can be done 
as follows: 

1. Select New… 
The New Text Style dialog box is opened. 

2. Adapt the following settings:  

○ Style Type: 
Shows the available style types. Select the type that you want to use as a template. 

○ Display Name: 
Enter a name for the style. 

○ CSS Class Name: 
Contains the name of the style that is used in the CSS of the HTML text. The CSS Class Name is 
generated from the Display Name. You can change the name, if required. 

3. Select OK. 

The new text style is added to the preview in the corresponding style category. 

Duplicate or inherit a style 

Alternatively, you can also duplicate or inherit an existing style in a style section.  

• Duplicate: 
Use this function if you want the duplicated style and the source style to use the same base style. 
Note that a default style cannot be duplicated. 

• Inherit: 
Use this function if you want the inherited style to use the source style as the base style. 

The functions can be used as follows: 
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1. Select the source style in the preview. 

2. Select Duplicate or Inherit. 
The New Text Style dialog box is opened. 

3. Adapt the following settings: 

○ Display Name: 
Enter a name for the style. 

○ CSS Class Name: 
Contains the name of the style that is used in the CSS of the HTML text. The CSS Class Name is 
generated from the Display Name. You can change the name, if required. 

4. Select OK. 

The new text style is added to the preview under the source style. 

13.9.4 Editing a Text Style 

To edit a text style, proceed as follows: 

1. Select the style that you want to change. 
To open a style category, select the category name. 

2. Edit the settings in the settings page. 
Each text style includes style relevant parameters that can be adapted. The main sections are:   

○ Text - general parameters 

○ Paragraph 

○ Margin 

○ Padding 

○ Border 

○ List Level 

3. Select Save to save your changes. 

 Recommendation 
In some cases, it is necessary to have a fallback font type, if the specified font cannot be displayed. 
You can add a fallback font type to your specified font, separated by a comma. For Example: Standard 
Font,Fallback Font 

13.10 Using Colors 

Colors can be used in various parts of the Producer, such as for texts in the HTML editor, or for objects in the 
project editor or book page editor. 

You can specify colors in the Custom Color Dialog Box. 

To specify a set of colors you can use the Color Palette resource. The colors of the resource can be selected from 
the Color Selection Dialog Box. 
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13.10.1 Custom Color Dialog Box 

The custom color dialog box allows you to define and customize your colors. The dialog box can be opened by 
selecting Font Color...  or by selecting a color preview of a color parameter. 

 Note 
If the workarea has a Color Palette resource, then the dialog box can be opened by selecting Custom Color...  in 
the Color Selection dialog box. 
See also Color Palette. 

The following settings are available for defining the color values: 

• Color wheel: 
The color wheel contains a wide variety of shades that can be selected by simply clicking on the required color. 

• Brightness: 
The brightness control allows you to define the brightness of the color wheel or the selected color. 

• New / Current: 
The two fields below the color wheel display the current and the selected color values. By selecting Current, 
the New color value will be removed and the value will be reset to its original state. 

•  Color Picker: 
The color picker allows you to choose a specific color shade on the screen. 
Click on the button and with the mouse button held down, drag the picker icon onto the required color shade. 
Release the mouse button to confirm the color value shown. 

• RGB color value: 
The RGB color value allows you to define a color via an RGB color space. 

• HSV color value: 
The HSV color value allows you to define a color using an HSV color space. 

• Hex color value: 
The hexadecimal color value allows you to define a color using the RGB color space as a hexadecimal value. 

• Recently Used: 
This fields display the last 16 colors that have been previously selected. 

• Standard Palette: 
This fields display 16 predefined standard colors. 

•  Add to Palette...: 
Select the button to add a custom color to the color palette. The color palette dialog box is opened. 

13.10.2 Color Palette 

The color palette allows you to predefine a set of colors used for content creation. For example, you can specify the 
colors of your corporate design. This helps the author to use the colors in the content consistently. 

The color palette is a resource type of the Adaptable Resources. 
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 Note 
The color palette is not a default resource of the workarea. The resource is added after you specify and save colors 
in the color palette editor. 

Color palette editor 

The editor can be opened with the Tools -> Customization -> Edit Color Palettes...  menu. 

The editor is structured as follows: 

• Toolbar: 
Contains functions for editing colors. 

○  New Color: 
Allows you to create a new color for the resource. 

○  Edit Name and Description: 
Allows you to edit the name and description of a color. 

○  Reset Color: 
Resets the color and discards the last changes. 

○  Move Color Up / Move Color Down: 
Changes the order of the color in the list. 

○  Delete Color: 
Deletes a selected color from the resource. 

• Color list: 
Show the colors of the resource with preview, name and description. 

• Color selection controls: 
Contains controls for specifying a color. See also Color Selection Dialog Box. 

13.10.2.1 Customizing a Color Palette 

You can create a new color specification or you can change an available color. 

Creating a new color 

To create a new color, proceed as follows: 

1. Select New to create a new color. Select Edit to edit an available color. 

2. A dialog box is opened. 

1. Color preview: 
The field shows a preview of the current color and the Hex value. 

2. Color Name: 
Allows you to enter a name for the color. 

3. Description: 
Allows you to enter a description for the color. The description can contain a use case or limitations for 
the color. 
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3. Select OK. 
The new color is created and selected in the list. 

4. Specify the color by using the color wheel or enter a color value. 

Changing an available color 

To change an available color, proceed as follows: 

1. Select a color in the list. 

2. To edit the name and description select Edit in the toolbar or double-click the color. 

1. A dialog box is opened. Change the values. 

2. Select OK. 

3. Specify the color by using the color wheel or enter a color value. 

13.10.3 Color Selection Dialog Box 

The color selection dialog box allows you to select the colors of a color palette. The dialog box can be opened by 
selecting Font Color...  or by selecting a color preview of a color parameter. 

 Note 
The dialog box is only available, if the workarea has a Color Palette resource. 
See also Color Palette. 

• Recently Used: 
This fields display the last 7 colors that have been previously selected. 

• Standard Palette: 
This fields display the colors of the Color Palette. 
You can display the colors or the colors and the descriptions. Select a button in the top of the dialog box to 
change the view. 

○  Show List View 

○  Show Swatch View 

•  Custom Colors...: 
The control opens the custom color dialog box to specify a custom color. 

13.11 Using an External Editor for Images 

Images are one of the main contents in objects, especially in projects. In some cases, it may be necessary to 
change, update or retouch an image. You can use an image editing editor, in order to make it easier to edit images. 
When editing content, you can open a specific image from the Producer in the external editor. Once the image has 
been edited and saved, the changes are visible in the Producer. 

An external editor can be used for all types of images in: 

• projects 
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• book pages 

• style editor 

Editing an image externally 

To use an external editor, proceed as follows: 

1. Select the macro with the included image. 

2. Select Replace Image  (macro editor) of the image parameter. Choose External Editor... from the menu. 
The image is opened in the editor and a dialog box appears.  

 Note  
Do not close the dialog box when editing the image. When you close the dialog box, the changes are discarded.  

3. Edit the image in the editor. 

4. Save the image in the editor and close the image. 

5. Select OK to confirm the changes. 

Specifying the external editor 

The default editor for editing images is Microsoft Paint. To set a different editor, proceed as follows: 

1. Select Browse... (see above) in the dialog box. 

2. Select the executable file of the editor. 

3. Confirm with Open. 

4. Select Cancel or OK and restart the function for editing in the selected editor. 

13.12 Keyboard Settings 

Many functions in Producer may be executed using keyboard shortcuts (hotkeys). It is important to distinguish 
between shortcuts that relate to the Producer menu commands and keyboard shortcuts that relate to particular 
actions during the recording of a step. All actions can be assigned or reassigned from default settings to individually 
selected keys using the command Tools -> Keyboard Settings... This is where you may also assign hotkeys to 
actions that have not been assigned a default shortcut setting. 

This function allows the user to freely assign shortcuts to the keys that seem the most logical or are the easiest to 
remember. 

On the left you will see a complete list of available actions. These are subdivided into groups which can be selected 
via a drop-down list box. The list box contains the actions in that group. If an action has been selected, its name and 
its current key assignment are displayed. The PC keyboard layout is displayed on the right side of the screen. Under 
the keyboard graphic in the Action box the name of the selected action is displayed along with the previous and new 
key assignment (if any new assignment has been made). 

All keys are color-coded. Yellow indicates the key assigned to the action in question. Red indicates that a key 
already has an assignment. Green indicates a free key. Blue indicates whether the Shift, Alt or Ctrl key needs to 
be held for the particular action. White fields indicate keys that are not available for individual assignments. 
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The currently assigned keyboard shortcut for each of the different keys can be checked by moving the mouse 
pointer over it. A small status line under the keyboard displays which action is using the key. Pressing the Shift, 
Alt or Ctrl keys is simulated by simply clicking on the corresponding position on the keyboard display. Clicking it 
again deactivates it. 

Assigning shortcuts 

To assign a new hotkey, simply click on the green key of your choice. When all changes have been made, click on OK 
or Apply in order to activate all hotkeys. If you would like to return to the default settings, simply click on the button 
System Default. Individual key assignments can be deactivated using the button Remove Hotkey. The key will then 
be available for a new action assignment. Note that the corresponding action can no longer be carried out with a 
keyboard shortcut until a new one is assigned. 

In addition to default keyboard shortcuts, there are several actions that have no default keyboard shortcuts. You 
may assign these shortcuts as you wish. 

13.13 watchdog 

The watchdog is a functionality of SAP Enable Now and is used to show a feedback to the user if a product 
component is not responding during a process. 

 

In such a case a dialog box with a hint is opened. The dialog box contains the following buttons: 

• Restart: 
Restarts the Producer. 

• Please Wait: 
Waits for finishing the process. The Producer will not be closed. 

• Close: 
Closes the product component. In case of an exception the button is displayed instead of Please Wait. 

• Open Log Folder: 
Opens a folder with a log file and closes the Producer. 
The log file contains information about the executed processes and can be used by the support to analyze the 
occurred problem.  
 
The log files are stored in the folder: 
C:\Users\User\AppData\Local\Temp\Low\watchdog_logfiles 
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14 Settings Dialog Box 

The Settings dialog box contains all the global settings for working with Producer as well as the settings for 
recording and editing contents and settings for the trainer installed in the current workarea. You can open the 
dialog box by using the menu Tools -> Settings... . 

14.1 General Usage 

The functions and characteristics of the Settings dialog box are: 

• Layouts 
The most setting pages using different layouts, that can be switched about the title bar. 

○ Standard Layout - contains the basic settings 

○ Advanced Layout - contains the further settings for advanced users 

• Green Control 
Some of the settings have a green control, that allows it to activate  or deactivate  a setting. A deactivated 
setting uses the default settings of the Producer. To edit a deactivated setting, the green control has to be 
activated per click. 

• Project Override 
The Project Override subcategory provides specific settings for the currently opened project. The global 
settings are not affected. 

• Default Settings 
The Default Settings button allows it to reject executed changes. 

• Restart 
Some of the settings require a Producer restart before they become active. In this case a dialog shows up 
when the settings are applied or the dialog is closed. 

14.2 Initialization and Fallback Default Parameters 

Parameters defined in the central configuration dialog are differentiated in terms of how they are used into initial 
and so-called fallback parameters. This involves differentiating according to whether they are supposed to initiate a 
global default of the available parameters or overwrite non-individualized parameters. 

 Note 
Parameters are saved for each workarea where they are filed under Resources -> Configurations . Particularly 
close attention is to be paid to this if individual parameter settings are also to be made available to other authors or 
used as a Workarea standard when connecting to Manager. 
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14.2.1 Use in the Macro Settings 

Macro Initialization and Macro Fallback Defaults allow you to define specific macro parameters across a workarea. 
However, they do not apply in the case of individualized parameter definitions (with green lamp activated). 

Macro Initialization 

You can use the Macro Initialization to define all of the relevant macros' parameters prior to the project creation 
process, thus ensuring the greatest possible project consistency. Parameters that are predefined using Macro 
Initialization are shown as being activated in the relevant macro settings (the green lamp preceding the parameter is 
activated). That means they are unaffected by changes in the Macro Fallback Defaults. 

 Note 
Note that Project Initialization depict initial parameters. The parameter definitions they contain only apply once 
they have been established and are not applied to already existing projects. 

Macro Fallback Defaults 

The Macro Fallback Defaults allow you to determine parameters in all of the workarea's previously recorded 
projects, thereby ensuring, for example, consistency within the workarea upon conclusion of the project creation 
process. Unlike when defining Macro Initialization parameter settings made via the Macro Fallback Defaults in the 
relevant macros are NOT shown as being activated (the green lamp preceding the parameter remains inactive). The 
advantage of this is that settings specified using Macro Fallback Defaults can always be changed globally again. 

 Note 
Note that Macro Fallback Defaults only take effect in NON-activated parameter data. 

14.2.2 Application Example 

The following case study is intended to explain the different Macro Initialization and Macro Fallback Defaults 
application examples using the explanation bubble. 

When creating the workarea prior to recording the projects, it needs to be stipulated that all explanatory bubbles to 
be inserted should use the Info display type. The author can apply any necessary variances himself on a case by 
case basis although as a matter of principle the explanatory bubble should be used for this type of information. 
To avoid inconsistencies as a result of omitting this parameter configuration and to free the author from having to 
reapply this setting each time, this setting is defined as a Macro default. 

To this end, parameter type (2) is defined in the central configuration dialog under Authoring Settings -> Macro 
Initialization (1) -> Explanation. It will then be placed in the explanatory bubble in all the projects that are to be 
recorded. 

Once all projects have finished recording, it is recognized in the workarea finalization process that most explanatory 
bubble content contains excessively detailed additional information, thus distorting in Test mode what the learner 
has actually learned. As this was not considered in the planning phase, the parameter In Test mode was not 
activated in any of the recorded projects and consequently was not defined either. At this point, the extra effort of 
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rectifying all the projects manually can be avoided by amending the specific Macro alternate parameter. 
Deactivating the parameter In Test mode (2) in the central configuration dialog in Playback Settings -> Macro 
Fallback Defaults parameter (1) -> Explanation deactivates the parameter in all workarea projects. 

 Note 
Note that Macro Fallback Defaults only take effect with default parameters, namely ones which have not been 
changed. Activated parameters (green lamp) are unaffected when an alternate parameter is changed. 

14.3 Producer 

The Producer area contains the basic settings for the administration of the Producer. Further there are 
configurations of the tools and the functions for the creation and editing of content. 

• General 
The settings page influences the appearance and the use of specific editing tools of the Producer. 

• Manager Workarea 
The settings page influences the communication between the local and Manager workarea. 

• Directories 
The settings page defines the auto save function and the automatic update of the Producer. 

• Save 
The settings page defines the modes, which will be created when generating a project. All modes are activated 
by default. 

• Templates 
The settings page defines the templates for the creation of content objects. 

• Expert Features 
The settings activate additional Producer functions. Note, that the functions are not covered by the standard 
support package and do not represent standard guaranteed system properties. 

14.3.1 General 

Settings are located in this category which influence the appearance and the use of specific editing tools of 
Producer. 
Some of the settings require Producer to be restarted before they become active. In this case, you will be informed 
by a dialog as soon as the settings are applied or the dialog closes. 

• Primary Language: 
Defines interface language of the Producer. 

• Secondary Language: 
Defines the fallback user interface language of the Producer. In the primary language not available 
translations will be shown in the secondary language. 

• Default Language for Spell Checking: 
This option defines a default language to be used for spell checking. Typically the language used is the one 
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defined for an object. If no language package for Windows Office is installed, the Producer uses the defined 
default language. 

• Spell Check: 
Activates spell checking for the HTML editor. This requires an installed spell checker for Microsoft Word. 

• Drag&Drop Macro Editing:  
Specifies, that macros can be moved with drag&drop in the project editor.  

• Advanced Accessibility Features: 
Enables the advanced accessibility features (magnifiers) of the Producer. 
If the features are not needed, deactivate the option to save memory. 

• Move Time with Macros:  
The effect of this option is that when a macro is inserted or removed, the other macros are seamlessly shifted 
along the timeline or any gaps arising are closed. Move time with macros enables the other macros to 
seamlessly shift along the timeline when a macro is inserted or removed. When a macro is inserted, all 
subsequent macros shift back along the timeline by the exact duration of the inserted macro. If a macro is 
deleted within a step, the resulting gap is automatically closed. 

• Max. most recently used folders: 
This allows you to define how many of the recently opened directories are to be displayed in file dialogs. 

• Show disabled warnings: 
If dialogs were suppressed by selecting the option Don't show this message again, activating this parameter 
can redisplay the dialogs. 

• Use Old Office formats: 
This option is used to generate documents in the 97-2003 Office format (DOC/PPT). If the option is 
deactivated, the DOCX/PPTX formats are generated. 

• Generate library on Closing Producer: 
Specifies whether the library should be generated when closing the Producer. 
It is recommended to deactivate the setting if the workarea includes a large number of objects. 

• Forbid Active Content: 
Activate this setting to prevent the import of JS, HTM and HTML files. This will forbid the import of potentially 
dangerous content. 

• Preferred localhost Address: 
Select whether localhost should be addressed by name or by IP address. This setting may affect both 
performance and security, depending on your preferred browser and your IT's administrative settings. 

14.3.2 Server Workarea 

The settings in this category influence the communication between the local and the server workarea. 

The main parts of the settings page are: 

• General: 
The settings influence the creation and the handling of a server workarea. 

• Workflow Settings: 
The settings define the behavior and the default values of the server interaction dialogs (like Save to Server, 
Finish Editing, Change Workflow, ...). 
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• Preferred actions: 
The settings define, whether the context menu provides operation calls for the current, single object or the 
relevant bulk operation calls including the sub-objects as well, if existent. 

• Show Tree Selection: 
The settings define, whether the tree selection dialog is displayed when executing an operation. 

14.3.3 Directories 

The settings in this category affect the paths used by Producer for saving settings and other program components, 
as well as the Autosave functionality. 

• Updates' path: 
This allows automatic updates for associated resources to be configured. In the process, an administrator 
creates a central folder in which the new resources are filed. When the path is specified, the new resources are 
imported into the Workarea when the Producer is launched. 

• Autosave: 
When this option is activated, projects are saved automatically at regular intervals with the time increment 
entered under Autosave Interval. 

• Autosave Interval: 
The value entered here specifies the frequency in minutes with which projects are automatically backed up if 
the option Use Autosave is activated. 

14.3.4 Save 

In this area, you can define which modes are to be created when saving a project. All modes are activated by 
default. Deactivate a mode for a particular project type if you do not wish to generate that mode. 

• SAP Companion for desktop   

○ SAP Companion for desktop  

• Standard (Simulation) 

○ Demo 

○ Practice 

○ Test 

○ Concurrent 

○ Guided Presentation 

○ Free Presentation 

• SAP Companion   

○ SAP Companion  
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14.3.5 Templates 

In this area, you can configure standard templates for use when creating new objects in the workarea. A template is 
an object that has been created with predefined settings and properties. For more detailed information, refer to the 
section on Templates for objects in the workarea in this user guide. 

Templates can be created for the following types of objects: 

• Simulation Project 

• Quiz Project 

• Context Help Project - SAP Companion for desktop 

• Guided Tour Project - SAP Companion for desktop 

• Context Help Project - SAP Companion 

• Guided Tour Project - SAP Companion 

• Group 

• SAP Companion for desktop  

• Book 

• Book Page 

• Text Unit 

14.3.6 Expert Features 

In this area, you can activate additional Producer functions that have been reserved for special users. This is 
accomplished by entering parameters in the list. The syntax used for an entry follows this example: Feature=1; 
One entry per line can be made. 1 activates a feature, 0 deactivates it without deleting the line. 

 Note 
Note that additional functionality created by entries made in this tab is not covered by the standard support 
package offered by SAP SE and are not standard guaranteed system properties. 

14.4 Authoring Settings 

The Authoring Settings area contains settings for the creation, recording and editing of simulation projects as soon 
as for the creation of book pages. 
The Authoring Settings are a resource type of the Adaptable Resources. 

• Record - General 
The settings on this page define the recording of projects and include settings for the object recognition and 
the screenshot creation. 

• Audio (Simulation) 
The settings on this page define the usage of audio in simulation projects. 
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• Auto Crop (Documentation) 
The settings on this page define the cropping area for the auto crop function of documentation. 

• Recording (Simulation) 
The settings on this page include functions for the recording of controls as soon as automated editing 
functions which will be executed during the recording. 

• Rerecording (Simulation) 
The settings on this page include functions for the rerecording of controls and for the handling of conflict 
situations. 

• Macro Initialization (Simulation) 
The Macro Initialization area includes the initial settings for all editable parameters of the macros. The settings 
should be set before the recording or the insert of a macro to take effect. 

• Book Page Editor (Book Page) 
The settings define the grid lines of the book pages in the book page editor as well as the snapping behavior 
when moving an object in relation to other objects. 

• Book Page Initialization (Book Page) 
The Book Page Initialization area includes the default settings for all editable parameters of the book page 
objects. The settings should be set before the recording or the insert of an object to take effect. 

14.4.1 Recording - General 

You use the settings in this category when recording simulation projects. They control the way screenshots are 
made when recording an application and object recognition is performed. 

If a project is open, the additional Project Overrides subcategory is available. It provides specific settings that apply 
only to the project that is currently open. 

Settings 

• Record Bar Position: 
Specifies the position of the record bar during the recording. The positions are: Top, Bottom or Minimized. 

• Area: 
Specifies the area for recording the screenshot and controls. There are two types: 

○ Region: 
Lets you record a specified screen area. The area size can be specified in the Size parameter. 

○ Active Window: 
Lets you record the window that is currently in the foreground. 

○ Browser Client Area: 
Lets you record the client area of a browser window. The area size can be specified in the Size parameter. 

• Size: 
Specifies the size of the recording area for the selected Region option. Select a predefined size from the 
dropdown box. 
You can specify a size manually in the input field (top, left, width, height) or click on Edit Size  to display 
a selection border. 



 

Producer (Cloud Edition) 
Settings Dialog Box 

 
PUBLIC   509 

 

 Recommendation 
If you want to show the change of application in the taskbar, you need to enlarge the recording area for the 
taskbar. 

• Fit Application Window: 
Changes the application window to the size of the recording area when you start recording or when you 
reposition the window. 

• Fit Newly Opened Application Window: 
Changes a newly opened application window to the size of the recording area during the recording. The setting 
is active if the Fit Application Window setting has been activated. 

• Disable Path Building: 
While recording, the path information is saved for the rerecognition of objects during rerecording. You can 
deactivate path building, if the recording is very time-consuming and no rerecording is required. 

• Automatic Profile Change: 
If you change the application during recording, the selected application profile might need to be adapted. 
There are the following options: 

○ Always Change: 
Specifies that the profile changes automatically during the recording process. If no application profile is 
associated with the current application, the Standard profile is used. 

○ Never Change: 
Specifies that the profile is used for all applications during recording that have been selected at the 
beginning of the recording. 

○ Restrict to Profile: 
Specifies that a specific profile is used for recording. The authors cannot change the profile. Select a 
profile in the Application Profile parameter. 

• Application Profile: 
Specifies the profile used during recording if the Restrict to Profile option is used for the Automatic Profile 
Change. 

• Record Hot Keys:  
Specifies that keyboard shortcuts you used during the recording are recorded. 

• Generate Inspection Pages:  
Specifies that additional information that forms the basis for subsequent control recognition are saved. It can 
be used in a later process for additional control recognition. The process can be time-consuming. 

• Control Recognition Method: 
Specifies the method for the recognition of controls during recording. 

○ Profound Recognition: 
Recognizes controls by using interfaces to read page and object information. The method is 
recommended for recording projects used for rerecording and SAP Companion for desktop project 
conversion. 

○ Simple Recognition: 
Recognizes controls as graphical objects. This is required, for example, when recording with Citrix or 
when using terminal applications. 
An individual cursor is displayed for this setting if the Allow Rollover Effects option is deactivated. 



 

Producer (Cloud Edition) 
Settings Dialog Box 

 
PUBLIC   510 

 

 Note 
When recording using the Simple Recognition option, make sure that the mouse option In dialog fields 
automatically jump to the standard button is deactivated in the Microsoft Windows settings. This mouse attribute 
impairs the control recognition function by preventing mouse movements. 

• Allow RollOver Effects: 
Specifies whether rollover effects are suppressed during recording when moving the cursor over a control. 
This prevents the menu from being changed accidentally, for example, with rollover effects not visible on the 
screenshot. 

• Recording Mode: 
Specifies the mode used for recording a simulation. You can start the activated mode by using the Record 
Application toolbar button. 

○ Quick Recording: 
Lets you record a project quickly without object recognition. 

○ Profile-Based Recording: 
Lets you record a project using application profiles for object recognition. 
This mode is recommended, when using projects for rerecording and SAP Companion for desktop. 

○ Both Recording Modes: 
The recording mode can be selected when you start recoding. This allows you to select a recording mode 
that is specific to the use case. 

• Lock Recording Area: 
Specifies that a dialog box for changing the recording area is not displayed during recording. Activate this 
setting if authors should use a predefined area. 

Fallback method for object recognition 

• Fallback Method: 
Specifies the method for recording controls that are not identified correctly during recording:  

○ Recognize Hotspot: 
Creates a macro with the values of the clicked position. The object name and field image are recorded 
and the macro settings are defined using standard values. 
Once the recording is complete, the macro can be edited in the macro editor. 

14.4.2 Rerecording 

A number of different settings can be made for rerecording in the settings dialog box. 

The following settings can be adjusted: 

 

General 

• Response Time: 
This value entered here defines how long the Producer waits during the rerecording process for a new screen 
to be rendered before performing and recording the next action in the application. The value is entered in 
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milliseconds. Should the default value of 2 seconds (2000ms) not be sufficient because your application 
response time is longer, you should increase this value.  

• Keep Crop: 
This setting specifies that a layout that was set up for a Screen macro is to be kept intact. 
If this setting is deactivated, the layout will not be applied during rerecording. This can be necessary if a 
control is at a different position in the new version of an application and the layout has to be reset.  

• Keep Bubble Orientation: 
Activating this setting retains the selected bubble orientation. If this option is deactivated the orientation of 
the bubble may change relative to the original project according to the position and size of the object to be 
rerecorded.  

• Language Dependent Type: 
If this parameter has been activated, the name of the control is a clue that can be used to recognize it during 
rerecording. This is useful in new versions of an application in which corresponding Controls occupy a 
different position or are differently designed. A search then takes place for this Control via the relevant 
interface using the associated name.  

Automatic Mode 

• Hotspot Handling: 
This setting defines how a click range is to be edited during automatic rerecording of a project.   

○ No Editing: 
If this option is selected a Hotspot is recorded automatically by Producer. In the process the Producer 
uses the recorded position to identify a control device at this position. If no control device is identified a 
Hotspot is recorded at this point.  

○ Interactive: 
With this option the rerecording changes at a Hotspot from the automatic to the interactive mode. As a 
result it is possible to edit the Hotspot. Refer to the chapter on interactive rerecording for this.  

• Dropdown List Interactive: 
Activate this setting to rerecord the dropdown lists of your project interactively during the automatic 
rerecording. Thus the particular choice can be influenced manually.  

Interactive mode 

• Bubble Type: 
Specifies which bubble type is displayed in the editor during rerecording when a control is edited.  

14.4.3 Audio 

The settings on this page define the usage of audio in simulation projects and for book pages. 

• Recording Device: 
Specifies the audio device for recording. Click on Configure… to open a system dialog with further settings for 
the device.  

• Bubble Text for Text-to-Speech: 
Specifies the mode for the bubble text for converting text to speech.  
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• Voice for Text-to-Speech: 
Specifies a voice for generating Text-to-Speech audio. The dropdown list displays the available voices based 
on your Text-to-Speech service configuration. 

• Configure Text-to-Speech Services 
Opens a dialog where you can choose between Windows Text-to-Speech and Google Text-to-Speech and 
configure the Google service API URL and API Key parameters. 
You can also choose to Show only language specific voices in voice selection, in this case you will see only the 
voices available for your current Producer language.  

• Audio Format: 
Sets the global audio format. The standard format shows default in the entry and a changed format shows 
current. 

○ Output Format: 
Sets the audio format used for content publishing. 

○ Editing Format: 
Sets the audio format used for content editing. 

14.4.4 Macro Initialization 

The Macro Initialization area includes the initial settings for all editable parameters of the macros. The settings 
override the default settings of the Producer and should be set before the recording or the insert of an element to 
take effect. To initialize the parameters allow it to achieve consistency in the content creation and to reduce the 
editing effort. 

The area is separated into the macro groups: 

• Interactions 

• Special Macros 

• Page Macros 

• Quiz Items 

• Documentation Macros 

14.4.5 Book Page Editor 

Here you can define the grid lines for the book pages in the book page editor as well as the snap-in-place function 
with the ledger lines, which is a helpful tool when dragging an object to ensure that they are properly aligned with 
other objects. 

Configuring the grid 

The grid is part of the background and assists you in precisely designing the layout of your objects on a book page. 
You can define the space between the grid lines as well as the distance from the upper-left corner. The settings for 
the grid are: 

• Grid Spacing Horizontal 
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• Grid Spacing Vertical 

• Grid Offset Left 

• Grid Offset Top 

Configuring the snap-in-place function 

You can activate and deactivate the Snap-in-place option as well as define which objects should use this option and 
how much distance there should be between the object and the grid area where it will be snapped into place. If this 
option is activated, when dragging an object, it will automatically lock to the grid, which facilitates positioning 
objects and helps to maintain conformity and accuracy throughout your project. The settings for the snapping are: 

• Show Snap Positions 

• Enable Snapping 

• Snapping Distance 

• Snap to Objects 

• Snap to Centers 

• Snap to Guiders 

• Snap to Grid 

• Snap to inner Border 

• Snap to outer Border 

 Recommendation 
You can activate the snapping of objects temporally with pressed Ctrl key. For that deactivate the snapping in 
general and activate the snapping to specific objects. 

14.4.6 Book Page Initialization 

The Book Page Initialization area includes the initial settings for all editable parameters of the book page objects. 
The settings override the default settings of the Producer and should be set before the recording or the insert of an 
object to take effect. To initialize the parameters allow it to achieve consistency in the content creation and to 
reduce the editing effort. 

The area is separated into the book page object groups: 

• Action Objects 

• Layout 

• Link Buttons 

• Media Objects 

• Book Page Objects 
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14.5 Playback Settings 

The Playback Settings area contains settings for the playback of simulation projects and of book pages which, will 
be interpreted at runtime of the trainer, book reader and library functionalities. 
The Playback Settings are a resource type of the Adaptable Resources. 

• General (Simulation) 
The settings on this page define the properties of simulation projects for the playback. 
Specific settings for an opened project can be set on the Project Override subpage. 

• trainer (Simulation) 
The settings on this page define the playback and tracking of content and the properties of the trainer 
functionality. 
The settings are the global settings for the use of the trainer functionality. Individual settings can be set on the 
pages library, book reader or for each mode. 

• book reader  
The settings on this page define the playback and tracking of content and the properties of the book reader 
functionality. 

• library  
The settings on this page define the playback of content and the properties of the library functionality. 

• Mode Settings 
The settings on these pages define the playback and tracking for each mode. 
Specific settings for an opened project can be set on the Project Override subpage. 
There are the following modes: 

○ Demo Mode 

○ Practice Mode 

○ Test Mode 

○ Concurrent Mode 

○ Guided Presentation Mode  

○ Free Presentation Mode 

• Macro Fallback Defaults 
The Macro Fallback Defaults area includes the fallback settings for all and deactivated (green lamp ) 
parameters of the macros. 

• Book Page Fallback Defaults 
The Book Page Fallback Defaults area includes the fallback settings for all and deactivated (green lamp ) 
parameters of the book page objects. 

14.5.1 General 

The settings here define how highlights and bubbles are displayed globally for all projects contained in the current 
workarea. They are used as default settings for all recorded highlights and bubbles. For changed settings to take 
effect, the modes of a project need to be generated again. 

In the subcategory Project Overrides the same group of settings can also be applied specifically to the current 
project only. The global settings for all projects are not affected. 
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• Explanation Link (Forward): 
In the parameter you can specify a link text or image, which will be used for continuing a simulation in the 
displayed explanation bubble. The text may contain HTML attributes. 

• Show Note in Test Mode:  
If this option is activated, a bubble is displayed in test mode which contains a link which opens an additional 
window in demo mode showing the actual step and closing it again afterwards. The bubbles for entry fields 
also show the explanation from practice mode. 

• Step-Based Demo Playback (Audio off): 
Having deactivated the trainer bars audio button, this parameter will suppress automatic playback of Demo 
mode. Instead every step has to be confirmed manually by clicking the automatically inserted Next button 
within the action bubble. With activated audio, the playback will resume automatically when step-based audio 
has finished. 

• Show Mouse:  
This option also shows the mouse pointer for actions that are performed in the application with the mouse. By 
default, the mouse pointer is hidden. 

• Handle Mouse Wheel as Incorrect:  
If activated, using the mouse wheel in Practice and Test Mode is handled as incorrect action if another action 
is required. By default, using mouse wheel counts as scrolling or zooming. 

• Points per Step:  
Specifies the number of attempts users can get in Test Mode for each step from 1 to 5. If only 1 attempt is 
defined, users need to perform the correct action at the first attempt or continue if they make a mistake. 

Setting subcategories 

There are the following subcategories of the settings: 

• Highlights: 
Contains settings for the style of highlights. 

• Bubbles: 
Contains settings for the style and the behavior of bubbles. 

• Quiz: 
Contains settings for the display and the behavior of the quiz playback. 
See also Central Settings for Quizzes. 

• Page Style: 
Contains settings for the style of simulation pages. 
See also Designing Simulation Pages. 

• Feedback: 
Contains settings for the feedback during playback of the test mode or the practice mode. 

• Video: 
Contains duration settings for content pages for the video generation. 
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14.5.2 Macro Fallback Defaults 

The Macro Fallback Defaults area includes the fallback settings for all and deactivated (green lamp) parameters of 
the macros. The settings take effect during the playback of the content and can always be changed. To set fallback 
defaults allows it, to achieve consistency and to set parameters centrally. 

The area is separated into the macro groups: 

• Interactions 

• Special Macros 

• Page Macros 

• Quiz Items 

• Documentation Macros 

 Note 
Note that the Macro Fallback Defaults only take effect in non-activated parameter data. 

14.5.3 Book Page Fallback Defaults 

The Book Page Fallback Defaults area includes the fallback settings for all and deactivated (green lamp) parameters 
of the book page objects. The settings take effect during the playback of the content and can always be changed. To 
set fallback defaults allows it, to achieve consistency and to set parameters centrally. 

The area is separated into the book page object groups: 

• Action Objects 

• Layout 

• Link Buttons 

• Media Objects 

• Quiz Items 

• Book Page Objects 

 Note 
Note that the Book Page Fallback Defaults only take effect in non-activated parameter data. 

14.5.4 Settings of trainer, book reader, library and Modes 

The following chapters contain information about the setting areas and settings of: 

• trainer  

• book reader  

• library  

• Demo Mode 
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• Practice Mode 

• Test Mode 

• Concurrent Mode 

• Guided Presentation Mode 

• Free Presentation Mode 

14.5.4.1 Visual Properties 

The Visual properties section contains the following settings: 

• Show Focus Layer: 
Displays a gray layer to highlight the required control of the current step. 
Consider for each mode, when using the option: 

○ Demo mode: Shows a focus layer for the current control. 

○ Practice mode: Shows a focus layer for the required control if Show Help was selected for a wrong 
action. 

○ Test mode: Shows a focus layer for the required control if Show Help was selected for a wrong action. 

○ Concurrent mode: Shows a focus layer for the current control. 

○ Guided Presentation mode: No focus layer can be shown. 

○ Free Presentation mode: No focus layer can be shown. 

• Show start page / Show end page: 
When playing back a simulation, for each mode a start page can be displayed which explains the mode and 
what the user has to expect. When the simulation is over or was closed, a stop page is displayed in order to 
indicate that the mode has been terminated. In test mode the stop page also informs the user if he passed the 
test or not. 
 

14.5.4.2 Audio 

The trainer uses different audio channels to playback audio content. These channels allow authors to preconfigure 
the volume of the audio and learners can change the volume during playback. 

The following channels can be modified in the Audio subcategory for the Playback Settings of trainer - Global, book 
reader and for each simulation mode: 

Setting Description 

General 
Specifies the initial general volume of audio files (0-100). The volume of 
all other sound channels depends on this setting. 

Narrative 
Specifies the initial volume (0-100) of the sound channels Explanations 
and Page Sound. 
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Setting Description 

Book sound Specifies the initial volume (0-100) of the sound channel Book Sound. 

Effects Specifies the initial volume (0-100) of the sound channel Effects. 

Simulation sound 
Specifies the initial volume (0-100) of the sounds that is played in 
simulations. 

A volume slider is displayed for each audio channel in the control bar of the trainer bar or book reader bar. 

14.5.4.3 Function Keys 

Using the key functions, you can control the trainer via the keyboard. These correspond to the button functionality. 
The key functions are defined by default for Demo mode and Concurrent mode and the trainer, as it is possible to 
manipulate the sequence of events in these modes. For the book reader and the library the hotkeys for Back, Next 
and Feedback are used. 

The following keys are assigned by default to their respective functions: 

Function Key 

Play Space 

Pause Space 

Stop   

Back Left 

Next Right 

Feedback Ctrl + F1 

• Ignore Hotkeys for Browser: 
Defines that the hotkeys of the browser cannot be used during content playback. The learner can use only the 
navigations of the trainer and the specified hotkeys. 
The following hotkeys will not be prevented: 
Safari: CTRL+F, CTRL+P, CTRL+O 

14.6 SAP Companion for desktop: Authoring Settings 

The SAP Companion for desktop: Authoring Settings area contains settings for the creation, recording and editing of 
SAP Companion for desktop content. 
The SAP Companion for desktop: Authoring Settings are a resource type of the Adaptable Resources. 
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• Macro Initialization 
The Macro Initialization area includes the default settings for all editable parameters of the macros. The 
settings should be set before the recording or the insert of a macro to take effect. 

14.6.1 Macro Initialization 

The Macro Initialization area includes the initial settings for all editable parameters of the macros. The settings 
override the default settings of the Producer and should be set before the recording or the insert of a macro to take 
effect. To initialize the parameters allow it to achieve consistency in the content creation and to reduce the editing 
effort. 

14.7 SAP Companion for desktop: Playback Settings 

The SAP Companion for desktop: Playback Settings area contains settings for the playback of SAP Companion for 
desktop content, which will be interpreted at runtime of the SAP Companion for desktop. 
The SAP Companion for desktop: Playback Settings are a resource type of the Adaptable Resources. 

• General 
The settings on this page define the properties of SAP Companion for desktop content for the playback. 
Specific settings for an opened project can be set on the Project Override subpage. 

• Macro Fallback Defaults 
The Macro Fallback Defaults area includes the fallback settings for all and deactivated (green lamp ) 
parameters of the macros. 

• SAP Companion for desktop Settings 
The SAP Companion for desktop area contains settings for the playback of SAP Companion for desktop 
content. 

14.7.1 General 

The General settings contain the following subareas: 

Object Bubble 

Contains parameters for specifying the design of the object bubbles. 

Form Bubble 

Contains parameters for specifying the design of the form bubbles. 

Highlight 

Contains parameters for specifying the design of the highlights. 

Advanced (Advanced Layout) 
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• Update Frequency: 
Specifies how the frequently the SAP Companion for desktop checks for updated content. If updated content 
is available, the SAP Companion for desktop will start the content automatically. This is especially useful for 
change management processes. 

• Disable Standby Status: 
Specifies that the standby status of the SAP Companion for desktop cannot be set. If this option is 
deactivated, you can set the standby status with the shortcut CTRL + F11 or by clicking on the status icon. 

• Hide Exit Entry: 
Specifies that the 'Exit' entry in the context menu of the SAP Companion for desktop's status icon is hidden. 

• SAP Companion for desktop Tracking: 
Activates the tracking for SAP Companion for desktop content. The content has to be started from a Manager 
workarea. 

• Additional MIME Types: 
Defines additional MIME types that will be used by the local server to download SAP Companion for desktop 
content.The types must be defined one per line in the following format: 
msg:application/vnd.ms-outlook  
svg:image/svg+xml. 
For a full list of supported MIME types, see the chapter Supported MIME Types for Playback of this document. 

14.7.2 Macro Fallback Defaults 

The Macro Fallback Defaults area includes the fallback settings for all and deactivated (green lamp) parameters of 
the macros. The settings take effect during the playback of the content and can always be changed. To set fallback 
defaults allows it, to achieve consistency and to set parameters centrally. 

 Note 
Note that the Macro Fallback Defaults only take effect in non-activated parameter data. 

14.7.3 SAP Companion for desktop - SAP Companion 
Mode 

You can choose to use the SAP Companion mode to make your SAP Companion for desktop look and feel the same 
as SAP Companion. To activate it, select the checkbox Use SAP Companion mode. 

When you activate this mode, you can change the settings in the newly available group SAP Companion mode, which 
is now the first group of settings in the list. 

You can find the following setting in this group: 

• Style 
Defines the SAP Companion style shown during content playback. You can choose from styles defined in 
Adaptable Resources. Default is SAP Companion for desktop (SAP Companion mode). 

• Framework Server 
Defines the server from which the SAP Companion framework is loaded. The SAP Companion server provides 
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the in-app help framework. The server gets a request to load the framework.  
Default value is https://webassistant.enable-now.cloud.sap/. 
We recommend that you do not change the default framework URL as it always uses the latest release version. 

• Learning Center URL 
Defines the URL of the Learning Center. You can enter the URL to a library or an external page. 

 Recommendation 
You can enter the same URL that is used for the parameter learningCenterUrl in your SAP Companion. 

• Advanced: SAP Companion Parameters 
Most of the color customization parameters can be adjusted in Adaptable Resources, however, this field allows 
to add additional parameters for customization. Use the following syntax: Feature=value;. For example, 
showShortDescription=false;.  
You can find supported parameters and more information in SAP Companion Integration Guide, chapter 
Customizing the SAP Companion UI. 

Note 
When you have SAP Companion mode activated, some of the options for SAP Companion for desktop style and 
content become unavailable and are not shown in the further settings sections. For example, the Recording control 
becomes unavailable as this functionality is not supported in SAP Companion mode. 

For a full list of supported parameters, see the chapter Available Parameters for SAP Companion Mode of this 
document. 

14.7.4 SAP Companion for desktop - Style and Windows 

The settings for the appearance of the windows and sidebar are: 

• Style: 
Specifies the appearance of the SAP Companion for desktop's components. You can select a style from the 
resources. 

• Show Only Sidebar on Start: 
Specifies if only the sidebar is displayed instead of the main window when the SAP Companion for desktop is 
started.  

• Alignment: 
Specifies the alignment of the window on the screen. The option Free allows you to define a position in the 
associated parameter. 
Available for sidebar, main window, content window, and book window. 

• Position (Free): 
Specifies the window's position (left, top) for Free alignment on the screen. The values are given in pixels. 
Available for main window, content window, and book window. 

• Size: 
Specifies the size (width, height) of the main window in pixels. 
Available for main window, content window, and book window. 



 

Producer (Cloud Edition) 
Settings Dialog Box 

 
PUBLIC   522 

 

14.7.5 SAP Companion for desktop - Sidebar 

You can specify the position of a control in the sidebar for the playback of the SAP Companion for desktop. 

The settings for the sidebar are: 

• Position: 'Content' Control 

• Search 
The following settings allow you to configure the search of content: 

○ Search Type: 
Activates the search and specifies the search type. A control is displayed in the sidebar. 
You can search in the library or in the SAP Companion for desktop content. 

○ Search Group: 
Allows you to define a group of the workarea for searching content in the library. 

○ Position: 'Search' Control  

• External Search 
The following settings allow you, to configure the external search of content: 

○ URL 

○ Provide Context Information 

○ Context Information 

• Position: 'Instant Help' Control 

• Position: 'Add Sticky Note' Control 

• Request Content 
The following settings allow you, to configure the request of content: 

○ Request Content Type 

○ Request Content E-Mail / URL: 
Allows you to specify an e-mail address or a URL. 

○ Request Content URL Params: 
Allows you to specify the parameters for the author URL. 

○ Position: 'Request Content' Control 

• Position: 'Recording' Control 

• Position: 'Exit' Control 

Control Position 

For each control, you can specify a position in the sidebar. The controls can be positioned on the main level of the 
sidebar, some controls can also be positioned in the submenu. For the submenu, a control is displayed to open the 
submenu. 
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 Note 
Make sure to select for each control a unique position in the sidebar. For each position only one control is 
displayed. 

14.7.6 SAP Companion for desktop - Content and Behavior 

The settings for the content and behavior are: 

• Use Text from: 
Defines the text type for the SAP Companion for desktop. The default is Short Description. 

• Default Start Content: 
Defines the mode or the document format to be started by default from the content list.  

• Default Start Document: 
Defines the document type, if a document is set in the Default Start Content setting.  

• Show 'Info' Tab: 
Displays an control in the main window to display an info text. The info text can be entered in the short 
description of the SAP Companion for desktop group. 

• Show 'Share Content' Control 
Displays a 'Share Content' button in the footer of the main window. The button opens a dialog box with the link 
to the selected content. 

• Consider Roles: 
Activates the use of roles for the display of content during playback. 
See also Using Roles.  

• Consider Content Categories 
Activates the use of content categories for sorting content in the main window of the SAP Companion for 
desktop. 

• Content Sorting 
Defines the sorting of the available content in the list. 

• Hide Instant Help in Guided Tour: 
Defines that all instant help information are hidden during playback of the guided tour. If the guided tour has 
been finished, the instant help will be shown again.  

• Hide Book Reader Control Bar: 
Specifies if the book reader control bar is hidden during playback of books or book pages. 

• Exchange SAP Companion for desktop Direct Start and More options 
If this setting is activated, then clicking the bigger area of the SAP Companion for desktop item will start to 
play the content, whereas the smaller area will go into the detailed view where you can select additional 
options for this content item. 

• Enable Fuzzy match 
Defines whether fuzzy match is used for matching the context of the content with an application page. 

• Enable Advanced Application Identification 
Specifies that only the relevant application information is used for the SAP Companion for desktop playback. 
This allows you to optimize the performance of the SAP Companion for desktop.  
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Note: The option can lead to a false object recognition. It is recommended to test the playback before 
publishing the content. 

• Clear Content List on Context Mismatch 
Defines that the content list is cleared if no context was found. With deactivated setting the content of the last 
recognized object is shown. 

• Hide SAP Companion for desktop on Running SAP Companion 
Specifies that SAP Companion for desktop windows are hidden when SAP Companion is running in the 
foreground. 

○ Show SAP Companion Message 
Specifies that a message is displayed when SAP Companion is running in the foreground or leaves the 
foreground mode. 

○ Open SAP Companion Panel 
Opens the SAP Companion panel when SAP Companion is running in the foreground and SAP 
Companion for desktop windows are hidden. 
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14.7.7 Available Parameters for SAP Companion Mode 

The SAP Companion mode supports the following parameters of SAP Companion for desktop:  

SAP Companion for desktop Style and Windows  

Parameter SAP Companion Mode 

  

Style 
 

  

Show Only Sidebar on Start 
 

  

Sidebar Alignment 
 

  

Main Window Alignment 
 

  

Main Window Position (Free) 
 

  

Main Window Size 
 

  

Content Window Alignment 
 

  

Content Window Position (Free) 
 

  

Content Window Size 
 

  

Book Window Alignment 
 

  

Book Window Position (Free) 
 

  

Book Window Size 
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SAP Companion for desktop Sidebar  

 Parameter SAP Companion Mode 

  

Position: 'Content' Control 
 

  

Search Type 
 

  

Position: 'External Search' Control 
 

  

Position: 'Instant Help' Control 
 

  

Position: 'Add Sticky Note' Control 
 

  

Request Content Type 
 

  

Position: 'Recording' Control 
 

  

Position: 'Exit' Control 
 

SAP Companion for desktop Content and Behavior 

 Parameter SAP Companion Mode 

  

Use Text From 
 

  

Default Start Content 
 

  

Default Start Document 
 

  

Show 'Info' Tab 
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 Parameter SAP Companion Mode 

  

Show 'Share Content' Control 
 

  

Consider Roles 
 

  

Consider Content Categories 
 

  

Content Sorting 
 

  

Hide Instant Help in Guided Tour 
 

  

Switch SAP Companion for desktop Direct Start and More 
Option 

 

Hide Book Reader Control Bar  

  

Enable Fuzzy Match 
 

  

Enable Advanced Application Identification 
 

  

Clear Content List on Content Mismatch 
 

  

Hide SAP Companion for desktop on Running SAP 
Companion 
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Cache 

 Parameter SAP Companion Mode 

  

Use Caching 
 

  

Folder Location 
 

Glossary Bubble 

 Parameter SAP Companion Mode 

  

Style 
 

  

Size 
 

 Supported 

 Not supported 

Note 
The following functionality is also not supported in SAP Companion for desktop - SAP Companion Mode: 

• Focus Layer  

• Restricted Mode 

• Form Mode 

• Conditions for Guided Tours and Context Help 

• Step List for Guided Tours 

• Automatic start of content 

• Content object attachments 

• SAP Companion for desktop Details window 
Also note that: 

• Each bubble macro of a Context Help project is represented as a tile in the Help Panel 

• Both short and long asset descriptions can only contain plain text and text length is limited to 234 symbols 

• Only one asset can be started for a content object, you need to specify it in the Default Start Content option 
There is also some regular SAP Companion functionality missing in this mode: 

• What’s New Mode 

• Link Tiles 

• Icons for Context Help tiles 
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14.7.8 Supported MIME Types for SAP Companion for 
desktop Playback 

The following MIME Types are supported for the SAP Companion for desktop playback: 

  

MIME Type in correct input format 

avi:video/avi 

mp4:video/mp4 

wmv:video/x-ms-wmv 

jpg:image/jpeg 

jpeg:image/jpeg 

gif:image/gif 

svg:image/svg+xml 

bmp:image/x-ms-bmp 

png:image/png 

htm:text/html 

html:text/html 

md:text/markdown 

rtf:application/msword 

docx:application/msword 

doc:application/msword 

dot:application/msword 

pptx:application/vnd.ms-powerpoint 

ppt:application/vnd.ms-powerpoint 

pot:application/vnd.ms-powerpoint 

xlsx:application/vnd.openxmlformats-officedocument.spreadsheetml.sheet 
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MIME Type in correct input format 

xls:application/vnd.ms-excel 

pdf:application/pdf 

txt:text/plain 

wav:audio/x-wav 

mp3:audio/x-mp3 

gsm:audio/x-gsm 

js:application/javascript 

css:text/css 

xml:text/xml 

xliff:text/xml 

xlf:text/xml 

xlf:text/xml 

dnt:application/x-datango-navigation 

dkp:application/x-datango-package 

slc:application/x-wpb-slc 

potx:application/vnd.openxmlformats-officedocument.presentationml.template 

xltx:application/vnd.openxmlformats-officedocument.spreadsheetml.template 

dotx:application/vnd.openxmlformats-officedocument.wordprocessingml.template 

ttf:application/octet-stream 

woff:application/font-woff 

woff2:application/font-woff2 

svg:image/svg+xml 

eot:application/vnd.ms-fontobject 

msg:application/vnd.ms-outlook 
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14.8 Documentation Settings 

The Documentation Settings area contains settings for the creation of documentation. The properties of each 
documentation type can be specified individually. 
The Documentation Settings are a resource type. 

Further information to the documentation settings is available in the chapter Documentation Settings. 
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15 Technical Support 

Please use the SAP Incident Wizard on the SAP Support Portal to submit your incidents on the following 
components: 

• KM-SEN // Enable Now 

• KM-SEN-PRO // Enable Now – Producer 

• KM-SEN-IPR // Enable Now – Instant Producer 

• KM-SEN-MGR // Enable Now – Manager 

• KM-SEN-NAV // Enable Now – SAP Companion for desktop 

• KM-SEN-CXH // Enable Now – Context Sensitive Help 

• KM-SEN-APR // Enable Now – Application Profiles 

• KM-SEN-SMI // Enable Now – Solution Manager Integration 

Using the SAP Support Portal 

If you are not familiar with the SAP Support Portal, read the following information: 

• To access the SAP Support Portal you need an S-user ID and password. You can request access data from 
your SAP Super Administrator or register online on the SAP Support Portal page under Registration. 

• With this user, you have read-access to all the contents of the SAP Support Portal, you can use the SAP 
Community Network and SAP Help Portal, and you can also book courses under SAP Education. 

• If you want to work with the support applications (Incident Wizard, license key request, system data 
maintenance, manage remote connections, software download and so on), you need the corresponding 
authorizations, which your SAP Super Administrator can give you. 

• You can find information for new users and about support applications on the Support Portal Homepage 
under Learn More. There you can also register for a personal overview demonstration of the SAP Support 
Portal. 

• In case of problems with SAP Support Portal contact your local Customer Interaction Center.  
An online web form is available on http://support.sap.com/contactus. This web form should be used for all 
written communication with your local customer interaction center. More Details about Incident Processing, 
Support Addresses and Hotline Numbers can be found here:  
http://service.sap.com/sap/support/notes/560499 

• Are you interested in a tour through the SAP Support Portal? Register for an online demo. 

Diagnosis function in Producer 

The Producer diagnosis function can also be used to check the technical data of the installation on your computer 
(version, operating system, browser, etc.). Open Producer and select Diagnosis… by using the Help menu. The 
Producer transmits the required information automatically and lists this in a corresponding dialog box. This 
information can also be saved as a text file and sent as an E-mail attachment to the SAP support staff. 

http://support.sap.com/contactus
http://service.sap.com/sap/support/notes/560499
https://service.sap.com/%7Eform/sapnet?_FRAME=OBJECT&_HIER_KEY=501100035870000019462&_HIER_KEY=601100035870000239025&_HIER_KEY=701100035871000579073&_SCENARIO=01100035870000000202&#HOME
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16 Important Disclaimers on Legal Aspects 

This document is for informational purposes only. Its content is subject to change without notice, and SAP does not 
warrant that it is error-free. SAP MAKES NO WARRANTIES, EXPRESS OR IMPLIED, OR OF MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Coding Samples 

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are 
not intended to be used in a productive system environment. The Code is only intended to better explain and 
visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness 
of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless 
damages were caused by SAP intentionally or by SAP's gross negligence. 

Accessibility 

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of 
the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software 
products. SAP specifically disclaims any liability with respect to this document and no contractual obligations or 
commitments are formed either directly or indirectly by this document. 

Gender-Neutral Language 

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed 
directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to 
members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not 
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the 
documentation remains comprehensible. 

Internet Hyperlinks 

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint 
about where to find related information. SAP does not warrant the availability and correctness of this related 
information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages 
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful 
misconduct. Regarding link classification, see: http://help.sap.com/disclaimer. 

http://help.sap.com/disclaimer
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